Dell™ Multifunction Color Laser Printer 3115cn User's Guide

Click the links to the left for information on the features, options, and operation of your multifunction printer. For information on other documentation included with your multifunction printer, see "Finding Information."
To order replacement print cartridges or supplies from Dell:

1. Double-click the icon on your desktop.

2. Visit Dell's website, or order Dell printer supplies by phone.

   www.dell.com/supplies

   For best service, have your Dell printer Service Tag available.

   For help locating your Service Tag number, see "Express Service Code and Service Tag number."

---

**Notes, Notices, and Cautions**

- **NOTE:** A NOTE indicates important information that helps you make better use of your multifunction printer.
UNITED STATES GOVERNMENT RESTRICTED RIGHTS

This software and documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 and in applicable FAR provisions: Dell Inc., One Dell Way, Round Rock, Texas, 78682, USA.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules.

November 2008 Rev. A02
# Finding Information

<table>
<thead>
<tr>
<th>What are you looking for?</th>
<th>Find it here</th>
</tr>
</thead>
</table>
| · Drivers for my multifunction printer  
  · My *User's Guide* | *Drivers and Utilities CD* |

The *Drivers and Utilities CD* contains documentation and drivers for your multifunction printer. You can use the CD to uninstall/reinstall drivers or access your documentation.

Readme files may be included on your CD to provide last-minute updates about technical changes to your multifunction printer or advanced technical reference material for experienced users or technicians.

| · Safety information  
  · How to use my multifunction printer  
  · Warranty information | *Owner's Manual* |

⚠️ **CAUTION:** Read and follow all safety instructions in your *Owner's Manual* prior to setting up and operating your multifunction printer.

NOTE: The *Owner's Manual* may not be available in your country or region.

| · Safety information  
  · Warranty information | *Product Information Guide* |

⚠️ **CAUTION:** Read and follow all safety instructions in the *Product Information Guide* prior to setting up and operating your multifunction printer.
<table>
<thead>
<tr>
<th>How to set up my multifunction printer</th>
<th>Setup diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Troubleshooting Guide</td>
<td><strong>Troubleshooting Guide:</strong></td>
</tr>
<tr>
<td></td>
<td>- User Settings</td>
</tr>
<tr>
<td></td>
<td>- Configuration</td>
</tr>
<tr>
<td></td>
<td>- Troubleshooting Instructions</td>
</tr>
<tr>
<td></td>
<td>- Others</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Express Service Code and Service Tag number</th>
</tr>
</thead>
</table>

The Express Service Code and Service Tag numbers are located inside the front door of your multifunction printer.
Dell Support Website

The Dell Support Website provides several online tools, including:
- Solutions - Troubleshooting hints and tips, articles from technicians, and online courses
- Upgrades - Upgrade information for components, such as memory
- Customer Care - Contact information, order status, warranty, and repair information
- Downloads - Drivers
- Reference - Multifunction printer documentation and product specifications

You can access Dell Support at support.dell.com. Select your region on the support page, and fill in the requested details to access help tools and information.
Dell Printer Configuration Web Tool

Using the Dell Printer Configuration Web Tool

One of the features of the Dell Printer Configuration Web Tool is the E-Mail Alert Setup, which sends you or the key operator an e-mail when the multifunction printer needs supplies or intervention.

To fill out printer inventory reports requiring the asset tag number of all of the multifunction printer in your area, use the Printer Information feature in the Dell Printer Configuration Web Tool. Just type the IP address of each printer on the network to display the asset tag number.

The Dell Printer Configuration Web Tool feature also lets you change printer settings and keep track of printing trends. If you are a network administrator, you can easily copy the printer's settings to one or all printers on the network using your Web browser.

To launch the Dell Printer Configuration Web Tool, type your network printer's IP address in your Web browser.

If you do not know what your printer's IP address is, print a printer settings page, which lists the IP address:

1. Press ▼ until >SETUP appears, and then press ✓.
1. Press ▼ until >Reports appears, and then press ✓.

2. System Settings is displayed. Press ✓.

   The system settings page is printed.

   If the IP address shows 0.0.0.0 (the factory default), an IP address has not been assigned. To assign one for your multifunction printer, see "Assign an IP Address."

   Use the Dell Printer Configuration Web Tool for:

   **Printer Status**

   Use the Printer Status menu to get immediate feedback on printer supply status. When print cartridge is running low, click the Order Supplies link on the first screen to order additional print cartridges.

   **Printer Jobs**

   Use the Printer Jobs menu to contain information on Job List page and Completed Jobs page. These pages show the details of the status regarding each protocol or the print jobs.

   **Printer Settings**

   Use the Printer Settings menu to change printer settings and view the operator panel remotely.

   **Print Server Settings**

   Using the Print Server Settings menu, you can change the type of printer interface and necessary conditions for communications.

   **Copy Printer Settings**

   Use the Copy Printer Settings menu to copy the printer's settings to another printer or printers on the network just by typing each printer’s IP address.

   **NOTE:** You must log in as an administrator to use this feature.

   **Address Book**

   Use the Address Book menu to organize E-Mail Address, Server Address and Phone Book.

   **Print Volume**

   Use the Print Volume option to keep track of printing trends, such as paper usage and types of jobs being printed, and limit which users use the color mode and the maximum number of pages they can print.
Printer Information

Use the Printer Information menu to get the information you need for service calls, inventory reports, or the status of current memory and engine code levels.

Tray Settings

Use the Tray Settings menu to get the information about the paper type and size for each tray.

E-Mail Alert

Use the E-Mail Alert menu to receive an e-mail when the multifunction printer needs supplies or intervention. Type your name or the key operator's name in the e-mail list box to be notified.

Set Password

Use the Set Password menu to lock the operator panel with a password so that other users don't inadvertently change the printer settings you selected.

NOTE: You must log in as an administrator to use this feature.

Online Help

Click Online Help to visit the Dell web page, and see the User's Guide on that page to verify configured settings.

Order Supplies at:

www.dell.com/supplies

Contact Dell Support at:

support.dell.com

Using the Dell Printer Configuration Web Tool

Be sure to activate JavaScript in your browser before using the Dell Printer Configuration Web Tool.

Environment Settings for Web Browsers

Dell recommends configuring the environment settings for your Web browsers, before using the Dell Printer Configuration Web Tool.
NOTE: The Dell Printer Configuration Web Tool pages may be displayed unreadable if you browse the pages that were configured by using the browser of which language setting is different with your browser's.

For Internet Explorer 6.0/7.0

Setting Up the Display Language

1. Select **Preferences** from the **Edit** menu.
2. Select **Languages** in the **General** tab.
3. Specify the display language in order of preference in the **Language in order of preference** list.

   For example:
   - Italian (Italy) [it]
   - Spanish (Traditional Sort) [es]
   - German (Germany) [de]
   - French (France) [fr]
   - English [en] or English (United States) [en-us]

Setting the Printer's IP Address to Non-proxy

1. Select **Internet Options** from the **Tools** menu.
2. Select **Proxy server** under **LAN Settings** in the **Connections** tab.
3. Do either of the following:
   - Clear the **Use a proxy server for your LAN** check box.
   - Click **Advanced**, and then specify the printer's IP address in the **Do not use proxy server for addresses beginning with** field under **Exceptions**.

When you have finished setting the language and proxy, type `<http://nnn.nnn.nnn.nnn/>` (the printer's IP address) in the URL entry field of the browser to activate the **Dell Printer Configuration Web Tool**.

For Netscape Communicator 7.1

Setting Up the Display Language

1. Select **Preferences** from the **Edit** menu.
2. Select **Languages** under the **Navigator** group.
3. Specify the display language in order of preference in the **Language in order of preference** list.

For example:
- English [en] or English/United States [en-us]
- German [de]
Setting the Printer’s IP Address to Non-proxy

1. Select **Preferences** from the **Edit** menu.

2. In the Navigator group, select **Proxies** in the **Advanced** tab. 

3. Select either **Direct connection to the Internet** or **Manual proxy configuration**. When you select **Manual proxy configuration**, specify the printer’s IP address in the **No Proxy for:** box.

When you have finished setting the language and proxy, type `<http://nnn.nnn.nnn.nnn/>` (the printer’s IP address) in the URL entry field of the browser to activate the **Dell Printer Configuration Web Tool**.

For Firefox 1.5 or Later

Setting Up the Display Language

1. Select **Options** from the **Tools** menu.

2. In the Navigator group, select **Proxies** in the **Advanced** tab.

3. Click Edit Languages in the General tab.

4. Specify the display language in order of preference in the Language in order of preference list.

For example:

*English [en] or English/United States [en-gb]*
*Italian [it]*
*Spanish [es]*
*German [de]*
*French [fr]*
*Netherlands [nl]*
*Norwegian [no]*
*Swedish [sv]*

Setting the Printer’s IP Address to Non-proxy

1. Select **Options** from the **Tools** menu.

2. Click General on the Options dialog box.

3. Click Connection Settings→Connection Settings.

4. Do one of the following:
When you have finished setting the language and proxy, type <http://nnn.nnn.nnn.nnn/> (the printer's IP address) in the URL entry field of the browser to activate the Dell Printer Configuration Web Tool.

**Page Display Format**

The layout of the page is divided into three sections mentioned below:

**Top Frame**

Located at the top of all pages is the Top Frame. When Dell Printer Configuration Web Tool is activated, the current status and specifications of the multifunction printer are displayed in the Top Frame on every page.

The following items are displayed in the Top Frame.

<table>
<thead>
<tr>
<th>Dell MFP Laser 3115cn</th>
<th>Displays the printer product name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address:</td>
<td>Displays the printer's IP address.</td>
</tr>
<tr>
<td>Location:</td>
<td>Displays the printer's location. The location can be changed in Basic Information on the Print Server Settings page.</td>
</tr>
<tr>
<td>Contact Person:</td>
<td>Displays the printer's administrator's name. The name can be changed in the Basic Information on the Print Server Settings page.</td>
</tr>
<tr>
<td>Printer Console</td>
<td>Displays the status of the printer operator panel display and indicators. This is automatically refreshed at the set interval. The interval can be changed in the Basic Information on Print Server Settings page.</td>
</tr>
<tr>
<td>Help</td>
<td>Links to the Dell web page. See the User's Guide on the Dell Support site for help on this product.</td>
</tr>
<tr>
<td>Printer Bitmap</td>
<td>Shows the printer bitmap. The Printer Status menu appears in the Right Frame by clicking the bitmap.</td>
</tr>
</tbody>
</table>

**Left Frame**

Located at the left side of all pages is the Left Frame. The titles of menus displayed in the Left Frame are linked to corresponding menus and pages. You can go to the corresponding page by clicking their characters.

The following menus are displayed in the Left Frame.
### Right Frame

Located at the right side of all pages is the Right Frame. The contents of the Right Frame correspond to the menu that you select in the Left Frame. For details on the items displayed in the Right Frame, see "Details of Menu Items ."

#### Buttons on the Right Frame

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Refresh Button</strong></td>
<td>Receives the current printer configuration and updates the latest information in the Right Frame.</td>
</tr>
<tr>
<td><strong>Apply New Settings Button</strong></td>
<td>Submits new settings made on the Dell Printer Configuration Web Tool to the multifunction printer. The old printer settings will be replaced by the new settings.</td>
</tr>
<tr>
<td><strong>Restart printer to apply new settings Button</strong></td>
<td>Submits new settings made on the Dell Printer Configuration Web Tool to the multifunction printer and reboots the multifunction printer. The old printer settings will be replaced by the new settings.</td>
</tr>
<tr>
<td><strong>Restore Settings Button</strong></td>
<td>Restores the old settings from before changes made. New settings will not be submitted to the multifunction printer.</td>
</tr>
</tbody>
</table>

#### Changing the Settings of Menu Items
Some menus allow you to change the printer settings through the **Dell Printer Configuration Web Tool**. When you are accessing these menus, the authentication dialog appears on the screen. Type a user name and password for the printer's administrator by following the prompts displayed in the dialog box.

The default user name is **admin**, and the default password is left blank (NULL). You can change only the password in the **Set Password** page in the **Print Server Settings** menu. The user name cannot be changed. See "Set Password" for more information.

### Details of Menu Items

<table>
<thead>
<tr>
<th>Printer Status</th>
<th>Printer Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Events</td>
<td></td>
</tr>
<tr>
<td>Printer Information</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Printer Jobs</th>
<th>Job List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed Jobs</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Printer Settings</th>
<th>Printer Settings Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Settings</td>
<td></td>
</tr>
<tr>
<td>Reports</td>
<td></td>
</tr>
<tr>
<td>System Settings</td>
<td></td>
</tr>
<tr>
<td>Parallel Settings</td>
<td></td>
</tr>
<tr>
<td>Network Settings</td>
<td></td>
</tr>
<tr>
<td>USB Settings</td>
<td></td>
</tr>
<tr>
<td>PCL Settings</td>
<td></td>
</tr>
<tr>
<td>PS Settings</td>
<td></td>
</tr>
<tr>
<td>Secure Settings</td>
<td></td>
</tr>
<tr>
<td>Copy Defaults</td>
<td></td>
</tr>
<tr>
<td>Copy Color Balance</td>
<td></td>
</tr>
<tr>
<td>Copy Settings</td>
<td></td>
</tr>
<tr>
<td>Scan Defaults</td>
<td></td>
</tr>
<tr>
<td>Fax Defaults</td>
<td></td>
</tr>
<tr>
<td>Fax Settings</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Printer Maintenance</th>
<th>Paper Density</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust BTR</td>
<td></td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Category</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Fuser</td>
<td>&quot;Adjust Fuser &quot;</td>
</tr>
<tr>
<td>Auto Registration Adjustment</td>
<td>&quot;Auto Registration Adjustment &quot;</td>
</tr>
<tr>
<td>Color Registration Adjustments</td>
<td>&quot;Color Registration Adjustments &quot;</td>
</tr>
<tr>
<td>Adjust Altitude</td>
<td>&quot;Adjust Altitude &quot;</td>
</tr>
<tr>
<td>Reset Defaults</td>
<td>&quot;Reset Defaults &quot;</td>
</tr>
<tr>
<td>Clear Storage *1</td>
<td>&quot;Clear Storage &quot;*1</td>
</tr>
<tr>
<td>Non-Dell Toner</td>
<td>&quot;Non-Dell Toner &quot;</td>
</tr>
<tr>
<td>Initialize PrintMeter</td>
<td>&quot;Initialize PrintMeter &quot;</td>
</tr>
<tr>
<td>Clock Settings</td>
<td>&quot;Clock Settings &quot;</td>
</tr>
<tr>
<td>Web Link Customization</td>
<td>&quot;Web Link Customization &quot;</td>
</tr>
<tr>
<td>Print Server Settings</td>
<td>&quot;Print Server Settings &quot;</td>
</tr>
<tr>
<td>Print Server Reports</td>
<td>&quot;Print Server Reports &quot;</td>
</tr>
<tr>
<td>Print Server Setup Page</td>
<td>&quot;Print Server Setup Page &quot;</td>
</tr>
<tr>
<td>NetWare Setup Page *2</td>
<td>&quot;NetWare Setup Page &quot;*2</td>
</tr>
<tr>
<td>E-Mail Alert Setup Page</td>
<td>&quot;E-Mail Alert Setup Page &quot;</td>
</tr>
<tr>
<td>Print Server Settings</td>
<td>&quot;Print Server Settings &quot;</td>
</tr>
<tr>
<td>Basic Information</td>
<td>&quot;Basic Information &quot;</td>
</tr>
<tr>
<td>Port Settings</td>
<td>&quot;Port Settings &quot;</td>
</tr>
<tr>
<td>Wireless LAN *3</td>
<td>&quot;Wireless LAN &quot;*3</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>&quot;TCP/IP &quot;</td>
</tr>
<tr>
<td>NetWare *2</td>
<td>&quot;NetWare &quot;*2</td>
</tr>
<tr>
<td>SMB *2</td>
<td>&quot;SMB &quot;*2</td>
</tr>
<tr>
<td>AppleTalk *3</td>
<td>&quot;AppleTalk &quot;*3</td>
</tr>
<tr>
<td>E-Mail Alert</td>
<td>&quot;E-Mail Alert &quot;</td>
</tr>
<tr>
<td>Bonjour (mDNS) *2</td>
<td>&quot;Bonjour (mDNS) &quot;*2</td>
</tr>
<tr>
<td>SNMP</td>
<td>&quot;SNMP &quot;</td>
</tr>
<tr>
<td>Scan to PC</td>
<td>&quot;Scan to PC &quot;</td>
</tr>
<tr>
<td>Other Features</td>
<td>&quot;Other Features &quot;</td>
</tr>
<tr>
<td>Set Password</td>
<td>&quot;Set Password &quot;</td>
</tr>
<tr>
<td>Security *3</td>
<td>&quot;Security &quot;*3</td>
</tr>
<tr>
<td>IPsec *2</td>
<td>&quot;IPsec &quot;*2</td>
</tr>
<tr>
<td>Reset Print Server</td>
<td>&quot;Reset Print Server &quot;</td>
</tr>
<tr>
<td>Copy Printer Settings</td>
<td>Copy Printer Settings Report</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Print Volume</td>
<td>Print Volume</td>
</tr>
<tr>
<td>Del ColorTrack</td>
<td></td>
</tr>
<tr>
<td>Address Book</td>
<td>E-Mail Address</td>
</tr>
<tr>
<td></td>
<td>Server Address - Top Page</td>
</tr>
<tr>
<td></td>
<td>Phone Book</td>
</tr>
<tr>
<td>Tray Settings</td>
<td>Tray 1 Paper Type</td>
</tr>
<tr>
<td></td>
<td>Tray 1 Paper Size</td>
</tr>
<tr>
<td></td>
<td>Tray 1 Custom Size - Y</td>
</tr>
<tr>
<td></td>
<td>Tray 1 Custom Size - X</td>
</tr>
<tr>
<td></td>
<td>Tray 2 Paper Type **5</td>
</tr>
<tr>
<td></td>
<td>Tray 2 Paper Size **5</td>
</tr>
<tr>
<td></td>
<td>Tray 2 Custom Size - Y **5</td>
</tr>
<tr>
<td></td>
<td>Tray 2 Custom Size - X **5</td>
</tr>
<tr>
<td></td>
<td>MPF Mode</td>
</tr>
<tr>
<td></td>
<td>Display Popup</td>
</tr>
<tr>
<td></td>
<td>MPF Paper Type</td>
</tr>
<tr>
<td></td>
<td>MPF Paper Size</td>
</tr>
<tr>
<td></td>
<td>MPF Custom Size - Y</td>
</tr>
<tr>
<td></td>
<td>MPF Custom Size - X</td>
</tr>
</tbody>
</table>

*1 This item is only available when the RAM disk is set to on.

*2 This item is only available when the optional multi-protocol card is installed.

*3 This item is only available when the optional wireless printer adapter is installed.

*4 This item is only available with the printer using the PostScript driver.

*5 This item is only available when the optional 550-sheet paper feeder is installed.

**Printer Status**

Use the **Printer Status** menu to check the status of consumables, hardware, and specifications of the multifunction printer.
The following pages are displayed in the **Printer Status** menu.

**Printer Status**

**Purpose:**
To check the status of remaining consumables and trays.

**Values:**

<table>
<thead>
<tr>
<th>Consumables</th>
<th>Status</th>
<th>n%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyan Cartridge Level</td>
<td>Displays the percent of toner remaining in each print cartridge. When a cartridge is empty, a message appears. The text <em>Print Cartridge</em> is linked to the Dell Printer Supplies website.</td>
<td></td>
</tr>
<tr>
<td>Magenta Cartridge Level</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yellow Cartridge Level</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Black Cartridge Level</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Trays</th>
<th>Status</th>
<th>OK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates that there is some paper in the tray but the quantity is unknown.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Paper</td>
<td>Indicates that there is no paper in the tray.</td>
<td></td>
</tr>
</tbody>
</table>

| Capacity | Displays the maximum capacity of the paper tray. |
| Size | Displays the size of paper in the tray. |

<table>
<thead>
<tr>
<th>Output Tray</th>
<th>Status</th>
<th>OK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates that the tray is available.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Capacity | Displays the maximum capacity of the paper tray. |

<table>
<thead>
<tr>
<th>Cover</th>
<th>Status</th>
<th>Closed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicates that the cover is closed.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Open | Indicates that the cover is open. |

| Printer Type | Displays the type of printing for the multifunction printer. *Color Laser* is displayed normally. |

| Printing Speed | Displays the printing speed for the multifunction printer. |

**Printer Events**

**Purpose:**
When printer faults occur such as *running out of paper* or *running out of print cartridge*, the details of all alerts or indications of faults are displayed in the **Printer Events** page.

**Values:**
<table>
<thead>
<tr>
<th>Location</th>
<th>Displays the location where the printer fault occurred.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Displays the details of the printer fault.</td>
</tr>
</tbody>
</table>

**Printer Information**

**Purpose:**
To verify the printer details such as hardware configuration and software version. This page can also be displayed by clicking **Printer Information** in the Left Frame.

**Values:**

<table>
<thead>
<tr>
<th>Dell Service Tag Number</th>
<th>Displays Dell's service tag number.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Tag Number</td>
<td>Displays the printer's asset tag number.</td>
</tr>
<tr>
<td>Printer Serial Number</td>
<td>Displays the printer's serial number.</td>
</tr>
<tr>
<td>Memory Capacity</td>
<td>Displays the memory capacity.</td>
</tr>
<tr>
<td>Processor Speed</td>
<td>Displays the processing speed.</td>
</tr>
<tr>
<td>Printer Revision Levels</td>
<td><strong>Firmware Version</strong> Displays the revision date (revision level).</td>
</tr>
<tr>
<td></td>
<td><strong>Network Firmware Version</strong> Displays the revision date (revision level).</td>
</tr>
</tbody>
</table>

**Printer Jobs**

The **Printer Jobs** menu contains information on the **Job List** and **Completed Jobs** pages. These pages show the details of the status regarding each protocol or the print jobs.

**Job List**

**Purpose:**
To confirm the print jobs that are being processed. Click the **Refresh** button to update the screen.

**Values:**
<table>
<thead>
<tr>
<th>ID</th>
<th>Displays the job id.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>Displays the file name of the job being printed.</td>
</tr>
<tr>
<td>Owner</td>
<td>Displays the job owner's name.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Displays the name of the host computer.</td>
</tr>
<tr>
<td>Job Status</td>
<td>Displays the status of the job being printed.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Displays the type of the job.</td>
</tr>
<tr>
<td>Host I/F</td>
<td>Displays the status of the host interface.</td>
</tr>
<tr>
<td>Job Submitted Time</td>
<td>Displays the date the print job was submitted.</td>
</tr>
</tbody>
</table>

**Completed Jobs**

**Purpose:**
To check the completed print jobs. Up to the last 22 print jobs are displayed. Click the **Refresh** button to update the screen.

**Values:**

<table>
<thead>
<tr>
<th>Id</th>
<th>Displays the job id.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>Displays the file name of the completed print job.</td>
</tr>
<tr>
<td>Owner</td>
<td>Displays the job owner's name.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Displays the name of the host computer.</td>
</tr>
<tr>
<td>Output Result</td>
<td>Displays the status of completed print jobs.</td>
</tr>
<tr>
<td>Job Type</td>
<td>Displays the type of the job.</td>
</tr>
<tr>
<td>Impression Number</td>
<td>Displays the number of pages in the print job.</td>
</tr>
<tr>
<td>No. of Sheets</td>
<td>Displays the number of sheets in the print job.</td>
</tr>
<tr>
<td>Host I/F</td>
<td>Displays the status of the host interface.</td>
</tr>
<tr>
<td>Job Submitted Time</td>
<td>Displays the date the print job was submitted.</td>
</tr>
</tbody>
</table>

**Printer Settings**

Use the **Printer Settings** menu to display the printer settings report and to configure printer settings.

The following tabbed pages are displayed at the top of the Right Frame.

**Printer Settings Report**
The **Printer Settings Report** tab includes the **Menu Settings** and **Reports** pages.

**Menu Settings**

**Purpose:**
To display the current settings of the operator panel menus.

**Values:**

<table>
<thead>
<tr>
<th>System Settings</th>
<th>Power Saver Mode 2</th>
<th>Displays the status for the power saver mode 2.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Saver Timer Mode 1</td>
<td>Displays the amount of time before the multifunction printer enters the power saver timer mode 1 after it finishes a print job.</td>
<td></td>
</tr>
<tr>
<td>Power Saver Timer Mode 2</td>
<td>Displays the amount of time before the multifunction printer enters the power saver timer mode 2 after it finishes a print job.</td>
<td></td>
</tr>
<tr>
<td>Auto Reset</td>
<td>Displays the amount of time before the printer is reset.</td>
<td></td>
</tr>
<tr>
<td>Panel Select Tone</td>
<td>Displays the selected tone for the panel.</td>
<td></td>
</tr>
<tr>
<td>Panel Alert Tone</td>
<td>Displays the alert tone for the panel.</td>
<td></td>
</tr>
<tr>
<td>Machine Ready Tone</td>
<td>Displays the tone when the machine becomes ready.</td>
<td></td>
</tr>
<tr>
<td>Copy Job Tone</td>
<td>Displays the tone when copying starts.</td>
<td></td>
</tr>
<tr>
<td>Non-Copy Job Tone</td>
<td>Displays the tone when copying is complete.</td>
<td></td>
</tr>
<tr>
<td>Fault Tone</td>
<td>Displays the tone when an error occurs.</td>
<td></td>
</tr>
<tr>
<td>Alert Tone</td>
<td>Displays whether the multifunction printer sounds an alarm when an error occurs.</td>
<td></td>
</tr>
<tr>
<td>Out of Paper Tone</td>
<td>Displays the tone when the paper runs out.</td>
<td></td>
</tr>
<tr>
<td>Low Toner Tone</td>
<td>Displays the tone when the toner is low.</td>
<td></td>
</tr>
<tr>
<td>Auto Clear Alert Tone</td>
<td>Displays the tone when the jam is cleared.</td>
<td></td>
</tr>
<tr>
<td>Base Tone</td>
<td>Displays the base tone.</td>
<td></td>
</tr>
<tr>
<td>All Tones</td>
<td>Displays all tones.</td>
<td></td>
</tr>
<tr>
<td>Time-Out</td>
<td>Displays specify the amount of time the multifunction printer waits to receive additional bytes of data from the computer.</td>
<td></td>
</tr>
<tr>
<td>Panel Language</td>
<td>Displays the language of the text on the operator panel screen.</td>
<td></td>
</tr>
<tr>
<td>Auto Log Print</td>
<td>Displays whether the printer outputs logs automatically.</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Print ID</strong></td>
<td>Displays a location where the user ID is printed.</td>
<td></td>
</tr>
<tr>
<td><strong>Print Text</strong></td>
<td>Displays whether the multifunction printer outputs PDL (Page Description Language) data, which is not supported by the multifunction printer, as text when the multifunction printer receives it.</td>
<td></td>
</tr>
<tr>
<td><strong>Banner Sheet Insert Position</strong></td>
<td>Displays the position of banner sheet.</td>
<td></td>
</tr>
<tr>
<td><strong>Banner Sheet Specify Tray</strong></td>
<td>Displays the tray in which the banner sheet is loaded.</td>
<td></td>
</tr>
<tr>
<td><strong>RAM Disk</strong></td>
<td>Displays whether to allocate memory to the RAM disk file system for the Secure Print and Proof Print features. This item is only available when the 256 MB, or higher, optional memory card is installed.</td>
<td></td>
</tr>
<tr>
<td><strong>Substitute Tray</strong></td>
<td>Displays whether or not to use another size paper when the paper that is loaded in the specified tray does not match the paper size settings for the current job.</td>
<td></td>
</tr>
<tr>
<td><strong>mm/inch</strong></td>
<td>Displays the measurement unit on the operator panel screen.</td>
<td></td>
</tr>
<tr>
<td><strong>Fax Activity</strong></td>
<td>Displays the status for printing the fax activity.</td>
<td></td>
</tr>
<tr>
<td><strong>Fax Transmit</strong></td>
<td>Displays the status for printing the fax transmission.</td>
<td></td>
</tr>
<tr>
<td><strong>Fax Broadcast</strong></td>
<td>Displays the status for printing the fax broadcast.</td>
<td></td>
</tr>
<tr>
<td><strong>Protocol Monitor</strong></td>
<td>Displays the status for printing the protocol monitor.</td>
<td></td>
</tr>
<tr>
<td><strong>Parallel Settings</strong></td>
<td><strong>ECP</strong> Displays the ECP (Extended Capability Port) communication mode of the parallel interface.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Adobe Protocol</strong> Displays PostScript communication protocol for each interface.</td>
<td></td>
</tr>
<tr>
<td><strong>Network Settings</strong></td>
<td><strong>Adobe Protocol</strong> Displays PostScript communication protocol for each interface.</td>
<td></td>
</tr>
<tr>
<td><strong>USB Settings</strong></td>
<td><strong>Adobe Protocol</strong> Displays PostScript communication protocol for each interface.</td>
<td></td>
</tr>
<tr>
<td><strong>PCL Settings</strong></td>
<td><strong>Paper Tray</strong> Displays the input tray.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Paper Size</strong> Displays the default paper size.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Custom Size - Y</strong> Displays the length of paper.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Custom Size - X</strong> Displays the width of paper.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Orientation</strong> Displays how text and graphics are oriented on the page.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>2 Sided</strong> Displays whether to do duplexing as the default for all print jobs. This item is only available when the optional duplexer is installed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Font</strong> Displays the default font from the registered fonts in the multifunction printer.</td>
<td></td>
</tr>
<tr>
<td>Symbol Set</td>
<td>Displays a symbol set for a specified font.</td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Font Size</td>
<td>Displays the font size for scalable typographic fonts.</td>
<td></td>
</tr>
<tr>
<td>Font Pitch</td>
<td>Displays the font pitch for scalable monospaced fonts.</td>
<td></td>
</tr>
<tr>
<td>Form Line</td>
<td>Displays the number of characters in a line.</td>
<td></td>
</tr>
<tr>
<td>Quantity</td>
<td>Displays the number of copies you want for the printer default value.</td>
<td></td>
</tr>
<tr>
<td>Image Enhancement</td>
<td>Displays whether to perform the image enhancement feature.</td>
<td></td>
</tr>
<tr>
<td>Hex Dump</td>
<td>Displays whether the Hex Dump feature is on or off.</td>
<td></td>
</tr>
<tr>
<td>Draft Mode</td>
<td>Displays whether to print in the draft mode.</td>
<td></td>
</tr>
<tr>
<td>Line Termination</td>
<td>Displays whether to set the line termination.</td>
<td></td>
</tr>
<tr>
<td>Default Color</td>
<td>Displays the color mode setting.</td>
<td></td>
</tr>
</tbody>
</table>

**PS Settings**

| PS Error Report | Displays whether the multifunction printer outputs error contents for a PS (PostScript) error. |
| PS Job Time-Out | Displays the execution time for one PostScript job. |
| Paper Select Mode | Displays the tray that is selected in the PostScript printing. |

**Secure Settings**

| Panel Lock Set | Displays whether or not to lock Admin menu with a password. |
| Copy/Scan/Fax Set | Displays whether or not to lock Copy, Scan, or Fax menus with a password. |
| Secure Receive Set | Displays whether or not to require the password for printing received fax documents. |

**Copy Defaults**

<p>| Color | Prints in the Color or Black&amp;White mode. |
| Input Tray | The paper is fed from the selected tray. |
| Reduce/Enlarge | Enlarges or reduces the size of a copied image. |
| Custom Reduce/Enlarge | Reduces or enlarges the image to the custom size (25-400%) if Reduce/Enlarge is set to Custom. |
| Original Type | Uses for documents with both text or photo/gray tones. |
| Lighter/Darker | Works with light print or dark print. |
| Sharpness | Makes the copy sharper or softer than the original. |
| Color Saturation | Adjusts the amount of color to make the colors deeper or lighter than the original. |</p>
<table>
<thead>
<tr>
<th>Auto Exposure</th>
<th>Adjusts the overall brightness to make the copy overexposed than the original.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Exposure Level</td>
<td>Displays the level of the overall brightness.</td>
</tr>
</tbody>
</table>

**Copy Color Balance**

<table>
<thead>
<tr>
<th>Copy Color Balance</th>
<th>Yellow Low Dens.</th>
<th>Displays the yellow low density.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Yellow Medium Dens.</td>
<td>Displays the yellow medium density.</td>
</tr>
<tr>
<td></td>
<td>Yellow High Dens.</td>
<td>Displays the yellow high density.</td>
</tr>
<tr>
<td></td>
<td>Magenta Low Dens.</td>
<td>Displays the magenta low density.</td>
</tr>
<tr>
<td></td>
<td>Magenta Medium Dens.</td>
<td>Displays the magenta medium density.</td>
</tr>
<tr>
<td></td>
<td>Magenta High Dens.</td>
<td>Displays the magenta high density.</td>
</tr>
<tr>
<td></td>
<td>Cyan Low Dens.</td>
<td>Displays the cyan low density.</td>
</tr>
<tr>
<td></td>
<td>Cyan Medium Dens.</td>
<td>Displays the cyan medium density.</td>
</tr>
<tr>
<td></td>
<td>Cyan High Dens.</td>
<td>Displays the cyan high density.</td>
</tr>
<tr>
<td></td>
<td>Black Low Dens.</td>
<td>Displays the black low density.</td>
</tr>
<tr>
<td></td>
<td>Black Medium Dens.</td>
<td>Displays the black medium density.</td>
</tr>
<tr>
<td></td>
<td>Black High Dens.</td>
<td>Displays the black high density.</td>
</tr>
</tbody>
</table>

**Copy Settings**

<table>
<thead>
<tr>
<th>Copy Settings</th>
<th>Auto Fit</th>
<th>On</th>
<th>Fits the image on the paper currently loaded.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off*</td>
<td></td>
<td>Does not fit the image on the paper currently loaded.</td>
</tr>
<tr>
<td></td>
<td>2Sided *2</td>
<td>1-&gt;1Sided</td>
<td>Does not print a 2-sided original document onto one sheet of paper.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LongEdgeBinding</td>
<td>Uses for long-edge binding when you perform duplex printing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ShortEdgeBinding</td>
<td>Uses for short-edge binding when you perform duplex printing.</td>
</tr>
<tr>
<td></td>
<td>Multiple-Up</td>
<td>Off*</td>
<td>Does not perform multiple-up printing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Auto</td>
<td>Automatically reduces the original pages to fit onto one sheet of paper.</td>
</tr>
<tr>
<td><strong>ID Copy</strong></td>
<td>Prints the original pages onto one sheet of paper in the original size.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Manual</strong></td>
<td>Prints the original pages onto the one sheet of paper in the size specified in Reduce/Enlarge.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Collated</strong></td>
<td><strong>Uncollated</strong></td>
<td>Does not sort the copy job.</td>
<td></td>
</tr>
<tr>
<td><strong>Collated</strong></td>
<td>Sorts the copy job.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Poster</strong></td>
<td><strong>Off</strong></td>
<td>Does not print an image onto several sheets of paper.</td>
<td></td>
</tr>
<tr>
<td><strong>2 x 2</strong></td>
<td>Prints an image onto 4 sheets of paper (2 by 2).</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>3 x 3</strong></td>
<td>Prints an image onto 9 sheets of paper (3 by 3).</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>4 x 4</strong></td>
<td>Prints an image onto 16 sheets of paper (4 by 4).</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Poster Docu. Size</strong></td>
<td><strong>A4</strong></td>
<td>Displays the size of the divided sheets.</td>
<td></td>
</tr>
<tr>
<td><strong>Letter</strong></td>
<td><strong>B5</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>A5</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Image Repeat</strong></td>
<td><strong>Off</strong></td>
<td>Does not print multiple image copies from the original document on a single page.</td>
<td></td>
</tr>
<tr>
<td><strong>On</strong></td>
<td>Prints multiple image copies from the original document on a single page.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Margin</strong></td>
<td><strong>Off</strong></td>
<td>Does not specify the margin of the copy.</td>
<td></td>
</tr>
<tr>
<td><strong>On</strong></td>
<td>Specifies the margin of the copy.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Margin Top/Bottom</strong></td>
<td>4-50 mm (0.2-2.0 inch)</td>
<td>Displays the size of the top and bottom margins. The default is 5 mm.</td>
<td></td>
</tr>
<tr>
<td><strong>Margin Left/Right</strong></td>
<td>4-50 mm (0.2-2.0 inch)</td>
<td>Displays the size of the right and left margins. The default is 5 mm.</td>
<td></td>
</tr>
<tr>
<td><strong>Margin Middle</strong></td>
<td>0-50 mm (0.0-2.0 inch)</td>
<td>Displays the size of the middle margin. The default is 10 mm.</td>
<td></td>
</tr>
<tr>
<td><strong>Scan Defaults</strong></td>
<td><strong>Send to Client</strong></td>
<td><strong>Server</strong></td>
<td>Stores the scanned image on the server by using the FTP (File Transfer Protocol) protocol.</td>
</tr>
<tr>
<td></td>
<td><strong>Computer</strong></td>
<td>Stores the scanned image on the computer by using the SMB (Server Message Block) protocol.</td>
<td></td>
</tr>
<tr>
<td><strong>Network Port</strong></td>
<td>Wired*</td>
<td>Stores data via the wired connection.</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>--------------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wireless</td>
<td>Stores data via the wireless connection.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>File Format</strong></th>
<th>PDF*</th>
<th>Saves the scanned copy in PDF.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MultiPageTIFF</td>
<td>Saves the scanned copy in MultiPageTIFF.</td>
</tr>
<tr>
<td></td>
<td>TIFF</td>
<td>Saves the scanned copy in TIFF.</td>
</tr>
<tr>
<td></td>
<td>JPEG</td>
<td>Saves the scanned copy in JPEG.</td>
</tr>
<tr>
<td></td>
<td>MP TIFF NonComp *3</td>
<td>Saves the scanned copy in MP TIFF NonComp.</td>
</tr>
<tr>
<td></td>
<td>TIFF NonComp *3</td>
<td>Saves the scanned copy in TIFF NonComp.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Color</strong></th>
<th>Color*</th>
<th>Prints in the color mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Black&amp;White</td>
<td>Prints in the black and white mode.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Resolution</strong></th>
<th>150*</th>
<th>Scans an image in 150 dpi.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>300</td>
<td>Scans an image in 300 dpi.</td>
</tr>
<tr>
<td></td>
<td>400</td>
<td>Scans an image in 400 dpi.</td>
</tr>
<tr>
<td></td>
<td>600</td>
<td>Scans an image in 600 dpi.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Original Type</strong></th>
<th>Text&amp;Photo</th>
<th>Uses for documents with both text and photo/gray tones.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Photo</td>
<td>Uses for documents with photo or gray tones.</td>
</tr>
<tr>
<td></td>
<td>Text</td>
<td>Uses for documents with text.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Document Size</strong></th>
<th>A4</th>
<th>Sets the document size in A4.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Letter</td>
<td>Sets the document size in Letter.</td>
</tr>
<tr>
<td></td>
<td>B5</td>
<td>Sets the document size in B5.</td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td>Sets the document size in A5.</td>
</tr>
<tr>
<td></td>
<td>Executive</td>
<td>Sets the document size in Executive.</td>
</tr>
<tr>
<td></td>
<td>8.5x13&quot; *5</td>
<td>Sets the document size in 8.5&quot;x13&quot;.</td>
</tr>
<tr>
<td></td>
<td>Legal *5</td>
<td>Sets the document size in Legal.</td>
</tr>
</tbody>
</table>

<p>| <strong>Lighter/Darker</strong> | Normal* | Works well with standard typed or printed documents. |</p>
<table>
<thead>
<tr>
<th>Sharpness</th>
<th>Softer</th>
<th>Adjusts sharpness of color to make the copy softer than the original.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Normal*</td>
<td>Does not adjust sharpness of color to make the copy sharper or softer than the original.</td>
</tr>
<tr>
<td></td>
<td>Sharper</td>
<td>Adjusts sharpness of color to make the copy sharper than the original.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Normal*</td>
<td>Does not adjust the amount of color in a specified hue to make the copy sharper or softer than the original.</td>
</tr>
<tr>
<td></td>
<td>Higher</td>
<td>Adjusts the amount of color in a specified hue to make the copy sharper than the original.</td>
</tr>
<tr>
<td></td>
<td>Lower</td>
<td>Adjusts the amount of color in a specified hue to make the copy softer than the original.</td>
</tr>
<tr>
<td>Auto Exposure</td>
<td>On</td>
<td>Adjusts the overall brightness to make the copy overexposed than the original.</td>
</tr>
<tr>
<td>Auto Exposure Level</td>
<td>Normal*</td>
<td>Displays the level of the overall brightness in Normal.</td>
</tr>
<tr>
<td></td>
<td>Higher(1)</td>
<td>Displays the level of the overall brightness in Higher(1).</td>
</tr>
<tr>
<td></td>
<td>Higher(2)</td>
<td>Displays the level of the overall brightness in Higher(2).</td>
</tr>
<tr>
<td>TIFF File Format</td>
<td>TIFF V6*</td>
<td>Sets the file in the TIFF V6 format.</td>
</tr>
<tr>
<td></td>
<td>TTN2</td>
<td>Sets the file in the TTN2 format.</td>
</tr>
<tr>
<td>Image Compression</td>
<td>Lower</td>
<td>Compresses an image in Lower.</td>
</tr>
<tr>
<td></td>
<td>Normal*</td>
<td>Compresses an image in Normal.</td>
</tr>
<tr>
<td></td>
<td>Higher</td>
<td>Compresses an image in Higher.</td>
</tr>
<tr>
<td>Max E-Mail Size</td>
<td>50-16384</td>
<td>Sets a maximum volume of e-mail data. The default is 2048 bytes.</td>
</tr>
<tr>
<td>Fax Defaults</td>
<td>Resolution</td>
<td>Standard* For documents with normal sized characters.</td>
</tr>
<tr>
<td><strong>Fine</strong></td>
<td>For documents containing small characters or thin lines or documents printed using a dot-matrix printer.</td>
<td></td>
</tr>
<tr>
<td><strong>SuperFine</strong></td>
<td>For documents containing extremely fine detail. The super fine mode is enabled only if the remote printer also supports the Super Fine resolution.</td>
<td></td>
</tr>
<tr>
<td><strong>Original Type</strong></td>
<td><strong>Text&amp;Photo</strong></td>
<td>Uses for documents with both text and photo/gray tones.</td>
</tr>
<tr>
<td></td>
<td><strong>Photo</strong></td>
<td>Uses for documents with photo or gray tones.</td>
</tr>
<tr>
<td></td>
<td><strong>Text</strong></td>
<td>Uses for documents with text.</td>
</tr>
<tr>
<td><strong>Lighter/Darker</strong></td>
<td><strong>Normal</strong></td>
<td>Works well with standard typed or printed documents.</td>
</tr>
<tr>
<td></td>
<td><strong>Darker1</strong></td>
<td>Works well with light print or faint pencil markings.</td>
</tr>
<tr>
<td></td>
<td><strong>Darker2</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Darker3</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Lighter3</strong></td>
<td>Works well with dark print.</td>
</tr>
<tr>
<td></td>
<td><strong>Lighter2</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Lighter1</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Delayed Start</strong></td>
<td>Saves scanned documents for transmission at a specified time (0-23:59) in order to take advantage of lower long distance rates. The default is 21:00.</td>
<td></td>
</tr>
<tr>
<td><strong>Fax Settings</strong></td>
<td><strong>Interval Timer</strong></td>
<td>Specifies the interval time (3-255 minutes) of the resend attempts. The default is 8min.</td>
</tr>
<tr>
<td></td>
<td><strong>Number of Redial</strong></td>
<td>Specifies the number of redial attempts, 0-9. If you enter 0, the multifunction printer will not redial. The default is 3.</td>
</tr>
<tr>
<td></td>
<td><strong>Interval of Redial</strong></td>
<td>Automatically redials a remote fax machine if it was busy. Intervals from 1-15 minutes can be entered. The default is 1min.</td>
</tr>
<tr>
<td><strong>Answer Select</strong></td>
<td>Selects the default fax receiving mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· TEL Mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· FAX Mode (automatic receive mode)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· TEL/FAX Mode*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· Ans/FAX Mode</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· DRPD (Distinctive Ring, Pattern Detection) Mode (DRPD is a service provided by some telephone companies.)</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Answer Fax</strong></td>
<td>Answers an incoming call and automatically goes into the receive mode in 0-255 seconds. The default is 1sec.</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Answer TEL/FAX</strong></td>
<td>Shares one telephone line with an external telephone in 0-255 seconds. The default is 6sec.</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Answer Ans/FAX</strong></td>
<td>Shares one telephone line with an answering machine in 0-255 seconds. The default is 48sec.</td>
<td></td>
</tr>
<tr>
<td><strong>Line Monitor</strong></td>
<td>off</td>
<td>Turns off the volume for the line monitor.</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Specifies the volume in Min for the incoming faxes.</td>
</tr>
<tr>
<td></td>
<td>Middle*</td>
<td>Specifies the volume in Middle for the incoming faxes.</td>
</tr>
<tr>
<td></td>
<td>Max</td>
<td>Specifies the volume in Max for the incoming faxes.</td>
</tr>
<tr>
<td><strong>Ring Tone Volume</strong></td>
<td>None</td>
<td>Turns off the volume for the incoming faxes.</td>
</tr>
<tr>
<td></td>
<td>Min</td>
<td>Specifies the volume in Min for the incoming faxes.</td>
</tr>
<tr>
<td></td>
<td>Middle</td>
<td>Specifies the volume in Middle for the incoming faxes.</td>
</tr>
<tr>
<td></td>
<td>Max*</td>
<td>Specifies the volume in Max for the incoming faxes.</td>
</tr>
<tr>
<td><strong>Line Type</strong></td>
<td>PSTN*</td>
<td>Sets PSTN (Public Switched Telephone Network) as the line type.</td>
</tr>
<tr>
<td></td>
<td>PBX</td>
<td>Sets PBX (Private Branch Exchange) as the line type.</td>
</tr>
<tr>
<td><strong>Dialing Type</strong></td>
<td>PB*</td>
<td>Sets PB (Push Button) as the dial type.</td>
</tr>
<tr>
<td></td>
<td>DP (10PPS)</td>
<td>Sets &quot;DP (10PPS)&quot; (Dial Pulse, 10 Pulse Per Second) as the dial type.</td>
</tr>
<tr>
<td></td>
<td>DP (20PPS)</td>
<td>Sets &quot;DP (20PPS)&quot; (Dial Pulse, 20 Pulse Per Second) as the dial type.</td>
</tr>
<tr>
<td><strong>DM Prevention</strong></td>
<td>On</td>
<td>Only accepts faxes from numbers registered in the PhoneBook. Incoming faxes from numbers whose G3ID is not registered correctly are not accepted even if the number is registered in the PhoneBook.</td>
</tr>
<tr>
<td></td>
<td>Off*</td>
<td>Accepts faxes from numbers that are not registered in the PhoneBook.</td>
</tr>
<tr>
<td><strong>Remote Receive</strong></td>
<td>On</td>
<td>Receives a fax by pressing the remote receive code on the external telephone.</td>
</tr>
<tr>
<td></td>
<td>Off*</td>
<td>Does not receive a fax by pressing the remote receive code on the external telephone.</td>
</tr>
<tr>
<td>Feature</td>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remote Receive Tone</td>
<td></td>
<td>Specifies the tone in 2-digit numbers (00-99) when Remote Receive is set to On.</td>
</tr>
<tr>
<td>Duplex Print</td>
<td>On</td>
<td>Uses duplex printing when you receive a fax.</td>
</tr>
<tr>
<td></td>
<td>Off*</td>
<td>Does not use duplex printing when you receive a fax.</td>
</tr>
<tr>
<td>Send Header</td>
<td>On*</td>
<td>Creates cover pages for the faxes.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Does not create cover pages for the faxes.</td>
</tr>
<tr>
<td>Send Header Name</td>
<td></td>
<td>Includes the header name in the cover pages for the faxes.</td>
</tr>
<tr>
<td>G3ID</td>
<td></td>
<td>Contains your telephone number in the cover pages for the faxes.</td>
</tr>
<tr>
<td>Local Name</td>
<td></td>
<td>Contains the local name in the cover pages for the faxes.</td>
</tr>
<tr>
<td>DRPD Pattern</td>
<td>Patternn</td>
<td>Sets the DRPD pattern from Pattern1 to Pattern5. DRPD is a service provided by some telephone companies.</td>
</tr>
<tr>
<td>Forwarding Settings</td>
<td>Trans. At Error</td>
<td>Forwards the incoming faxes when an error occurs.</td>
</tr>
<tr>
<td></td>
<td>Trans. Always.</td>
<td>Always forwards the incoming faxes.</td>
</tr>
<tr>
<td></td>
<td>Not Trans.*</td>
<td>Does not forward the incoming faxes.</td>
</tr>
<tr>
<td>Forward Settings Number</td>
<td></td>
<td>Displays the Forward Settings number.</td>
</tr>
<tr>
<td>Forward Set Print</td>
<td>On</td>
<td>Prints the ongoing faxes when you can set the multifunction printer to forward the faxes.</td>
</tr>
<tr>
<td></td>
<td>Off*</td>
<td>Does not prints the ongoing faxes when you can set the multifunction printer to forward the faxes.</td>
</tr>
<tr>
<td>Prefix Dial</td>
<td>On</td>
<td>Adds the prefix number when you send a fax. Prefix Dial is only available when PBX is set as the line type.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Does not add the prefix number when you send a fax.</td>
</tr>
<tr>
<td>Prefix Dial Number</td>
<td></td>
<td>Sets a prefix dial number up to five digits.</td>
</tr>
<tr>
<td>Discard Size</td>
<td>On</td>
<td>Discards any excess document at the bottom of the page.</td>
</tr>
<tr>
<td></td>
<td>Off*</td>
<td>Does not discard any excess document at the bottom of the page.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Reduction</strong></td>
<td>Automatically reduces the size if there is any excess document at the bottom of the page.</td>
<td></td>
</tr>
<tr>
<td><strong>Color Fax</strong></td>
<td><strong>On</strong> Allows color faxes to be sent and received (select color or black and white when sending a fax).</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Off</strong> Faxes are sent and received in black and white only.</td>
<td></td>
</tr>
<tr>
<td><strong>Extel Hook Thresh</strong></td>
<td><strong>Lower</strong> Sets Lower in the threshold value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Normal</strong> Sets Normal in the threshold value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Higher</strong> Sets Higher in the threshold value.</td>
<td></td>
</tr>
<tr>
<td><strong>Fwd. Error Print</strong></td>
<td><strong>On</strong> Prints documents that failed to transfer when Forward Set Print is set to Off.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Off</strong> Does not print documents that failed to transfer when Forward Set Print is set to Off.</td>
<td></td>
</tr>
<tr>
<td><strong>Country</strong></td>
<td>6 United States Sets the country for the fax.</td>
<td></td>
</tr>
<tr>
<td><strong>Paper Density</strong></td>
<td><strong>Plain</strong> Light Displays the paper density in Light for the plain paper.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Normal</strong> Displays the paper density in Normal for the plain paper.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Label</strong> Light* Displays the paper density in Light for the label.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Normal</strong> Displays the paper density in Normal for the label.</td>
<td></td>
</tr>
<tr>
<td><strong>Adjust BTR</strong></td>
<td><strong>Plain</strong> Displays the voltage settings of the transfer roller (-3-3) for plain paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Plain Thick</strong> Displays the voltage settings of the transfer roller (-3-3) for thick plain paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Transparency</strong> Displays the voltage settings of the transfer roller (-3-3) for transparencies. The default is 0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Covers</strong> Displays the voltage settings of the transfer roller (-3-3) for cover paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Covers Thick</strong> Displays the voltage settings of the transfer roller (-3-3) for thick cover paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Label</strong> Displays the voltage settings of the transfer roller (-3-3) for labels. The default is 0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Coated</strong> Displays the voltage settings of the transfer roller (-3-3) for coated paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Coated Thick</td>
<td>Displays the voltage settings of the transfer roller (-3-3) for thick coated paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Envelope</td>
<td>Displays the voltage settings of the transfer roller (-3-3) for envelopes. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Adjust Fuser</td>
<td>Plain</td>
<td>Displays the temperature settings of the fuser unit (-2-2) for plain paper. The default is 0.</td>
</tr>
<tr>
<td></td>
<td>Plain Thick</td>
<td>Displays the temperature settings of the fuser unit (-2-2) for thick plain paper. The default is 0.</td>
</tr>
<tr>
<td></td>
<td>Transparency</td>
<td>Displays the temperature settings of the fuser unit (-2-2) for transparencies. The default is 0.</td>
</tr>
<tr>
<td></td>
<td>Covers</td>
<td>Displays the temperature settings of the fuser unit (-2-2) for cover paper. The default is 0.</td>
</tr>
<tr>
<td></td>
<td>Covers Thick</td>
<td>Displays the temperature settings of the fuser unit (-2-2) for thick cover paper. The default is 0.</td>
</tr>
<tr>
<td></td>
<td>Label</td>
<td>Displays the temperature settings of the fuser unit (-2-2) for labels. The default is 0.</td>
</tr>
<tr>
<td></td>
<td>Coated</td>
<td>Displays the temperature settings of the fuser unit (-2-2) for coated paper. The default is 0.</td>
</tr>
<tr>
<td></td>
<td>Coated Thick</td>
<td>Displays the temperature settings of the fuser unit (-2-2) for thick coated paper. The default is 0.</td>
</tr>
<tr>
<td></td>
<td>Envelope</td>
<td>Displays the temperature settings of the fuser unit (-2-2) for envelopes. The default is 0.</td>
</tr>
<tr>
<td>Auto Registration Adjustment</td>
<td>Auto Registration Adjustment</td>
<td>Displays whether to adjust the registration automatically.</td>
</tr>
<tr>
<td>Adjust Altitude</td>
<td>Adjust Altitude</td>
<td>Displays whether to adjust the height of the installation location of the printer.</td>
</tr>
<tr>
<td>Non-Dell Toner</td>
<td>Non-Dell Toner</td>
<td>Displays whether to use a refilled print cartridge.</td>
</tr>
<tr>
<td>Clock Settings</td>
<td>Date Format</td>
<td>Specifies the date format.</td>
</tr>
<tr>
<td></td>
<td>Time Format</td>
<td>Specifies the time format in 24H or 12H.</td>
</tr>
<tr>
<td></td>
<td>Time Zone</td>
<td>Specifies the time zone.</td>
</tr>
<tr>
<td></td>
<td>Set Date</td>
<td>Sets the date.</td>
</tr>
<tr>
<td></td>
<td>Set Time</td>
<td>Sets the time.</td>
</tr>
<tr>
<td>Web Link Customization</td>
<td>Select Reorder URL</td>
<td>Regular*</td>
</tr>
<tr>
<td>Tray Settings</td>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Tray Settings</td>
<td>Tray 1 Paper Type</td>
<td>Displays the type of paper loaded in the standard 250-sheet tray</td>
</tr>
<tr>
<td></td>
<td>Tray 1 Paper Size</td>
<td>Displays the size of paper loaded in the standard 250-sheet tray</td>
</tr>
<tr>
<td></td>
<td>Tray 1 Custom Size - Y</td>
<td>Displays the length of paper loaded in the standard 250-sheet tray</td>
</tr>
<tr>
<td></td>
<td>Tray 1 Custom Size - X</td>
<td>Displays the width of paper loaded in the standard 250-sheet tray</td>
</tr>
<tr>
<td></td>
<td>Tray 2 Paper Type</td>
<td>Displays the type of paper loaded in the optional 550-sheet paper feeder</td>
</tr>
<tr>
<td></td>
<td>Tray 2 Paper Size</td>
<td>Displays the size of paper loaded in the optional 550-sheet paper feeder</td>
</tr>
<tr>
<td></td>
<td>Tray 2 Custom Size - Y</td>
<td>Displays the length of paper loaded in the optional feeder</td>
</tr>
<tr>
<td></td>
<td>Tray 2 Custom Size - X</td>
<td>Displays the width of paper loaded in the optional feeder</td>
</tr>
<tr>
<td></td>
<td>MPF Mode</td>
<td>Displays the paper size and type when paper is loaded in the multipurpose feeder</td>
</tr>
<tr>
<td></td>
<td>Display Popup</td>
<td>Displays a popup menu when paper is loaded in the multipurpose feeder</td>
</tr>
<tr>
<td></td>
<td>MPF Paper Type</td>
<td>Displays the type of paper loaded in the multipurpose feeder</td>
</tr>
<tr>
<td></td>
<td>MPF Paper Size</td>
<td>Displays the size of paper loaded in the multipurpose feeder</td>
</tr>
<tr>
<td></td>
<td>MPF Custom Size - Y</td>
<td>Displays the length of paper loaded in the multipurpose feeder</td>
</tr>
<tr>
<td></td>
<td>MPF Custom Size - X</td>
<td>Displays the width of paper loaded in the multipurpose feeder</td>
</tr>
</tbody>
</table>

*1 All changes made on the Printer Settings, Copy Printer Settings, Dell ColorTrack, and Tray Settings menus on the Dell Printer Configuration Web Tool are discarded if they are made while the multifunction printer is in power saver mode. Exit the mode to change the settings.

*2 This item is only available when the optional duplexer is installed.

*3 This item is only available when the optional memory card is set to on.

*4 This item is only available when the optional wireless printer adapter is installed.

*5 You can only use the Auto Document Feeder (ADF) to read the 8.5”x13” and Legal documents.

*6 Click Restart printer to apply new settings for change to take effect.
Reports

Purpose:
To print various types of reports and lists.

Values:

<table>
<thead>
<tr>
<th>System Settings</th>
<th>Click the Start button to print the system settings page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Settings</td>
<td>Click the Start button to print the panel settings page.</td>
</tr>
<tr>
<td>PCL Fonts List</td>
<td>Click the Start button to print the PCL (Hewlett-Packard Printer Control Language) fonts list.</td>
</tr>
<tr>
<td>PCL Macro List</td>
<td>Click the Start button to print the PCL Macro list.</td>
</tr>
<tr>
<td>Job History</td>
<td>Click the Start button to print the job history report.</td>
</tr>
<tr>
<td>Error History</td>
<td>Click the Start button to print the error history report.</td>
</tr>
<tr>
<td>PS Fonts List</td>
<td>Click the Start button to print the PS fonts list.</td>
</tr>
<tr>
<td>Print Meter</td>
<td>Click the Start button to print the print volume report.</td>
</tr>
<tr>
<td>Color Test Page</td>
<td>Click the Start button to print the color test page.</td>
</tr>
<tr>
<td>Stored Documents</td>
<td>Click the Start button to print the stored documents list. This item is only available when the Ram disk is set to on.</td>
</tr>
<tr>
<td>Speed Dial</td>
<td>Click the Start button to print the Speed Dial report.</td>
</tr>
<tr>
<td>Protocol Monitor</td>
<td>Click the Start button to print the Protocol Monitor report.</td>
</tr>
<tr>
<td>Address Book</td>
<td>Click the Start button to print the Address Book report.</td>
</tr>
<tr>
<td>Server Address</td>
<td>Click the Start button to print the server address report.</td>
</tr>
<tr>
<td>Fax Activity</td>
<td>Click the Start button to print the fax activity report.</td>
</tr>
<tr>
<td>Fax Pending</td>
<td>Click the Start button to print the pending faxes report.</td>
</tr>
</tbody>
</table>

Printer Settings

The Printer Settings tab includes System Settings, Parallel Settings, Network Settings, USB Settings, PCL Settings, PS Settings, and Secure Settings pages.

System Settings

Purpose:
To configure the basic printer settings.

Values:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Saver Mode 2</td>
<td>Displays the status for the power saver mode 2.</td>
</tr>
<tr>
<td>Power Saver Timer Mode 1</td>
<td>Displays the amount of time before the multifunction printer enters the power saver timer mode 1 after it finishes a print job.</td>
</tr>
<tr>
<td>Power Saver Timer Mode 2</td>
<td>Displays the amount of time before the multifunction printer enters the power saver timer mode 2 after it finishes a print job.</td>
</tr>
<tr>
<td>Auto Reset</td>
<td>Displays the amount of time before the setting is reset automatically.</td>
</tr>
<tr>
<td>Panel Select Tone</td>
<td>Displays the selected tone for the panel.</td>
</tr>
<tr>
<td>Panel Alert Tone</td>
<td>Displays the alert tone for the panel.</td>
</tr>
<tr>
<td>Machine Ready Tone</td>
<td>Displays the tone when the machine becomes ready.</td>
</tr>
<tr>
<td>Copy Job Tone</td>
<td>Displays the tone when copying starts.</td>
</tr>
<tr>
<td>Non-Copy Job Tone</td>
<td>Displays the tone when copying is complete.</td>
</tr>
<tr>
<td>Fault Tone</td>
<td>Displays the tone when an error occurs.</td>
</tr>
<tr>
<td>Alert Tone</td>
<td>Specifies whether the multifunction printer sounds an alarm when an error occurs.</td>
</tr>
<tr>
<td>Out of Paper Tone</td>
<td>Displays the tone when the paper runs out.</td>
</tr>
<tr>
<td>Low Toner Tone</td>
<td>Displays the tone when the toner is low.</td>
</tr>
<tr>
<td>Auto Clear Alert Tone</td>
<td>Displays the tone when the jam is cleared.</td>
</tr>
<tr>
<td>Base Tone</td>
<td>Displays the base tone.</td>
</tr>
<tr>
<td>All Tones</td>
<td>Displays all types of tones.</td>
</tr>
<tr>
<td>Time-Out</td>
<td>Specifies the amount of time the multifunction printer waits to receive additional bytes of data from the computer. When this timeout expires, the print job is canceled.</td>
</tr>
<tr>
<td>Panel Language</td>
<td>Determines the language of the text on the operator panel screen.</td>
</tr>
<tr>
<td>Auto Log Print</td>
<td>Specifies whether the multifunction printer outputs logs automatically.</td>
</tr>
<tr>
<td>Print ID</td>
<td>Specifies a location where the user ID is printed.</td>
</tr>
<tr>
<td>Print Text</td>
<td>Specifies whether the multifunction printer outputs PDL data, which is not supported by the multifunction printer, as text when the multifunction printer receives it.</td>
</tr>
<tr>
<td>Banner Sheet Insert Position</td>
<td>Specifies the position of banner sheet.</td>
</tr>
<tr>
<td>Banner Sheet Specify Tray</td>
<td>Specifies the tray in which the banner sheet is loaded.</td>
</tr>
</tbody>
</table>
### RAM Disk
Specifies whether to allocate memory to the RAM disk file system for the Secure Print and Store Print features. This item is only available when the 256 MB, or higher, optional memory card is installed.

### Substitute Tray
Specifies whether or not to use another size paper when the paper that is loaded in the specified tray does not match the paper size settings for the current job.

### mm/inch
Specifies the measurement unit on the operator panel screen as either mm or inches.

### Fax Activity
Displays the status for printing the fax activity.

### Fax Transmit
Displays the status for printing the fax transmission.

### Fax Broadcast
Displays the status for printing the fax broadcast.

### Protocol Monitor
Displays the status for printing the protocol monitor.

### Parallel Settings
**Purpose:**
To configure the parallel interface.

**Values:**

<table>
<thead>
<tr>
<th>ECP</th>
<th>Specifies the ECP communication mode of the parallel interface.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Protocol</td>
<td>Specifies PostScript communication protocol for each interface.</td>
</tr>
</tbody>
</table>

### Network Settings
**Purpose:**
To Specify the PostScript communication protocol for this multifunction printer.

**Values:**

| Adobe Protocol | Specifies PostScript communication protocol for each interface. |

### USB Settings
**Purpose:**
To change printer settings affecting a USB (Universal Serial Bus) port.

**Values:**

| Adobe Protocol | Specifies PostScript communication protocol for each interface. |

### PCL Settings
**Purpose:**
To change printer settings that only affect jobs using the PCL emulation printer language.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper Tray</strong></td>
<td>Specifies the input tray.</td>
</tr>
<tr>
<td><strong>Paper Size</strong></td>
<td>Specifies the default paper size.</td>
</tr>
<tr>
<td><strong>Custom Size - Y</strong></td>
<td>Specifies the length of paper. The available range is from 98 mm (3.89 in.) to 355 mm (13.98 in.).</td>
</tr>
<tr>
<td><strong>Custom Size - X</strong></td>
<td>Specifies the width of paper. The available range is from 77 mm (3.03 in.) to 220 mm (8.66 in.).</td>
</tr>
<tr>
<td><strong>Orientation</strong></td>
<td>Specifies how text and graphics are oriented on the page.</td>
</tr>
<tr>
<td><strong>2 Sided</strong></td>
<td>Sets duplexing as the default for all print jobs. This item is only available when the optional duplexer is installed.</td>
</tr>
<tr>
<td><strong>Font</strong></td>
<td>Specifies the default font from the registered fonts in the multifunction printer.</td>
</tr>
<tr>
<td><strong>Symbol Set</strong></td>
<td>Specifies a symbol set for a specified font.</td>
</tr>
<tr>
<td><strong>Font Size</strong></td>
<td>Specifies the font size for scalable typographic fonts.</td>
</tr>
<tr>
<td><strong>Font Pitch</strong></td>
<td>Specifies the font pitch for scalable monospaced fonts.</td>
</tr>
<tr>
<td><strong>Form Line</strong></td>
<td>Specifies the number of characters in a line.</td>
</tr>
<tr>
<td><strong>Quantity</strong></td>
<td>Sets the number of copies you want for the printer default value.</td>
</tr>
<tr>
<td><strong>Image Enhancement</strong></td>
<td>Specifies whether to perform the image enhancement feature.</td>
</tr>
<tr>
<td><strong>Hex Dump</strong></td>
<td>Specifies whether to help isolate the source of a print job problem. With Hex Dump selected, all data sent to the multifunction printer is printed in hexadecimal and character representation. Control codes are not executed.</td>
</tr>
<tr>
<td><strong>Draft Mode</strong></td>
<td>Specifies whether to print in the draft mode.</td>
</tr>
<tr>
<td><strong>Line Termination</strong></td>
<td>Sets the line termination.</td>
</tr>
<tr>
<td><strong>Default Color</strong></td>
<td>Specifies the color mode to <strong>Color</strong> or <strong>Black</strong>. This setting is used when the color printing mode setting is not specified for the print job that is sent to the multifunction printer.</td>
</tr>
</tbody>
</table>

**PS Settings**

**Purpose:**

To change printer settings that only affect jobs using the PostScript emulation printer language.

**Values:**
<table>
<thead>
<tr>
<th>PS Error Report</th>
<th>Specifies whether the multifunction printer outputs error contents for a PostScript error.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS Job Time-Out</td>
<td>Specifies the execution time for one PostScript job.</td>
</tr>
<tr>
<td>Paper Select Mode</td>
<td>Specifies the way to select the tray for the PostScript mode.</td>
</tr>
</tbody>
</table>

**Secure Settings**

**Purpose:**
To set or change the password to limit access to the menus from the operator panel.

Set the password of the **Dell Printer Configuration Web Tool** from **Set Password** in **Print Server Settings**.

**Values:**

<table>
<thead>
<tr>
<th>Panel Lock</th>
<th>Panel Lock Set</th>
<th>Specifies whether to limit access to the Admin menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New Password</td>
<td>Sets a password to limit access to the menus.</td>
</tr>
<tr>
<td></td>
<td>Re-enter Password</td>
<td>Type the new password again to confirm.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Copy/Scan/Fax Lock</th>
<th>Copy/Scan/Fax Set</th>
<th>Specifies whether to limit access to the Copy, Scan, and Fax menus.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New Password</td>
<td>Sets a password to limit access to the menus.</td>
</tr>
<tr>
<td></td>
<td>Re-enter Password</td>
<td>Type the new password again to confirm.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Secure Receive</th>
<th>Secure Receive Set</th>
<th>Specifies whether to limit printing received fax documents.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>New Password</td>
<td>Sets a password for receiving faxes.</td>
</tr>
<tr>
<td></td>
<td>Re-enter Password</td>
<td>Type the new password again to confirm.</td>
</tr>
</tbody>
</table>

**NOTE:** This menu sets a password to lock the operator panel. When changing the password for the **Dell Printer Configuration Web Tool**, click **Set Password** on the left frame and set the password.

**Copy Defaults**

**Purpose:**
To create your own default Copy settings.

**Values:**
Color | Prints in the Color or Black&White mode.
---|---
Input Tray | The paper is fed from the selected tray.
Reduce/Enlarge | Enlarges or reduces the size of a copied image.
Custom Reduce/Enlarge | Reduces or enlarges the image to the custom size (25-400%) if Reduce/Enlarge is set to Custom.
Original Type | Uses for documents with both text or photo/gray tones.
Lighter/Darker | Works with light print or dark print.
Sharpness | Makes the copy sharper or softer than the original.
Color Saturation | Adjusts the amount of color to make the colors deeper or lighter than the original.
Auto Exposure | Adjusts the overall brightness to make the copy overexposed than the original.
Auto Exposure Level | Displays the level of the overall brightness.

*1 All changes made on the Tray Setting menus on the Dell Printer Configuration Web Tool are discarded if they are made while the multifunction printer in power saver mode. Exit the mode to change the settings.

Copy Color Balance

Purpose:
To set the Copy color balance.

Values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow Low Dens.</td>
<td>Displays the yellow low density.</td>
</tr>
<tr>
<td>Yellow Medium Dens.</td>
<td>Displays the yellow medium density.</td>
</tr>
<tr>
<td>Yellow High Dens.</td>
<td>Displays the yellow high density.</td>
</tr>
<tr>
<td>Magenta Low Dens.</td>
<td>Displays the magenta low density.</td>
</tr>
<tr>
<td>Magenta Medium Dens.</td>
<td>Displays the magenta medium density.</td>
</tr>
<tr>
<td>Magenta High Dens.</td>
<td>Displays the magenta high density.</td>
</tr>
<tr>
<td>Cyan Low Dens.</td>
<td>Displays the cyan low density.</td>
</tr>
<tr>
<td>Cyan Medium Dens.</td>
<td>Displays the cyan medium density.</td>
</tr>
<tr>
<td>Cyan High Dens.</td>
<td>Displays the cyan high density.</td>
</tr>
<tr>
<td>Black Low Dens.</td>
<td>Displays the black low density.</td>
</tr>
<tr>
<td>Black Medium Dens.</td>
<td>Displays the black medium density.</td>
</tr>
</tbody>
</table>
Black High Dens. | Displays the black high density.

Copy Settings

Purpose:
To confirm the Copy settings.

Values:

<table>
<thead>
<tr>
<th>Auto Fit</th>
<th>On</th>
<th>Fits the image on the paper currently loaded.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td></td>
<td>Does not fit the image on the paper currently loaded.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2Sided* 1</th>
<th>1-&gt;1Sided</th>
<th>Does not print a 2-sided original document onto one sheet of paper.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>LongEdgeBinding</th>
<th>Uses for long-edge binding when you perform duplex printing.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>ShortEdgeBinding</th>
<th>Uses for short-edge binding when you perform duplex printing.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Multiple-Up</th>
<th>Off*</th>
<th>Does not perform multiple-up printing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td></td>
<td>Automatically reduces the original pages to fit onto one sheet of paper.</td>
</tr>
<tr>
<td>ID Copy</td>
<td></td>
<td>Prints the original pages onto one sheet of paper in the original size.</td>
</tr>
<tr>
<td>Manual</td>
<td></td>
<td>Prints the original pages onto the one sheet of paper in the size specified in Reduce/Enlarge.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Collated* 2</th>
<th>Uncollated</th>
<th>Does not sort the copy job.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collated</td>
<td></td>
<td>Sorts the copy job.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Poster</th>
<th>Off*</th>
<th>Does not print an image onto several sheets of paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 x 2</td>
<td></td>
<td>Prints an image onto 4 sheets of paper (2 by 2).</td>
</tr>
<tr>
<td>3 x 3</td>
<td></td>
<td>Prints an image onto 9 sheets of paper (3 by 3).</td>
</tr>
<tr>
<td>4 x 4</td>
<td></td>
<td>Prints an image onto 16 sheets of paper (4 by 4).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Poster Docu. Size</th>
<th>A4</th>
<th>Displays the size of the divided sheets.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image Repeat</td>
<td>Off*</td>
<td>Does not print multiple image copies from the original document on a single page.</td>
</tr>
<tr>
<td>-------------</td>
<td>------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Prints multiple image copies from the original document on a single page.</td>
</tr>
<tr>
<td>Margin</td>
<td>Off*</td>
<td>Does not specify the margin of the copy.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Specifies the margin of the copy.</td>
</tr>
<tr>
<td>Margin Top/Bottom</td>
<td>4-50 mm (0.2-2.0 inch)</td>
<td>Displays the size of the top and bottom margins.</td>
</tr>
<tr>
<td>Margin Left/Right</td>
<td>4-50 mm (0.2-2.0 inch)</td>
<td>Displays the size of the right and left margins.</td>
</tr>
<tr>
<td>Margin Middle</td>
<td>0-50 mm (0.0-2.0 inch)</td>
<td>Displays the size of the middle margin.</td>
</tr>
</tbody>
</table>

*1 This item is only available when the optional duplexer is installed.
*2 This item is only available when the optional memory card is set to on.

### Scan Defaults

**Purpose:**

To create your own default Scan settings.

**Values:**

<table>
<thead>
<tr>
<th>Send to Client</th>
<th>Server</th>
<th>Stores the scanned image on the server by using the FTP protocol.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Computer*</td>
<td>Stores the scanned image on the computer by using the SMB protocol.</td>
</tr>
<tr>
<td>Network Port</td>
<td>Wired</td>
<td>Stores data via the wired connection.</td>
</tr>
<tr>
<td></td>
<td>Wireless</td>
<td>Stores data via the wireless connection.</td>
</tr>
<tr>
<td>File Format</td>
<td>PDF*</td>
<td>Saves the scanned copy in PDF.</td>
</tr>
<tr>
<td></td>
<td>Multi Page TIFF</td>
<td>Saves the scanned copy in MultiPageTIFF.</td>
</tr>
<tr>
<td></td>
<td>TIFF</td>
<td>Saves the scanned copy in TIFF.</td>
</tr>
<tr>
<td></td>
<td>JPEG</td>
<td>Saves the scanned copy in JPEG.</td>
</tr>
<tr>
<td></td>
<td>MP TIFF NonComp</td>
<td>Saves the scanned copy in MP TIFF NonComp.</td>
</tr>
<tr>
<td></td>
<td>TIFF NonComp</td>
<td>Saves the scanned copy in TIFF NonComp.</td>
</tr>
<tr>
<td>Color</td>
<td>Color*</td>
<td>Prints in the color mode.</td>
</tr>
<tr>
<td>---------------</td>
<td>--------</td>
<td>----------------------------------------------------------------</td>
</tr>
<tr>
<td>Black&amp;White</td>
<td></td>
<td>Prints in the black and white mode.</td>
</tr>
<tr>
<td>Resolution</td>
<td>150*</td>
<td>Scans an image in 150 dpi.</td>
</tr>
<tr>
<td></td>
<td>300</td>
<td>Scans an image in 300 dpi.</td>
</tr>
<tr>
<td></td>
<td>400</td>
<td>Scans an image in 400 dpi.</td>
</tr>
<tr>
<td></td>
<td>600</td>
<td>Scans an image in 600 dpi.</td>
</tr>
<tr>
<td>Original Type</td>
<td>Text&amp;Photo*</td>
<td>Uses for documents with both text and photo/gray tones.</td>
</tr>
<tr>
<td></td>
<td>Photo</td>
<td>Uses for documents with photo or gray tones.</td>
</tr>
<tr>
<td></td>
<td>Text</td>
<td>Uses for documents with text.</td>
</tr>
<tr>
<td></td>
<td>Letter</td>
<td>Sets the document size in Letter.</td>
</tr>
<tr>
<td></td>
<td>B5</td>
<td>Sets the document size in B5.</td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td>Sets the document size in A5.</td>
</tr>
<tr>
<td></td>
<td>Executive</td>
<td>Sets the document size in Executive.</td>
</tr>
<tr>
<td></td>
<td>8.5&quot;x13&quot;*</td>
<td>Sets the document size in 8.5&quot;x13&quot;.</td>
</tr>
<tr>
<td></td>
<td>Legal*</td>
<td>Sets the document size in Legal.</td>
</tr>
<tr>
<td>Lighter/Darker</td>
<td>Normal*</td>
<td>Works well with standard typed or printed documents.</td>
</tr>
<tr>
<td></td>
<td>Darker1</td>
<td>Works well with light print or faint pencil markings.</td>
</tr>
<tr>
<td></td>
<td>Darker2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Darker3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lighter3</td>
<td>Works well with dark print.</td>
</tr>
<tr>
<td></td>
<td>Lighter2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lighter1</td>
<td></td>
</tr>
<tr>
<td>Sharpness</td>
<td>Softer</td>
<td>Adjusts sharpness of color to make the copy softer than the original.</td>
</tr>
<tr>
<td></td>
<td>Normal*</td>
<td>Does not adjust sharpness of color to make the copy sharper or softer than the original.</td>
</tr>
<tr>
<td></td>
<td>Sharper</td>
<td>Adjusts sharpness of color to make the copy sharper than the original.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Normal*</td>
<td>Does not adjust the amount of color in a specified hue to make the copy sharper or softer than the original.</td>
</tr>
<tr>
<td>Higher</td>
<td>Adjusts the amount of color in a specified hue to make the copy sharper than the original.</td>
<td></td>
</tr>
<tr>
<td>Lower</td>
<td>Adjusts the amount of color in a specified hue to make the copy softer than the original.</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Exposure</strong></td>
<td><strong>On</strong></td>
<td>Adjusts the overall brightness to make the copy overexposed than the original.</td>
</tr>
<tr>
<td><strong>Auto Exposure Level</strong></td>
<td><strong>Normal</strong>*</td>
<td>Displays the level of the overall brightness in Normal.</td>
</tr>
<tr>
<td></td>
<td><strong>Higher(1)</strong></td>
<td>Displays the level of the overall brightness in Higher(1).</td>
</tr>
<tr>
<td></td>
<td><strong>Higher(2)</strong></td>
<td>Displays the level of the overall brightness in Higher(2).</td>
</tr>
<tr>
<td><strong>TIFF File Format</strong></td>
<td><strong>TIFF V6</strong>*</td>
<td>Sets the file in the TIFF V6 format.</td>
</tr>
<tr>
<td></td>
<td><strong>TTN2</strong></td>
<td>Sets the file in the TTN2 format.</td>
</tr>
<tr>
<td><strong>Image Compression</strong></td>
<td><strong>Lower</strong></td>
<td>Compresses an image in Lower.</td>
</tr>
<tr>
<td></td>
<td><strong>Normal</strong>*</td>
<td>Compresses an image in Normal.</td>
</tr>
<tr>
<td></td>
<td><strong>Higher</strong></td>
<td>Compresses an image in Higher.</td>
</tr>
<tr>
<td><strong>Max E-Mail Size</strong></td>
<td><strong>50-16384</strong></td>
<td>Sets a maximum volume of e-mail data. The default is 2048 K bytes.</td>
</tr>
</tbody>
</table>

*1 You can only use the Auto Document Feeder (ADF) to read the 8.5"x13" and Legal documents.

**Fax Defaults**

**Purpose:**

To create your own default Fax settings.

**Values:**

<p>| Resolution | <strong>Standard</strong>* | For documents with normal sized characters. |
|  | <strong>Fine</strong> | For documents containing small characters or thin lines or documents printed using a dot-matrix printer. |
|  | <strong>SuperFine</strong> | For documents containing extremely fine detail. The super fine mode is enabled only if the remote printer also supports the Super Fine resolution. |
| <strong>Original Type</strong> | <strong>Text&amp;Photo</strong> | Uses for documents with both text and photo/gray tones. |
|  | <strong>Photo</strong> | Uses for documents with photo or gray tones. |
|  | <strong>Text</strong>* | Uses for documents with text. |
| <strong>Lighter/Darker</strong> | <strong>Normal</strong>* | Works well with standard typed or printed documents. |</p>
<table>
<thead>
<tr>
<th>Darker1</th>
<th>Works well with light print or faint pencil markings.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Darker2</td>
<td></td>
</tr>
<tr>
<td>Darker3</td>
<td></td>
</tr>
<tr>
<td>Lighter3</td>
<td>Works well with dark print.</td>
</tr>
<tr>
<td>Lighter2</td>
<td></td>
</tr>
<tr>
<td>Lighter1</td>
<td></td>
</tr>
</tbody>
</table>

**Delayed Start**

<table>
<thead>
<tr>
<th>21:00*</th>
<th>Saves scanned documents for transmission at a specified time in order to take advantage of lower long distance rates.</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00-23:59</td>
<td></td>
</tr>
</tbody>
</table>

**Fax Settings**

**Purpose:**

To confirm the Fax settings.

**Values:**

<table>
<thead>
<tr>
<th>Interval Timer</th>
<th>Specifies the interval time (3-255 minutes) of the resend attempts.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Redial</td>
<td>Specifies the number of redial attempts, 0-9. If you enter 0, the multifunction printer will not redial. The default is 3.</td>
</tr>
<tr>
<td>Interval of Redial</td>
<td>Automatically redials a remote fax machine if it was busy. Intervals from 1-15 minutes can be entered.</td>
</tr>
<tr>
<td>Answer Select</td>
<td>You can select the default fax receiving mode.</td>
</tr>
<tr>
<td></td>
<td>· TEL Mode</td>
</tr>
<tr>
<td></td>
<td>· FAX Mode (automatic receive mode)</td>
</tr>
<tr>
<td></td>
<td>· TEL/FAX Mode</td>
</tr>
<tr>
<td></td>
<td>· Ans/FAX Mode</td>
</tr>
<tr>
<td></td>
<td>· DRPD (Distinctive Ring. Pattern Detection) Mode (DRPD is a service provided by some telephone companies.)</td>
</tr>
<tr>
<td>Auto Answer Fax</td>
<td>Answers an incoming call and automatically goes into the receive mode.</td>
</tr>
<tr>
<td>Auto Answer TEL/FAX</td>
<td>Shares one telephone line with an external telephone.</td>
</tr>
<tr>
<td>Auto Answer Ans/FAX</td>
<td>Shares one telephone line with an answering machine.</td>
</tr>
<tr>
<td>Line Monitor</td>
<td>Specifies the volume of the external telephone (line monitor).</td>
</tr>
<tr>
<td>Ring Tone Volume</td>
<td>Specifies the volume for the incoming faxes.</td>
</tr>
<tr>
<td>Line Type</td>
<td>PSTN</td>
</tr>
<tr>
<td></td>
<td>PBX</td>
</tr>
<tr>
<td>Dialing Type</td>
<td>PB</td>
</tr>
<tr>
<td></td>
<td>DP (10PPS)</td>
</tr>
<tr>
<td></td>
<td>DP (20PPS)</td>
</tr>
<tr>
<td>DM Prevention</td>
<td>On</td>
</tr>
<tr>
<td>Remote Receive</td>
<td>On</td>
</tr>
<tr>
<td>Remote Receive Tone</td>
<td></td>
</tr>
<tr>
<td>Duplex Print*</td>
<td>On</td>
</tr>
<tr>
<td>Send Header</td>
<td>On</td>
</tr>
<tr>
<td>Send Header Name</td>
<td></td>
</tr>
<tr>
<td>G3ID</td>
<td></td>
</tr>
<tr>
<td>Local Name</td>
<td></td>
</tr>
<tr>
<td>DRPD Pattern</td>
<td>Patternn</td>
</tr>
<tr>
<td>Forward Settings</td>
<td>Trans. At Error*</td>
</tr>
<tr>
<td>Forward Settings</td>
<td>Trans. Always.</td>
</tr>
<tr>
<td>Forward Settings</td>
<td>Not Trans.</td>
</tr>
<tr>
<td>Forward Settings Number</td>
<td></td>
</tr>
<tr>
<td>Forward Set Print</td>
<td>On</td>
</tr>
<tr>
<td>Forward Set Print</td>
<td>Off</td>
</tr>
<tr>
<td>Prefix Dial</td>
<td>On</td>
</tr>
<tr>
<td>Prefix Dial</td>
<td>Off</td>
</tr>
<tr>
<td>Prefix Dial Number</td>
<td></td>
</tr>
<tr>
<td>Discard Size</td>
<td>On</td>
</tr>
<tr>
<td>Discard Size</td>
<td>Off*</td>
</tr>
<tr>
<td>Color Fax</td>
<td>On</td>
</tr>
<tr>
<td>--------------</td>
<td>----------</td>
</tr>
<tr>
<td></td>
<td>Off*</td>
</tr>
<tr>
<td>Extel Hook Thresh</td>
<td>Lower</td>
</tr>
<tr>
<td></td>
<td>Normal*</td>
</tr>
<tr>
<td></td>
<td>Higher</td>
</tr>
<tr>
<td>Fwd. Error Print</td>
<td>On</td>
</tr>
<tr>
<td>Country* 2</td>
<td>United States</td>
</tr>
</tbody>
</table>

*1 This item is only available when the optional duplexer is installed.

*2 click Restart printer to apply new settings for change to take effect.

**Printer Maintenance**

The Printer Maintenance tab includes Paper Density, Adjust BTR, Adjust Fuser, Auto Registration Adjustment, Color Registration Adjustments, Adjust Altitude, Reset Defaults, Clear Storage, Non-Dell Toner, Initialize PrintMeter, Clock Settings, and Web Link Customization pages.

**Paper Density**

**Purpose:**

To specify the paper density.

**Values:**

<table>
<thead>
<tr>
<th>Plain</th>
<th>Light</th>
<th>Normal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Light</td>
<td>Normal</td>
</tr>
</tbody>
</table>

**Adjust BTR**

**Purpose:**

To specify the reference voltage settings for the transfer roller.

**Values:**
Plain | Sets the reference voltage settings for the transfer roller for plain paper.
---|---
Plain Thick | Sets the reference voltage settings for the transfer roller for thick plain paper.
Transparency | Sets the reference voltage settings for the transfer roller for transparencies.
Covers | Sets the reference voltage settings for the transfer roller for cover paper.
Covers Thick | Sets the reference voltage settings for the transfer roller for thick cover paper.
Label | Sets the reference voltage settings for the transfer roller for labels.
Coated | Sets the reference voltage settings for the transfer roller for coated paper.
Coated Thick | Sets the reference voltage settings for the transfer roller for thick coated paper.
Envelope | Sets the reference voltage settings for the transfer roller for envelopes.

Adjust Fuser

**Purpose:**
To specify the temperature settings value for the fuser unit.

**Values:**

| Plain | Sets the temperature settings for the fuser unit for plain paper. |
| Plain Thick | Sets the temperature settings for the fuser unit for thick plain paper. |
| Transparency | Sets the temperature settings for the fuser unit for transparencies. |
| Covers | Sets the temperature settings for the fuser unit for cover paper. |
| Covers Thick | Sets the temperature settings for the fuser unit for thick cover paper. |
| Label | Sets the temperature settings for the fuser unit for labels. |
| Coated | Sets the temperature settings for the fuser unit for coated paper. |
| Coated Thick | Sets the temperature settings for the fuser unit for thick coated paper. |
| Envelope | Sets the temperature settings for the fuser unit for envelopes. |

Auto Registration Adjustment

**Purpose:**
Specifies whether to adjust the color registration automatically.

**Values:**

| Auto Registration Adjustment | Specifies whether to adjust the color registration automatically. |
**Color Registration Adjustments**

**Purpose:**

To print the color registration chart and to adjust the color registration by using the chart.

This function is required after the multifunction printer is set up or moved.

**Values:**

<table>
<thead>
<tr>
<th>Auto Correct</th>
<th>Click <strong>Start</strong> to adjust color registration automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Regi Chart</td>
<td>Click <strong>Start</strong> to print the color registration chart.</td>
</tr>
<tr>
<td>Enter Number</td>
<td>Yellow</td>
</tr>
<tr>
<td></td>
<td>Magenta</td>
</tr>
<tr>
<td></td>
<td>Cyan</td>
</tr>
</tbody>
</table>

**Adjust Altitude**

**Purpose:**

To adjust the height of the installation location of the multifunction printer.

**Values:**

| 0 meter | Select the value close to the height of the installation location of the multifunction printer. |
| 1000 meters |
| 2000 meters |
| 3000 meters |

**Reset Defaults**

**Purpose:**

To initialize the non-volatile memory (NVM). After executing this function and rebooting the multifunction printer, all the menu parameters are reset to their default values.

**Values:**

<table>
<thead>
<tr>
<th>Reset Defaults and restart printer.</th>
<th>Click <strong>Start</strong> to initialize the non-volatile memory (NVM) memory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset Defaults User Section</td>
<td>Click <strong>Start</strong> to initialize the user section.</td>
</tr>
</tbody>
</table>

**Clear Storage**
Purpose:
To clear all files that are stored as Secure and Proof Print in the RAM disk. This item is only available when the RAM disk is set to on.

Values:

| Clear Storage | Click Start to clear all files stored in the RAM disk. |

Non-Dell Toner

Purpose:
Specifies whether to use the refilled print cartridge or not. When this setting is on, you can use print cartridges provided by other companies.

Values:

| Non-Dell Toner | Overrides factory print cartridge setting. Non-Dell-brand print cartridges may disable some printer features, reduce print quality and reduce the reliability of your multifunction printer. Dell recommends only new Dell-brand print cartridges for your multifunction printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell. |

Initialize PrintMeter

Purpose:
To initialize the print meter of the multifunction printer. Executing this function restarts the multifunction printer.

Values:

| Initialize PrintMeter | Click Start to initialize the print meter. |

Clock Settings

Purpose:
To specify the clock settings.

Values:

| Date Format | Specifies the date format. |
| Time Format | Specifies the time format in 24H or 12H. |
| Time Zone | Specifies the time zone. |
| Set Date | Sets the date format. The default is mm/dd/yy. |
| Set Time | Sets the time. |

Web Link Customization
**Purpose:**
To configure the link used for ordering supplies.

**Values:**

<table>
<thead>
<tr>
<th>Select Reorder URL</th>
<th>Specifies the URL that Order Supplies at links to in the left frame.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular</td>
<td><a href="http://accessories.us.dell.com/sna">http://accessories.us.dell.com/sna</a></td>
</tr>
<tr>
<td>Premier</td>
<td><a href="http://premier.dell.com">http://premier.dell.com</a></td>
</tr>
</tbody>
</table>

**Print Server Settings**

Use the **Print Server Settings** menu to set the type of printer interface and necessary conditions for communications.

The following tabbed pages are displayed in the top of the Right Frame.

**Print Server Reports**

The **Print Server Reports** tab includes **Print Server Setup Page**, **NetWare Setup Page**, and **E-Mail Alert Setup Page**.

**Print Server Setup Page**

**Purpose:**
To verify the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) protocol and printing ports. On this page, you can only verify the settings of items. If you want to change the settings, go to the pages in the **Print Server Settings** tab.

**Values:**

<table>
<thead>
<tr>
<th>Ethernet * 1</th>
<th>Ethernet Settings</th>
<th>Displays the current settings of Ethernet transmission rate and the duplex settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Current Ethernet Settings</td>
<td>Displays the current Ethernet settings.</td>
</tr>
<tr>
<td></td>
<td>MAC Address</td>
<td>Displays the printer's MAC (Media Access Control Address) address.</td>
</tr>
<tr>
<td>Wireless Settings * 2, * 3</td>
<td>SSID</td>
<td>Displays SSID (Service Set ID) that identifies the network.</td>
</tr>
<tr>
<td></td>
<td>Network Type</td>
<td>Displays the network type from either the Ad-Hoc or Infrastructure mode.</td>
</tr>
<tr>
<td></td>
<td>MAC Address</td>
<td>Displays the MAC address of the wireless printer adapter.</td>
</tr>
<tr>
<td></td>
<td>Link Channel</td>
<td>Displays the channel number of the connection.</td>
</tr>
<tr>
<td></td>
<td>Link Quality</td>
<td>Displays the quality of the connection.</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>IP Mode</td>
<td>Displays the IP mode.</td>
</tr>
<tr>
<td>Settings</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Host Name</strong></td>
<td>Displays the host name.</td>
<td></td>
</tr>
<tr>
<td><strong>IPv4</strong></td>
<td><strong>IP Address Mode</strong> Displays the IP address mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>IP Address</strong> Displays the IP address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Subnet Mask</strong> Displays the subnet mask.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Gateway Address</strong> Displays the gateway address.</td>
<td></td>
</tr>
<tr>
<td><strong>IPv6</strong></td>
<td><strong>Use Manual Address</strong> Displays whether to set the IP address manually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Manual Address</strong> Displays the IP address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Stateless Address 1-3</strong> Displays the stateless addresses.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Link Local Address</strong> Displays the link local address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Manual Gateway Address</strong> Displays the gateway address.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Auto Configure Gateway Address</strong> Displays the gateway address.</td>
<td></td>
</tr>
<tr>
<td>*<em>DNS <em>3</em></em></td>
<td><strong>IPv4</strong> <strong>Get DNS Server Address from DHCP</strong> Displays whether to automatically get a DNS (Domain Name System) server address from the DHCP (Dynamic Host Configuration Protocol) server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Current DNS Server Address</strong> Displays the DNS server address.</td>
<td></td>
</tr>
<tr>
<td><strong>IPv6</strong></td>
<td><strong>Get DNS Server Address from DHCPv6-lite</strong> Displays whether to automatically get a DNS server address from the DHCPv6-lite server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Current DNS Server Address</strong> Displays the DNS server address.</td>
<td></td>
</tr>
<tr>
<td><em><em>DNS Dynamic Update (IPv4)</em> 2</em>*</td>
<td>Displays the status of the DNS Dynamic Update feature.</td>
<td></td>
</tr>
<tr>
<td><em><em>DNS Dynamic Update (IPv6)</em> 2</em>*</td>
<td>Displays the status of the DNS Dynamic Update feature.</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Generate Search List</strong></td>
<td>Displays whether to automatically generate a search list.</td>
<td></td>
</tr>
<tr>
<td><strong>Search Domain Name</strong></td>
<td>Displays the search domain name.</td>
<td></td>
</tr>
<tr>
<td><strong>Time-out</strong></td>
<td>Displays the time-out period.</td>
<td></td>
</tr>
<tr>
<td><strong>Priority to IPv6 DNS Name Resolution</strong></td>
<td>Displays whether to use the DNS Name Resolution feature.</td>
<td></td>
</tr>
<tr>
<td>*<em>WINS <em>3</em></em></td>
<td><strong>WINS Mode</strong> Displays the setting of how to get the WINS (Windows Internet Name Service) server address.</td>
<td></td>
</tr>
<tr>
<td>Port</td>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>WINS Primary Server</strong></td>
<td>Displays the primary WINS server address.</td>
<td></td>
</tr>
<tr>
<td><strong>WINS Secondary Server</strong></td>
<td>Displays the secondary WINS server address.</td>
<td></td>
</tr>
<tr>
<td><strong>LPD</strong></td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
</tr>
<tr>
<td><strong>Port9100</strong></td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td>Port Number</td>
<td>Displays the port number.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
</tr>
<tr>
<td><strong>IPP * 3</strong></td>
<td>Port Status</td>
<td>Displays the IPP (Internet Printing Protocol) port status.</td>
</tr>
<tr>
<td></td>
<td>Printer URI</td>
<td>Displays the printer URI (Uniform Resource Identifier).</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
</tr>
<tr>
<td></td>
<td>Port Number</td>
<td>Displays the IPP port number.</td>
</tr>
<tr>
<td></td>
<td>Maximum Sessions</td>
<td>Displays the maximum number of connections received simultaneously by the client.</td>
</tr>
<tr>
<td><strong>WSD * 3</strong></td>
<td>Port Status</td>
<td>Displays the WSD port status.</td>
</tr>
<tr>
<td></td>
<td>Port Number</td>
<td>Displays the WSD port number.</td>
</tr>
<tr>
<td></td>
<td>Receive Time-Out</td>
<td>Displays the receive timeout period.</td>
</tr>
<tr>
<td></td>
<td>Notification Time-Out</td>
<td>Displays the notification timeout period.</td>
</tr>
<tr>
<td></td>
<td>Maximum Number of TTL</td>
<td>Displays the maximum number of TTLs.</td>
</tr>
<tr>
<td></td>
<td>Maximum Number of Notification</td>
<td>Displays the maximum number of notifications.</td>
</tr>
<tr>
<td><strong>HTTP</strong></td>
<td>Port Status</td>
<td>Displays the HTTP (Hyper Text Transfer Protocol) port status.</td>
</tr>
<tr>
<td></td>
<td>Port Number</td>
<td>Displays the HTTP port number.</td>
</tr>
<tr>
<td></td>
<td>Simultaneous Connections</td>
<td>Displays the number of connections received simultaneously by the client.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
</tr>
<tr>
<td><strong>FTP</strong></td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
</tr>
<tr>
<td><strong>SMB * 3</strong></td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td>Host Name</td>
<td>Displays the host name.</td>
</tr>
<tr>
<td><strong>Workgroup</strong></td>
<td>Displays the workgroup name.</td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Maximum Sessions</strong></td>
<td>Displays the maximum number of connections received simultaneously by the client.</td>
<td></td>
</tr>
<tr>
<td><strong>Unicode Support</strong></td>
<td>Displays the status of the <strong>Unicode Support</strong> feature.</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Master Mode</strong></td>
<td>Displays the status of the <strong>Auto Master Mode</strong> feature.</td>
<td></td>
</tr>
<tr>
<td><strong>Encrypt Password</strong></td>
<td>Displays the status of the <strong>Encrypt Password</strong> feature.</td>
<td></td>
</tr>
<tr>
<td><strong>Job Time-Out</strong></td>
<td>Displays the timeout period.</td>
<td></td>
</tr>
<tr>
<td><strong>Connection Time-Out</strong></td>
<td>Displays the connection timeout period.</td>
<td></td>
</tr>
<tr>
<td><strong>AppleTalk * 3</strong></td>
<td><strong>Port Status</strong></td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td><strong>Printer</strong></td>
<td>Displays the printer name used in AppleTalk.</td>
</tr>
<tr>
<td></td>
<td><strong>AppleTalk Zone</strong></td>
<td>Displays the AppleTalk zone name.</td>
</tr>
<tr>
<td></td>
<td><strong>AppleTalk Type</strong></td>
<td>Displays the AppleTalk type.</td>
</tr>
<tr>
<td></td>
<td><strong>Delay Start Time</strong></td>
<td>Specifies the print start time period in second.</td>
</tr>
<tr>
<td><strong>Bonjour (mDNS) * 3</strong></td>
<td><strong>Port Status</strong></td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td><strong>Host Name</strong></td>
<td>Displays the host name.</td>
</tr>
<tr>
<td></td>
<td><strong>Printer Name</strong></td>
<td>Displays the printer name.</td>
</tr>
<tr>
<td><strong>SNMP Agent</strong></td>
<td><strong>Port Status</strong></td>
<td>Displays the port status.</td>
</tr>
<tr>
<td></td>
<td><strong>Trap Notification 1-4</strong></td>
<td>Displays the status of the <strong>Trap Notification</strong> feature and IP address.</td>
</tr>
<tr>
<td></td>
<td><strong>Authenticate Error Trap</strong></td>
<td>Displays the status of the <strong>Authenticate Error Trap</strong>.</td>
</tr>
<tr>
<td><strong>Scan to PC</strong></td>
<td><strong>FTP Client</strong></td>
<td>Scans data by using the FTP client.</td>
</tr>
<tr>
<td></td>
<td><strong>SMB Client</strong></td>
<td>Scans data by using the SMB client.</td>
</tr>
<tr>
<td><strong>IPsec Settings</strong></td>
<td><strong>Protocol</strong></td>
<td>Displays the protocol status.</td>
</tr>
<tr>
<td></td>
<td><strong>IKE</strong></td>
<td>Displays to use a preshared key for IKE authentication.</td>
</tr>
<tr>
<td></td>
<td><strong>IKE SA Lifetime</strong></td>
<td>Displays the lifetime for IKE SA.</td>
</tr>
<tr>
<td></td>
<td><strong>IPsec SA Lifetime</strong></td>
<td>Displays the lifetime for IPsec SA.</td>
</tr>
<tr>
<td></td>
<td><strong>DH Group</strong></td>
<td>Displays the DH group.</td>
</tr>
<tr>
<td></td>
<td><strong>PFS</strong></td>
<td>Displays the PFS status.</td>
</tr>
<tr>
<td></td>
<td><strong>Remote peers IPv4 address</strong></td>
<td>Displays the IP address to connect to.</td>
</tr>
<tr>
<td><strong>Remote peers IPv6 address</strong></td>
<td>Displays the IP address to connect to.</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Non IPsec communication policy</strong></td>
<td>Displays the status of the <em>Non IPsec communication policy</em> feature.</td>
<td></td>
</tr>
<tr>
<td>*<em>IP Filter (IPv4) <em>4</em></em></td>
<td><strong>Access List</strong></td>
<td>Displays the list of IP addresses that are permitted or denied access to the multifunction printer.</td>
</tr>
</tbody>
</table>

*1 The *Ethernet* settings are not displayed when the optional wireless printer adapter is installed.

*2 An optional wireless printer adapter is required to display the item.

*3 An optional multi-protocol card is required to display the items.

*4 This item is only available for LPD or Port9100.

---

**NetWare Setup Page**

**Purpose:**

To verify the current settings of IPX/SPX (Internetwork Packet Exchange/Sequenced Packet Exchange) and Netware. In this page, you can only verify the settings of items. If you want to change the settings, go to the pages in the *Print Server Settings* tab.

**Values:**

<table>
<thead>
<tr>
<th><strong>IPX/SPX Settings</strong></th>
<th><strong>Frame Type</strong></th>
<th>Displays the active frame type.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Current Frame Type</strong></td>
<td>Displays the current frame type.</td>
<td></td>
</tr>
<tr>
<td><strong>Network Address</strong></td>
<td>Displays the IPX/SPX network address.</td>
<td></td>
</tr>
<tr>
<td><strong>NetWare</strong></td>
<td><strong>Port Status</strong></td>
<td>Displays the port status. When NetWare is implemented, the status of IPX/SPX and TCP/IP is also displayed.</td>
</tr>
<tr>
<td><strong>Device Name</strong></td>
<td>Displays the printer name.</td>
<td></td>
</tr>
<tr>
<td><strong>Active Mode</strong></td>
<td>Displays the current mode for Active Mode.</td>
<td></td>
</tr>
<tr>
<td><strong>Tree Name</strong></td>
<td>Displays the tree name.</td>
<td></td>
</tr>
<tr>
<td><strong>Context Name</strong></td>
<td>Displays the context name of the Print Server Object.</td>
<td></td>
</tr>
<tr>
<td><strong>File Server Name</strong></td>
<td>Displays the file server name.</td>
<td></td>
</tr>
<tr>
<td><strong>Polling Interval</strong></td>
<td>Displays the time interval.</td>
<td></td>
</tr>
<tr>
<td><strong>NCP Packet Burst</strong></td>
<td>Displays the status, and whether to use NCP (NetWare Core Protocol) packet burst.</td>
<td></td>
</tr>
<tr>
<td><strong>Status Information</strong></td>
<td>Displays messages according to the conditions of the multifunction printer.</td>
<td></td>
</tr>
</tbody>
</table>
### Active Discovery
Displays whether active discovery is enabled.

**NOTE:** An optional multi-protocol card is required to display the NetWare Setup page.

### E-Mail Alert Setup Page

**Purpose:**
To verify the current settings of SMTP/POP (Simple Mail Transfer Protocol/Post Office Protocol) used for the e-mail feature and E-Mail Alerts feature. In this page, you can only verify the settings of items. If you want to change the settings, go to the pages in the Print Server Settings tab.

#### Values:

<table>
<thead>
<tr>
<th>E-Mail Server Settings</th>
<th>Port Status</th>
<th>Displays the port status.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary SMTP Gateway</td>
<td>Displays the primary SMTP (Simple Mail Transfer Protocol) gateway.</td>
<td></td>
</tr>
<tr>
<td>SMTP Port Number</td>
<td>Displays the SMTP port number.</td>
<td></td>
</tr>
<tr>
<td>E-Mail Send Authentication</td>
<td>Displays the authentication method for outgoing e-mail.</td>
<td></td>
</tr>
<tr>
<td>POP3 Server Address</td>
<td>Displays the POP3 (Post Office Protocol 3) server address.</td>
<td></td>
</tr>
<tr>
<td>POP3 Port Number</td>
<td>Displays the POP3 port number.</td>
<td></td>
</tr>
<tr>
<td>Reply Address</td>
<td>Displays the IP address of servers connected with SMTP protocol when data is incoming.</td>
<td></td>
</tr>
<tr>
<td>SMTP Server Connection</td>
<td>Displays the status of the SMTP server connection.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E-Mail Alert Settings</th>
<th>E-Mail List 1</th>
<th>Displays the acceptable e-mail addresses for the E-Mail Alert feature specified in E-Mail List 1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Alerts for List 1</td>
<td>Supplies Alerts</td>
<td>Displays the status, and whether to receive an E-Mail Alert for consumables.</td>
</tr>
<tr>
<td>Paper Handling Alerts</td>
<td>Displays the status, and whether to receive an E-Mail Alert for paper handling.</td>
<td></td>
</tr>
<tr>
<td>Service Call</td>
<td>Displays the status, and whether to receive an E-Mail Alert for Service Calls.</td>
<td></td>
</tr>
<tr>
<td>E-Mail List 2</td>
<td>Displays the acceptable e-mail addresses for the E-Mail Alert feature specified in E-Mail List 2.</td>
<td></td>
</tr>
<tr>
<td>Select Alerts for List 2</td>
<td>Supplies Alerts</td>
<td>Displays the status, and whether to receive an E-Mail Alert for consumables.</td>
</tr>
<tr>
<td>Paper Handling Alerts</td>
<td>Displays the status, and whether to receive an E-Mail Alert for paper handling.</td>
<td></td>
</tr>
</tbody>
</table>
Print Server Settings

The Print Server Settings tab includes Basic Information, Port Settings, Wireless LAN, TCP/IP, NetWare, SMB, AppleTalk, E-Mail Alert, Bonjour(mDNS), and SNMP pages.

Basic Information

Purpose:
To configure the printer's basic information.

Values:

<table>
<thead>
<tr>
<th>System Settings</th>
<th>Printer Name</th>
<th>Specifies the name of the multifunction printer up to 31 alphanumeric characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td></td>
<td>Specifies the location of the multifunction printer up to 63 alphanumeric characters.</td>
</tr>
<tr>
<td>Contact Person</td>
<td></td>
<td>Specifies the contact name, number, and other information of the printer administrator and service center up to 63 alphanumeric characters.</td>
</tr>
<tr>
<td>Administrator E-Mail Address</td>
<td></td>
<td>Specifies the contact address of the printer administrator and service center up to 63 alphanumeric characters.</td>
</tr>
<tr>
<td>Asset Tag Number</td>
<td>Enter the asset tag number for the multifunction printer.</td>
<td></td>
</tr>
</tbody>
</table>

EWS Settings

<table>
<thead>
<tr>
<th>Auto Refresh</th>
<th>On</th>
<th>Refreshes the contents of the status display pages automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off</td>
<td>Does not refresh the status display pages automatically.</td>
</tr>
</tbody>
</table>

Auto Refresh Interval

Sets the time interval for refreshing the contents of the status display pages automatically from 15 to 600 seconds.

NOTE: The auto refresh feature is effective for the contents of the Top Frame, Printer Status page, Job List page, and Completed Jobs page.

Port Settings

Purpose:
To specify whether to enable or disable printing ports and management protocol features.

Values:
<table>
<thead>
<tr>
<th>Ethernet Settings</th>
<th>Auto</th>
<th>Detects Ethernet transmission rate and the duplex settings automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>10BASE-T</td>
<td></td>
<td>Selects 10Base-T Half-Duplex as the default value.</td>
</tr>
<tr>
<td>Half-Duplex</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selects 10Base-T Full-Duplex as the default value.</td>
</tr>
<tr>
<td>100BASE-T</td>
<td></td>
<td>Selects 100Base-T Half-Duplex as the default value.</td>
</tr>
<tr>
<td>Full-Duplex</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100BASE-T</td>
<td></td>
<td>Selects 100Base-T Full-Duplex as the default value.</td>
</tr>
<tr>
<td>Full-Duplex</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Current Ethernet Settings**

Displays the current settings of Ethernet.

**MAC Address**

Displays the printer's MAC address.

<table>
<thead>
<tr>
<th>Port Status</th>
<th>LPD</th>
<th>Select the check box to enable the LPD.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Port9100</td>
<td>Select the check box to enable the Port9100.</td>
</tr>
<tr>
<td></td>
<td>IPP * 2</td>
<td>Select the check box to enable the IPP port.</td>
</tr>
<tr>
<td></td>
<td>WSD</td>
<td>Select the check box to enable the WSD port.</td>
</tr>
<tr>
<td></td>
<td>FTP</td>
<td>Select the check box to enable the FTP port.</td>
</tr>
<tr>
<td></td>
<td>SMB * 2</td>
<td>Select the check box to enable the SMB. You can also configure the transport protocol to be used. TCP/IP and NetBEUI can be selected simultaneously as the transport protocol.</td>
</tr>
<tr>
<td></td>
<td>NetWare * 2</td>
<td>Select the check box to enable the NetWare port. You can also configure the transport protocol to be used. IPX/SPX and TCP/IP can be selected simultaneously as the transport protocol.</td>
</tr>
<tr>
<td></td>
<td>AppleTalk * 2</td>
<td>Select the check box to enable the AppleTalk port.</td>
</tr>
<tr>
<td></td>
<td>Bonjour (mDNS) * 2</td>
<td>Select the check box to enable the Bonjour(mDNS) feature.</td>
</tr>
<tr>
<td></td>
<td>E-Mail Alert</td>
<td>Select the check box to enable the E-Mail Alert feature.</td>
</tr>
<tr>
<td></td>
<td>SNMP Agent</td>
<td>Select the check box to enable the SNMP (Simple Network Management Protocol). You can also configure the transport protocol to be used. UDP and IPX can be selected simultaneously as the transport protocol. IPX is only available when the multi-protocol card is installed.</td>
</tr>
</tbody>
</table>

*1 The Ethernet settings are not displayed when the optional wireless printer adapter is installed.

*2 An optional multi-protocol card is required to display the item.
NOTE: The settings in the Port Settings page will be valid only when the multifunction printer is rebooted. When you change or configure the settings, click the Restart printer to apply new settings button to apply new settings.

Wireless LAN

Purpose:

To configure the detailed setting for the wireless network.

<table>
<thead>
<tr>
<th>Wireless Settings</th>
<th>SSID</th>
<th>Specifies the name that identifies the wireless network. Up to 32 alphanumeric characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Type</td>
<td></td>
<td>Specifies the network type from either Ad-Hoc or Infrastructure.</td>
</tr>
<tr>
<td>MAC Address</td>
<td></td>
<td>Displays the MAC address of the printer's wireless network adapter.</td>
</tr>
<tr>
<td>Link Channel</td>
<td></td>
<td>Displays the channel number of the printer's wireless connection.</td>
</tr>
<tr>
<td>Link Quality</td>
<td></td>
<td>Displays the quality of the printer's wireless network connection.</td>
</tr>
</tbody>
</table>

Security Settings

<table>
<thead>
<tr>
<th>Encryption</th>
<th>Select the security method from the list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEP Key 1-4</td>
<td>Specifies the WEP key set used through the wireless network only when WEP 128bit or WEP 64bit is selected for Encryption.</td>
</tr>
<tr>
<td>Transmit Key</td>
<td>Specifies the transmit key from the list.</td>
</tr>
<tr>
<td>Pass Phrase</td>
<td>Specifies the pass phrase from 8 to 63 alphanumeric characters only when WPA-PSK AES or WPA-PSK TKIP is selected for Encryption.</td>
</tr>
</tbody>
</table>

NOTE: To set WPA2-PSK, select WPA-PSK AES.

NOTE: An optional wireless printer adapter is required to display the Wireless page.

TCP/IP

Purpose:

To configure the IP address, subnet mask, and gateway address of the multifunction printer.

Values:

<table>
<thead>
<tr>
<th>TCP/IP Settings</th>
<th>IP Mode</th>
<th>Specifies the IP mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td></td>
<td>Specifies the host name.</td>
</tr>
<tr>
<td>IPv4 IP Address Mode</td>
<td>Selects the IP address mode.</td>
<td></td>
</tr>
<tr>
<td><strong>Manual IP Address</strong></td>
<td>Sets the IP address.</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Manual Subnet Mask</strong></td>
<td>Sets the subnet mask.</td>
<td></td>
</tr>
<tr>
<td><strong>Manual Gateway Address</strong></td>
<td>Sets the gateway address.</td>
<td></td>
</tr>
<tr>
<td><strong>IPv6</strong></td>
<td><strong>Use Manual Address</strong></td>
<td>Select the check box to set the IP address manually.</td>
</tr>
<tr>
<td><strong>IPv6</strong></td>
<td><strong>Manual Address</strong></td>
<td>Sets the IP address.</td>
</tr>
<tr>
<td><strong>IPv6</strong></td>
<td><strong>Manual Gateway Address</strong></td>
<td>Sets the gateway address.</td>
</tr>
<tr>
<td><strong>DNS</strong></td>
<td><strong>DNS Domain Name</strong></td>
<td>Specifies the domain name of the domain name server. Up to 255 alphanumeric characters, periods, and hyphens can be used. If you need to specify more than one domain name, separate them using a comma or semicolon.</td>
</tr>
<tr>
<td><strong>IPv4</strong></td>
<td><strong>Get DNS Server Address from DHCP</strong></td>
<td>Select the check box to get the DNS server address automatically from the DHCP server.</td>
</tr>
<tr>
<td><strong>IPv4</strong></td>
<td><strong>Manual DNS Server Address</strong></td>
<td>Sets the DNS server address.</td>
</tr>
<tr>
<td><strong>IPv6</strong></td>
<td><strong>Get DNS Server Address from DHCPv6-lite</strong></td>
<td>Select the check box to get the DNS server address automatically from the DHCPv6-lite server.</td>
</tr>
<tr>
<td><strong>IPv6</strong></td>
<td><strong>Manual DNS Server Address</strong></td>
<td>Sets the DNS server address.</td>
</tr>
<tr>
<td><strong>DNS Dynamic Update (IPv4)</strong></td>
<td>Select the check box to enable dynamic updates to DNS.</td>
<td></td>
</tr>
<tr>
<td><strong>DNS Dynamic Update (IPv6)</strong></td>
<td>Select the check box to enable dynamic updates to DNS.</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Generate Search List</strong></td>
<td>Select the check box to automatically generate the search list.</td>
<td></td>
</tr>
<tr>
<td><strong>Search Domain Name</strong></td>
<td>Specifies the search domain name. Up to 255 alphanumeric characters, periods, and hyphens can be used. If you need to specify more than one domain name, separate them using a comma or semicolon.</td>
<td></td>
</tr>
<tr>
<td><strong>Time-out</strong></td>
<td>Specifies the time-out period between 1 and 60 seconds.</td>
<td></td>
</tr>
<tr>
<td><strong>Priority to IPv6 DNS Name Resolution</strong></td>
<td>Select the check box to enable the DNS Name Resolution feature.</td>
<td></td>
</tr>
<tr>
<td><strong>WINS</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td><strong>WINS Mode</strong></td>
<td>Select the check box to get the WINS server address automatically from the DHCP server.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>WINS Primary Server</strong></td>
<td>Sets WINS server address in the <code>nnn.nnn.nnn.nnn</code> format. Each section of <code>nnn.nnn.nnn.nnn</code> is a value between 0 and 254. Note that values 127 and 224-254 are not valid for the first three-digits.</td>
<td></td>
</tr>
<tr>
<td><strong>WINS Secondary Server</strong></td>
<td>Sets a back up WINS server address in the <code>nnn.nnn.nnn.nnn</code> format. Each section of <code>nnn.nnn.nnn.nnn</code> is a value between 0 and 254. Note that values 127 and 224-254 are not valid for the first three-digits.</td>
<td></td>
</tr>
<tr>
<td><strong>LPD</strong></td>
<td><strong>Connection Time-Out</strong></td>
<td>Sets the connection timeout period from 1 to 1000 seconds.</td>
</tr>
<tr>
<td></td>
<td><strong>IP Filter (IPv4)</strong></td>
<td>To set the IP Filter settings, click <strong>IP Filter</strong>. The <strong>IP Filter</strong> page is displayed.</td>
</tr>
<tr>
<td><strong>Port9100</strong></td>
<td><strong>Port Number</strong></td>
<td>Sets the port number from 9000 to 9999.</td>
</tr>
<tr>
<td></td>
<td><strong>Connection Time-Out</strong></td>
<td>Sets the connection timeout period between 1 and 1000 seconds.</td>
</tr>
<tr>
<td></td>
<td><strong>IP Filter (IPv4)</strong></td>
<td>To set the IP Filter settings, click <strong>IP Filter</strong>. The <strong>IP Filter</strong> page is displayed.</td>
</tr>
<tr>
<td><strong>IPP</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td><strong>Printer URI</strong></td>
<td>Displays the printer URI.</td>
</tr>
<tr>
<td></td>
<td><strong>Connection Time-Out</strong></td>
<td>Sets the connection timeout period from 1 to 1000 seconds.</td>
</tr>
<tr>
<td></td>
<td><strong>Port Number</strong></td>
<td>Displays the port number for receiving requests from the client.</td>
</tr>
<tr>
<td></td>
<td><strong>Maximum Sessions</strong></td>
<td>Displays the maximum number of connections received simultaneously by the client.</td>
</tr>
<tr>
<td><strong>WSD</strong></td>
<td><strong>Port Number</strong></td>
<td>Sets the port number from 8000 to 9999.</td>
</tr>
<tr>
<td></td>
<td><strong>Receive Time-Out</strong></td>
<td>Sets the receive timeout period from 1 to 65535 seconds.</td>
</tr>
<tr>
<td></td>
<td><strong>Notification Time-Out</strong></td>
<td>Sets the notification timeout period from 1 to 60 seconds.</td>
</tr>
<tr>
<td></td>
<td><strong>Maximum Number of TTL</strong></td>
<td>Sets the maximum number of TTL from 1 to 10.</td>
</tr>
<tr>
<td></td>
<td><strong>Maximum Number of Notification</strong></td>
<td>Sets the maximum number of notifications from 10 to 20.</td>
</tr>
<tr>
<td><strong>HTTP</strong></td>
<td><strong>Port Number</strong></td>
<td>Sets the port number to 80 or from 8000 to 9999.</td>
</tr>
<tr>
<td></td>
<td><strong>Simultaneous Connections</strong></td>
<td>Displays the maximum number of connections received simultaneously by the client.</td>
</tr>
<tr>
<td></td>
<td><strong>Connection Time-Out</strong></td>
<td>Sets the connection timeout period from 1 to 255 seconds.</td>
</tr>
<tr>
<td><strong>FTP</strong></td>
<td><strong>Password</strong></td>
<td>Sets whether to enable or disable the password. And also specifies the password value up to 7 characters.</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Connection Time-Out</strong></td>
<td>Sets the connection timeout period from 1 to 1000 seconds.</td>
<td></td>
</tr>
<tr>
<td><strong>IP Filter (IPv4)</strong> *2</td>
<td><strong>Address</strong></td>
<td>Sets the address in the address field. Enter a numeric value between 0 and 255 in each field of &quot;aaa.bbb.ccc.ddd.&quot; However, 127 and 224-254 cannot be used to &quot;aaa.&quot;</td>
</tr>
<tr>
<td><strong>Address Mask</strong></td>
<td>Sets the Subnet Mask in the Mask field. Enter a numeric value between 0 and 255 in each field.</td>
<td></td>
</tr>
<tr>
<td><strong>Active Mode</strong></td>
<td><strong>Reject</strong></td>
<td>Rejects printing from specified network address.</td>
</tr>
<tr>
<td></td>
<td><strong>Permit</strong></td>
<td>Permits printing from specified network address.</td>
</tr>
<tr>
<td></td>
<td><strong>Disabled</strong></td>
<td>Disables the IP Filter feature for the specified IP address.</td>
</tr>
</tbody>
</table>

*1 An optional multi-protocol card is required to display the item.

*2 This item is only available for LPD or Port9100.

**NetWare**

**Purpose:**

To configure detailed settings for IPX/SPX and NetWare.

**Values:**

<table>
<thead>
<tr>
<th><strong>IPX/SPX Settings</strong></th>
<th><strong>Frame Type</strong></th>
<th><strong>Auto</strong></th>
<th>Specifies the active frame type automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Ethernet II</strong></td>
<td>Selects Ethernet II frame type.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Ethernet 802.3</strong></td>
<td>Selects IEEE802.3 frame type.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Ethernet 802.2</strong></td>
<td>Selects IEEE802.2 frame type.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Ethernet SNAP</strong></td>
<td>Selects SNAP (Sub Network Access Protocol) frame type.</td>
<td></td>
</tr>
<tr>
<td><strong>Current Frame Type</strong></td>
<td>Displays the current frame type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Network Address</strong></td>
<td>Displays the IPX network address.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>NetWare</strong></th>
<th>*<em>Device Name <em>1</em></em></th>
<th>Specifies the printer name up to 47 alphanumeric characters. For PServer Mode, set the Print Server Name (Print Server Object Name). The original setting remains valid if no input is made.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active Mode</strong></td>
<td><strong>Directory: PServer Mode</strong></td>
<td>Selects this option when using in <strong>Directory: PServer Mode</strong>.</td>
</tr>
</tbody>
</table>
| **Bindery: PServer Mode** | Selects this option when using in **Bindery: PServer Mode**.

---

| **Tree Name *1** | Specifies the tree name up to 32 alphanumeric characters. Configure this item only when **Directory: PServer Mode** is selected.

---

| **Context Name** | Specifies the context name of the Print Server Object up to 255 alphanumeric characters. Configure this item only when **Directory: PServer Mode** or **Directory: RPrinter Mode** is selected.

---

| **File Server Name *1** | Specifies the file server name up to 47 alphanumeric characters. Configure this item only when **Bindery: PServer Mode** is selected.

---

| **Polling Interval** | Sets the time interval from when print data enters the print queue until printing starts. The setting range is from 1 to 1000 seconds. The original setting remains valid if no input is made. Configure this item only when **Bindery: PServer Mode** or **Directory: PServer Mode** is selected.

---

| **NCP Packet Burst** | **On** Uses NCP packet burst.  
| | **Off** Does not use NCP packet burst.

---

| **Password** | Sets the print server password up to 32 alphanumeric characters. Configure this item only when **Binary: PServer Mode** or **Directory: PServer Mode** is selected.

---

| **Confirm Password** | Enter the password again.

---

| **Status Information** | Displays the status of NetWare.

---

| **SLP** | **Active Discovery** Select the check box to enable Active Discovery.

---

*1 The following are illegal characters: semicolon (;), colon (:), asterisk (*), question mark (?), period (.), comma (,), yen mark (¥), back slash (\), double quotation ("), comparison symbols (< >), brackets ([ ]), operation symbols (+, =, or ~), pipe (|), slash (/), and space ( ).

**NOTE:** The settings in the **NetWare** page will be valid only when NetWare or the multifunction printer is rebooted. Click the **Restart printer to apply new settings** button to apply new settings.

**NOTE:** An optional multi-protocol card is required to display the **NetWare** page.

**SMB**

**Purpose:**

To configure detailed settings for SMB.

**Values:**
### Host Name
Specifies the host name up to 15 alphanumeric characters. The original setting will remain valid if no input is made.

### Workgroup
Specifies the workgroup name up to 15 alphanumeric characters. The original setting will remain valid if no input is made.

### Administrator Name
Specifies the administrator name up to 20 alphanumeric characters. The original setting will remain valid if no input is made. The default name is `admin`.

### Administrator Password
Specifies the administrator password up to 14 alphanumeric characters. The original setting will remain valid if no input is made. The default password is `password`.

### Confirm Administrator Password
Allows you to confirm the configured administrator password by re-entering the same password.

### Maximum Sessions
Displays the maximum sessions.

### Unicode Support
- **On**: Notifies the host name and workgroup name in Unicode characters.
- **Off**: Does not notify the host name and workgroup name in Unicode characters.

### Auto Master Mode
- **On**: Enables the Auto Master Mode.
- **Off**: Disables the Auto Master Mode.

### Encrypt Password
- **On**: Encrypts the password.
- **Off**: Does not encrypt the password.

### Job Time-Out
Sets the timeout period from 60 to 3600 seconds.

### Connection Time-Out
Sets the connection timeout period from 60 to 3600 seconds.

---

**NOTE:** The settings in the SMB page will be valid only when the multifunction printer is rebooted. Click the **Restart printer to apply new settings** button to apply new settings.

**NOTE:** An optional multi-protocol card is required to display the SMB page.

---

### AppleTalk

**Purpose:**
To configure the detailed settings for AppleTalk.

**Values:**

### AppleTalk

<table>
<thead>
<tr>
<th><strong>AppleTalk</strong></th>
<th><strong>Printer</strong></th>
<th>Specifies the printer name in the AppleTalk network up to 32 alphanumeric characters and symbol sets.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AppleTalk Zone</strong></td>
<td></td>
<td>Specifies the AppleTalk zone name up to 32 alphanumeric characters and symbol sets.</td>
</tr>
<tr>
<td><strong>AppleTalk Type</strong></td>
<td></td>
<td>Displays the AppleTalk type.</td>
</tr>
<tr>
<td><strong>Delay Start Time</strong></td>
<td></td>
<td>Specifies the delay start time between 1 and 255 seconds. A zero (0) value specifies no delay.</td>
</tr>
</tbody>
</table>

**NOTE:** An optional multi-protocol card is required to display the AppleTalk page.

### E-Mail Alert

**Purpose:**

To configure detailed settings for E-Mail Alert. This page can also be displayed by clicking **E-Mail Alert** in the Left Frame.

**Values:**

<table>
<thead>
<tr>
<th><strong>E-Mail Server Settings</strong></th>
<th><strong>Primary SMTP Gateway</strong></th>
<th>Sets the primary SMTP gateway.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>SMTP Port Number</strong></td>
<td>Specifies the SMTP port number. This must be 25 or between 5000 and 65535.</td>
</tr>
<tr>
<td></td>
<td><strong>E-Mail Send Authentication</strong></td>
<td>Specifies the authentication method for outgoing e-mail.</td>
</tr>
<tr>
<td></td>
<td><strong>SMTP Login User</strong></td>
<td>Specifies the SMTP login user. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas.</td>
</tr>
<tr>
<td></td>
<td><strong>SMTP Login Password</strong></td>
<td>Specifies the SMTP account password up to 31 alphanumeric characters.</td>
</tr>
<tr>
<td></td>
<td><strong>POP3 Server Address</strong></td>
<td>Specifies the POP3 server address in IP address format of &quot;aaa.bbb.ccc.ddd&quot; or as a DNS host name up to 63 characters.</td>
</tr>
<tr>
<td></td>
<td><strong>POP3 Port Number</strong></td>
<td>Specifies the POP3 server port number. This must be 110 or between 5000 and 65535.</td>
</tr>
<tr>
<td></td>
<td><strong>POP User Name</strong></td>
<td>Specifies the POP3 account user name. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas.</td>
</tr>
<tr>
<td></td>
<td><strong>POP User Password</strong></td>
<td>Specifies the POP3 account password up to 31 alphanumeric characters.</td>
</tr>
<tr>
<td></td>
<td><strong>Reply Address</strong></td>
<td>Designates the reply e-mail address sent with each E-mail Alert.</td>
</tr>
<tr>
<td><strong>SMTP Server Connection</strong></td>
<td>Displays the status of the SMTP server connection.</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>E-Mail Alert Settings</strong></td>
<td><strong>E-Mail List 1</strong></td>
<td>Sets acceptable e-mail addresses for the E-Mail Alert feature up to 255 alphanumeric characters.</td>
</tr>
<tr>
<td><strong>Select Alerts for List 1</strong></td>
<td><strong>Supplies Alerts</strong></td>
<td>Select the check box to receive an E-Mail Alert for consumables.</td>
</tr>
<tr>
<td><strong>Paper Handling Alerts</strong></td>
<td></td>
<td>Select the check box to receive an E-Mail Alert for paper handling.</td>
</tr>
<tr>
<td><strong>Service Call</strong></td>
<td></td>
<td>Select the check box to receive an E-Mail Alert for Service Calls.</td>
</tr>
<tr>
<td><strong>E-Mail List 2</strong></td>
<td></td>
<td>Sets acceptable e-mail addresses for the E-Mail Alert feature up to 255 alphanumeric characters.</td>
</tr>
<tr>
<td><strong>Select Alerts for List 2</strong></td>
<td><strong>Supplies Alerts</strong></td>
<td>Select the check box to receive an E-Mail Alert for consumables.</td>
</tr>
<tr>
<td><strong>Paper Handling Alerts</strong></td>
<td></td>
<td>Select the check box to receive an E-Mail Alert for paper handling.</td>
</tr>
<tr>
<td><strong>Service Call</strong></td>
<td></td>
<td>Select the check box to receive an E-Mail Alert for Service Calls.</td>
</tr>
</tbody>
</table>

*1 Available when POP before SMTP for E-Mail Send Authentication is selected.

**Bonjour (mDNS)**

**Purpose:**
To configure the detailed settings for Bonjour.

**Values:**

<table>
<thead>
<tr>
<th><strong>Bonjour (mDNS)</strong></th>
<th><strong>Host Name</strong></th>
<th>Specifies the host name up to 63 alphanumeric characters and &quot;-&quot; (dash). The original setting will remain valid if no input is made.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer Name</strong></td>
<td></td>
<td>Specifies the printer name up to 63 alphanumeric characters and symbol sets. The original setting will remain valid if no input is made.</td>
</tr>
</tbody>
</table>

**NOTE:** An optional multi-protocol card is required to display the Bonjour (mDNS) page.

**SNMP**

**Purpose:**
To configure the detailed settings of SNMP.

**Values:**

### SNMP Agent

**Community Name (Read only) *1**

Specifies the community name to access (read only) the data up to 31 alphanumeric characters. The original setting will remain valid if no input is made. Characters entered for community name in previous settings will not be displayed on the screen. The default Read Community is public.

**Community Name (Read/Write) *1**

Specifies the community name to access (read and write) the data up to 31 alphanumeric characters. The original setting will remain valid if no input is made. Characters entered for community name in previous settings will not be displayed on the screen. The default Read/Write Community is private.

**Community Name (Trap) *1**

Specifies the community name used for trap up to 31 alphanumeric characters. The original settings will remain valid if no input is made. Characters entered for Community Name (Trap) in previous settings will not be displayed on the screen. The default Trap Community is " " (NULL).

**Trap Notification 1-4**

Select the check boxes to notify trap occurrence. In this case, specify the IP address and IP socket in the following format:

- **IPv4**
  Specify the IP address and IP socket in the nnn.nnn.nnn.nnn:mmmmm format. Each section of "nnn" is a variable value between 0 and 255. Note that values 127 and 224-254 are not valid for the first three-digits only. IP socket mmmmm is a variable value between 0 and 65535.

- **IPv6**
  Specify the IP address and IP socket in the xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:mmmmm format. Each section of "xxxx" is a hexadecimal variable value between 0 and ffff. IP socket mmmmm is a variable value between 0 and 65535.

- **IPX**
  Specify the IPX address in the nnnnnnnn.mmmmmmmmmmm.mllll format. IP network nnnnnnnn is a hexadecimal variable value between 0 and ffffffff, IPX node mmmmmmmmmmm is a hexadecimal value between 0 and ffffffffffff and IPX socket lllll is a hexadecimal variable value between 0 and ffff.

**Authenticate Error Trap**

Select the check box to notify Authenticate Error Trap.

---

*1 The default value of each items can be changed by using Dell Printer Configuration Web Tool.

*2 An optional multi-protocol card is required to display the item.

### Scan to PC

**Purpose:**

To specify the client when scanning data.

**Values:**

<table>
<thead>
<tr>
<th>Scan to PC</th>
<th>FTP Client</th>
<th>SMB Client</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Scans data by using the FTP client.</td>
<td>Scans data by using the SMB client.</td>
</tr>
</tbody>
</table>

**IP Filter**

**Purpose:**
To configure the detailed settings for the IP Filter used for LPD and Port9100.

**Values:**

<table>
<thead>
<tr>
<th>Address Mask</th>
<th>Sets the Subnet Mask in the mask field. Enter a numeric value between 0 and 255 in each field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Sets the address in the address field. Enter a numeric value between 0 and 255 in each field of &quot;aaa.bbb.ccc.ddd.&quot; However, 127 and 224-254 cannot be used to &quot;aaa.&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Active Mode</th>
<th>Reject</th>
<th>Rejects printing from specified network address.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Permit</td>
<td>Permits printing from specified network address.</td>
</tr>
<tr>
<td></td>
<td>Disabled</td>
<td>Disables the IP Filter feature for the specified IP address.</td>
</tr>
</tbody>
</table>

When you make the settings for the filter, enter the IP address of the IP Filter in the **Address** field and the Subnet Mask in the **Address Mask** field. Enter a numeric value between 0 and 255 in each field. "*" is appended to the current value.

**Setup Procedure**

You can set up to a maximum of five items and the first item takes priority. Enter the shortest address first before proceeding to the next longer address when setting multiple filters.

The following section explains how the **IP Filter** operates.

1. **IP Filter Procedure**
   a. Enabling Printing From a Specified User

The following describes the procedure to enable printing only from the "192.168.100.10" IP address.

**Procedures:**

i. Click the first column of **Access List** row 1.

ii. Enter "192.168.100.10" in the **Address** field and "255.255.255.255" in the **Address Mask** field.

iii. Select **Permit**.

iv. Click **Apply New Settings**.

b. Disabling Printing From a Specified User

The following describes the procedure to disable printing only from the "192.168.100.10" IP address.

**Procedures:**

i. Click the first column of **Access List** row 1.

ii. Enter "192.168.100.10" in the **Address** field and "255.255.255.255" in the **Address Mask** field.

iii. Select **Reject**.
iv. Click the first column of **Access List** row 2.
v. Enter "0.0.0.0" in the **Address** field and "0.0.0.0" in the **Address Mask** field.
vi. Select **Permit**.
vii. Click **Apply New Settings**.

- **Enabling and Disabling Printing from Network Addresses**

You can enable printing from the "192.168" network address and disable printing from the "192.168.200" network address. However, the example below describes how to enable printing from the "192.168.200.10" IP address.

**Procedures:**

i. Click the first column of the **Access List** row 1.
ii. Enter "192.168.200.10" in the **Address** field and "255.255.255.255" in the **Address Mask** field.
iii. Select **Permit**.
iv. Click the first column of the **Access List** row 2.
v. Enter "192.168.200.0" in the **Address** field and "255.255.255.0" in the **Address Mask** field.
vi. Select **Reject**.
vii. Click the first column of the **Access List** row 3.
viii. Enter "192.168.0.0" in the **Address** field and "255.255.0.0" in the **Address Mask** field.
ix. Select **Permit**.
x. Click **Apply New Settings**.

**Other Features**

The **Other Features** tab includes **Set Password**, **Security**, **IPsec** and **Reset Print Server** pages.

**Set Password**

**Purpose:**

To set or change the password that is required to access the printer setup parameters from the **Dell Printer Configuration Web Tool**.

Set the password of the operator panel from **Panel Settings** in the **Printer Settings**. This page can also be displayed by clicking **Set Password** in the Left Frame.

**NOTE:** To restore the password to default (NULL), initialize the non-volatile memory (NVM).

**Values:**
Administrator Password

Sets the password up to 10 alphanumeric characters. The password will appear as asterisks (*) in the field when it is entered.

Confirm Administrator Password

Enter the password again to confirm it.

Security

Purpose:

To specify the settings for the SSL encryption communication to the multifunction printer.

Values:

<table>
<thead>
<tr>
<th>HTTPS</th>
<th>Displays the port status.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Number</td>
<td>Specifies the port number, which is not identical with that of HTTP for TCP/IP. This must be 443 or between 8000 and 9999.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Set the correct Time Zone to generate SSL authorization. The initial value, 0 or -5 (hours)*1, is set.</td>
</tr>
<tr>
<td>Generate Self-Signed Certificate</td>
<td>Click to display Generate Self-Signed Certificate page and to create a security certification from the page.</td>
</tr>
</tbody>
</table>

*1 Initial values may vary for different countries.

NOTE: An optional multi-protocol card is required to display the Security page.

IPsec

Purpose:

To specify the Security Architecture settings for Internet Protocol (IPsec) for encrypted communication to the printer.

Values:
### Protocol
Select the check box to enable the protocol.

<table>
<thead>
<tr>
<th><strong>IKE</strong></th>
<th>Use a preshared key for IKE authentication.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pre-Shared Key</strong></td>
<td>Specifies a shared key.</td>
</tr>
<tr>
<td><strong>Re-enter Pre-Shared Key</strong></td>
<td>Enter the shared key again to confirm it.</td>
</tr>
<tr>
<td><strong>IKE SA Lifetime</strong></td>
<td>Sets the lifetime for IKE SA from 5 to 28800 minutes.</td>
</tr>
<tr>
<td><strong>IPsec SA Lifetime</strong></td>
<td>Sets the lifetime for IPsec SA from 5 to 2880 minutes.</td>
</tr>
<tr>
<td><strong>DH Group</strong></td>
<td>Selects the DH group.</td>
</tr>
<tr>
<td><strong>PFS</strong></td>
<td>Selects the check box to enable the PFS setting.</td>
</tr>
<tr>
<td><strong>Remote peers IPv4 address</strong></td>
<td>Specifies the IP address to connect to.</td>
</tr>
<tr>
<td><strong>Remote peers IPv6 address</strong></td>
<td>Specifies the IP address to connect to.</td>
</tr>
<tr>
<td><strong>Non IPsec communication policy</strong></td>
<td>Selects whether or not to communicate with a device which does not support IPsec.</td>
</tr>
</tbody>
</table>

**NOTE:** If IPsec is enabled with incorrect settings, you must disable it using the **Reset IPsec** menu on the operator panel.

### Reset Print Server

**Purpose:**

To initialize NVRAM (non-volatile RAM) for the network feature and reboot the multifunction printer. You can also initialize the printer's NVRAM from **Reset Defaults** in the **Printer Settings** menu.

**Values:**

<table>
<thead>
<tr>
<th><strong>Initialize NIC NVRAM Memory and restart printer</strong></th>
<th>Click the <strong>Start</strong> button to initialize NVRAM. Network settings will revert to the factory default settings and reboot the network capability.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Restart Printer</strong></td>
<td>Click the <strong>Start</strong> button to reboot the multifunction printer.</td>
</tr>
</tbody>
</table>

### Copy Printer Settings

The **Copy Printer Settings** menu includes the **Copy Printer Settings** and **Copy Printer Settings Report** pages.

**NOTE:** You cannot copy the following printer settings:

- Copy Defaults
- Copy Color Balance
- Copy Settings
Copy Printer Settings

Purpose:
To copy the printer settings to one or more of the same model of the multifunction printer.

To copy the settings to another printer, specify the IP address and password of the printer to which the settings are copied in the IP Address text box and Password text box. Then, click the Copy the settings to the Host in the above list button. Copying the settings is complete. The connection time-out period is 60 seconds. After that, you can check whether settings were copied to this page. And you need to check the Copy the settings to the Host in the above list and reboot the machine menu of the Dell Printer Configuration Web Tool in the destination printer to verify if settings were actually copied or not.

If the settings can be copied but printer configuration is different, the settings of only the same items are copied. Printer settings are simultaneously copied to printers of up to 10 IP addresses.

Copy Printer Settings Report

Purpose:
To verify the histories of copying.

NOTE: The history is cleared by turning off the multifunction printer:

Address Book

The Address Book menu includes the E-Mail Address, Server Address, and Phone Book pages.

<table>
<thead>
<tr>
<th>E-Mail Address</th>
<th>E-Mail Address</th>
<th>Registers a new user in E-Mail Address.</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Mail Group</td>
<td>E-Mail Group</td>
<td>Registers a maximum of 10 users in the group.</td>
</tr>
<tr>
<td>Default Setup</td>
<td>Default Setup</td>
<td>Creates your own default settings for E-Mail Address.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Server Address</th>
<th>Server Address</th>
<th>Displays the Server Address list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Book</td>
<td>FAX Speed Dial</td>
<td>Display the Phone Book list.</td>
</tr>
<tr>
<td></td>
<td>FAX Group</td>
<td>Displays fax groups.</td>
</tr>
</tbody>
</table>

E-Mail Address
Purpose:
To organize E-Mail Address, E-Mail Group, and Default Setup.

Values:

<table>
<thead>
<tr>
<th>E-Mail Address</th>
<th>Registers a new user in E-Mail Address.</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Mail Group</td>
<td>Registers a maximum of 10 users in the group.</td>
</tr>
<tr>
<td>Default Setup</td>
<td>Creates your own default settings for E-Mail Address.</td>
</tr>
</tbody>
</table>

E-Mail Address - Top Page

Purpose:
To view your own default settings for E-Mail Address.

Values:

<table>
<thead>
<tr>
<th>ID : Name</th>
<th>Displays the e-mail addresses in the group.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Deletes the registered e-mail address.</td>
</tr>
<tr>
<td>Confirm / Change</td>
<td>Edits the registered e-mail address.</td>
</tr>
<tr>
<td>Create</td>
<td>Creates the new e-mail addresses in the group.</td>
</tr>
</tbody>
</table>

E-Mail Address

Purpose:
To edit the registered users in E-Mail Group.

Values:

<table>
<thead>
<tr>
<th>ID</th>
<th>Automatically specifies the registration number.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name for the new e-mail address.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the new e-mail address.</td>
</tr>
<tr>
<td>E-Mail Address</td>
<td>Lists the e-mail addresses.</td>
</tr>
<tr>
<td>Delete</td>
<td>Press this button to delete the specified e-mail user.</td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>Press this button to apply the specified settings.</td>
</tr>
<tr>
<td>Restore Settings</td>
<td>Press this button to restore the previous settings.</td>
</tr>
<tr>
<td>Back</td>
<td>Press this button to return to the top page where the user belongs.</td>
</tr>
</tbody>
</table>
**E-Mail Group -Top Page**

**Purpose:**
To view your own default settings for E-Mail Address.

**Values:**

<table>
<thead>
<tr>
<th>Group ID</th>
<th>Displays the group ID.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays names registered in the group.</td>
</tr>
<tr>
<td>Create</td>
<td>Creates the new user in the group.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the registered user.</td>
</tr>
<tr>
<td>Confirm / Change</td>
<td>Edits the registered user.</td>
</tr>
</tbody>
</table>

**E-Mail Group**

**Purpose:**
To register the user in E-Mail Group.

**Values:**

<table>
<thead>
<tr>
<th>E-Mail Group</th>
<th>ID</th>
<th>Automatically specifies the registration number.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Name</td>
<td>Enter the name for the new e-mail address.</td>
</tr>
<tr>
<td>E-Mail Address</td>
<td>Address List to</td>
<td>Displays buttons including up to 20 addresses.</td>
</tr>
<tr>
<td></td>
<td>ID</td>
<td>Displays the IDs registered in the group.</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>Displays the names registered in the group.</td>
</tr>
<tr>
<td></td>
<td>Address</td>
<td>Enter the new e-mail address.</td>
</tr>
<tr>
<td></td>
<td>Apply New Settings</td>
<td>Press this button to apply the specified settings.</td>
</tr>
<tr>
<td></td>
<td>Restore Settings</td>
<td>Press this button to restore the previous settings.</td>
</tr>
<tr>
<td></td>
<td>Back</td>
<td>Press this button to return to the top page where the user belongs.</td>
</tr>
</tbody>
</table>

**Default Setup**

**Purpose:**
To create your own default settings for E-Mail Address.

**Values:**
<table>
<thead>
<tr>
<th><strong>Default Subject</strong></th>
<th>Enter the subject of e-mail.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Body Text</strong></td>
<td>Enter the body text of e-mail.</td>
</tr>
<tr>
<td><strong>Apply New Settings</strong></td>
<td>Press this button to apply the specified settings.</td>
</tr>
<tr>
<td><strong>Restore Settings</strong></td>
<td>Press this button to restore the previous settings.</td>
</tr>
</tbody>
</table>

### Server Address - Top Page

**Purpose:**
To display the Server Address list.

**Values:**

<table>
<thead>
<tr>
<th><strong>Address List to:</strong></th>
<th>Displays buttons including 20 and 13 addresses. Click the button to list addresses associated with the IDs on the button.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
<td>Displays the ID including user names.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Displays user names registered in each ID.</td>
</tr>
<tr>
<td><strong>Server Address</strong></td>
<td>Displays the beginning characters of the server address.</td>
</tr>
<tr>
<td><strong>Create</strong></td>
<td>Creates the new user.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Deletes the registered user.</td>
</tr>
<tr>
<td><strong>Confirm / Change</strong></td>
<td>Edits the registered user.</td>
</tr>
</tbody>
</table>

### Server Address

**Purpose:**
To edit the Server Address list.

**Values:**
### ID
Displays the ID including user names.

### Name
Displays user names registered in each ID.

### Server Type
- **FTP**
  Uses the FTP protocol to store the scanned image on the server.
- **SMB**
  Uses the SMB protocol to store the scanned image on the computer.

### Server Address
Displays the server address.

### Server Port Number
Displays the server port number. If this option is left black, the default is used.

### Login Name
Displays the login name.

### Login Password
- **Enable Password**
  Check this option to use the password. The password is only shown in asterisks.

### Share Name
Displays the shared name.

### Server Path
Displays the server path.

### Delete
Deletes the registered user.

### Apply New Settings
Press this button to apply the specified settings.

### Restore Settings
Press this button to restore the previous settings.

### Back
Press this button to return to the top page where the user belongs.

**Phone Book**

<table>
<thead>
<tr>
<th>FAX Speed Dial</th>
<th>Displays the Phone Book list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAX Group</td>
<td>Displays fax groups.</td>
</tr>
</tbody>
</table>

**Phone Book - Top Page**

**Purpose:**

To display the Phone Book list.

**Values:**
<table>
<thead>
<tr>
<th><strong>Speed Dial List to:</strong></th>
<th>Displays buttons including up to 20 dials. Click the button to list dials associated with the IDs on the button.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
<td>Displays the IDs registered in the group.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Displays the user names registered in the group.</td>
</tr>
<tr>
<td><strong>Number</strong></td>
<td>Displays the beginning numbers of the dial.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Deletes the registered dial.</td>
</tr>
<tr>
<td><strong>Confirm / Change</strong></td>
<td>Edits the registered dial.</td>
</tr>
<tr>
<td><strong>Create</strong></td>
<td>Creates the new dial.</td>
</tr>
</tbody>
</table>

**FAX Speed Dial**

**Purpose:**
To register the new dial.

**Values:**

<table>
<thead>
<tr>
<th><strong>ID</strong></th>
<th>Automatically specifies the registration number.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Enter the user name.</td>
</tr>
<tr>
<td><strong>Phone Number</strong></td>
<td>Enter the phone number.</td>
</tr>
<tr>
<td><strong>ID</strong></td>
<td>Displays the IDs registered in the group.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Displays the user names registered in the group.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Press this button to delete the specified ID number.</td>
</tr>
<tr>
<td><strong>Apply New Settings</strong></td>
<td>Press this button to apply the specified settings.</td>
</tr>
<tr>
<td><strong>Restore Settings</strong></td>
<td>Press this button to restore the previous settings.</td>
</tr>
<tr>
<td><strong>Back</strong></td>
<td>Press this button to return to the top page where the user belongs.</td>
</tr>
</tbody>
</table>

**FAX Group - Top Page**

**Purpose:**
To displays fax groups.

**Values:**
ID | Displays the IDs registered in the group.
---|----------------------------------------
Name | Displays the user names registered in the group.
Delete | Deletes the registered fax group.
Confirm / Change | Edits the registered fax group.
Create | Creates the new user in the fax group.

**FAX Group**

**Purpose:**
To register the fax group.

**Values:**

<table>
<thead>
<tr>
<th>FAX Group</th>
<th>ID</th>
<th>Automatically specifies the registration number.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Name</td>
<td>Enter the group name.</td>
</tr>
<tr>
<td>FAX Speed Dial</td>
<td>Speed Dial List to:</td>
<td>Displays buttons including up to 20 speed dials. Click the button to list dials associated with the IDs on the button.</td>
</tr>
<tr>
<td></td>
<td>ID</td>
<td>Automatically specifies the registration number.</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>Displays names registered in each ID.</td>
</tr>
<tr>
<td></td>
<td>Phone Number</td>
<td>Displays the phone numbers registered in each ID.</td>
</tr>
<tr>
<td></td>
<td>Apply New Settings</td>
<td>Press this button to apply the specified settings.</td>
</tr>
<tr>
<td></td>
<td>Restore Settings</td>
<td>Press this button to restore the previous settings.</td>
</tr>
<tr>
<td></td>
<td>Back</td>
<td>Press this button to return to the top page where the user belongs.</td>
</tr>
</tbody>
</table>

**Print Volume**

The **Print Volume** menu includes the **Print Volume** and **Dell ColorTrack** pages.

**Print Volume**

**Purpose:**
To verify the number of printed pages. This page can also be displayed by clicking **Print Volume** in the Left Frame.

**Values:**
<table>
<thead>
<tr>
<th>Printer Page Count</th>
<th>Displays the total number of pages printed since the multifunction printer was shipped from the factory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Used</td>
<td>Displays the number of pages for each paper size.</td>
</tr>
</tbody>
</table>

**Dell ColorTrack**

**Purpose:**
To specify which users have access to color printing and to limit print volume per user.

**Values:**

<table>
<thead>
<tr>
<th>Print User Limitation</th>
<th>Select the check box to restrict users from using the multifunction printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permit printing without specifying user</td>
<td>Select the check box to use the multifunction printer without user limitations.</td>
</tr>
<tr>
<td>User Registration</td>
<td>Displayed when <strong>Print User Limitation</strong> is enabled. To register a user, click <strong>Edit User Registration</strong> to open the <strong>Edit Print User Registration</strong> page, and then specify <strong>User Registration No.</strong> and click <strong>Edit</strong> to open the <strong>Print User Settings</strong> page.</td>
</tr>
</tbody>
</table>

**Edit Print User Registration**

**Purpose:**
To edit the user registration number.

**Values:**

| User Registration No., Edit | Type the user registration number to edit the print user settings. |

**Print User Settings**

**Purpose:**
To specify the user settings for the printer.

**Values:**
<table>
<thead>
<tr>
<th><strong>User Registration No.</strong></th>
<th>Displays the user registration number.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Name</strong></td>
<td>Edits the user name.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Registers the password.</td>
</tr>
<tr>
<td><strong>Color Mode Limitation</strong></td>
<td>Selects the color mode.</td>
</tr>
<tr>
<td><strong>Upper Limit for Color Print</strong></td>
<td>Type the number of pages for color print.</td>
</tr>
<tr>
<td><strong>Cumulative Color Page Count</strong></td>
<td>Counts and displays the color pages cumulatively.</td>
</tr>
<tr>
<td><strong>Upper Limit for Monochrome Print</strong></td>
<td>Type the number of pages for mono chrome print.</td>
</tr>
<tr>
<td><strong>Cumulative Monochrome Page Count</strong></td>
<td>Counts the black and white pages cumulatively.</td>
</tr>
</tbody>
</table>

**Tray Settings**

Use the **Tray Settings** menu to set the printer media types and sizes for trays respectively.

**Values:**

<table>
<thead>
<tr>
<th><strong>Tray 1 Paper Type</strong></th>
<th>Sets the type of paper loaded in the standard 250-sheet tray.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tray 1 Paper Size</strong></td>
<td>Sets the size of paper loaded in the standard 250-sheet tray.</td>
</tr>
<tr>
<td><strong>Tray 1 Custom Size - Y</strong></td>
<td>Sets the length of paper loaded in the standard 250-sheet tray.</td>
</tr>
<tr>
<td><strong>Tray 1 Custom Size - X</strong></td>
<td>Sets the width of paper loaded in the standard 250-sheet tray.</td>
</tr>
<tr>
<td><strong>Tray 2 Paper Type</strong></td>
<td>Sets the type of paper loaded in the optional 550-sheet paper feeder.</td>
</tr>
<tr>
<td><strong>Tray 2 Paper Size</strong></td>
<td>Sets the size of paper loaded in the optional 550-sheet paper feeder.</td>
</tr>
<tr>
<td><strong>Tray 2 Custom Size - Y</strong></td>
<td>Sets the length of paper loaded in the optional 550-sheet paper feeder.</td>
</tr>
<tr>
<td><strong>Tray 2 Custom Size - X</strong></td>
<td>Sets the width of paper loaded in the optional 550-sheet paper feeder.</td>
</tr>
<tr>
<td><strong>MPF Mode</strong></td>
<td>Sets the paper size and type when paper is loaded in the multipurpose feeder.</td>
</tr>
<tr>
<td><strong>Display Popup</strong></td>
<td>Sets the paper size and type when paper is loaded in the multipurpose feeder.</td>
</tr>
<tr>
<td><strong>MPF Paper Type</strong></td>
<td>Sets the type of paper loaded in the multipurpose feeder.</td>
</tr>
<tr>
<td><strong>MPF Paper Size</strong></td>
<td>Sets the size of paper loaded in the multipurpose feeder.</td>
</tr>
<tr>
<td><strong>MPF Custom Size - Y</strong></td>
<td>Sets the length of paper loaded in the multipurpose feeder.</td>
</tr>
<tr>
<td><strong>MPF Custom Size - X</strong></td>
<td>Sets the width of paper loaded in the multipurpose feeder.</td>
</tr>
</tbody>
</table>
About Your Multifunction Printer

- **Automatic Document Feeder (ADF)**
- **Operator Panel**
- **Power Saver Mode2**

The following illustrations show the standard Dell™ Multifunction Color Laser Printer 3115cn, with an optional 550-sheet paper feeder and duplex module.
<table>
<thead>
<tr>
<th></th>
<th>Optional duplexer</th>
<th>5</th>
<th>Optional 550-sheet paper feeder</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Operator panel</td>
<td>6</td>
<td>Multipurpose feeder</td>
</tr>
<tr>
<td>3</td>
<td>Front cover</td>
<td>7</td>
<td>Button (right side)</td>
</tr>
<tr>
<td>4</td>
<td>Standard 250-sheet tray</td>
<td>8</td>
<td>Transfer belt unit</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td>Automatic Document Feeder (ADF)</td>
</tr>
</tbody>
</table>

**NOTE:** Your multifunction printer allows for a maximum of three trays (standard 250-sheet tray, optional 550-sheet paper feeder, and multipurpose feeder).

**NOTE:** When you use the multifunction printer with the multipurpose feeder opened, do not locate the multifunction printer in direct sunlight. Doing so may cause a malfunction or unnatural screen image.

Leave enough room to open the printer trays, covers, and options. It is also important to allow space around the multifunction printer for proper ventilation.

---

**Automatic Document Feeder (ADF)**
The scan lamp under the document feeder glass automatically turns off when it is not in actual use during a preset period to reduce power consumption and extend the lamp life. The lamp automatically turns on and the warm-up cycle begins whenever any key is pressed or the document cover is opened.

You can set the length of time for which the scan lamp waits after a scan job is completed before it switches to the Power Saver Mode2.

1. Press ▼ until >SETUP appears, and then press ✔.
2. Press ▼ until >Admin Menu appears, and then press ✓.

3. Press ▼ until System Settings appears, and then press ✓.

4. Press ▼ until >Power Saver Mode2 appears, and then press ✓.

5. Press ► to select On, and then press ✓.

6. Press ▼ until >Power Saver Timer appears, and then press ✓.

7. Press ► to select the desired time, and then press ✓.

8. To return to the standby mode, press Cancel.
Installing the Print Cartridges

CAUTION: Before performing any of the following procedures, read and follow the safety instructions in your Owner's Manual or Product Information Guide.

NOTICE: To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.

NOTICE: Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, or oil from your hands on the film of the transfer belt unit may reduce print quality.

Installing the Print Cartridges

1. Push the button (right side) and open the front cover.

2. Pull up the tag to remove the seal from the unit belt.
3. Remove the seals over the levers at both ends of the fuser unit, and then pull the tag to remove the seal from the fuser unit.

**NOTE:** Ensure to lock both levers at ends of the fuser unit, after removing the seal.

4. Hold one print cartridge firmly and shake it five or six times to distribute the toner evenly.
5. Remove the print cartridge from its packaging.

![Image]

**NOTE:** To protect the drum against bright light, do not remove the orange protective cover of the print cartridge before the cartridge is inserted into its slot in the multifunction printer.

6. Completely remove the seal from the print cartridge by pulling the tab on the end of the print cartridge.

![Image]

**NOTE:** Pull the seal out straight. Pulling the seal diagonally may tear it.

7. Grasp both handles of the print cartridge with the label facing up and slide the cartridge into the same color slot. Ensure the cartridge is fully inserted.
8. Repeat steps 4, 5, 6, and 7 to install the other print cartridges.

9. Remove the orange protective covers of the each of the installed print cartridges.

10. After installing all of the print cartridges, close the front cover.
Choosing the Right Cable

Your Dell™ Multifunction Color Laser Printer 3115cn interconnection cable must meet the following requirements:

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Connection specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parallel</td>
<td>IEEE (the Institute of Electrical and Electronic Engineers) 1284</td>
</tr>
<tr>
<td>USB</td>
<td>USB 2.0</td>
</tr>
<tr>
<td>Ethernet</td>
<td>10 Base-T/100 Base-TX</td>
</tr>
<tr>
<td>Wireless</td>
<td>IEEE802.11b/802.11g</td>
</tr>
<tr>
<td>Wall jack connector</td>
<td>RJ11</td>
</tr>
<tr>
<td>Phone connector</td>
<td>RJ11</td>
</tr>
</tbody>
</table>
Connecting the Multifunction Printer Locally

A local printer is a printer attached to your computer using a USB or parallel cable. If your multifunction printer is attached to a network instead of your computer, skip this step and go on to "Connecting the

To attach the multifunction printer to a computer:

1. Ensure the multifunction printer, computer, and any other attached devices are turned off and unplugged.

2. Connect the multifunction printer to the computer using a USB or parallel cable.

A USB/parallel port requires a USB/parallel cable. Be sure to match the USB/parallel symbol on the cable to the USB/parallel symbol on the multifunction printer.

Plug the other end of the cable into a USB or parallel port on the back of the computer. For a USB cable, do not plug it into the USB keyboard.

**Turn On the Multifunction Printer**
Before turning on the multifunction printer, be sure to release the carriage lock of the scanner.

- **NOTE:** If you use the optional duplexer, remove the protection film attached to the transfer belt unit of the duplexer. For details, see "Installing a Duplexer".

- **NOTE:** When you are moving the multifunction printer or do not intend to use it for a long period of time, move the switch to the lock position.

1. Plug one end of the printer power cable into the socket at the back of the multifunction printer and the other end into a properly grounded outlet.

- **CAUTION:** Do not use extension cords or power strips.

- **CAUTION:** The multifunction printer should not be plugged into a UPS system.

2. Turn on the computer and the multifunction printer.
Connecting the Multifunction Printer to the Network

To attach the multifunction printer to a network:

1. Ensure the multifunction printer, computer, and any other attached devices are turned off and unplugged.

2. Connect the multifunction printer to the network using an Ethernet cable or the wireless printer adapter.
   To use a wireless printer adapter, you must install the Multi-Protocol Card first. To install the card, see "Installing the Dell Multi-Protocol Card".

<table>
<thead>
<tr>
<th>1</th>
<th>Ethernet port</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Optional wireless printer adapter socket</td>
</tr>
</tbody>
</table>

To connect the multifunction printer to the network, plug one end of an Ethernet cable into the Ethernet port on the back of the multifunction printer, and the other end into a LAN drop or hub. For a wireless connection, insert the wireless printer adapter into the wireless printer socket on the back of the multifunction printer.

Turn On the Multifunction Printer

1. Plug one end of the printer power cable into the socket at the back of the multifunction printer and the other end into a properly grounded outlet.
CAUTION: Do not use extension cords or power strips.

CAUTION: The multifunction printer should not be plugged into a UPS system.

2. Turn on the computer and the multifunction printer.

Print and Check the System Settings Page

Print a system settings page to verify the network connection. This page also provides important information that helps you configure for network printing.

NOTE: Depending on the network configuration, the multifunction printer may not be provided an IP address immediately. If the System Settings page does not show an assigned IP address, wait five minutes and try again.

1. Press ▼ until >SETUP appears, and then press ✓.

2. Press ▼ until >Reports appears, and then press ✓.

3. System Settings is displayed. Press ✓.

The system settings page is printed.

4. If the IP address shows anything other than 0.0.0.0 (the factory default) or 169.254.xx.xx, the multifunction printer has an IP address assigned and stored. Go to "Verify the IP Settings."

Assign an IP Address
When you assign an IP address manually in **IPv6 Mode**, use the **Dell Printer Configuration Web Tool**. To open the **Dell Printer Configuration Web Tool**, use the link local address. (To check a link local address, see "Print and Check the System Settings Page".)

An IP address is a unique number that consists of four sections that are delimited by a period and can include up to three digits in each section, for example, 111.222.33.44.

Assigning an IP address already in use can cause network performance issues.

**NOTE:** Assigning an IP address is considered as an advanced function and is normally done by a system administrator.

For more information on using your operator panel, see "Operator Panel".

1. Turn on the multifunction printer.

   >COPY appears.

2. Press ▼ until >Setup appears, and then press ✓.

3. Press ▼ until >Admin Menu appears, and then press ✓.

4. Press ▼ until >Wired Net or >Wireless Net appears, and then press ✓.

5. Press ▼ until >TCP/IP appears, and then press ✓.

6. Press ▼ until >IP Address appears, and then press ✓.

7. The cursor is located at the first digit of the IP address. Press ▲ ▼ to enter the numbers for the IP address.

8. Press ✓.

   The cursor moves to the next digit.

9. Repeat steps 7 and 8 to enter all of the digits in the IP address, and then press ✓.

10. Press the **Back** button.

11. Press ▼ until >Subnet Mask appears, and then press ✓.

12. Repeat steps 7 to 8 to set Subnet Mask, and then press ✓.

13. Press the **Back** button.

14. Press ▼ until >Gateway Address appears, and then press ✓.
15. Repeat steps 7 to 8 to set Gateway Address, and then press ✅.

16. Turn off the multifunction printer, and then turn it on again.

The IP address is assigned to your multifunction printer. To verify the setting, open the web browser on any computer connected to the network and enter the IP address into the address bar on the browser. If the IP address is set up correctly, the Dell Printer Configuration Web Tool displays in your browser.

You can also assign the IP address to the multifunction printer when installing the printer drivers with installer. When you use the Network Installation feature, and the Get IP Address is set to AutoIP on the operator panel menu, you can set the IP address from 0.0.0.0 to the desired IP address on the printer selection window.

**Verify the IP Settings**

1. Print another system settings page.

2. Look under the TCP/IP heading on the system settings page to ensure that the IP address, netmask, and gateway are what you expected.

or

Ping the multifunction printer and verify that it responds. For example, at a command prompt on a network computer, type ping followed by the new printer IP address (for example, 192.168.0.11):

```
ping 192.168.0.11
```

If the multifunction printer is active on the network, you will receive a reply.

---

**Connecting the Telephone Line**

⚠️ **NOTE:** Do not connect your multifunction printer directly to a DSL (digital subscriber line). This may damage the multifunction printer. To use a DSL, you will need to use an appropriate DSL filter. Contact your service provider for the DSL filter.

1. Plug one end of a telephone line cord into the Wall Jack connector and the other end into an active wall jack.
2. To connect a telephone and/or answering machine to your multifunction printer, plug the telephone or answering machine line cord into the Phone connector ( ).

If the phone communication is serial in your country (such as Germany, Sweden, Denmark, Austria, Belgium, Italy, France and Switzerland), and that you are supplied with a terminator plug, insert the terminator plug into the Phone connector ( ).
Enterprise Console Management Modules

The following enterprise console management modules and user's manuals are available on your *Drivers and Utilities* CD:

- IBM Tivoli® NetView®
- CA Unicenter®
- HP OpenView®

To use the modules, go to the following directory on your CD and run each `.exe` file or `.chm` file.

IBM Tivoli: `\Utilities\SnapIns\IBM Tivoli`

CA Unicenter: `\Utilities\SnapIns\CA Unicenter`

HP OpenView: `\Utilities\SnapIns\HP OpenView`
Installing Optional Modules

You can make the multifunction printer more functional by installing the options. This chapter describes how to install the printer’s options such as the duplexer and optional 550-sheet paper feeder.

- Installing the Optional 550-Sheet Paper Feeder
- Installing a Duplexer
- Installing a Memory Card
- Installing the Dell Multi-Protocol Card
- Installing the Dell Wireless Printer Adapter 3310 USB

Installing the Optional 550-Sheet Paper Feeder

⚠️ **CAUTION:** If you are adding an optional 550-sheet paper feeder after setting up the multifunction printer, be sure to turn off the multifunction printer, unplug the power cable, and disconnect all cables from the back of the multifunction printer before completing these tasks.

⚠️ **CAUTION:** Do not move the multifunction printer with the optional 550-sheet paper feeder attached. You may be hurt if the optional 550-sheet paper feeder falls off. Be sure to remove the optional 550-sheet paper feeder from the multifunction printer before you move it.

1. Place the optional 550-sheet paper feeder in the location that the multifunction printer is located.
2. Ensure that the multifunction printer is turned off.
3. Attach the extensions to the optional 550-sheet paper feeder by aligning the hooks to the holes.
4. Lift the multifunction printer and align the four guide pins of the 550-sheet paper feeder with the holes at the bottom of the multifunction printer. Gently lower the multifunction printer onto the optional 550-sheet paper feeder.

**CAUTION:** To lift the multifunction printer safely, lift it with two people facing the front and back. Never try to lift the multifunction printer while facing its right and left sides.

**NOTICE:** Be careful not to pinch your fingers when lowering the multifunction printer onto the optional 550-sheet paper feeder.

5. Pull the tray out of the multifunction printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the multifunction printer.
6. Join the optional 550-sheet paper feeder and the multifunction printer by tightening the two screws provided with the feeder with a coin or similar object.

7. Insert the tray into the multifunction printer, and push until it stops.
8. Turn on the multifunction printer.

**NOTE:** The multifunction printer will automatically detect the attached tray but will not detect the paper type.

9. Print a system settings page to verify that the optional 550-sheet paper feeder is installed correctly.

a. Press ▼ until >SETUP appears, and then press ✔.

b. Press ▼ until >Reports appears, and then press ✔.

c. System Settings is displayed. Press ✔.

   The system settings page is printed.

d. Verify **550 Sheet Feeder** is listed in the system settings under **Printer Options**.

   If the tray module is not listed, turn off the multifunction printer, unplug the power cable, and reinstall the optional 550-sheet paper feeder.

10. After loading paper in the installed tray, specify the paper type from the printer operator panel.

a. Press ▼ until >SETUP appears, and then press ✔.

b. Press ▼ until >Tray Settings appears, and then press ✔.
c. Press ▼ until the installed tray appears, and then press ✓.

d. Press ▼ until >Paper Type appears, and then press ✓.

e. Press ▼ until >Paper Size appears, and then press ✓.

f. Confirm that the selected paper type is marked with an asterisk(*), and then press Menu.

11. If you installed the optional 550-sheet paper feeder after installing the printer driver, update your driver by following the instructions for each operating system. If the multifunction printer is on a network, update the driver for each client.

**When Using PCL Driver**

**Microsoft® Windows Vista®**

1. Click **Start → Control Panel → Hardware and Sound → Printers**.

2. Right-click the multifunction printer and select **Properties**.

3. Click the **Options** tab, and then select **Get Information from Printer**.

4. Click **Apply**, and then click **OK**.

5. Close the **Printers** dialog box.


1. Click **Start → Printers and Faxes**.

2. Right-click the multifunction printer and select **Properties**.

3. Click the **Options** tab, and then select **Get Information from Printer**.

4. Click **Apply**, and then click **OK**.

5. Close the **Printers and Faxes** dialog box.


1. Click **Start → Control Panel → Printers**.

2. Right-click the multifunction printer and select **Properties**.

3. Click the **Options** tab, and then select **Get Information from Printer**.

4. Click **Apply**, and then click **OK**.

5. Close the **Printers** dialog box.
Windows 2000/Windows NT® 4.0

1. Click **Start** → **Settings** → **Printers**.
2. Right-click the multifunction printer and select **Properties**.
3. Click the **Options** tab, and then select **Get Information from Printer**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1. Click the **Options** tab, and then select **550 Sheet Feeder** in the **Items** list box.
2. Select **Available** for the 550-sheet feeder setting.
3. Click **Apply**, and then click **OK**.
4. Close the **Printers and Faxes** (or **Printers**) dialog box.

When Using PS Driver

**Microsoft Windows Vista**

1. Click **Start** → **Control Panel** → **Hardware and Sound** → **Printers**.
2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.
3. Click the **Device Settings** tab, and then select **2-Tray Module** for the **Paper Tray Configuration** item under **Installable Options**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.


1. Click **Start** → **Printers and Faxes**.
2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.
3. Click the **Device Settings** tab, and then select **2-Tray Module** for the **Paper Tray Configuration** item under **Installable Options**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers and Faxes** dialog box.


1. Click **Start** → **Control Panel** → **Printers**.

2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.

3. Click the **Device Settings** tab, and then select **2-Tray Module** for the **Paper Tray Configuration** item under **Installable Options**.

4. Click **Apply**, and then click **OK**.

5. Close the **Printers** dialog box.

**Windows 2000/Windows NT 4.0**

1. Click **Start** → **Settings** → **Printers**.

2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.

3. Click the **Device Settings** tab, and then select **2-Tray Module** for the **Paper Tray Configuration** item under **Installable Options**.

4. Click **OK**.

5. Close the **Printers** dialog box.

**Mac OS X**

1. Select the multifunction printer from the **Printer List** screen in **Print Center** (or **Printer Setup Utility**).

2. Click **Printers** on the **Print Center** (or **Printer Setup Utility**) menu bar, and select **Show Info**.

3. Select **Installable Options**, and select the options that have been installed on the multifunction printer, and then click **Apply Changes**.

---

**Installing a Duplexer**

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.
**NOTICE:** Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, or oil from your hands on the film of the transfer belt unit may reduce print quality.

1. Ensure that the multifunction printer is turned off.
2. Remove all packaging from duplex module.
3. Push the button (right side) and open the front cover.

4. Pull up on the belt release levers and rotate the transfer belt unit up as shown in the illustration.
5. Remove the connector cap.

**NOTE:** The connector cap in your printer may look different from illustration.

6. With the connector of the duplexer toward the slot, push the duplexer into the slot.
**NOTE:** Ensure that the duplexer is correctly connected to the multifunction printer with connectors and cannot be moved easily.

7. Close the transfer belt unit by pulling it down.
8. Close the front cover.

9. Turn on the multifunction printer.

10. Print a system settings page to verify that the optional duplexer is installed correctly.

    a. Press ▼ until > SETUP appears, and then press ✓.
b. Press ▼ until >Reports appears, and then press ✓.

c. System Settings is displayed. Press ✓.

The system settings page is printed.

d. Verify Duplexer is listed in the system settings under Printer Options.

If the duplexer is not listed, turn off the multifunction printer, unplug the power cable, and reinstall the optional duplexer.

11. If you installed the optional duplexer after installing the printer driver, update your driver by following the instructions for each operating system. If the multifunction printer is on a network, update the driver for each client.

**When Using PCL Driver**

**Microsoft® Windows Vista®**

1. Click Start → Control Panel → Hardware and Sound → Printers.
2. Right-click the multifunction printer and select Properties.
3. Click the Options tab, and then select Get Information from Printer.
4. Click Apply, and then click OK.
5. Close the Printers dialog box.


1. Click Start → Printers and Faxes.
2. Right-click the multifunction printer and select Properties.
3. Click the Options tab, and then select Get Information from Printer.
4. Click Apply, and then click OK.
5. Close the Printers and Faxes dialog box.


1. Click Start → Control Panel → Printers.
2. Right-click the multifunction printer and select Properties.
3. Click the **Options** tab, and then select **Get Information from Printer**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.

**Windows 2000/Windows NT® 4.0**

1. Click **Start → Settings → Printers**.
2. Right-click the multifunction printer and select **Properties**.
3. Click the **Options** tab, and then select **Get Information from Printer**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1. Click the **Options** tab, and then select **Duplexer** in the **Items** list box.
2. Select **Available** for the duplexer setting.
3. Click **Apply**, and then click **OK**.
4. Close the **Printers and Faxes** (or **Printers**) dialog box.

**When Using PS Driver**

**Microsoft Windows Vista**

1. Click **Start → Control Panel → Hardware and Sound → Printers**.
2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.
3. Click the **Device Settings** tab, and then select **Available** for the **Duplexer** item under **Installable Options**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.


1. Click **Start → Printers and Faxes**.
2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.

3. Click the **Device Settings** tab, and then select **Available** for the **Duplexer** item under **Installable Options**.

4. Click **Apply**, and then click **OK**.

5. Close the **Printers and Faxes** dialog box.


1. Click **Start** → **Control Panel** → **Printers**.

2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.

3. Click the **Device Settings** tab, and then select **Available** for the **Duplexer** item under **Installable Options**.

4. Click **Apply**, and then click **OK**.

5. Close the **Printers** dialog box.

**Windows 2000/Windows NT 4.0**

1. Click **Start** → **Settings** → **Printers**.

2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.

3. Click the **Device Settings** tab, and then select **Available** for the **Duplexer** item under **Installable Options**.

4. Click **OK**.

5. Close the **Printers** dialog box.

**Mac OS X**

1. Select the multifunction printer from the **Printer List** screen in **Print Center** (or **Printer Setup Utility**).

2. Click **Printers** on the **Print Center** (or **Printer Setup Utility**) menu bar, and select **Show Info**.

3. Select **Installable Options**, and select the options that have been installed on the multifunction printer, and then click **Apply Changes**.

4. Click **Apply**, and then click **OK**.
Installing a Memory Card

Your multifunction printer supports 256 MB, 512 MB, and 1024 MB additional memory cards.

1. Ensure that the multifunction printer is turned off.

2. Turn the screw on the control board cover in a counter-clockwise direction and open the cover.

3. With the connector of the memory card toward the slot, insert the memory card at an angle into the slot.

4. Push the memory card into the slot firmly.
5. Pivot the memory card downward until it clicks into place.

**NOTE:** Ensure that the memory card is firmly fixed in the slot and cannot be moved easily.

6. Close the control board cover and turn the screw clockwise.
7. Turn on the multifunction printer.

8. Print a system settings page to verify that the additional print memory is installed correctly.
   a. Press ▼ until >SETUP appears, and then press ✔.
   
   b. Press ▼ until >Reports appears, and then press ✔.
   
   c. System Settings is displayed. Press ✔.

      The system settings page is printed.

   d. Verify the capacity of the installed memory listed in the system settings under **General**.

      If the memory capacity has not increased, turn off the multifunction printer, unplug the power cable, and reinstall the memory card.

9. If you installed the additional print memory after installing the printer driver, update your driver by following the instructions for the operating system you are using. If the multifunction printer is on a network, update the driver for each client.

**When Using PCL Driver**

**Microsoft® Windows Vista®**

1. Click **Start** → **Control Panel** → **Hardware and Sound** → **Printers**.

2. Right-click the multifunction printer and select **Properties**.

3. Click the **Options** tab, and then select **Get Information from Printer**.

4. Click **Apply**, and then click **OK**.

5. Close the **Printers** dialog box

1. Click Start → Printers and Faxes.
2. Right-click the multifunction printer and select Properties.
3. Click the Options tab, and then select Get Information from Printer.
4. Click Apply, and then click OK.
5. Close the Printers and Faxes dialog box.


1. Click Start → Control Panel → Printers.
2. Right-click the multifunction printer and select Properties.
3. Click the Options tab, and then select Get Information from Printer.
4. Click Apply, and then click OK.
5. Close the Printers dialog box.

Windows 2000/Windows NT® 4.0

1. Click Start → Settings → Printers.
2. Right-click the multifunction printer and select Properties.
3. Click the Options tab, and then select Get Information from Printer.
4. Click Apply, and then click OK.
5. Close the Printers dialog box.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1. Click the Options tab, and then select Memory Capacity on the Items list box.
2. Select the total amount of the installed print memory for the memory capacity setting.
3. Click Apply, and then click OK.
4. Close the Printers and Faxes (or Printers) dialog box.
When Using PS Driver

**Microsoft Windows Vista**

1. Click **Start** → **Control Panel** → **Hardware and Sound** → **Printers**.
2. Right-click the multifunction printer and select **Properties**.
3. Click the **Options** tab, and then select **Get Information from Printer**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.


1. Click **Start** → **Printers and Faxes**.
2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.
3. Click the **Device Settings** tab, and then select the total amount of the installed print memory for the **Memory Capacity** item under **Installable Options**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.


1. Click **Start** → **Control Panel** → **Printers**.
2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.
3. Click the **Device Settings** tab, and then select the total amount of the installed print memory for the **Memory Capacity** item under **Installable Options**.
4. Click **Apply**, and then click **OK**.
5. Close the **Printers** dialog box.

**Windows 2000/Windows NT 4.0**

1. Click **Start** → **Settings** → **Printers**.
2. Right-click the multifunction printer that is using the PS driver, and then select **Properties** from the displayed list.
3. Click the **Device Settings** tab, and then select the total amount of the installed print memory for the
Memory Capacity item under Installable Options.

4. Click OK.

5. Close the Printers dialog box.

### Mac OS X

1. Select the multifunction printer from the Printer List screen in Print Center (or Printer Setup Utility).

2. Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select Show Info.

3. Select Installable Options, and select the options that have been installed on the multifunction printer, and then click Apply Changes.

4. Click Apply, and then click OK.

---

### Installing the Dell Multi-Protocol Card

A multi-protocol card allows you to use the following network protocols.

<table>
<thead>
<tr>
<th>Network protocol</th>
<th>Supported operating systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPP</td>
<td>Windows Vista/XP/XP x64/Server 2003/Server 2003 x64/Server 2008/Server 2008 x64/2000/NT 4.0, Mac OS X 10.3.9/10.4.3</td>
</tr>
<tr>
<td>SMB</td>
<td>Windows Vista/XP/XP x64/Server 2003/Server 2003 x64/Server 2008/Server 2008 x64/2000/ NT 4.0</td>
</tr>
<tr>
<td>IPX/SPX</td>
<td>NetWare 3.12/3.2/4.1/4.11/4.2/5/6/6.5*</td>
</tr>
<tr>
<td>AppleTalk</td>
<td>Mac OS X 10.2.8/10.3.9/10.4.3</td>
</tr>
<tr>
<td>Bonjour</td>
<td>Mac OS X 10.2.8/10.3.9/10.4.3</td>
</tr>
<tr>
<td>IPv6</td>
<td>Windows Vista</td>
</tr>
</tbody>
</table>

*Only compatible with Support Pack 1.1 or later.

1. Ensure that the multifunction printer is turned off and unplug all cables including the power cord from the rear of the multifunction printer.

2. Turn the screw on the control board cover in counter-clockwise direction and open the cover.
3. With the connector of the multi-protocol card aligned over the mating connector on the control board, make connections together by pressing on the back of the MPC card nearest the connector pins.

4. Press the printed circles with your fingers to secure the multi-protocol card to the connector.
NOTE: Avoid pressing down on the multi-protocol card’s connector.

NOTE: Ensure that the multi-protocol card is firmly fixed in the connector and cannot be moved easily.

5. Insert the two screws through the control board case and into the Multi-Protocol Card as shown, and tighten the screws.

6. Close the control board cover and turn the screw clockwise.
Confirming the Installation of the Multi-Protocol Card

1. Print a printer settings page to verify that the optional multi-protocol card is installed correctly.
   a. Press ▼ until >SETUP appears, and then press ✓.
   b. Press ▼ until >Reports appears, and then press ✓.
   c. System Settings is displayed. Press ✓.
      
      The system settings page is printed.
   d. Verify Multi-Protocol Card is listed in the system settings under Printer Options.
      
      If it is not listed, turn off the multifunction printer, unplug the power cable, and reinstall the optional multi-protocol card.

Installing the Dell Wireless Printer Adapter 3310 USB

<table>
<thead>
<tr>
<th>Connectivity Technology</th>
<th>Wireless</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compliant Standards</td>
<td>802.11b/802.11g</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>2.4GHz</td>
</tr>
</tbody>
</table>
| Data Transfer Rate      | 11g mode: 54, 48, 36, 24, 18, 12, 9, 6 Mbps  
                          | 11b mode: 11, 5.5, 2, 1 Mbps |
| Device Type             | Wireless Printer Adapter |
| Security                | 64(40-bit key)/128(104-bit key) WEP Encryption/WPA/WAP2 |
**NOTE:** To use the wireless printer adapter, you must install the multi-protocol card first. To install the card, see "Installing the Dell Multi-Protocol Card ".

1. Ensure that the multifunction printer is turned off and unplug all cables including the power cord from the rear of the multifunction printer.

**NOTE:** Ensure that the multi-protocol card is installed.

2. Remove the single thumbscrew from the top of the plate covering the wireless printer adapter socket and then remove the plate.

3. Insert the wireless printer adapter into the USB socket with the Dell logo of the adapter facing out.
**NOTE:** Ensure that the adapter is firmly fixed in the socket and cannot be moved easily.

4. Attach the wireless printer adapter cap by inserting the cap with the mark facing out until it clicks into place.

5. Turn on the multifunction printer and configure the wireless network settings.

### Wireless Installation using USB connection

**NOTE:** The optional multi-protocol card with the Wireless LAN Adapter attached must be installed on the multifunction printer. Read this manual or the installation manual found in the wireless network adapter box to install the optional multi-protocol card and wireless network adapter for the Dell MFP Laser 3115cn.

<table>
<thead>
<tr>
<th>Case</th>
<th>Setup the wireless connection in the Infrastructure mode through the USB cable, if you are using Microsoft® Windows® XP, Windows 2000, Windows Server® 2003, Windows Server® 2008, or Windows Vista®</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case 1</td>
<td>Installation of the printer driver on an existing wirelessly connected Dell Multifunction Color Laser Printer 3115cn</td>
</tr>
<tr>
<td>Case 2</td>
<td>Construct new wireless network environment for both computer and multifunction printer (When wireless setting needs to your computer)</td>
</tr>
</tbody>
</table>

**Case 1. Setup the wireless connection in the Infrastructure mode through the USB cable, if you are using Microsoft® Windows® XP, Windows 2000, Windows Server® 2003, Windows Server® 2008, or Windows Vista®**
NOTE: The recommended wireless protocol setup requires a USB cable to be present during setup. Ensure that it is available before you start the wireless setup. To purchase a USB cable, visit www.dell.com.

NOTE: Ensure that your computer is already connected to your wireless access point, and that you have the wireless protocol information (SSID, Security Settings, and Password) about your wireless access point before you start the wireless setup. If in doubt, contact your wireless access point distributor.

If you are using Windows XP, Windows Server 2003 (after SP1), Windows Server 2008, or Windows Vista, you will need to turn off Windows Firewall before you proceed with the installation. To disable or enable your built-in operating system firewall:

1. Click Start → Help and Support.
2. In the Search box, type firewall and then click the green arrow.
3. In the Pick a Task list, click Enable or disable Internet Connection Firewall and then follow the instructions on the screen.

NOTE: Dell recommends that you enable your built-in operating system firewall after you install the printer software. Enabling the built-in operating system firewall after you install the printer software does not limit the use of your network printer.

1. Insert the Drivers and Utilities CD into the computer.

NOTE: If the CD does not automatically launch, click Start → Run, type D:\Setup.exe (where D is the drive letter of your CD), and then click OK.

NOTE: For Windows Vista, click Continue when the User Account Control dialog box appears.

2. Select Network Installation.
3. Connect a USB cable from the Dell MFP Laser 3115cn to your computer.

![NOTE: When the Found New Hardware Wizard dialog box appears, press Cancel to continue.](image)

4. Select **Configure Wireless Printer using a USB connection** to setup the wireless protocol on the printer.
5. When this instruction screen appears, follow the instructions to reset the wireless settings on the printer.

6. Click **OK** when you are done.

**NOTE:** When the **Found New Hardware Wizard** dialog box appears, press **Cancel** to continue.
7. Click on the checkbox next to the printer you want to configure and click **Next**.

   **NOTE:** If you are unable to see any printer listed, click on **Update** to search for the printer. If you are still unable to see a printer listed in the Printer text box, check your USB connection, ensure that the wireless adapter is seated correctly and restart the installation again.

![Dell Printer Installation](image)

8. Enter the **SSID** used in your wireless router.

9. Enter the **Security** used in your wireless router.

10. If you are using **WEP** or **WPA-PSK** security in your wireless router, enter the **Index**, **Protocol**, and **Password** information.

   **NOTE:** To set WPA2-PSK-AES as security, select WPA-PSK and AES.

11. Click **Next** when you are done.
12. You can change the Printer Name and driver setup according to your requirement. When you select the **Fixed IP** option button for **IP Address assignment**, click **Change...** and enter the IP address and subnet mask on the screen.

**NOTE:** When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

13. Click **Next** when you are done.
14. Select the different printer software to install.

15. Click **Install** when you are done.

16. When you see the **Wireless configuration is now complete** screen, you have successfully configured the wireless setting on your printer.
17. Click **Next** to continue.

18. You should now see this screen with an IP Address detected for your wireless printer. If you do not see an IP Address listed next to your printer, click **Update**.

19. Click **Install** to continue.

**NOTE:** If you are unable to locate an IP Address for your printer, check that you have disabled the Windows Firewall on your computer, and that your computer is properly connected to your wireless access point or wireless router, and that your USB cable is properly connected to your printer. Click **Cancel** and restart the installation again.
20. If you select the **I am setting up this printer on server** check box on the **Select Printer** screen and also select the **PostScript Driver** check box on the **Enter Printer Settings** screen, the **Adobe Systems Inc. License Agreement** screen appears. Select the **I accept the terms of the license agreement** option button, and then click **Install**.

21. You have now successfully setup the wireless settings on your printer and successfully installed the printer software on the computer.

22. Disconnect the USB cable from your computer.

23. Click **Print Test Page** to test your printer software setup or **FAX Initial Setup** to setup the fax on your printer or click **Finish** to exit the installation.
Case 2. Installation of the printer driver on an existing wirelessly connected Dell Multifunction Color Laser Printer 3115cn

- **NOTE:** Ensure that your computer is already connected to your wireless router, and that you have the wireless protocol information about your wireless router before you start the wireless setup. If in doubt, contact your wireless router distributor.

- **NOTE:** If you are using Windows XP, Windows Server 2003 (after SP1), Windows Server 2008, or Windows Vista, you will need to turn off Windows Firewall before you proceed with the installation.

To disable or enable your built-in operating system firewall, perform the following steps:

1. Click **Start** → **Help and Support**.
2. In the **Search** box, type **firewall** and then click the green arrow.
3. In the **Pick a Task** list, click **Enable or disable Internet Connection Firewall** and then follow the instructions on the screen.

- **NOTE:** Dell recommends that you enable your built-in operating system firewall after you install the printer software. Enabling the built-in operating system firewall after you install the printer software does not limit the use of your network printer.

1. Insert the **Drivers and Utilities** CD into the computer.

- **NOTE:** If the CD does not automatically launch, click **Start** → **Run**, type `D:\Setup.exe` (where D is the drive letter of your CD), and then click **OK**.
NOTE: For Windows Vista, click **Continue** when the **User Account Control** dialog box appears.

2. Select **Personal Installation**.

3. Select **Configure New Wired Printer, or Install Driver and Software for existing network printer** to install the printer software on your computer.
4. Click **Local Installation-Install printer on this computer** to install the printer software on your computer.

5. Click on the checkbox next to the printer to select the printer that you want to connect to for this installation.
6. Click **Update** if you do not see your printer listed or click **Add Printer** to manually add the IP address.

7. Click **Next** to continue.

8. You can change the Printer Name and driver setup according to your requirement.
9. Click **Next** when you are done.

10. Select the different printer software to install.

11. Click **Install** when you are done.

12. You have now successfully installed the printer software on the computer.

13. Click **Print Test Page** to test your printer software setup or **FAX Initial Setup** to setup the fax on your printer or click **Finish** to exit the installation.
Case 3. Construct new wireless network environment for both computer and multifunction printer (When wireless setting needs to be set to your computer)

1. Insert the *Drivers and Utilities* CD into your computer.

2. The *Drivers and Utilities* CD should launch the installation software automatically. If the CD does not automatically launch, click **Start** → **Run**, type `D:\Setup.exe` (where D is the drive letter of your CD), and then click **OK**.

**NOTE:** For Windows Vista, click **Continue** when the **User Account Control** dialog box appears.

3. Select the **Network Installation** option button, and then click **Next**.

4. Select the **Configure Wireless Printer using a USB connection (Recommended)** option button, and then click **Next**.

5. Reset the wireless setting of the multifunction printer following the steps on the **Reset Wireless Setting** screen.

6. In the list on the **Select Printer** screen, check the check box of the target printer that you are making wireless setting for, and then click **Next**.

**NOTE:** When you enter a fixed IP address, avoid the "169.254.xxx.xxx " address used by AutoIP.

7. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**. When you select the **Fixed IP** option button for **IP Address assignment**, click **Change...** and enter the IP address and subnet mask on the screen.
8. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

9. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the multifunction printer.

10. On the **Wireless configuration is now complete** screen, create the wireless setting sent to the multifunction printer on your computer following the steps below, and then click **Next**.

    **For Windows XP, Windows Server 2003:**
    
    a. Select **Network Connections** from **Control Panel**.
    
    b. Right-click **Wireless Network Connection** and select **Properties**.
    
    c. Select the **Wireless Network** tab.
    
    d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.
    
    e. Click **Advanced**.
    
    f. Do either of the following:

    **When wireless ad-hoc mode is set to the multifunction printer:**
    
    o Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

    **When wireless infrastructure mode is set to the multifunction printer:**
    
    o Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

    g. Click **Add** to display Wireless network properties.
    
    h. Enter the setting that you send to the multifunction printer and click **OK**.
    
    i. Click **Move up** to move the setting to the top of the list.
    
    j. Click **OK** to close the **Property** dialog box.

    **For Windows Vista:**
    
    a. Open **Control Panel**.
    
    b. Select **Network and Internet**.
    
    c. Select **Network and Sharing Center**.
    
    d. Select **Connect to a network**.
    
    e. Select the setting you send to the multifunction from the network items listed in **Connect to a**
network.

f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select the setting you send to the printer from the network items listed in **Connect to a network**.

e. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

f. Click **Close** in the dialog box after confirming the connection is a success.

11. On the **Setting-Ready Printer** screen, verify that the correct IP address is assigned to the multifunction printer to which the wireless setting is set, and then click **Install**.

**NOTE:** If your system has any of the following operating systems:
- Windows XP x64
- Windows Server® 2003 x64
- Windows Server® 2008 x64
- Windows Vista x64
- Windows Vista x86,
skip step 12 and go to step 13.

12. If you select the **I am setting up this printer on server** check box on the **Select Printer** screen and also select the **PostScript Driver** check box on the **Enter Printer Settings** screen, the **Adobe Systems Inc. License Agreement** screen appears. Select the **I accept the terms of the license agreement** option button, and then click **Install**.

13. On the **Congratulations!** screen, click **Finish** to complete the installation. A test page will be printed with the installed printer by clicking the **Print Test Page** button.

Use the **Dell Printer Configuration Web Tool** to monitor the status of your network printer without leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web browser.

**NOTE:** The **Dell Printer Configuration Web Tool** is not available when the multifunction printer is locally attached to a computer or a print server.
Wireless Installation using wireless connection

Step 1. Install a multifunction printer to the already-operating wireless network (When wireless setting is already set to your computer)

1. Insert the Drivers and Utilities CD into your computer to launch the installation software.

   **NOTE:** If the CD does not automatically launch, click **Start** → **Run**, and then type D:\setup.exe (where D is the drive letter of your CD), and then click **OK**.

   **NOTE:** For Windows Vista, click **Continue** when the User Account Control dialog box appears.

2. Select the **Network Installation** option button, and then click **Next**.

3. Select the **Configure Wireless Printer using a wireless connection (Advanced)** option button, and then click **Next**.

4. Reset the wireless setting of the multifunction printer following the steps on the **Reset Wireless Setting** screen.

5. Create the wireless setting of your computer following the steps shown on the **Enable Communication with Printer** screen, and then click **Next**.

The steps are as follows:

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

   **NOTE:** Ensure that you write down the current wireless computer settings in steps d and f so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

g. Click the **Add** button to display Wireless network properties.

h. In the **Association** tab, enter the following information and click **OK**.

   **Network name (SSID):** dell_device
   **Network Authentication:** Open
Data encryption: Disabled
Ad hoc network: checked

i. Click the Move up button to move the newly added SSID to the top of the list.

j. Click OK to close the Property dialog box.

For Windows Vista:

a. Open Control Panel.

b. Select Network and Internet.

c. Select Network and Sharing Center.

d. Select Connect to a network.

e. Select dell_device from the network items listed in Connect to a network.

f. Select Connect Anyway in the warning dialog box indication indicating you are entering an unsecured area.

g. Click Close in the dialog box after confirming the connection is a success.

For Windows Server 2008:

a. Open Control Panel.

b. Select Network and Sharing Center.

c. Select Connect to a network.

6. On the Enter Wireless Network Settings screen, set each wireless setting item, and then click Next.

7. When you select the Fixed IP option button for IP Address assignment, click Change... and enter the IP address and subnet mask on the screen.

**NOTE:** When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

8. Set each item on the Enter Printer Settings screen, and then click Next.

9. On the Printer Software screen, specify the software that you want to install and installation path, and then click Next. At this point, the wireless setting specified on the Enter Wireless Network Settings screen is sent to the multifunction printer.

10. On the Wireless configuration is now complete screen, change the wireless setting of your computer to the same as that sent to the multifunction printer, and then click Next.
For Windows XP and Windows Server 2003:

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Network** tab.

d. Click **Advanced**.

e. Do either of the following:

**When wireless ad-hoc mode is set to the multifunction printer:**

- Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the multifunction printer:**

- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

f. Select the setting that you send to the multifunction printer in the list in **Preferred Network** group.

g. Click **Move up** to move the setting to the top of the list.

h. Click **OK** to close the **Property** dialog box.

For Windows Vista:

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

For Windows Server 2008:

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.
11. On the Setting-Ready Printer screen, verify that the correct IP address is assigned to the multifunction printer to which the wireless setting is set, and then click Install.

**NOTE:** If your system has any of the following operating systems:
- Windows XP x64
- Windows Server® 2003 x64
- Windows Server® 2008x64
- Windows Vista x64
- Windows Vista x86
, skip step 12 and go to step 13.

12. If you select the I am setting up this printer on server check box on the Select Printer screen and also select the PostScript Driver check box on the Enter Printer Settings screen, the Adobe Systems Inc. License Agreement screen appears. Select the I accept the terms of the license agreement option button, and then click Install.

13. On the Congratulations! screen, click Finish to complete the installation. A test page will be printed with the installed printer by clicking the Print Test Page button.

**Step 2. Construct new wireless network environment for both computer and multifunction printer (When wireless setting needs to be set to your computer)**

1. Insert the Drivers and Utilities CD into your computer to launch the installation software.

**NOTE:** If the CD does not automatically launch, click Start → Run, and then type D:\setup.exe (where D is the drive letter of your CD), and then click OK.

**NOTE:** For Windows Vista, click Continue when the User Account Control dialog box appears.

2. Select the Network Installation option button, and then click Next.

3. Select the Configure Wireless Printer using a wireless connection (Advanced) option button, and then click Next.

4. Reset the wireless setting of the multifunction printer following the steps on the Reset Wireless Setting screen.

5. Create the wireless setting of your computer following the steps shown on the Enable Communication with Printer screen, and then click Next. The steps are as follows:

**For Windows XP and Windows Server 2003:**

a. Select Network Connections from Control Panel.

b. Right-click Wireless Network Connection and select Properties.

c. Select the Wireless Networks tab.
d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

**NOTE:** Ensure that you write down the current wireless computer settings in step d and step f so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

g. Click the **Add** button to display **Wireless network properties**.

h. In the **Association** tab, enter the following information and click **OK**.

Network name (SSID): *dell_device*
Network Authentication: *Open*
Data encryption: *Disabled*
Ad hoc network: *checked*

i. Click the **Move up** button to move the newly added SSID to the top of the list.

j. Click **OK** to close the **Property** dialog box.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select *dell_device* from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select *dell_device* from the network items listed in **Connect to a network**.
e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

f. Click **Close** in the dialog box after confirming the connection is a success.

6. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**.

7. When you select the **Fixed IP** option button for **IP address assignment**, click **Change...** and enter the IP address and subnet mask on the screen.

**NOTE:** When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

8. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

9. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the multifunction printer.

10. On the **Wireless configuration is now complete** screen, create the wireless setting sent to the multifunction printer on your computer following the steps below, and then click **Next**.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Network** tab.

d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

e. Click **Advanced**.

f. Do either of the following:

**When wireless ad-hoc mode is set to the multifunction printer:**

- Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the multifunction printer:**

- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

g. Click **Add** to display **Wireless network** properties.

h. Enter the setting that you send to the multifunction printer and click **OK**.

i. Click **Move up** to move the setting to the top of the list.
j. Click **OK** to close the **Property** dialog box.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the setting you send to the multifunction from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select the setting you send to the printer from the network items listed in **Connect to a network**.

e. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

f. Click **Close** in the dialog box after confirming the connection is a success.

11. On the **Setting-Ready Printer** screen, verify that the correct IP address is assigned to the multifunction printer to which the wireless setting is set, and then click **Install**.

**NOTE:** If your system has any of the following operating systems:
- Windows XP x64
- Windows Server® 2003 x64
- Windows Server® 2008 x64
- Windows Vista x64
- Windows Vista x86

,skip step 12 and go to step 13.

12. If you select the **I am setting up this printer on server** check box on the **Select Printer** screen and also select the **PostScript Driver** check box on the **Enter Printer Settings** screen, the **Adobe Systems Inc. License Agreement** screen appears. Select the **I accept the terms of the license**
agreement option button, and then click Install.

13. On the Congratulations! screen, click Finish to complete the installation. A test page will be printed with the installed printer by clicking the Print Test Page button.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web browser.

NOTE: The Dell Printer Configuration Web Tool is not available when the multifunction printer is locally attached to a computer or a print server.

Wireless Installation using Dell Printer Configuration Web Tool

Step 1. Install a multifunction printer to the already-operating wireless network (When wireless setting is already set to your computer)

For Dynamic Host Configuration Protocol network:

1. Create wireless setting of your computer following the steps below:

   For Windows XP and Windows Server 2003:
   a. Select Network Connections from Control Panel.
   b. Right-click Wireless Network Connection and select Properties.
   c. Select the Wireless Networks tab.
   d. Ensure that the check box for Use Windows to configure my wireless network settings is checked.
   e. Click the Advanced button.
   f. Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
   g. Click the Add button to display Wireless network properties.
   h. In the Association tab, enter the following information and click OK.

Network name (SSID): dell_device
Network Authentication: Open
Data encryption: Disabled
Ad hoc network: checked

i. Click the **Move up** button to move the newly added SSID to the top of the list.

j. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select **dell_device** from the network items listed in **Connect to a network**.

e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

f. Click **Close** in the dialog box after confirming the connection is a success.

2. Check the IP address assigned by AutoIP on the multifunction printer.

   For example, 168.254.1.1

3. Check that the IP address on your computer is assigned by DHCP.

4. Open Dell Printer Configuration Web Tool using the Web browser.

   For example, http://168.254.1.1/
5. Change the wireless setting of the multifunction printer on Dell Printer Configuration Web Tool.
6. Reset the multifunction printer.
7. Restore the wireless setting on your computer.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Click **Advanced**.

e. Do either of the following:

**When wireless ad-hoc mode is set to the multifunction printer:**

- Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the multifunction printer:**

- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

f. Select the setting that you send to the multifunction printer in the list in **Preferred Network** group.

g. Click **Move up** to move the setting to the top of the list.

h. Click **OK** to close the **Property** dialog box.

[NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.]

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

**For Windows Server 2008:**
a. Open Control Panel.

b. Select Network and Sharing Center.

c. Select Connect to a network.

d. Select the original setting from the network items listed in Connect to a network, and then click Connect.

**For Fixed IP network:**

1. Create wireless setting of your computer following the steps below:

   **For Windows XP and Windows Server 2003:**
   
a. Select Network Connections from Control Panel.
   
b. Right-click Wireless Network Connection and select Properties.
   
c. Select the Wireless Networks tab.
   
d. Ensure that the check box for Use Windows to configure my wireless network settings is checked.

   **NOTE:** Ensure that you write down the current wireless computer settings in steps d and f so that you can restore them later.

   e. Click the Advanced button.
   
f. Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
   
g. Click the Add button to display Wireless network properties.
   
h. In the Association tab, enter the following information and click OK.

   Network name (SSID): dell_device
   Network Authentication: Open
   Data encryption: Disabled
   Ad hoc network: checked

   i. Click the Move up button to move the newly added SSID to the top of the list.
   
j. Click OK to close the Property dialog box.

   **NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

   **For Windows Vista:**
a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select **dell_device** from the network items listed in **Connect to a network**.

e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

f. Click **Close** in the dialog box after confirming the connection is a success.

2. Check the IP address on your computer.

   For example, 1.2.3.4

3. Set the IP address on the multifunction printer.

   For example, 1.2.3.5

4. Open Dell Printer Configuration Web Tool using the Web browser.

   For example, http://1.2.3.5/

5. Change the wireless setting of the multifunction printer on Dell Printer Configuration Web Tool.

6. Reset the multifunction printer.

7. Restore the wireless setting on your computer.

   **For Windows XP and Windows Server 2003:**
a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Click **Advanced**.

e. Do either of the following:

**When wireless ad-hoc mode is set to the multifunction printer:**

- Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the multifunction printer:**

- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

f. Select the setting that you send to the multifunction printer in the list in **Preferred Network** group.

g. Click **Move up** to move the setting to the top of the list.

h. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.
Step 2. Construct new wireless network environment for both computer and multifunction printer (When wireless setting needs to be set to your computer)

For Dynamic Host Configuration Protocol network:

1. Create wireless setting of your computer following the steps below:

   For Windows XP and Windows Server 2003:
   a. Select Network Connections from Control Panel.
   b. Right-click Wireless Network Connection and select Properties.
   c. Select the Wireless Networks tab.
   d. Ensure that the check box for Use Windows to configure my wireless network settings is checked.

   **NOTE:** Ensure that you write down the current wireless computer settings in steps e and g so that you can restore them later.
   
   e. Click the Advanced button.
   f. Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
   g. Click the Add button to display Wireless network properties.
   h. In the Association tab, enter the following information and click OK.

   Network name (SSID): dell_device
   Network Authentication: Open
   Data encryption: Disabled
   Ad hoc network: checked
   
   i. Click the Move up button to move the newly added SSID to the top of the list.
   j. Click OK to close the Property dialog box.

   **NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

   For Windows Vista:
   a. Open Control Panel.
b. Select **Network and Internet**.
c. Select **Network and Sharing Center**.
d. Select **Connect to a network**.
e. Select `dell_device` from the network items listed in **Connect to a network**.
f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.
g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.
c. Select **Connect to a network**.
d. Select `dell_device` from the network items listed in **Connect to a network**.
e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.
f. Click **Close** in the dialog box after confirming the connection is a success.

2. Check the IP address assigned by AutoIP on the multifunction printer.

For example, 168.254.1.1

3. Check that the IP address on your computer is assigned by DHCP.

4. Open Dell Printer Configuration Web Tool using the Web browser.

For example, http://168.254.1.1

5. See "Print Server Settings" in the "Dell Printer Configuration Web Tool" to create a wireless setting.

6. Reset the multifunction printer.

7. Restore the wireless setting on your computer.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.
d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

e. Click **Advanced**.

f. Do either of the following:

**When wireless ad-hoc mode is set to the multifunction printer:**

- Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the multifunction printer:**

- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

g. Click **Add** to display **Wireless network properties**.

h. Enter the setting that you send to the multifunction printer and click **OK**.

i. Click **Move up** to move the setting to the top of the list.

j. Click **OK** to close the **Property** dialog box.

![](image)

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the setting you send to the multifunction from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.
d. Select the setting you send to the printer from the network items listed in Connect to a network.

e. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

f. Click Close in the dialog box after confirming the connection is a success.

For Fixed IP network:

1. Create wireless setting of your computer following the steps below:

   For Windows XP and Windows Server 2003:
   a. Select Network Connections from Control Panel.
   b. Right-click Wireless Network Connection and select Properties.
   c. Select the Wireless Networks tab.
   d. Ensure that the check box for Use Windows to configure my wireless network settings is checked.

   ![NOTE:](image)
   Ensure that you write down the current wireless computer settings in steps d and f so that you can restore them later.

   e. Click the Advanced button.
   f. Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
   g. Click the Add button to display Wireless network properties.
   h. In the Association tab, enter the following information and click OK.

   **Network name (SSID):** dell_device
   **Network Authentication:** Open
   **Data encryption:** Disabled
   **Ad hoc network:** checked
    
    i. Click the Move up button to move the newly added SSID to the top of the list.
    
    j. Click OK to close the Property dialog box.

   ![NOTE:](image)
   When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

   For Windows Vista:
   a. Open Control Panel.
b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select *dell_device* from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

- a. Open **Control Panel**.

- b. Select **Network and Sharing Center**.

- c. Select **Connect to a network**.

- d. Select *dell_device* from the network items listed in **Connect to a network**.

- e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

- f. Click **Close** in the dialog box after confirming the connection is a success.

2. Check the IP address on your computer.

    For example, 1.2.3.4

3. Set the IP address on the multifunction printer.

    For example, 1.2.3.5

4. Open Dell Printer Configuration Web Tool using the Web browser.

    For example, http://1.2.3.5

5. Change the wireless setting of the multifunction printer on Dell Printer Configuration Web Tool.

6. Reset the multifunction printer.

7. Restore the wireless setting on your computer.

**For Windows XP and Windows Server 2003:**

- a. Select **Network Connections** from **Control Panel**.
b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

e. Click **Advanced**.

f. Do either of the following:

**When wireless ad-hoc mode is set to the multifunction printer:**

- Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the multifunction printer:**

- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

g. Click **Add** to display **Wireless network properties**.

h. Enter the setting that you send to the multifunction printer and click **OK**.

i. Click **Move up** to move the setting to the top of the list.

j. Click **OK** to close the **Property** dialog box.

- **NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the setting you send to the multifunction from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.
b. Select Network and Sharing Center.

c. Select Connect to a network.

d. Select the setting you send to the printer from the network items listed in Connect to a network.

e. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

f. Click Close in the dialog box after confirming the connection is a success.

Wireless Setting through Dell Printer Configuration Web Tool - Advanced setup

Access point (Infrastructure, DHCP network)

1. Create new wireless settings for your computer.

For Windows XP and Windows Server 2003:

a. Select Network Connections from Control Panel.

b. Right-click Wireless Network Connection and select Properties.

c. Select the Wireless Networks tab.

d. Ensure that the check box for Use Windows to configure my wireless network settings is checked.

NOTE: Ensure that you write down the current wireless computer settings in steps d and g so that you can restore them later.

e. Click the Advanced button.

f. Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.

g. Click the Add button to display Wireless network properties.

h. In the Association tab, enter the following information and click OK.

Network name (SSID): dell_device
Network Authentication: Open
Data encryption: Disabled
Ad hoc network: checked

i. Click the Move up button to move the newly added SSID to the top of the list.
j. Click **OK** to close the Property dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select **dell_device** from the network items listed in **Connect to a network**.

e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

f. Click **Close** in the dialog box after confirming the connection is a success.

2. Set up the printer wireless adapter IP address.

   a. Reset the settings for the wireless adapter to the default.

   i. Press **Menu** on printer **Control Panel**.
   
   ii. Scroll down and select **Admin Menu**.
   
   iii. Scroll down and select **Wireless net**.
   
   iv. Scroll down and select **Reset MPC**.
   
   v. Restart the multifunction printer.

   b. Retrieve the wireless adapter IP address on the multifunction printer.
i. Press **Menu** on printer **Control Panel**.
ii. Scroll down and select **Admin Menu**.
iii. Scroll down and select **Wireless net**.
iv. Scroll down and select **TCP/IP**.
v. Scroll down and select **IP Address**.
(Default IP address range: 169.254.xxx.yyy, where "xxx" and "yyy" are variables ranging from 0 to 255)

3. Access Dell Printer Configuration Web Tool on your computer browser.
   a. Assign the TCP/IP address by DHCP mode (Change the TCP/IP properties to obtain the IP address automatically).
   b. Ensure that your computer has the same IP address range as the printer wireless adapter.

   For example, 169.254.xxx.zzz, where "xxx" and "zzz" are variables ranging from 0 to 255
   c. Access the Dell Printer Configuration Web Tool using the Web browser, and then type printer wireless adapter settings in the address field of the browser.

   For example, http://169.254.xxx.yyy/, where "xxx" and "yyy" are variables ranging from 0 to 255 (Your wireless adapter IP address)
   d. Change wireless settings (SSID/communication mode) from Dell Printer Configuration Web Tool.

   i. Click **Print server setting** on the left navigational bar.
   ii. Click the **Print server setting** tab.
   iii. Click the **TCP/IP** sub-tab.
   iv. Select **DHCP**.
   v. Click the **Apply new setting** button without restarting the multifunction printer (Ignore the screen instructions to restart the multifunction printer).
   vi. Click the **Wireless LAN** sub-tab.
   vii. Change the **SSID** setting (according to your Access point SSID) and change **Network type** to **Infrastructure**.
   viii. Click the **Restart printer to apply new settings** button.

4. Once printer wireless adapter is properly configured, you may use the typical network printer installation method to complete driver installation.

5. To communicate with the multifunction printer, you need to restore the previous wireless settings on your computer.

6. Restore the previous wireless settings for your computer.

   **For Windows XP and Windows Server 2003:**
   a. Select **Network Connections** from **Control Panel**.
b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Network** tab.

d. Click the **Advanced** button.

e. Select **Access point (Infrastructure) networks only** and close the Advanced dialog box (Applicable to the multifunction printer with the wireless infrastructure mode).

f. Select the setting that you send to the multifunction printer in the list in the **Preferred Network**
group

  g. Click **Move up** to move the setting to the top of the list.

  h. Click **OK** to close the Property dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

  a. Open **Control Panel**.

  b. Select **Network and Internet**.

  c. Select **Network and Sharing Center**.

  d. Select **Connect to a network**.

  e. Select the setting you send to the multifunction from the network items listed in **Connect to a network**.

  f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

  g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

  a. Open **Control Panel**.

  b. Select **Network and Sharing Center**.

  c. Select **Connect to a network**.

  d. Select the setting you send to the printer from the network items listed in **Connect to a network**.

  e. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

  f. Click **Close** in the dialog box after confirming the connection is a success.
Access point (Infrastructure, Fixed IP network)

1. Ensure that the addresses of your computer and access point is in the same IP range. Match the subnet mask and gateway addresses of your computer to the access point settings.

2. Create new wireless settings of your computer by following the steps below:

   **For Windows XP and Windows Server 2003:**
   a. Select Network Connections from Control Panel.
   b. Right-click Wireless Network Connection and select Properties.
   c. Select the Wireless Networks tab.
   d. Ensure that the check box for Use Windows to configure my wireless network settings is checked.
   
   **NOTE:** Ensure that you write down the current wireless computer settings in steps d and f so that you can restore them later.
   e. Click the Advanced button.
   f. Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
   g. Click the Add button to display Wireless network properties.
   h. In the Association tab, enter the following information and click OK.

   Network name (SSID): dell_device
   Network Authentication: Open
   Data encryption: Disabled
   Ad hoc network: Checked

   i. Click the Move up button to move the newly added SSID to the top of the list.
   j. Click OK to close the Property dialog box.

   **NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

   **For Windows Vista:**
   a. Open Control Panel.
   b. Select Network and Internet.
   c. Select Network and Sharing Center.
d. Select **Connect to a network**.

e. Select `dell_device` from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select `dell_device` from the network items listed in **Connect to a network**.

e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

f. Click **Close** in the dialog box after confirming the connection is a success.

3. Check the IP, subnet mask, and gateway address on your computer.

   For example, IP: 192.168.1.1
   Subnet mask: 255.255.0.0

4. Set the IP address from the multifunction printer **Control Panel** to be in the same range as that of your computer. Match the subnet mask and gateway addresses of the multifunction printer to your computer settings.

   a. Press the **Menu** button.

   b. Scroll to the **Admin** menu.

   c. Select **Wireless Net**.

   d. Select **TCP/IP**.

   e. Select **Get IP Address**.

   f. Select **Panel**.

   g. Scroll back to **IP Address**.

   h. Manually enter the IP address using the directional buttons on the control panel and press enter button.

   For example, 192.168.1.2
i. Scroll back to **Subnet Mask**.

j. Manually enter the subnet mask address using the directional buttons on **Control Panel** and press the <Enter> button.

k. Scroll back to **Gateway Address**.

l. Manually enter the gateway address using the directional buttons on **Control Panel** and press the <Enter> button.

m. Restart the multifunction printer.

5. Open Dell Printer Configuration Web Tool using the Web browser.

   For example, http://192.168.1.2

6. Change wireless settings of the multifunction printer from Dell Printer Configuration Web Tool.

   a. Click **Print server setting** on the left navigational bar.

   b. Click **Print server setting** tab.

   c. Click **Wireless LAN** sub-tab.

   d. Change the SSID setting (according to your access point SSID) and change **Network type** to **Infrastructure**.

   e. Click the **Restart printer to apply new settings** button.

7. Restore the previous wireless settings for your computer.

   **For Windows XP and Windows Server 2003:**

   a. Select **Network Connections** from **Control Panel**.

   b. Right-click **Wireless Network Connection** and select **Properties**.

   c. Select **Wireless Network** tab.

   d. Click **Advanced**.

   e. Do either of the following:

   *When wireless ad-hoc mode is set to the multifunction printer:*

   o Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

   *When wireless infrastructure mode is set to the multifunction printer:*

   o Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.
f. Select the setting that you send to the multifunction printer in the list in Preferred Network group.

   g. Click Move up to move the setting to the top of the list.

For Windows Vista:

   a. Open Control Panel.

   b. Select Network and Internet.

   c. Select Network and Sharing Center.

   d. Select Connect to a network.

   e. Select the setting you send to the multifunction from the network items listed in Connect to a network.

   f. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

   g. Click Close in the dialog box after confirming the connection is a success.

For Windows Server 2008:

   a. Open Control Panel.

   b. Select Network and Sharing Center.

   c. Select Connect to a network.

   d. Select the setting you send to the printer from the network items listed in Connect to a network.

   e. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

   f. Click Close in the dialog box after confirming the connection is a success.

8. Click OK to close the Property dialog box.

   NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

Confirming the Installation of the Wireless Printer Adapter

Print a system settings page to verify that the optional wireless printer adapter is installed correctly.

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Reports appears, and then press ✔.

3. System Settings is displayed. Press ✔.

   The system settings page is printed.

4. Verify that the **Wireless LAN Adapter** is listed in the system settings under **Printer Options**.

   If it is not listed, turn off the multifunction printer, unplug the power cable, and reinstall the optional wireless printer adapter.
Print Media Guidelines

Print media is paper, transparencies, labels, envelopes, coated paper among others. Your multifunction printer provides high-quality printing on a variety of print media. Selecting the appropriate print media for your multifunction printer helps avoid printing troubles. This section describes how to select print media, how to care for print media, and how to load the print media in the standard 250-sheet tray or optional 550-sheet paper feeder.

- **Paper**
- **Transparencies**
- **Envelopes**
- **Labels**
- **Storing Print Media**
- **Identifying Print Media Sources and Specifications**

---

**Paper**

For the best print quality in color, use 75 g/m² (20 lb) xerographic, grain long paper. For the best print quality in black and white, use 90 g/m² (24 lb) xerographic, grain long paper. Before buying large quantities of any print media, Dell recommends trying a sample first.

When loading paper, identify the recommended print side on the paper package, and load the paper accordingly. See "Loading Print Media in Standard and Optional Trays" and "Loading the Multipurpose Feeder" for detailed loading instructions.

**Paper Characteristics**

The following paper characteristics affect print quality and reliability. Dell recommends that you follow these guidelines when evaluating new paper stock.

**Weight**

The tray automatically feeds paper weights from 60 to 216 g/m² (16 to 60 lb bond) grain long. The multipurpose feeder automatically feeds paper weights from 60 to 216 g/m² (16 to 80 lb bond) grain long. Paper lighter than 60 g/m² (16 lb) might not be stiff enough to feed properly, and could cause paper jams. For best performance, use 75 g/m² (20 lb bond) grain long paper.

**Curl**

Curl is the tendency of print media to curve at its edges. Excessive curl can cause paper feeding problems. Curl usually occurs after the paper passes through the multifunction printer, where it is exposed to high temperatures. Storing paper unwrapped, even in the paper tray, can contribute to paper curling prior to printing and cause feeding problems regardless of humidity. When printing on curled paper, straighten the
paper and then insert it into the multipurpose feeder.

**Smoothness**

The degree of paper smoothness directly affects print quality. If the paper is too rough, the toner does not fuse to the paper properly, resulting in poor print quality. If the paper is too smooth, it can cause paper feeding problems. Smoothness between 150 and 250 Sheffield points produces the best print quality.

**Moisture Content**

The amount of moisture in the paper affects both print quality and the ability of the multifunction printer to feed the paper properly. Leave the paper in its original packaging until you are ready to use it. This limits the exposure of the paper to moisture changes that can degrade its performance.

**Grain Direction**

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of the paper, or grain short, running the width of the paper. For 60 to 135 g/m² (16 to 36 lb bond) paper, grain long fibers are recommended. For papers heavier than 135 g/m² (36 lb bond), grain short is preferred.

**Fiber Content**

Most high-quality xerographic paper is made from 100% chemically pulped wood. Paper containing fibers such as cotton possess characteristics that can result in degraded paper handling.

**Recommended Paper**

To ensure the best print quality and feed reliability, use 75 g/m² (20 lb) xerographic paper. Business papers designed for general business use also provide acceptable print quality. Only use paper able to withstand high temperatures without discoloring, bleeding, or releasing hazardous emissions. The laser printing process heats paper to high temperatures. Check with the manufacturer or vendor to determine whether the paper you have chosen is acceptable for laser printers.

Always print several samples before buying large quantities of any type of print media. When choosing any print media, you should consider the weight, fiber content, and color.

**Unacceptable Paper**

The following paper types are not recommended for use with the multifunction printer:

- Chemically treated papers used to make copies without carbon paper, also known as carbonless papers, carbonless copy paper (CCP), or no carbon required (NCR) paper
- Preprinted papers with chemicals that may contaminate the multifunction printer
- Preprinted papers that can be affected by the temperature in the printer fuser unit
- Preprinted papers that require a registration (the precise print location on the page) greater than ±0.09 in., such as optical character recognition (OCR) forms

In some cases, you can adjust registration with your software program to successfully print on these forms.
- Coated papers (erasable bond), synthetic papers, thermal papers
- Rough-edged, rough or heavily textured surface papers or curled papers
- Recycled papers containing more than 25% post-consumer waste that do not meet DIN 19 309
- Multiple-part forms or documents
- Print quality may deteriorate (blank spaces or blotches may appear in the text) when printing on talc or acid paper.

**Selecting Paper**

Proper paper selection helps prevent jams and ensures trouble-free printing.

To help avoid jams or poor print quality:

- Always use new, undamaged paper.
- Before loading the paper, identify the recommended print side of the paper. This information is usually indicated on the paper package.
- Do not use paper that you have cut or trimmed yourself.
- Do not mix print media sizes, weights, or types in the same source. This may result in a paper jam.
- Do not remove trays while a job is printing or Printing is displayed on the operator panel.
- Ensure the Paper Type setting is correct. (See "Tray Settings" for detailed information about these settings.)
- Ensure the paper is properly loaded in the tray.
- Flex paper back and forth, and then fan them. Straighten the edges of the stack on a level surface.
Selecting Preprinted Forms and Letterhead

When selecting preprinted forms and letterhead paper for the multifunction printer:

- Use grain long papers for best results.
- Use only forms and letterhead printed using an offset lithographic or engraved printing process.
- Select papers that absorb ink, but do not bleed.
- Avoid papers with rough or heavily textured surfaces.
- Use papers printed with heat-resistant inks designed for use in xerographic copiers. The ink must withstand temperatures of 225°C (437°F) without melting or releasing hazardous emissions.
- Use inks that are not affected by the resin in toner or the silicone in the fuser unit. Inks that are oxidation-set or oil-based should meet these requirements; latex inks might not. If you are in doubt, contact your paper supplier.

Printing on Letterhead

Check with the manufacturer or vendor to determine whether the pre-printed letterhead you have selected is acceptable for laser printers.

Page orientation is important when printing on letterhead. Use the following table for help when loading letterhead in the print media sources.
<table>
<thead>
<tr>
<th>Print media source</th>
<th>Print side</th>
<th>Page orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard 250-sheet tray Optional 550-sheet paper feeder</td>
<td>Face up</td>
<td>Letterhead enters the multifunction printer last</td>
</tr>
<tr>
<td>Multipurpose feeder</td>
<td>Face down</td>
<td>Letterhead enters the multifunction printer first</td>
</tr>
</tbody>
</table>

**Selecting Pre-punched Paper**

Pre-punched paper brands can differ in the number and placement of holes and in manufacturing techniques. However, it may not be possible to print on the paper to depending on the placement of holes on the paper.

To select and use pre-punched paper:

- Test paper from several manufacturers before ordering and using large quantities of pre-punched paper.
- Paper should be punched at the paper manufacturer and not drilled into paper already packaged in a ream. Drilled paper can cause jams when multiple sheets feed through the multifunction printer. This may result in a paper jam.
- Pre-punched paper can include more paper dust than standard paper. Your multifunction printer may require more frequent cleaning and feed reliability may not be as good as standard paper.
- Weight guidelines for pre-punched paper are the same as non-punched paper.

**Transparencies**
You can load up to 75 sheets of transparencies in the multipurpose feeder for a single print job. Before buying large quantities of any print media, Dell recommends trying a sample first.

When printing on transparencies:

- Set the paper type to **Transparency** from the printer driver to avoid damaging your multifunction printer.

- Use transparencies designed specifically for laser printers. Do not use regular transparencies. Transparencies must be able to withstand temperatures of 205°C (401°F) without melting, discoloring, offsetting or releasing hazardous emissions.

- Avoid getting fingerprints on the transparencies. This may result in poor print quality.

- Before loading transparencies, fan the stack to prevent sheets from sticking together.

- Non-white transparencies are not supported with the multifunction printer.

### Selecting Transparencies

The multifunction printer can print directly on transparencies designed for use in laser printers. Print quality and durability depend on the transparency used. Before buying large quantities of any print media, Dell recommends trying a sample first.

The paper type setting for the multipurpose feeder should be set to **Transparency** to help prevent jams. (See "**Tray Settings**" for detailed information about this setting.) Check with the manufacturer or vendor to determine whether your transparencies are compatible with laser printers that reach temperatures as high as 205°C (401°F). Only use transparencies that are able to withstand these temperatures without melting, discoloring, offsetting, or releasing hazardous emissions.

### Envelopes

You can load a stack of envelopes up to 15 mm (0.59 in.) in height in the multipurpose feeder for a single print job. Depending on the type of envelope and how they have been stored, loading a large quantity of envelopes, within the maximum range, may not feed into the multifunction printer. If this happens, reduce the number of envelopes in the stack. Depending on the choice of envelopes, it is possible to expect variable levels of light wrinkling. Before buying large quantities of any print media, Dell recommends trying a sample first. See "**Loading the Multipurpose Feeder**" for instructions on loading an envelope.

When printing on envelopes:

- Use only high-quality envelopes that are designed for use in laser printers.

- Set the print media source to the multipurpose feeder. Set the paper type to **Envelope**, and select the correct size of envelope from the printer driver.
- For best performance, use envelopes made from 75 g/m² (20 lb bond) paper. You can use up to 105 g/m² (28 lb bond) weight for the envelope feeder as long as the cotton content is 25% or less. Envelopes with 100% cotton content must not exceed 90 g/m² (24 lb bond) weight.

- Use only new, undamaged envelopes.

- For best performance, do not use envelopes that:
  - Have excessive curl or twist
  - Are stuck together or damaged in any way
  - Contain windows, holes, perforations, cutouts, embossing
  - Use metal clasps, string ties, or metal folding bars
  - Have an interlocking design
  - Have postage stamps attached
  - Have any exposed adhesive when the flap is in the sealed or closed position
  - Have nicked edges or bent corners
  - Have rough, cockle, or laid finishes

- Use envelopes that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions. If you have any doubts about the envelopes you are considering, check with the envelope supplier.

- Adjust the guide to fit the width of the envelopes.

- To load envelope in the multipurpose feeder, insert the envelopes with the flaps closed and the short-edge of the envelopes facing into the multifunction printer. The print side must be facing down.

- See "Loading the Multipurpose Feeder" for instructions on loading an envelope.

- Use one envelope size during a print job.

- Ensure the humidity is low because high humidity (more than 60%) and the high printing temperatures may seal the envelopes.

---

**Labels**

Your multifunction printer can print on many labels designed for use with laser printers. Label adhesives, face sheet (printable stock), and topcoats must be able to withstand temperatures of 205°C (401°F) and pressure of 25 pounds per square inch (psi). Before buying large quantities of any print media, Dell recommends trying a sample first.

When printing on labels:

- Set the paper type to **Label** in the **Tray Settings**. Set the paper type to **Label** from the printer driver.
- Do not load labels together with paper or transparencies in the same tray. This may result in a jam.
- Do not use label sheets with a slick backing material.
- Do not print within 1 mm (0.04 in.) of the die cut.
- Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets also contaminate your multifunction printer and your cartridge with adhesive, and could void your multifunction printer and cartridge warranties.
- Use labels that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions.
- Do not print within 1 mm (0.04 in.) of the edge of the label, of the perforations, or between die-cuts of the label.
- Do not use label sheets that have adhesive to the edge of the sheet. Dell recommends zone coating of the adhesive at least 1 mm (0.04 in.) away from edges. Adhesive material contaminates your multifunction printer and could void your warranty.
- If zone coating of the adhesive is not possible, a 3 mm (0.125 in.) strip should be removed on the leading and driver edge, and a non-oozing adhesive should be used.
- Remove a 3 mm (0.125 in.) strip from the leading edge to prevent labels from peeling inside the multifunction printer.
- Portrait orientation is preferred, especially when printing bar codes.
- Do not use labels that have exposed adhesive.

---

**Storing Print Media**

For proper print media storage, the following guidelines help avoid media feeding problems and uneven print quality.

- For best results, store print media in an environment where the temperature is approximately 21°C (70°F) and the relative humidity is 40%.
- Store cartons of print media on a pallet or shelf, rather than directly on the floor.
- If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so that the edges do not buckle or curl.
- Do not place anything on top of the print media packages.

---

**Identifying Print Media Sources and Specifications**

The following tables provide information on standard and optional print media sources.
## Print Media Sizes and Support

<table>
<thead>
<tr>
<th>Print Media Supported</th>
<th>Multipurpose feeder</th>
<th>Standard 250-sheet tray</th>
<th>Optional 550-sheet paper feeder</th>
<th>Optional duplexer</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>A5</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>B5</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Letter</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Folio (8.5 x 13 in.)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Legal (8.5 x 14 in.)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Executive</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>COM-10 Envelope</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Monarch</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>C5</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>DL</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>User-specified print size</td>
<td>Y*1</td>
<td>Y*2</td>
<td>Y*2</td>
<td>Y*3</td>
</tr>
</tbody>
</table>

*1 The tray supports user-specified print media that are 76.2 mm (3.00 in.) to 220 mm (8.66 in.) wide and 98.4 mm (3.87 in.) to 355.6 mm (14.00 in.) long.

*2 The tray supports user-specified print media that are 148.5 mm (5.85 in.) to 215.9 mm (8.50 in.) wide and 210 mm (8.27 in.) to 355.6 mm (14.00 in.) long.

*3 The duplexer supports user-specified print media that are 148.5 mm (5.85 in.) to 215.9 mm (8.50 in.) wide and 210 mm (8.27 in.) to 355.6 mm (14.00 in.) long.
<table>
<thead>
<tr>
<th>Setup Paper Type</th>
<th>Multipurpose feeder</th>
<th>Standard 250-sheet tray</th>
<th>Optional 550-sheet paper feeder</th>
<th>Optional duplexer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper (60–80 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Plain Paper - Side2 (60–80 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Plain Thick Paper (81–105 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Plain Thick Paper - Side2 (81–105 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Covers (106–163 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Covers - Side2 (106–163 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Covers Thick (164–216 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Covers Thick - Side2 (164–216 gsm)*1</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Transparency</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Label</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Coated (106–163 gsm)</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Coated - Side2 (106–163 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Coated Thick (164–216 gsm)*1</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Coated Thick - Side2 (164–216 gsm)</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>Envelope</td>
<td>Y</td>
<td>N</td>
<td>N</td>
<td>N</td>
</tr>
</tbody>
</table>

*1 When you load several sheets of this type of paper on the ADF, two or more sheets of paper may be fed into the ADF at the same time. In this case, load fewer sheets of paper and ensure that the paper is not curled.
<table>
<thead>
<tr>
<th>Paper type</th>
<th>Weight (gsm)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper</td>
<td>60-80</td>
<td>-</td>
</tr>
<tr>
<td>Plain Thick Paper</td>
<td>81-105</td>
<td>-</td>
</tr>
<tr>
<td>Covers</td>
<td>106-163</td>
<td>-</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>164-216</td>
<td>-</td>
</tr>
<tr>
<td>Coated</td>
<td>106-163</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>164-216</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Transparency</td>
<td>-</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Label</td>
<td>-</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
Loading Print Media

Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading print media, identify the recommended print side of the print media. This information is usually on the print media package.

- Loading Print Media in Standard and Optional Trays
- Multipurpose Feeder
- Loading the Multipurpose Feeder
- Using the Multipurpose Feeder
- Linking Trays
- Using the Duplex Function
- Using the Output Tray
- Using the Output Tray Extension

NOTE: After loading paper in the tray, specify the same paper type on the operator panel.

Loading Print Media in Standard and Optional Trays

NOTE: To avoid paper jams, do not remove trays while a job prints.

NOTE: Use only laser print media. Do not use ink jet paper in the multifunction printer.

All trays are loaded the same way.

1. Pull the tray out of the multifunction printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the multifunction printer.
2. Slide the width guides to the edge of the tray. The width guides should be fully extended.

**NOTE:** For Letter paper, push the lever to the 8.5" position.

3. Slide the tray to the size of the paper to be loaded by using the length guide.
NOTE: When loading user-specified print media, fully extend the tray by squeezing the length guide at the back of the tray.

4. Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack on a level surface.

5. Place the print media into the tray with the recommended print side face up.

NOTE: Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

6. Adjust the width guides until they rest lightly against the edges of the stack of paper.

NOTE: When loading user-specified print media, adjust the width guides and slide the extendable part of the tray by squeezing the length guide and sliding it until it rests lightly against the edge of the stack of paper.
7. Insert the tray into the multifunction printer, and push until it stops.

8. Select the paper type from the operator panel if any print media other than plain print media is loaded. If a user-specified print media is loaded, you must specify the paper size setting by using the operator panel.

## Loading Letterhead

The letterhead must be toward the top edge of the standard tray or the optional feeder with the print side facing up. However, the letterhead must be inserted top edge first with the print side facing down when loading paper into the multipurpose feeder.

<table>
<thead>
<tr>
<th>Print media source</th>
<th>Print side</th>
<th>Page orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard 250-sheet tray</td>
<td>Face up</td>
<td>Letterhead enters the multifunction printer last</td>
</tr>
<tr>
<td>Optional 550-sheet paper feeder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multipurpose feeder</td>
<td>Face down</td>
<td>Letterhead enters the multifunction printer first</td>
</tr>
</tbody>
</table>

## Multipurpose Feeder

### Capacity

The multipurpose feeder can hold approximately:
150 sheets of the standard paper or 15 mm (0.59 in.) or less in height.

**Print Media Dimensions**

The multipurpose feeder accepts print media within the following dimensions:

- Width - 76.2 mm (3.00 in.) to 220.0 mm (8.66 in.)
- Length - 98.4 mm (3.87 in.) to 355.6 mm (14.00 in.)

---

**Loading the Multipurpose Feeder**

In addition to plain paper, the multipurpose feeder can use various other sizes and types of print media such as envelopes, and transparencies.

1. Gently pull open the multipurpose feeder cover.

2. Slide the guides to the edge of the tray. The guides should be fully extended.
3. Insert all media face down and top edge first into the multipurpose feeder.

**NOTE:** Do not force the print media.

4. Slide both guides until they rest lightly against the edge of the print media stack.

**NOTE:** Be careful not to bend the print media.
5. Ensure the type setting for the multipurpose feeder is set to the correct value for the print media you have loaded.

6. Select print media source, size, and type in your software program and select the print media size and type on the printer operator panel.

**Loading Envelopes**

To load envelopes in the multipurpose feeder, insert the envelopes with the flaps closed and the short-edge of the envelopes facing into the multifunction printer. Orientate the print side facing down and slide the envelope into the entry slot. You can load envelopes up to the maximum fill line in the tray at one time.

- **NOTE:** Ensure to set the envelopes with the flaps completely closed.

- **NOTICE:** Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and damage to the multifunction printer.
Using the Multipurpose Feeder

- Load only one size and type of print media during a single print job.

- To achieve the best possible print quality, use only high-quality print media that is designed for use in laser printers. For more guidelines on print media, see "Print Media Guidelines."

- Do not add or remove print media when there is still print media in the multipurpose feeder or when the multifunction printer is printing from the multipurpose feeder. This may result in a paper jam.

- Print media should be loaded with the recommended print side down and the top of the print media going into the multipurpose feeder first.

- Do not place objects on the multipurpose feeder. Also, avoid pressing down or applying excessive force on it.

- Do not remove any tray while a job is printing from the multipurpose feeder or Printing is displayed on the operator panel. This may result in a paper jam.

The icons on the multipurpose feeder identify how to load the multipurpose feeder with paper, and how to turn an envelope for printing.

Linking Trays

Tray linking allows you to load the same size and type of print media in multiple sources. The multifunction printer automatically links the source/trays and will use the first tray until it runs out, then switch to the linked tray.

If you load the same size print media in each tray, ensure that the print media is the same type in order to link the trays.

When the selected trays are loaded with the same size and type of print media, select the Paper Type settings in the Tray Settings for each source.

To disable tray linking, set the Paper Type to a unique value in each one of the trays. If all trays do not have the same type of print media when linked, you could mistakenly print a job on the wrong paper type.

Using the Duplex Function
Duplex printing (or two-sided printing) allows you to print on both sides of a sheet of paper. For sizes that are acceptable for duplex printing, see "Print Media Sizes and Support." Duplex printing is only available when the optional duplexer is installed on the multifunction printer. For information on how to install the duplexer, see "Installing a Duplexer."

**Using Booklet Print**

To use booklet print, you must select either **Flip on Short Edge** or **Flip on Long Edge** from the **Duplex** menu in the printer properties dialog box and then select **Booklet Creation** in the **Booklet/Poster/Mixed Document** dialog box displayed by clicking the **Booklet/Poster/Mixed Document** button. From the **Duplex** menu, you can define the way 2-sided print pages are bound, and how the printing on the back of the sheet (even-numbered pages) is oriented in relation to the printing on the front (odd-numbered pages).

<table>
<thead>
<tr>
<th>Flip on Long Edge</th>
<th>Assumes binding along the long edge of the page (left edge for portrait orientation and top edge for landscape orientation). The following illustration shows long-edge binding for portrait and landscape pages:</th>
</tr>
</thead>
</table>

![Illustration of long-edge binding](image)

<table>
<thead>
<tr>
<th>Flip on Short Edge</th>
<th>Assumes binding along the short edge of the page (top edge for portrait orientation and left edge for landscape orientation). The following illustration shows short-edge binding for portrait and landscape pages:</th>
</tr>
</thead>
</table>

![Illustration of short-edge binding](image)
Using the Output Tray

The output tray holds up to:

- 250 sheets (20 lb (75 g/m²)) of plain paper

Using the Output Tray Extension

The output tray extension is designed to prevent print media from falling from the multifunction printer after the print job is complete.

Before printing a document, ensure that the output tray extension is fully extended.
Operator Panel

- Using the Operator Panel Buttons
- Printing a Panel Settings Page

Using the Operator Panel Buttons

The printer operator panel has a 4-line by 20-character liquid crystal display (LCD), control buttons, and number pad, which allow you to control your multifunction printer.

1. LCD Panel
2. (Back) button
   - Returns to the previous screen.
3. buttons
   - In the **Menu mode**, selects submenus or sets values.
4. (Menu) button
   - Enters the operation menu from the top menu, and returns to the top menu from any menu level.
5. buttons
   - In the **Menu mode**, scrolls through menus or items.
   - To enter numbers or passwords, press these buttons.
6. (Start) button
   - Starts copying, scanning, or faxing.
7. ✓ button
   - Choose the currently displayed menu or item.

8. × (Cancel) button
   - In the **Menu mode**, returns to the standby mode without saving any settings.
   - Cancels the current working job (copy/scan/fax/print) by choosing the available listed job.

9. Number pad
   - Enters the characters and numbers, for example, for the Phone Book, and passwords.

10. ′ (Pause) button
    - Enters a pause.

---

**Printing a Panel Settings Page**

The Panel Settings page shows current settings for the operator panel menus.

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Reports appears, and then press ✓.
3. Press ► until Panel Settings appears, and then press ✓. The panel settings page is printed.
System Settings

You can change most system settings from your software program or operator panel. If your multifunction printer is attached to the network, you can change settings from the Dell Printer Configuration Web Tool. To launch the Dell Printer Configuration Web Tool, type the printer IP address in your Web browser. Print a printer settings page to find your printer’s IP address (see "Printing a System Settings Page").

Settings from the software program update the default system settings for the multifunction printer. Settings from the printer driver only apply to the job you are sending to the multifunction printer.

If you cannot change a setting from your software program, use the printer operator panel or the Dell Printer Configuration Web Tool. Changing a system setting from the printer operator panel or from the Dell Printer Configuration Web Tool makes that setting the user default.

Printing a System Settings Page

The system settings page lists all the options you purchased or installed. If a feature or an option is not listed, you need to check your installation.

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Reports appears, and then press ✓.
3. System Settings is displayed. Press ✓.

The system settings page is printed.

4. Verify that the options you installed are correctly listed under Printer Options.
5. If an option you installed is not listed, turn off the multifunction printer, unplug the power cord, and reinstall the option.
6. Verify the amount of memory installed is correctly listed under General.

Using the Operator Panel to Change System Settings

You can select menu items and corresponding values from the operator panel.

When you first enter the printer menus from the operator panel, you see an asterisk (*) next to a value in the menus.

Factory defaults may vary for different countries.
This asterisk indicates the factory default menu setting. These settings are the original system settings.

NOTE: Factory defaults may vary for different countries.

When you select a new setting from the operator panel, an asterisk appears next to the setting to identify it as the current user default menu setting.

These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ or ▲ until the desired menu appears, and then press ✓.
3. Press ▼, ▲, ▶, or ▼ until the desired menu or menu item appears, and then press ✓.
   o If the selection is a menu, the menu is opened and the first system setting in the menu appears.
   o If the selection is a menu item, the default menu setting for the menu item appears. (The current user default menu setting has an asterisk (*) beside it.)

Each menu item has a list of values for the menu item. A value can be:
   o A phrase or word to describe a setting
   o A numerical value that can be changed
   o An On or Off setting

4. Press ▶ or ▼ to scroll until the desired value appears.
5. Press Back to return to the previous menu.
   To continue setting other items, select the desired menu. To quit setting new values, press Cancel.

Driver settings may override changes previously made and may require you to change the operator panel defaults.

NOTE: To adjust the density to make the scanned copy lighter or darker than the original.

Using the Dell Printer Configuration Web Tool to Change System Settings

If your multifunction printer is connected to the network, you can change the operator panel settings from
your Web browser. If you are a network administrator, you can clone the system settings of one printer to one or all printers on the network.

Type your network printer IP address in your Web browser. Choose **System Settings** from the topics list, and then select the system settings you want to change.

To copy your system settings to another printer on the network, choose **Copy Printer Settings** from the topics list, and then type the other printer’s IP address.

If you do not know your printer IP address, see the system settings page. To print a system settings page:

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Reports appears, and then press ✓.
3. System Settings is displayed. Press ✓.

   The system settings page is printed.

### Resetting Defaults

After executing this function and rebooting the multifunction printer, all the menu parameters, except the parameters for the network, are reset to their default values.

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >Maintenance appears, and then press ✓.
4. Press ▼ until >Initialize NVM appears, and then press ✓.
5. Press ▼ to select >User Section or >System Section, and then press ✓.
7. The multifunction printer is turned off automatically to apply the settings.

### Initializing NVRAM for Network Settings

You can initialize the IP address and network-related settings by initializing NVRAM for Network settings.

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >Wired Net or Wireless Net appears, and then press ✓.

4. Press ▼ until >Reset LAN or >Reset MPC appears, and then press ✓.

5. The Are you sure? message appears on the operator panel. Press ✓.

6. Turn off the multifunction printer, and then on again to apply the settings.
Understanding Menus

When your multifunction printer is configured as a network printer available to a number of users, the access to the Admin Menu menus can be limited. This prevents other users from using the operator panel to inadvertently change a printer user default that has been set by the administrator.

However, you can use your printer driver to override printer user defaults and select settings for individual print jobs.

- Using the Copy Menus
- Using the Scan Menus
- Using the Fax Menus
- Using the Job Status Menus
- Using the Setup Menus
- Setting of Panel Lock

Using the Copy Menus

Use the Copy menus to configure a variety of copy features.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Number of Copies**

**Purpose:**

To select the number of copies from 1 to 99.

**Color**

**Purpose:**

To select color or black and white copying.

**Values:**
Color* Prints in the color mode.
Black&White Prints in the black and white mode.

**Paper Tray**

**Purpose:**
To specify the input tray.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray1*</td>
<td>The paper is fed from the standard 250-sheet tray.</td>
</tr>
<tr>
<td>Tray2*1</td>
<td>The paper is fed from the optional 550-sheet paper feeder.</td>
</tr>
<tr>
<td>MPF</td>
<td>The paper is fed from the multipurpose feeder.</td>
</tr>
</tbody>
</table>

*1 Only displayed when an optional 550-sheet paper feeder is installed on the multifunction printer.

**Reduce/Enlarge**

**Purpose:**
To reduce or enlarge the size of a copied image.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>100%*</td>
<td>Custom 100% (25-400%)</td>
</tr>
<tr>
<td>129% (in inch), 129% (in mm)</td>
<td>50%</td>
</tr>
<tr>
<td>154% (in inch), 141% (in mm)</td>
<td>70% (in inch), 64% (in mm)</td>
</tr>
<tr>
<td>200%</td>
<td>78% (in inch), 81% (in mm)</td>
</tr>
</tbody>
</table>

**NOTE:** You can set the value in a percent for Custom.

**Original Type**

**Purpose:**
To improve the image quality by selecting the document type.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Uses for documents with both text and photo/gray tones.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text&amp;Photo*</td>
<td>Uses for documents with photo or gray tones.</td>
</tr>
<tr>
<td>Photo</td>
<td>Uses for documents with fine text of high resolution.</td>
</tr>
<tr>
<td>Best</td>
<td>Uses for documents with text.</td>
</tr>
</tbody>
</table>

**Lighter/Darker**

**Purpose:**

To adjust the density, to make the copy lighter or darker than the original.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Works well with standard typed or printed documents.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal*</td>
<td>Works well with light print or faint pencil markings.</td>
</tr>
<tr>
<td>Darker1</td>
<td>Works well with dark print.</td>
</tr>
<tr>
<td>Darker2</td>
<td></td>
</tr>
<tr>
<td>Darker3</td>
<td></td>
</tr>
<tr>
<td>Lighter3</td>
<td>Works well with dark print.</td>
</tr>
<tr>
<td>Lighter2</td>
<td></td>
</tr>
<tr>
<td>Lighter1</td>
<td></td>
</tr>
</tbody>
</table>

**Sharpness**

**Purpose:**

To adjust the sharpness to make the copy sharper or softer than the original.

**Values:**
### Color Saturation

**Purpose:**

To adjust the amount of color to make the colors higher or lower than the original.

**Values:**

<table>
<thead>
<tr>
<th>Normal*</th>
<th>Does not adjust the amount of color to make the colors higher or lower than the original.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Higher</td>
<td>Adjusts the amount of color to make the colors higher than the original.</td>
</tr>
<tr>
<td>Lower</td>
<td>Adjusts the amount of color to make the colors lower than the original.</td>
</tr>
</tbody>
</table>

### Auto Exposure

**Purpose:**

To adjust the overall brightness to make the copy overexposed than the original.

**Values:**

<table>
<thead>
<tr>
<th>On*</th>
<th>Adjusts the overall brightness to make the copy overexposed than the original.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not adjust the overall brightness to make the copy overexposed than the original.</td>
</tr>
</tbody>
</table>

### Auto Fit

**Purpose:**

To automatically reduce or enlarge the image to fit the paper that is currently loaded in the multifunction printer.

**Values:**
<table>
<thead>
<tr>
<th><strong>On</strong></th>
<th>Fits the image on the paper currently loaded.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Off</strong></td>
<td>Does not fit the image on the paper currently loaded.</td>
</tr>
</tbody>
</table>

**2Sided**

**Purpose:**
To print a two-sided original document onto one sheet of paper.

**Values:**

<table>
<thead>
<tr>
<th><strong>1-&gt;1Sided</strong></th>
<th>Does not print a 2-sided original document onto one sheet of paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LongEdgeBinding</strong></td>
<td>Uses for long-edge binding when you perform duplex printing.</td>
</tr>
<tr>
<td><strong>ShortEdgeBinding</strong></td>
<td>Uses for short-edge binding when you perform duplex printing.</td>
</tr>
</tbody>
</table>

**Multiple-Up**

**Purpose:**
To print two original pages to fit onto one sheet of paper.

**Values:**

<table>
<thead>
<tr>
<th><strong>Off</strong></th>
<th>Does not perform multiple-up printing.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto</strong></td>
<td>Automatically reduces the original pages to fit onto one sheet of paper.</td>
</tr>
<tr>
<td><strong>ID Copy</strong></td>
<td>Prints the original pages onto one sheet of paper in the original size.</td>
</tr>
<tr>
<td><strong>Manual</strong></td>
<td>Prints the original pages onto the one sheet of paper in the size specified in Reduce/Enlarge.</td>
</tr>
</tbody>
</table>

**Collated**

**Purpose:**
To sort the copy job.
Values:

<table>
<thead>
<tr>
<th>Uncollated</th>
<th>Does not sort the copy job.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collated</td>
<td>Sorts the copy job.</td>
</tr>
</tbody>
</table>

**Poster**

Purpose:

To print an image onto several sheets of paper.

Values:

<table>
<thead>
<tr>
<th>Off*</th>
<th>Does not print an image onto several sheets of paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 x 2</td>
<td>Prints an image onto 4 sheets of paper (2 by 2).</td>
</tr>
<tr>
<td>3 x 3</td>
<td>Prints an image onto 9 sheets of paper (3 by 3).</td>
</tr>
<tr>
<td>4 x 4</td>
<td>Prints an image onto 16 sheets of paper (4 by 4).</td>
</tr>
</tbody>
</table>

**Image Repeat**

Purpose:

To print multiple image copies from the original document on a single page.

Values:

<table>
<thead>
<tr>
<th>Off*</th>
<th>Does not print multiple image copies from the original document on a single page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Prints multiple image copies from the original document on a single page.</td>
</tr>
</tbody>
</table>

**Margin**

Purpose:
To specify the margin of the copy.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Off</strong></td>
<td>Does not specify the margin of the copy.</td>
</tr>
<tr>
<td><strong>On</strong></td>
<td>Margin Top/Bottom</td>
</tr>
<tr>
<td></td>
<td>Margin Left/Right</td>
</tr>
<tr>
<td></td>
<td>Margin Middle</td>
</tr>
</tbody>
</table>

**Copy Defaults**

**Purpose:**

To use the **Copy Defaults** to modify the **Copy** menu defaults.

---

**Using the Scan Menus**

Use the **Scan** menus to configure a variety of scanner features.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Scan to Email**

**Purpose:**

To attach the scanned image to an e-mail.

**Values:**
| **Enter E-Mail** | Sends an e-mail by entering an e-mail address. |
| **Address Book** | Selects an e-mail to send from the **Address Book**. |
| **Group E-Mail** | Selects an e-mail to send from the group mail. |
| **Search Address** | Allows you search for an e-mail address or group address and specify it as the e-mail recipient. |
| **From** | Enters the sender from either of the following:  
  · Enter E-mail  
  · Address Book |

**Scan to Network**

**Purpose:**

To store the scanned image in the network server or a computer.

**Values:**

| **Server** | Stores the scanned image on the server by using the FTP protocol. |
| **Search Address** | Allows you search for a server address and specify it as the transfer destination. |
| **Computer** | Stores the scanned image on the computer by using the SMB protocol. |

**Scan to Application**

**Purpose:**

To store the scanned image in the application file.

**Values:**

| **TIFF** | Scans an image in TIFF. |
| **JPEG** | Scans an image in JPEG. |
| **PDF** | Scans an image in PDF. |
| **BMP** | Scans an image in BMP. |
File Format

Purpose:
To specify the file format to save the scanned copy.

Values:

<table>
<thead>
<tr>
<th>PDF*</th>
<th>MultiPageTIFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF</td>
<td>JPEG</td>
</tr>
<tr>
<td>MP TIFF NonComp</td>
<td>TIFF NonComp</td>
</tr>
</tbody>
</table>

**NOTE:** The MP TIFF NonComp and TIFF NonComp menus are only displayed when 256 MB or more of optional memory card is installed on the multifunction printer.

Color

Purpose:
To select color or black and white scanning.

Values:

<table>
<thead>
<tr>
<th>Color*</th>
<th>Scans in the color mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black&amp;White</td>
<td>Scans in the black and white mode.</td>
</tr>
</tbody>
</table>

Resolution

Purpose:
To specify the resolution of a scanned image.

Values:

<table>
<thead>
<tr>
<th>300</th>
<th>400</th>
</tr>
</thead>
<tbody>
<tr>
<td>600</td>
<td>150*</td>
</tr>
</tbody>
</table>
**Original Type**

**Purpose:**
To improve the image quality by selecting the document type.

**Values:**

<table>
<thead>
<tr>
<th>Text&amp;Photo*</th>
<th>Uses for documents with both text and photo/gray tones.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo</td>
<td>Uses for documents with photo or gray tones.</td>
</tr>
<tr>
<td>Text</td>
<td>Uses for documents with text.</td>
</tr>
</tbody>
</table>

**Document Size**

**Purpose:**
To specify the default paper size.

**Values:**

<table>
<thead>
<tr>
<th>A4</th>
<th>Letter*1</th>
</tr>
</thead>
<tbody>
<tr>
<td>B5</td>
<td>A5</td>
</tr>
<tr>
<td>Executive</td>
<td>8.5&quot;x13&quot;</td>
</tr>
<tr>
<td>Legal</td>
<td></td>
</tr>
</tbody>
</table>

*1 Denotes country-specific factory default values.

**Lighter/Darker**

**Purpose:**
To adjust the density to make the scanned copy lighter or darker than the original.

**Values:**


<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal*</td>
<td>Works well with standard typed or printed documents.</td>
</tr>
<tr>
<td>Darker1</td>
<td>Works well with light print or faint pencil markings.</td>
</tr>
<tr>
<td>Darker2</td>
<td></td>
</tr>
<tr>
<td>Darker3</td>
<td></td>
</tr>
<tr>
<td>Lighter3</td>
<td>Works well with dark print.</td>
</tr>
<tr>
<td>Lighter2</td>
<td></td>
</tr>
<tr>
<td>Lighter1</td>
<td></td>
</tr>
</tbody>
</table>

**Sharpness**

**Purpose:**
To adjust the sharpness to make the scanned copy sharper or softer than the original.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal*</td>
<td>Does not make the scanned copy sharper or softer than the original.</td>
</tr>
<tr>
<td>Sharper</td>
<td>Makes the scanned copy sharper than the original.</td>
</tr>
<tr>
<td>Softer</td>
<td>Makes the scanned copy softer than the original.</td>
</tr>
</tbody>
</table>

**Contrast**

**Purpose:**
To adjust the amount of color in a specified hue to make the scanned copy higher or lower than the original.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal*</td>
<td>Does not adjust the amount of color in a specified hue to make the scanned copy higher or lower than the original.</td>
</tr>
<tr>
<td>Higher</td>
<td>Adjusts the amount of color in a specified hue to make the scanned copy higher than the original.</td>
</tr>
<tr>
<td>Lower</td>
<td>Adjusts the amount of color in a specified hue to make the scanned copy lower than the original.</td>
</tr>
</tbody>
</table>
**Auto Exposure**

**Purpose:**
To adjust the overall brightness to make the scanned copy overexposed than the original.

**Values:**

<table>
<thead>
<tr>
<th>On*</th>
<th>Adjusts the overall brightness to make the scanned copy overexposed than the original.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not adjust the overall brightness to make the scanned copy overexposed than the original.</td>
</tr>
</tbody>
</table>

**Scan Defaults**

To use the **Scan Defaults** to modify the **Scan** menu defaults.

**Using the Fax Menus**

Use the **Fax** menus to configure a variety of fax features.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Phone Number**

**Purpose:**
To enter the FAX number of the destination.

**Speed Dial**

**Purpose:**
To show up to 200 frequently dialed numbers in speed dial locations (001-200).

**Phone Book**
Purpose:

To list all of the numbers currently stored in the printer's memory as speed dial numbers.

**Add PhoneBook Entry**

Purpose:

To enter numbers in the Phone Book list as speed dial and group dial numbers.

**Group Dial**

Purpose:

To list a group of destinations and set them under a one-digit (1-6) group dial location.

**Resolution**

Purpose:

To improve the output quality of the original or if scanning photographic materials.

Values:

<table>
<thead>
<tr>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard*</td>
<td>For documents with normal sized characters.</td>
</tr>
<tr>
<td>Fine</td>
<td>For documents containing small characters or thin lines or documents printed using a dot-matrix printer.</td>
</tr>
<tr>
<td>SuperFine</td>
<td>For documents containing extremely fine detail. The super fine mode is enabled only if the remote printer also supports the Super Fine resolution. See the notes below.</td>
</tr>
</tbody>
</table>

**NOTE:** Faxes scanned in the SuperFine resolution transmits at the highest resolution supported by the receiving device.

**Original Type**

Purpose:

To improve the image quality by selecting the document type.
Values:

<table>
<thead>
<tr>
<th>Text&amp;Photo</th>
<th>Uses for documents with both text and photo/gray tones.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo</td>
<td>Uses for documents with photo or gray tones.</td>
</tr>
<tr>
<td>Text*</td>
<td>Uses for documents with text.</td>
</tr>
</tbody>
</table>

**Lighter/Darker**

**Purpose:**

To adjust the density to make the copy lighter or darker than the original.

Values:

<table>
<thead>
<tr>
<th>Normal*</th>
<th>Works well with standard typed or printed documents.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Darker1</td>
<td>Works well with light print or faint pencil markings.</td>
</tr>
<tr>
<td>Darker2</td>
<td></td>
</tr>
<tr>
<td>Darker3</td>
<td></td>
</tr>
<tr>
<td>Lighter3</td>
<td>Works well with dark print.</td>
</tr>
<tr>
<td>Lighter2</td>
<td></td>
</tr>
<tr>
<td>Lighter1</td>
<td></td>
</tr>
</tbody>
</table>

**OnHook**

**Purpose:**

To send or receive a fax manually.

Values:

<table>
<thead>
<tr>
<th>Off*</th>
<th>Does not send or receive a fax manually.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Sends or receives a fax manually.</td>
</tr>
</tbody>
</table>
**Polling Receive**

**Purpose:**
To receive faxes from the remote fax machine when you want to receive it.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Off</strong></td>
<td>Does not receive faxes using Polling Receive.</td>
</tr>
<tr>
<td><strong>On</strong></td>
<td>Receives faxes using Polling Receive.</td>
</tr>
</tbody>
</table>

**Delayed Start**

**Purpose:**
To send a fax at a later time when you will not be present.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Off</strong></td>
<td>Does not send a fax at a later time.</td>
</tr>
<tr>
<td><strong>On</strong></td>
<td>Sends a fax at a later time.</td>
</tr>
</tbody>
</table>

**NOTE:** A maximum of 19 delayed fax jobs can be stored in the Dell Multifunction Color Laser Printer 3115cn.

**Fax Defaults**

**Purpose:**
To use the Fax Defaults to modify the Fax menu defaults.

**Using the Job Status Menus**

Use the Job Status menus to print the stored files and completed fax numbers.
Stored Print

This Stored Print menu provides applicable printing services such as Secure Print and Proof Print.

![NOTE:](image) The Stored Print menu is only displayed when 256 MB or more of optional memory card is installed on the multifunction printer.

Secure Print

Purpose:

To print confidential jobs. The multifunction printer can hold the job in memory until you arrive at the multifunction printer and type the password on the operator panel.

Values:

<table>
<thead>
<tr>
<th>Del after Print</th>
<th>Prints the job, and then deletes it from print memory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print and Save</td>
<td>Prints the job, and then saves it in print memory.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the job from print memory.</td>
</tr>
</tbody>
</table>

Proof Print

Purpose:

To print only one copy and check the print result before printing all of the copies. This prevents a large number of misprinted copies from being printed at one time.

Values:

<table>
<thead>
<tr>
<th>Del after Print</th>
<th>Prints the job, and then deletes it from print memory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print and Save</td>
<td>Prints the job, and then saves it in print memory.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the job from print memory.</td>
</tr>
</tbody>
</table>

Secure Receive
Purpose:

To list fax numbers received in the Secure Receive mode.

**Completed Fax**

Purpose:

To list completed fax numbers.

**Pending Fax**

Purpose:

To list pending fax numbers.

---

**Using the Setup Menus**

**Defaults Settings**

To use the **Defaults Settings** to modify the **Copy**, **Scan**, or **Fax** menu defaults.

**Tray Settings**

Use the **Tray Settings** menu to define the print media loaded in each tray.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**MPF**

Purpose:

To specify the paper loaded in the multipurpose feeder.

Values:
<table>
<thead>
<tr>
<th>Paper Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Plain*</td>
</tr>
<tr>
<td></td>
<td>Plain Thick</td>
</tr>
<tr>
<td></td>
<td>Transparency</td>
</tr>
<tr>
<td></td>
<td>Covers</td>
</tr>
<tr>
<td></td>
<td>Covers Thick</td>
</tr>
<tr>
<td></td>
<td>Label</td>
</tr>
<tr>
<td></td>
<td>Coated</td>
</tr>
<tr>
<td></td>
<td>Coated Thick</td>
</tr>
<tr>
<td></td>
<td>Envelope</td>
</tr>
<tr>
<td></td>
<td>Plain S2</td>
</tr>
<tr>
<td></td>
<td>Plain Thick S2</td>
</tr>
<tr>
<td></td>
<td>Covers S2</td>
</tr>
<tr>
<td></td>
<td>Covers Thick S2</td>
</tr>
<tr>
<td></td>
<td>Coated S2</td>
</tr>
<tr>
<td></td>
<td>Coated Thick S2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Size</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A4*</td>
</tr>
<tr>
<td></td>
<td>A5</td>
</tr>
<tr>
<td></td>
<td>B5</td>
</tr>
<tr>
<td></td>
<td>Driver Size</td>
</tr>
<tr>
<td></td>
<td>Letter</td>
</tr>
<tr>
<td></td>
<td>8.5x13&quot;</td>
</tr>
<tr>
<td></td>
<td>Legal</td>
</tr>
<tr>
<td></td>
<td>Executive</td>
</tr>
<tr>
<td></td>
<td>Monarch</td>
</tr>
<tr>
<td></td>
<td>DL</td>
</tr>
<tr>
<td></td>
<td>C5</td>
</tr>
<tr>
<td></td>
<td>Envelope #10</td>
</tr>
<tr>
<td></td>
<td>Custom Size</td>
</tr>
</tbody>
</table>
### MPF Mode

**Panel Specified**
- Stop printing and show an error on the operation panel if the paper specified from the printer driver does not match the paper configured for the MFP from the operation panel.

**Driver Specified**
- Continue to print even if the paper specified from the printer driver does not match the paper configured for the MFP from the operation panel.

**Display Pop Up**
- **On**
  - Specifies the size and type of paper loaded in the multipurpose feeder. This item is available only when Panel Specified is selected for MFP Mode.
- **Off**
  - Size and type of paper loaded in the multipurpose feeder is not specified. This item is available only when Panel Specified is selected for MFP Mode.

### NOTE:
For the standard 250-sheet tray or optional 550-sheet paper feeder, setting paper size is not required. These trays detect the paper size automatically. For more information on supported paper size for the standard and optional trays, see “Print Media Sizes and Support.”

Use this menu item to:
- Optimize print quality for the specified paper.
- Automatically switches trays. The multifunction printer automatically switches any trays containing the same type and size of paper, if you have set the Paper Type to the correct values.

### Tray 1

**Purpose:**

To specify the paper loaded in the 250-sheet tray.

**Values:**

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain*</td>
<td>Plain Thick</td>
</tr>
<tr>
<td></td>
<td>Covers</td>
</tr>
<tr>
<td></td>
<td>Covers Thick</td>
</tr>
<tr>
<td></td>
<td>Label</td>
</tr>
<tr>
<td></td>
<td>Coated</td>
</tr>
<tr>
<td></td>
<td>Coated Thick</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td>Custom Size</td>
</tr>
</tbody>
</table>
Tray 2

Purpose:

To specify the paper loaded in the optional 550-sheet paper feeder.

Values:

<table>
<thead>
<tr>
<th>Paper Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain*</td>
<td></td>
</tr>
<tr>
<td>Plain Thick</td>
<td></td>
</tr>
<tr>
<td>Covers</td>
<td></td>
</tr>
<tr>
<td>Covers Thick</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td></td>
</tr>
<tr>
<td>Coated</td>
<td></td>
</tr>
<tr>
<td>Coated Thick</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Size</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td></td>
</tr>
<tr>
<td>Custom Size</td>
<td></td>
</tr>
</tbody>
</table>

Reports

Use the Reports menu to print various types of reports and lists.

System Settings

Purpose:

To print a list of the current user default values, the installed options, the amount of installed print memory, and the status of printer supplies.

Panel Settings

Purpose:

To print a detailed list of all the settings on the operator panel menus.
**PCL Fonts List**

**Purpose:**

To print a sample of the available PCL fonts.

**See also:**

"Understanding Fonts", "Printing a Font Sample List"

**PS Fonts List**

**Purpose:**

To print a sample of the available Adobe PostScript 3 fonts.

**See also:**

"Understanding Fonts", "Printing a Font Sample List"

**Job History**

**Purpose:**

To print a detailed list of the processed print jobs. This list contains the latest 20 print jobs.

**Error History**

**Purpose:**

To print a detailed list of paper jam and fatal errors.

**Color Test Page**

**Purpose:**

To print a page for testing colors.

**Protocol Monitor**
Purpose:

To print a detailed list of monitored protocols.

PCL Macro List

Purpose:

To print the information on the downloaded PCL macro.

Stored Documents

Purpose:

To print a list of all files that are stored as Secure, Store, and Proof Print in the RAM disk.

NOTE: Stored Print is only displayed when 256 MB or more of optional memory card is installed on the multifunction printer.

Admin Menu

Use the Admin Menu menu to configure a variety of printer features.

Phone Book

Use the Phone Book menu to configure the Speed Dial and Group Dial settings.

Speed Dial

Purpose:

To store up to 200 frequently dialed numbers in speed dial locations.

Group Dial

Purpose:

To create a group of these destinations and set them under a two-digit group dial location.
**Print Language**

**Purpose:**
To specify the settings for PCL and PostScript.

**PCL**

Use the **PCL** menu to change printer settings that only affect jobs using the PCL emulation printer language.

*NOTE:* Values marked by an asterisk (*) are the factory default menu settings.

**Paper Tray**

**Purpose:**
To specify the input tray.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td>Automatically selects a tray according to the paper size and type settings of the printing job.</td>
</tr>
<tr>
<td>Tray 1</td>
<td>The paper is fed from the standard 250-sheet tray.</td>
</tr>
<tr>
<td>Tray 2 *1</td>
<td>The paper is fed from the optional 550-sheet paper feeder.</td>
</tr>
<tr>
<td>MPF</td>
<td>The paper is fed from the multipurpose feeder.</td>
</tr>
</tbody>
</table>

*1 Only displayed when an optional 550-sheet paper feeder is installed on the multifunction printer.

**Paper Size**

**Purpose:**
To specify the default paper size.

**Values:**
### Orientation

**Purpose:**
To specify how text and graphics are oriented on the page.

**Values:**

<table>
<thead>
<tr>
<th>Portrait*</th>
<th>Prints text and graphics parallel to the short edge of the paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Landscape</td>
<td>Prints text and graphics parallel to the long edge of the paper.</td>
</tr>
</tbody>
</table>

### 2 Sided Print

**Purpose:**
To set duplexing as the default for all print jobs. (Select **Duplex** from the printer driver to duplex only specific jobs.)

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**NOTE:** The **2 Sided Print** menu is only available when the optional duplexer is installed on the multifunction printer.

**Values:**
**Off**
Prints on one side of the paper.

**On**
Prints on both sides of the paper.

**Binding Edge**

To select binding along the long or short edge of the page. (Select Duplex from the printer driver to duplex only specific jobs.)

- **NOTE**: Values marked by an asterisk (*) are the factory default menu settings.
- **NOTE**: The **2 Sided** menu is only available when the optional duplexer is installed on the multifunction printer.

**Values:**

<table>
<thead>
<tr>
<th>Flip long edge*</th>
<th>Assumesh binding along the long edge of the page. (Left edge for portrait orientation and top edge for landscape orientation)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip short edge</td>
<td>Assumesh binding along the short edge of the page. (Top edge for portrait orientation and left edge for landscape orientation)</td>
</tr>
</tbody>
</table>

**Font**

**Purpose:**

To specify the default font from the registered fonts in the multifunction printer.

**Values:**

<table>
<thead>
<tr>
<th>CG Times</th>
<th>CG Times It</th>
<th>CG Times Bd</th>
</tr>
</thead>
<tbody>
<tr>
<td>CG Times BdIt</td>
<td>Univers Md</td>
<td>Univers MdIt</td>
</tr>
<tr>
<td>Univers Bd</td>
<td>Univers BdIt</td>
<td>Univers MdCd</td>
</tr>
<tr>
<td>Univers MdCdIt</td>
<td>Univers BdCd</td>
<td>Univers BdCdIt</td>
</tr>
<tr>
<td>Font</td>
<td>Bold Font</td>
<td>Italic Font</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>AntiqueOlv</td>
<td>AntiqueOlv It</td>
<td>AntiqueOlv Bd</td>
</tr>
<tr>
<td>CG Omega</td>
<td>CG Omega It</td>
<td>CG Omega Bd</td>
</tr>
<tr>
<td>CG Omega BdIt</td>
<td>GaramondAntiqua</td>
<td>Garamond Krsv</td>
</tr>
<tr>
<td>Garamond Hlb</td>
<td>GaramondKrsvHlb</td>
<td>Courier*</td>
</tr>
<tr>
<td>Courier It</td>
<td>Courier Bd</td>
<td>Courier BdIt</td>
</tr>
<tr>
<td>LetterGothic</td>
<td>LetterGothic It</td>
<td>LetterGothic Bd</td>
</tr>
<tr>
<td>Albertus Md</td>
<td>Albertus XBd</td>
<td>Clarendon Cd</td>
</tr>
<tr>
<td>Coronet</td>
<td>Marigold</td>
<td>Arial</td>
</tr>
<tr>
<td>Arial It</td>
<td>Arial Bd</td>
<td>Arial BdIt</td>
</tr>
<tr>
<td>Times New</td>
<td>Times New It</td>
<td>Times New Bd</td>
</tr>
<tr>
<td>Times New BdIt</td>
<td>Symbol</td>
<td>Wingdings</td>
</tr>
<tr>
<td>Line Printer</td>
<td>Times Roman</td>
<td>Times It</td>
</tr>
<tr>
<td>Times Bd</td>
<td>Times BdIt</td>
<td>Helvetica</td>
</tr>
<tr>
<td>Helvetica Ob</td>
<td>Helvetica Bd</td>
<td>Helvetica BdOb</td>
</tr>
<tr>
<td>CourierPS</td>
<td>CourierPS Ob</td>
<td>CourierPS Bd</td>
</tr>
<tr>
<td>CourierPS BdOb</td>
<td>SymbolPS</td>
<td>Palatino Roman</td>
</tr>
<tr>
<td>Palatino It</td>
<td>Palatino Bd</td>
<td>Palatino BdIt</td>
</tr>
<tr>
<td>ITCBookman Lt</td>
<td>ITCBookman LtIt</td>
<td>ITCBookmanDm</td>
</tr>
<tr>
<td>ITCBookmanDm It</td>
<td>HelveticaNr</td>
<td>HelveticaNr Ob</td>
</tr>
<tr>
<td>HelveticaNr Bd</td>
<td>HelveticaNrBdOb</td>
<td>N C Schbk Roman</td>
</tr>
<tr>
<td>Symbol Set</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purpose:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To specify a symbol set for a specified font.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Values:</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ROMAN-8</strong></td>
<td>ISO L1</td>
<td>ISO L2</td>
</tr>
<tr>
<td>ISO L5</td>
<td>ISO L6</td>
<td>PC-8</td>
</tr>
<tr>
<td>PC-8 DN</td>
<td>PC-775</td>
<td>PC-850</td>
</tr>
<tr>
<td>PC-852</td>
<td>PC-1004</td>
<td>PC-8 TK</td>
</tr>
<tr>
<td>WIN L1</td>
<td>WIN L2</td>
<td>WIN L5</td>
</tr>
<tr>
<td>DESKTOP</td>
<td>PS TEXT</td>
<td>MC TEXT</td>
</tr>
<tr>
<td>MS PUB</td>
<td>MATH-8</td>
<td>PS MATH</td>
</tr>
<tr>
<td>PI FONT</td>
<td>LEGAL</td>
<td>ISO-4</td>
</tr>
<tr>
<td>ISO-6</td>
<td>ISO-11</td>
<td>ISO-15</td>
</tr>
<tr>
<td>ISO-17</td>
<td>ISO-21</td>
<td>ISO-60</td>
</tr>
<tr>
<td>ISO-69</td>
<td>WIN 3.0</td>
<td>WINBALT</td>
</tr>
<tr>
<td>SYMBOL</td>
<td>WINGDINGS</td>
<td>DNGBTSM</td>
</tr>
</tbody>
</table>
Purpose:

To specify the font size for scalable typographic fonts.

Values:

<table>
<thead>
<tr>
<th>4.00 - 50.00</th>
<th>The values are in units of 0.25.</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.00*</td>
<td></td>
</tr>
</tbody>
</table>

Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch.

NOTE: The Font Size menu is only displayed for typographic fonts.

See also:

"Pitch and Point Size"

Font Pitch

Purpose:

To specify the font pitch for scalable monospaced fonts.

Values:

<table>
<thead>
<tr>
<th>6.00 - 24.00</th>
<th>The values are in units of 0.01.</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.00*</td>
<td></td>
</tr>
</tbody>
</table>

Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For nonscalable monospaced fonts, the pitch is displayed, but cannot be changed.

NOTE: The Font Pitch menu is only displayed for fixed, or monospaced, fonts.

See also:

"Pitch and Point Size"
Form Line

Purpose:

To set the number of lines in a page.

Values:

<table>
<thead>
<tr>
<th>5 - 128</th>
<th>The values are in units of 1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>64* or 64*1</td>
<td></td>
</tr>
</tbody>
</table>

*1 Denotes country-specific factory default values.

The multifunction printer sets the amount of space between each line (vertical line spacing) based on the Form Line and Orientation menu items. Select the correct Form Line and Orientation before changing Form Line.

See also:

"Orientation," "Use this menu item to:"

Quantity

Purpose:

To set the number of copies you want for the printer default value. (Set the number of copies required for a specific job from the printer driver. Values selected from the printer driver always override values selected from the operator panel.)

Values:

<table>
<thead>
<tr>
<th>1-999</th>
<th>The values are in units of 1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1*</td>
<td></td>
</tr>
</tbody>
</table>

Image Enhance

Purpose:
To specify whether to perform the image enhancement feature. Image enhancement is a feature that makes the boundary line between black and white smoother to decrease jagged edges and enhance the visual appearance.

Values:

<table>
<thead>
<tr>
<th></th>
<th>Enables to perform the image enhancement feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On*</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td>Disables to perform the image enhancement feature.</td>
</tr>
</tbody>
</table>

**Hex Dump**

**Purpose:**

To help isolate the source of a print job problem. With Hex Dump selected, all data sent to the multifunction printer is printed in hexadecimal and character representation. Control codes are not executed.

Values:

<table>
<thead>
<tr>
<th></th>
<th>Enables the Hex Dump feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable*</td>
<td>Disables the Hex Dump feature.</td>
</tr>
<tr>
<td>Enable</td>
<td></td>
</tr>
</tbody>
</table>

**Draft Mode**

**Purpose:**

To save toner by printing in the draft mode. The print quality is reduced when printing in the draft mode.

Values:

<table>
<thead>
<tr>
<th></th>
<th>Prints in the draft mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable*</td>
<td>Does not print in the draft mode.</td>
</tr>
<tr>
<td>Enable</td>
<td></td>
</tr>
</tbody>
</table>

**LineTermination**
Purpose:

To add the line termination commands.

Values:

<table>
<thead>
<tr>
<th>Off*</th>
<th>The line termination command is not added. CR=CR, LF=LF, FF=FF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add-LF</td>
<td>The LF command is added. CR=CR-LF, LF=LF, FF=FF</td>
</tr>
<tr>
<td>Add-CR</td>
<td>The CR command is added. CR=CR, LF=CR-LF, FF=CR-FF</td>
</tr>
<tr>
<td>CR-XX</td>
<td>The CR and LF commands are added. CR=CR-LF, LF=CR-LF, FF=CR-FF</td>
</tr>
</tbody>
</table>

Default Color

Purpose:

To specify the color mode to **Color** or **Black**. This setting is used when the color printing mode setting is not specified for the print job that is sent to the multifunction printer.

Value:

<table>
<thead>
<tr>
<th>Black*</th>
<th>Prints in the black and white mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Prints in the color mode.</td>
</tr>
</tbody>
</table>

PostScript

Use the PostScript menu to change printer settings that only affect jobs using the PostScript emulation printer language.

- **NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

PS Error Report

Purpose:
To specify whether the multifunction printer outputs error contents for a PostScript error. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Prints an error message before it discards the job.</td>
</tr>
<tr>
<td><strong>Off</strong></td>
<td>Discards the print job without printing an error message.</td>
</tr>
</tbody>
</table>

**NOTE:** This instructions from the PS driver override the settings specified on the operator panel.

**PS Job Time-Out**

**Purpose:**

To specify the execution time for one PostScript job. The change becomes effective after the multifunction printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Off</strong></td>
<td>Job timeout does not occur.</td>
</tr>
<tr>
<td>1-900min.</td>
<td>A PostScript error occurs if processing is not completed after the specified time.</td>
</tr>
</tbody>
</table>

**Paper Select Mode**

**Purpose:**

To specify the way to select the tray for PostScript mode. The change becomes effective after the multifunction printer is turned off and then on again.

**Value:**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto</strong></td>
<td>The tray is selected as the same setting as in the PCL mode.</td>
</tr>
<tr>
<td><strong>Select From Tray</strong></td>
<td>The tray is selected in a method compatible with regular Post Script printers.</td>
</tr>
</tbody>
</table>
Wired Network

Use the **Wired Network** menu to change printer settings affecting jobs sent to the multifunction printer through the wired network.

![NOTE: Values marked by an asterisk (*) are the factory default menu settings.]

**Ethernet**

**Purpose:**

To specify the communication speed and the duplex settings of Ethernet. The change becomes effective after the multifunction printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto</strong>*</td>
<td>Detects the Ethernet settings automatically.</td>
</tr>
<tr>
<td>10 Base Half</td>
<td>Uses 10base-T half-duplex.</td>
</tr>
<tr>
<td>10 Base Full</td>
<td>Uses 10base-T full-duplex.</td>
</tr>
<tr>
<td>100 Base Half</td>
<td>Uses 100base-TX half-duplex.</td>
</tr>
<tr>
<td>100 Base Full</td>
<td>Uses 100base-TX full-duplex.</td>
</tr>
</tbody>
</table>

**TCP/IP**

**Purpose:**

To specify the TCP/IP settings for the wired network. The change becomes effective after the multifunction printer is turned off and then on again.

**Values:**
<table>
<thead>
<tr>
<th>IP Mode*1</th>
<th>Dual Stack</th>
<th>Uses both IPv4 and IPv6 to set the IP address.</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv4 Mode</td>
<td></td>
<td>Uses IPv4 to set the IP address.</td>
</tr>
<tr>
<td>IPv6 Mode*3</td>
<td></td>
<td>Uses IPv6 to set the IP address.</td>
</tr>
</tbody>
</table>

**IPv4**

<table>
<thead>
<tr>
<th>Get IP Address</th>
<th>AutoIP*</th>
<th>Automatically sets the IP address.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BOOTP</td>
<td>Uses BOOTP to set the IP address.</td>
</tr>
<tr>
<td></td>
<td>RARP</td>
<td>Uses RARP to set the IP address.</td>
</tr>
<tr>
<td></td>
<td>DHCP</td>
<td>Uses DHCP to set the IP address.</td>
</tr>
<tr>
<td></td>
<td>Panel</td>
<td>Enables the IP address entered on the operator panel.</td>
</tr>
</tbody>
</table>

**IP Address**

Sets the IP address allocated to the printer by using the keys on the operator panel.

**Subnet Mask**

Sets the subnet mask.

**Gateway Address**

Sets the gateway address.

**Reset IPsec*2**

Disables IPsec.

*1 Only displayed when an optional multi-protocol card is installed on the printer.

*2 Only displayed when IPsec is enabled.

*3 This mode is available only when firmware version 200706291103 or later and network (MPC) firmware version 16.03 or later are installed. Since you cannot set IPsec in Windows Vista in this mode, use the Dell Printer Configuration Web Tool. The Get Information from Printer function on the Options tab of the printer driver is not available when using this mode.

---

**Protocol**

**Purpose:**

To enable or disable each item. The change becomes effective after the printer is turned off and then on again.

**Values:**
<table>
<thead>
<tr>
<th>Service</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LPD</td>
<td>Enable*</td>
<td>Enables the LPD port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the LPD port.</td>
</tr>
<tr>
<td>Port9100</td>
<td>Enable*</td>
<td>Enables the Port9100 port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the Port9100 port.</td>
</tr>
<tr>
<td>IPP*</td>
<td>Enable*</td>
<td>Enables the IPP port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the IPP port.</td>
</tr>
<tr>
<td>SMB TCP/IP*</td>
<td>Enable*</td>
<td>Uses TCP/IP for SMB.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Does not use TCP/IP for SMB.</td>
</tr>
<tr>
<td>SMB NetBEUI*</td>
<td>Enable*</td>
<td>Uses NetBEUI for SMB.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Does not use NetBEUI for SMB.</td>
</tr>
<tr>
<td>FTP</td>
<td>Enable*</td>
<td>Enables the FTP port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the FTP port.</td>
</tr>
<tr>
<td>NetWare IP</td>
<td>Enable*</td>
<td>Enables the IP.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the IP.</td>
</tr>
<tr>
<td>NetWare IPX</td>
<td>Enable*</td>
<td>Enables the IPX.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the IPX.</td>
</tr>
<tr>
<td>WSD</td>
<td>Enable*</td>
<td>Enables the WSD port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the WSD port.</td>
</tr>
<tr>
<td>SNMP UDP</td>
<td>Enable*</td>
<td>Enables the UDP.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the UDP.</td>
</tr>
<tr>
<td>Feature</td>
<td>Enable*</td>
<td>Disable</td>
</tr>
<tr>
<td>------------------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>E-Mail Alert</td>
<td>Enables the E-Mail Alert feature.</td>
<td>Disables the E-Mail Alert feature.</td>
</tr>
<tr>
<td>EWS</td>
<td>Enables an access to <strong>Dell Printer Configuration Web Tool</strong> embedded in the printer.</td>
<td>Disables an access to <strong>Dell Printer Configuration Web Tool</strong> embedded in the printer.</td>
</tr>
<tr>
<td>Apple Talk*1</td>
<td>Enables the AppleTalk port.</td>
<td>Disables the AppleTalk port.</td>
</tr>
<tr>
<td>Bonjour(mDNS)*1</td>
<td>Enables the Bonjour(mDNS) port.</td>
<td>Disables the Bonjour(mDNS) port.</td>
</tr>
</tbody>
</table>

*1 Only displayed when an optional multi-protocol card is installed on the printer and the optional wireless printer adapter is not installed on the card.

**IPX/SPX**

**Purpose:**

To configure the **IPX/SPX** settings for the wired network. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto</strong></td>
<td>Automatically sets the frame type.</td>
</tr>
<tr>
<td>Ethernet II</td>
<td>Uses the Ethernet II frame type.</td>
</tr>
<tr>
<td>Ethernet 802.3</td>
<td>Uses the IEEE802.3 frame type.</td>
</tr>
<tr>
<td>Ethernet 802.2</td>
<td>Uses the IEEE802.2 frame type.</td>
</tr>
<tr>
<td>Ethernet SNAP</td>
<td>Use the SNAP frame type.</td>
</tr>
</tbody>
</table>

**NOTE:** The **IPX/SPX** menu is only displayed when an optional multi-protocol card is installed on the printer and the optional wireless printer adapter is not installed on the card.
**IP Filter (IPv4)**

**Purpose:**

To specify that data received from certain IP addresses through the wired network is blocked. You can set up to five IP addresses. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Filter*1</th>
<th>No. n/Address (n is 1-5.)</th>
<th>Sets the IP address for Filter n.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No. n/Mask (n is 1-5.)</td>
<td>Sets the mask for Filter n.</td>
</tr>
<tr>
<td></td>
<td>No. n/Mode (n is 1-5.)</td>
<td>Off* Disable the IP Filter feature for Filter n.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Accept Accepts an access from specified IP address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reject Rejects an access from specified IP address.</td>
</tr>
</tbody>
</table>

*1 This item is only available for LPD or Port9100.

**Initialize NVM**

**Purpose:**

To initialize wired network data stored in NVM. After executing this function and rebooting the printer, all wired network settings are reset to their default values.

**Adobe Protocol**

**Purpose:**

To specify PostScript communication protocol for each interface. You can configure the Adobe Protocol settings for the wired network. The change becomes effective after the printer is turned off and then on again.

**Values:**
<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto*</td>
<td>Used when auto-detecting the PostScript communication protocol.</td>
</tr>
<tr>
<td>Standard</td>
<td>Used when the communication protocol is in ASCII interface.</td>
</tr>
<tr>
<td>BCP</td>
<td>Used when the communication protocol is in binary format.</td>
</tr>
<tr>
<td>TBCP</td>
<td>Used when the communication protocol supports both ASCII and binary data to switch between them according to the specified control code.</td>
</tr>
<tr>
<td>Binary</td>
<td>Used when no special processing is required for data.</td>
</tr>
</tbody>
</table>

**Wireless Network**

Use the **Wireless Network** menu to change print settings affecting jobs sent to the printer through a wireless network.

- **NOTE:** The **Wireless Net** menu is only displayed when an optional multi-protocol card is installed on the printer and the optional wireless printer adapter is installed on the card.

- **NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Wireless/Status**

**Purpose:**

To display the information on the wireless signal strength. Any change cannot be made on the operator panel to improve the status of the wireless connection.

**Values:**

<table>
<thead>
<tr>
<th>Signal Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td>Indicates good signal strength.</td>
</tr>
<tr>
<td>Acceptable</td>
<td>Indicates marginal signal strength.</td>
</tr>
<tr>
<td>Low</td>
<td>Indicates insufficient signal strength.</td>
</tr>
<tr>
<td>No Reception</td>
<td>Indicates that no signal is received.</td>
</tr>
</tbody>
</table>

**Wireless/Reset Wireless**
**Purpose:**

To initialize wireless network settings. After executing this function and rebooting the printer, all wireless network settings are reset to their default values.

**TCP/IP**

**Purpose:**

To specify the TCP/IP settings for the wireless network. The change becomes effective after the printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>IP Mode*¹</th>
<th>Dual Stack</th>
<th>Uses both IPv4 and IPv6 to set the IP address.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>IPv4 Mode</td>
<td>Uses IPv4 to set the IP address.</td>
</tr>
<tr>
<td></td>
<td>IPv6 Mode*³</td>
<td>Uses IPv6 to set the IP address.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IPv4</th>
<th>Get IP Address</th>
<th>AutoIP*</th>
<th>Automatically sets the IP address.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>BOOTP</td>
<td>Uses BOOTP to set the IP address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RARP</td>
<td>Uses RARP to set the IP address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DHCP</td>
<td>Uses DHCP to set the IP address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Panel</td>
<td>Enables the IP address entered on the operator panel.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IP Address</th>
<th>Sets the IP address allocated to the printer by using the keys on the operator panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subnet Mask</td>
<td>Sets the subnet mask.</td>
</tr>
<tr>
<td>Gateway Address</td>
<td>Sets the gateway address.</td>
</tr>
</tbody>
</table>

| Reset IPsec*² | Disables IPsec. |

---

*¹ Only displayed when an optional multi-protocol card is installed on the printer.

*² Only displayed when IPsec is enabled.
This mode is available only when firmware version 200706291103 or later and network (MPC) firmware version 16.03 or later are installed. Since you cannot set IPsec in Windows Vista in this mode, use the **Dell Printer Configuration Web Tool**. The **Get Information from Printer** function on the **Options** tab of the printer driver is not available when using this mode.

### Protocol

**Purpose:**

To enable or disable each item. The change becomes effective after the multifunction printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LPD</td>
<td>Enable*</td>
<td>Enables the LPD port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the LPD port.</td>
</tr>
<tr>
<td>Port9100</td>
<td>Enable*</td>
<td>Enables the Port9100 port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the Port9100 port.</td>
</tr>
<tr>
<td>IPP</td>
<td>Enable*</td>
<td>Enables the IPP port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the IPP port.</td>
</tr>
<tr>
<td>SMB TCP/IP</td>
<td>Enable*</td>
<td>Uses TCP/IP for SMB.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Does not use TCP/IP for SMB.</td>
</tr>
<tr>
<td>SMB NetBEUI</td>
<td>Enable*</td>
<td>Uses NetBEUI for SMB.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Does not use NetBEUI for SMB.</td>
</tr>
<tr>
<td>FTP</td>
<td>Enable*</td>
<td>Enables the FTP port.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the FTP port.</td>
</tr>
<tr>
<td>NetWare IP</td>
<td>Enable*</td>
<td>Enables the IP.</td>
</tr>
<tr>
<td></td>
<td>Disable</td>
<td>Disables the IP.</td>
</tr>
<tr>
<td>Feature</td>
<td>Enable*</td>
<td>Disable</td>
</tr>
<tr>
<td>------------------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>NetWare IPX</td>
<td>Enables the IPX.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disables the IPX.</td>
<td></td>
</tr>
<tr>
<td>WSD</td>
<td>Enables the WSD port.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disables the WSD port.</td>
<td></td>
</tr>
<tr>
<td>SNMP UDP</td>
<td>Enables the UDP.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disables the UDP.</td>
<td></td>
</tr>
<tr>
<td>SNMP IPX</td>
<td>Enables the IPX.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disables the IPX.</td>
<td></td>
</tr>
<tr>
<td>E-Mail Alert</td>
<td>Enables the E-Mail Alert feature.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disables the E-Mail Alert feature.</td>
<td></td>
</tr>
<tr>
<td>EWS</td>
<td>Enables an access to Dell Printer Configuration Web Tool embedded in the multifunction printer.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disables an access to Dell Printer Configuration Web Tool embedded in the multifunction printer.</td>
<td></td>
</tr>
<tr>
<td>Apple Talk</td>
<td>Enables the AppleTalk port.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disables the AppleTalk port.</td>
<td></td>
</tr>
<tr>
<td>Bonjour(mDNS)</td>
<td>Enables the Bonjour(mDNS) port.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disables the Bonjour(mDNS) port.</td>
<td></td>
</tr>
</tbody>
</table>

**IPX/SPX**

**Purpose:**

To configure the IPX/SPX settings for the wireless network. The change becomes effective after the multifunction printer is turned off and then on again.

**Values:**
### Auto
Automatically sets the frame type.

### Ethernet II
Uses the Ethernet II frame type.

### Ethernet 802.3
Uses the IEEE802.3 frame type.

### Ethernet 802.2
Uses the IEEE802.2 frame type.

### Ethernet SNAP
Use the SNAP frame type.

---

**IP Filter (IPv4)**

**Purpose:**
To specify that data received from certain IP addresses through the wireless network is blocked. You can set up to five IP addresses. The change becomes effective after the multifunction printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>IP Filter*1</th>
<th>No. n/Address (n is 1-5.)</th>
<th>Sets the IP address for Filter n.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No. n/Mask (n is 1-5.)</td>
<td>Sets the mask for Filter n.</td>
</tr>
<tr>
<td></td>
<td>No. n/Mode (n is 1-5.)</td>
<td><strong>Off</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Accept</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Reject</strong></td>
</tr>
</tbody>
</table>

*1 This item is only available for LPD or Port9100.

---

**Initialize NVM**

**Purpose:**
To initialize wireless network data stored in NVRAM.

---

**Adobe Protocol**
Purpose:

To specify PostScript communication protocol for each interface. You can configure Adobe Protocol settings for the wireless network. The change becomes effective after the multifunction printer is turned off and then on again.

Values:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Used when auto-detecting the PostScript communication protocol.</td>
</tr>
<tr>
<td>Standard</td>
<td>Used when the communication protocol is in ASCII interface.</td>
</tr>
<tr>
<td>BCP</td>
<td>Used when the communication protocol is in binary format.</td>
</tr>
<tr>
<td>TBCP*</td>
<td>Used when the communication protocol supports both ASCII and binary data to switch between them according to the specified control code.</td>
</tr>
<tr>
<td>Binary</td>
<td>Used when no special processing is required.</td>
</tr>
</tbody>
</table>

**Parallel Settings**

The **Parallel Settings** menu can be adjusted to configure the parallel interface.

![NOTE: Values marked by an asterisk (*) are the factory default menu settings.]

**ECP**

Purpose:

To specify the ECP communication mode of the parallel interface. The change becomes effective after the multifunction printer is turned off and then on again.

Values:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable*</td>
<td>The ECP communication mode is enabled.</td>
</tr>
<tr>
<td>Disable</td>
<td>The ECP communication mode is disabled.</td>
</tr>
</tbody>
</table>
Adobe Protocol

Purpose:

To specify PostScript communication protocol for each interface. You can configure Adobe Protocol settings for the wireless network. The change becomes effective after the multifunction printer is turned off and then on again.

Values:

<table>
<thead>
<tr>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Used when auto-detecting the PostScript communication protocol.</td>
</tr>
<tr>
<td>Standard</td>
<td>Used when the communication protocol is in ASCII interface.</td>
</tr>
<tr>
<td>BCP</td>
<td>Used when the communication protocol is in binary format.</td>
</tr>
<tr>
<td>TBCP*</td>
<td>Used when the communication protocol supports both ASCII and binary data to switch between them according to the specified control code.</td>
</tr>
<tr>
<td>Binary</td>
<td>Used when no special processing is required.</td>
</tr>
</tbody>
</table>

USB Settings

Use the **USB Settings** menu to change printer settings affecting a USB port.

⚠️ **NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

Fax Settings

Use the **Fax Settings** menu to configure the basic fax settings.

⚠️ **NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

Interval Timer

Purpose:

To specify the interval time (3-255 seconds) of the resend attempts.

Number of Redial
**Purpose:**

To specify the number of redial attempts, 0-9. If you enter 0, the multifunction printer will not redial.

**Int. of Redial**

**Purpose:**

To automatically redial a remote fax machine if it was busy. Intervals from 1-15 minutes can be entered.

**Ans Select**

**Purpose:**

To select the default fax receiving mode.

**Values:**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEL Mode</td>
<td>Automatic fax reception is turned off. You can receive a fax by picking up the handset of the external phone and then pressing the remote receive code, or by setting OnHook to On (you can hear voice or fax tones from the remote machine) and then pressing Start.</td>
</tr>
<tr>
<td>FAX Mode*</td>
<td>A fax is automatically received.</td>
</tr>
<tr>
<td>TEL/FAX Mode</td>
<td>When the multifunction printer receive an incoming a fax, the external telephone rings for the time specified in Auto Ans. TEL/FAX, and then the multifunction printer automatically receive a fax. If incoming data is not a fax, the multifunction printer beeps from the internal speaker.</td>
</tr>
<tr>
<td>Ans/FAX Mode</td>
<td>The multifunction printer can share one telephone line with an answering machine. In this mode, the multifunction printer will monitor the fax signal and pick up the line if there are fax tones. If the phone communication in your country is serial, this mode is not available.</td>
</tr>
<tr>
<td>DRPD Mode</td>
<td>Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive ring service must be installed on your telephone line by the telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern.</td>
</tr>
</tbody>
</table>

**Auto Answer Fax**

**Purpose:**

To answer an incoming call and automatically go into the receive mode. You can specify the time for incoming call of the external phone in 0-255 seconds.
Auto Ans. TEL/FAX

**Purpose:**

To share one telephone line with an external telephone. You can specify the time for incoming call of the external phone in 0-255 seconds.

Auto Ans. Ans/FAX

**Purpose:**

To share one telephone line with an answering machine. You can specify the time for incoming call of the external phone in 0-255 seconds.

**Line Monitor**

**Purpose:**

To specify the volume of the external phone (line monitor).

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Turns off the volume of the external phone.</td>
</tr>
<tr>
<td>Min</td>
<td>Selects the volume of the external phone.</td>
</tr>
<tr>
<td>Middle*</td>
<td></td>
</tr>
<tr>
<td>Max</td>
<td></td>
</tr>
</tbody>
</table>

**Ring Tone Volume**

**Purpose:**

To specify the volume for the incoming faxes.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Turns off the volume for the incoming faxes.</td>
</tr>
<tr>
<td>Min</td>
<td>Selects the volume for the incoming faxes.</td>
</tr>
<tr>
<td>Middle</td>
<td></td>
</tr>
<tr>
<td>Max*</td>
<td></td>
</tr>
</tbody>
</table>
**Line Type**

**Purpose:**
To select the default line type.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PSTN*</td>
<td>Uses PSTN.</td>
</tr>
<tr>
<td>PBX</td>
<td>Uses PBX.</td>
</tr>
</tbody>
</table>

**Dialing Type**

**Purpose:**
To select the dialing type.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PB*</td>
<td>Uses PB.</td>
</tr>
<tr>
<td>DP (10PPS)</td>
<td>Uses DP (10PPS).</td>
</tr>
<tr>
<td>DP (20PPS)</td>
<td>Uses DP (20PPS).</td>
</tr>
</tbody>
</table>

**DM Prevention**

**Purpose:**
To reject faxes sent from unwanted stations.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Only accepts faxes from numbers registered in the PhoneBook. Incoming faxes from numbers whose G3ID is not registered correctly are not accepted even if the number is registered in the PhoneBook.</td>
</tr>
<tr>
<td>Off*</td>
<td>Accepts faxes from numbers that are not registered in the PhoneBook.</td>
</tr>
</tbody>
</table>

**Remote Receive**

**Purpose:**
To receive a fax by pressing the remote receive code on the external telephone after picking up the handset of the telephone.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Receives a fax by pressing the remote receive code on the external telephone.</td>
</tr>
<tr>
<td><strong>Off</strong></td>
<td>Does not receive a fax by pressing the remote receive code on the external telephone.</td>
</tr>
</tbody>
</table>

**Remote Rcv Tone**

**Purpose:**

To specify the tone in two digits to start Remote Receive.

**Duplex Print**

**Purpose:**

To use duplex printing when you receive a fax. This option is available only when the optional duplexer is installed on your multifunction printer.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Uses duplex printing.</td>
</tr>
<tr>
<td><strong>Off</strong></td>
<td>Does not use duplex printing.</td>
</tr>
</tbody>
</table>

**Send Header**

**Purpose:**

To print the sender record at the head of the fax.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Prints the sender record at the head of the fax.</td>
</tr>
<tr>
<td><strong>Off</strong></td>
<td>Does not print the sender record at the head of the fax.</td>
</tr>
</tbody>
</table>

**Send Header Name**

**Purpose:**
To register the sender name to be recorded in the sender report.

**G3ID**

**Purpose:**

To contain your telephone number, which is printed at the top of each page sent from your multifunction printer.

⚠️ **NOTE:** Ensure to specify G3ID before using DM Prevention.

**Local Name**

**Purpose:**

To contain your name or company name, which is printed on the report sheet.

**DRPD Pattern**

**Purpose:**

To provide a separate number for faxing with a distinctive ring pattern.

**Values:**

<table>
<thead>
<tr>
<th>Pattern1-5</th>
<th>DRPD is a service provided by some telephone companies. DRPD Patterns are specified by your telephone company. The patterns provided with your multifunction printer are shown below:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image" alt="Pattern Diagram" /></td>
</tr>
<tr>
<td>Pattern 1</td>
<td><img src="image" alt="Pattern 1" /></td>
</tr>
<tr>
<td>Pattern 2</td>
<td><img src="image" alt="Pattern 2" /></td>
</tr>
<tr>
<td>Pattern 3</td>
<td><img src="image" alt="Pattern 3" /></td>
</tr>
<tr>
<td>Pattern 4</td>
<td><img src="image" alt="Pattern 4" /></td>
</tr>
<tr>
<td>Pattern 5</td>
<td><img src="image" alt="Pattern 5" /></td>
</tr>
</tbody>
</table>
Forward Settings

Purpose:

To set the multifunction printer to always forward all of the incoming faxes to the specified destination.

Values:

<table>
<thead>
<tr>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trans. at Error</td>
<td>Forwards the incoming faxes when an error occurs.</td>
</tr>
<tr>
<td>Trans. Always</td>
<td>Always forwards the incoming faxes.</td>
</tr>
<tr>
<td>Not Trans.*</td>
<td>Does not forward incoming faxes.</td>
</tr>
</tbody>
</table>

Fwd. Settings Num

Purpose:

To set the number of the multifunction printer to always forward all of the incoming faxes to the specified destination.

Fwd. Set Print

Purpose:

To print all of the ongoing faxes when you can set the multifunction printer to always forward the faxes to the specified destination.

Values:

<table>
<thead>
<tr>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Prints all of the ongoing faxes.</td>
</tr>
<tr>
<td>Off*</td>
<td>Does not print all of the ongoing faxes.</td>
</tr>
</tbody>
</table>

Prefix Dial

Purpose:

To select whether or not to add the prefix number when you send a fax.

Values:
Prefix Dial Num

Purpose:
To set a prefix dial number up to five digits. This number dials before any auto dial number is started. It is useful for accessing the PABX exchange.

Discard Size

Purpose:
To set the multifunction printer to discard any excess at the bottom of the page.

Values:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Discards any excess at the bottom of the page.</td>
</tr>
<tr>
<td><strong>Off</strong>*</td>
<td>Prints any excess at the bottom of the page without discarding it.</td>
</tr>
</tbody>
</table>

Auto Reduction
Automatically reduces the document to fit it onto the appropriate sized paper.

Color Fax

Purpose:
To set the multifunction printer to send and receive color faxes.

Values:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Allows color faxes to be sent and received (select color or black and white when sending a fax).</td>
</tr>
<tr>
<td><strong>Off</strong>*</td>
<td>Faxes are sent and received in black and white only.</td>
</tr>
</tbody>
</table>

Extel Hook Thresh

Purpose:
To set the threshold value for the external telephone.
Values:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower</td>
<td>Sets Lower in the threshold value.</td>
</tr>
<tr>
<td>Normal*</td>
<td>Sets Normal in the threshold value.</td>
</tr>
<tr>
<td>Higher</td>
<td>Sets Higher in the threshold value.</td>
</tr>
</tbody>
</table>

**Country**

**Purpose:**

To select the country where the multifunction printer is used.

**Fwd. Error Print**

**Purpose:**

To print the documents failed to transfer when Forward Set Print is set to **Off**.

**Values:**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>On*</td>
<td>Prints documents that failed to transfer when Forward Set Print is set to Off.</td>
</tr>
<tr>
<td>Off</td>
<td>Does not print documents that failed to transfer when Forward Set Print is set to Off.</td>
</tr>
</tbody>
</table>

**System Settings**

Use the **System Settings** menu to configure the basic printer settings.

⚠️ **NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Power Saver Mode2**

**Purpose:**

To enable Power Saver Mode2.

**Values:**
Enable* Enables Power Saver Mode2.
Disable Disables Power Saver Mode2.

**Power Saver Timer**

**Purpose:**

To specify the amount of time the multifunction printer waits after a job is submitted before it goes into the power saver mode.

**Values:**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode1</td>
<td>5-60 min</td>
<td>Specifies the amount of time before the multifunction printer enters power saver mode after it finishes a job.</td>
</tr>
<tr>
<td></td>
<td>5 min*</td>
<td></td>
</tr>
<tr>
<td>Mode2</td>
<td>1-6 min</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 min*</td>
<td></td>
</tr>
</tbody>
</table>

Enter 5 to put the multifunction printer in power saver mode five minutes after it finishes a job. This uses much less energy, but requires more warm-up time for the multifunction printer. Enter 5 if your multifunction printer shares an electrical circuit with room lighting and you notice lights flickering.

Select a high value if your multifunction printer is in constant use. Under most circumstances, this keeps the multifunction printer ready to operate with minimum warm-up time. Select a value between 5 and 60 minutes for power save mode if you want a balance between energy consumption and a shorter warm-up period.

The multifunction printer automatically returns to the standby mode from the power saver mode when it receives data from the computer or remote fax machine. You can also return the multifunction printer to the standby mode by pressing any button on the operator panel.

**Auto Reset**

**Purpose:**

To automatically reset the settings for COPY, SCAN, or FAX to the default and return to the standby mode after you do not specify any settings for the specified time.
Alert Tone

Purpose:
To sound an alert when an event associated each function occurs.

Values:

<table>
<thead>
<tr>
<th>Panel Select Tone</th>
<th>Soft</th>
<th>Normal</th>
<th>Loud</th>
<th>Off*</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sounds an alert when you press a button on the operator panel.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Panel Alert Tone</th>
<th>Soft</th>
<th>Normal</th>
<th>Loud</th>
<th>Off*</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sounds an alert when you press a wrong button.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Machine Ready Tone</th>
<th>Soft</th>
<th>Normal*</th>
<th>Loud</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sounds an alert when the multifunction printer is ready.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Copy Job Tone</th>
<th>Soft</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sounds an alert when copying is completed.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Normal*</td>
<td>Loud</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>Non-Copy Job Tone</td>
<td>Soft</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Normal*</td>
<td>Loud</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fault Tone</td>
<td>Soft</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Normal*</td>
<td>Loud</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alert Tone</td>
<td>Soft</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Normal*</td>
<td>Loud</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Out of Paper</td>
<td>Soft</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Normal*</td>
<td>Loud</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low Toner</td>
<td>Soft</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Normal*</td>
<td>Loud</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto Clear Alert</td>
<td>Soft</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>Loud</td>
</tr>
<tr>
<td></td>
<td>Off*</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Base Tone</td>
<td>Soft</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>Loud</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td>Setting by scrolling the loop menu.</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Loud</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Off*</td>
<td>Does not sound an alert when an operator panel display is returned to the default setting by scrolling the loop menu.</td>
<td></td>
</tr>
<tr>
<td>All Tones</td>
<td>Soft</td>
<td>All tone settings can be changed at one time by this setting.</td>
</tr>
<tr>
<td></td>
<td>Normal*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Loud</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

**Time-Out**

**Purpose:**

To specify the amount of time the multifunction printer waits to receive additional bytes of data from the computer. When this timeout expires, the print job is canceled.

**Values:**

<table>
<thead>
<tr>
<th>Off</th>
<th>Disables the job timeout.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>5-300 sec</strong></td>
<td>Specifies the amount of time the multifunction printer waits for additional data before it cancels the job.</td>
</tr>
<tr>
<td><strong>30 sec</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Clock Settings**

**Purpose:**

To specify the date format.

**Values:**


<table>
<thead>
<tr>
<th><strong>Set Date: yy/mm/dd</strong></th>
<th>Sets the date in the yy/mm/dd format depending on the settings for Date Format.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set Time</strong></td>
<td>Sets the time.</td>
</tr>
<tr>
<td><strong>Date Format</strong></td>
<td>Sets the date format.</td>
</tr>
<tr>
<td><strong>Time Format</strong></td>
<td>12H Sets the time in the 12H format.</td>
</tr>
<tr>
<td></td>
<td>24H* Sets the time in the 24H format.</td>
</tr>
<tr>
<td><strong>Time Zone</strong></td>
<td>Sets the time zone.</td>
</tr>
</tbody>
</table>

**mm/inch**

**Purpose:**

Specifies the default measurement unit displayed after the numeric value on the operator panel.

**Values:**

<table>
<thead>
<tr>
<th>mm</th>
<th>Selects millimeter as the default measurement unit.</th>
</tr>
</thead>
<tbody>
<tr>
<td>inch*</td>
<td>Selects inch as the default measurement unit.</td>
</tr>
</tbody>
</table>

**Auto Log Print**

**Purpose:**

To automatically print the Job History report when the number of Job History items reaches the maximum.

**Values:**

<table>
<thead>
<tr>
<th>Off*</th>
<th>Does not automatically print the Job History report.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Automatically print the Job History report when the number of Job History items reaches the maximum.</td>
</tr>
</tbody>
</table>

Print logs can also be printed using the **Report/List** menu.
See also:
"USB Settings"

Print ID

Purpose:
To specify a location where the user ID is printed. This feature is available for the PCL driver and unavailable for the PS driver.

Values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not print the user ID.</td>
</tr>
<tr>
<td>Top Left</td>
<td>Prints the user ID on the top left of the page.</td>
</tr>
<tr>
<td>Top Right</td>
<td>Prints the user ID on the top right of the page.</td>
</tr>
<tr>
<td>Bottom Left</td>
<td>Prints the user ID on the bottom left of the page.</td>
</tr>
<tr>
<td>Bottom Right</td>
<td>Prints the user ID on the bottom right of the page.</td>
</tr>
</tbody>
</table>

**NOTE:** When printing on DL size paper, a part of the user ID may not be printed correctly.

Print Text

Purpose:
To specify whether the multifunction printer outputs PDL data, which is not supported by the multifunction printer, as text when the multifunction printer receives it. Text data is printed on A4 or Letter size paper.

Values:

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Does not print the received data.</td>
</tr>
<tr>
<td>On*</td>
<td>Prints the received data as text data.</td>
</tr>
</tbody>
</table>
**Banner Sheet**

**Purpose:**

To specify the position of banner sheet, and also specify the tray in which the banner sheet is loaded. This feature is available for the PCL driver but is not available for the PS driver.

**Values:**

<table>
<thead>
<tr>
<th>Insert Position</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td></td>
<td>Does not print the banner sheet.</td>
</tr>
<tr>
<td>Front</td>
<td></td>
<td>Prints on the beginning of document.</td>
</tr>
<tr>
<td>Back</td>
<td></td>
<td>Prints on the end of document.</td>
</tr>
<tr>
<td>Front &amp; Back</td>
<td></td>
<td>Prints on both beginning and end of document.</td>
</tr>
</tbody>
</table>

**Specify Tray**

<table>
<thead>
<tr>
<th>Specify Tray</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1*</td>
<td></td>
<td>The banner sheet is loaded in the standard 250-sheet tray.</td>
</tr>
<tr>
<td>Tray 2*2</td>
<td></td>
<td>The banner sheet is loaded in tray 2.</td>
</tr>
<tr>
<td>MPF</td>
<td></td>
<td>The banner sheet is loaded in multipurpose feeder.</td>
</tr>
</tbody>
</table>

*1 When you load paper in the multipurpose feeder to print banner sheets, specify MPF Mode as Panel Specified and specify MPF PaperSize other than Driver Size from the operator panel.

*2 Only displayed when an optional 550-sheet paper feeder is installed on the multifunction printer.

**Fax Activity**

**Purpose:**

To show information about the faxes you recently received or sent.

**Values:**

<table>
<thead>
<tr>
<th>Auto Print</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Print*</td>
<td></td>
<td>Automatically prints information about the faxes when you received or sent 50 items of faxes.</td>
</tr>
<tr>
<td>No Auto Print</td>
<td>Does not automatically print information about the faxes when you received or sent 50 items of faxes.</td>
<td></td>
</tr>
</tbody>
</table>
**Fax Transmit**

**Purpose:**

To specify the communication result for the fax transmission.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Print</td>
<td>Does not print the report.</td>
</tr>
<tr>
<td>Print at Error</td>
<td>Prints the report when a communication error is detected.</td>
</tr>
<tr>
<td>Print Always*</td>
<td>Always prints the report for the fax transmission.</td>
</tr>
</tbody>
</table>

**Fax Broadcast**

**Purpose:**

To specify the communication result for a fax to multiple locations.

**Values:**

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Print</td>
<td>Does not print the report.</td>
</tr>
<tr>
<td>Print at Error</td>
<td>Prints the report when a communication error is detected.</td>
</tr>
<tr>
<td>Print Always*</td>
<td>Always prints the report for the fax transmission.</td>
</tr>
</tbody>
</table>

**Protocol Monitor**

**Purpose:**

To specify the protocol monitor report to detect the cause of the communication trouble.

**Values:**
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Print</td>
<td>Does not print the report.</td>
</tr>
<tr>
<td>Print at Error</td>
<td>Prints the report when a communication error is detected.</td>
</tr>
<tr>
<td>Print Always*</td>
<td>Always prints the report for the fax transmission.</td>
</tr>
</tbody>
</table>

**RAM Disk**

**Purpose:**

To allocate memory to the RAM disk file system for the Secure Print and Proof Print features. The change becomes effective after the multifunction printer is turned off and then on again.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Does not allocate memory to the RAM disk file system. Secure Print, Proof Print, and Copy Collate jobs will abort and be recorded to the job log.</td>
</tr>
<tr>
<td>Enable*</td>
<td>Allocates memory to the RAM disk file system automatically.</td>
</tr>
</tbody>
</table>

**NOTE:** The **RAM Disk** menu is only displayed when 256 MB or more of additional print memory is installed on the multifunction printer.

**NOTE:** Restart your multifunction printer when you change the settings for the **RAM Disk** menu.

**Substitute Tray**

**Purpose:**

Specifies whether or not to use another size paper when the paper that is loaded in the specified tray does not match the paper size settings for the current job.

**Values:**

Off* | No tray size substitute accepted.
Larger Size | Substitutes paper of next largest size. When there is no larger paper size, the multifunction printer substitutes paper of nearest size.
Nearest Size | Substitutes paper of nearest size.
MPF Feed | Substitutes paper from the multipurpose feeder.

**Maintenance**

Use the **Maintenance** menu to initialize the NV (non-volatile) memory, configure the plain paper quality adjustment settings, and configure the security settings.

*NOTE:* Values marked by an asterisk (*) are the factory default menu settings.

**Paper Density**

*Purpose:*

To specify the paper density.

*Values:*

<table>
<thead>
<tr>
<th>Plain</th>
<th>Normal*</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Light</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Label</th>
<th>Normal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Light*</td>
</tr>
</tbody>
</table>

**Adjust BTR**

*NOTE:* The print quality changes depending on the setting values you select for this item.

*Purpose:*
To specify the reference voltage settings for the transfer roller.

Values:

<table>
<thead>
<tr>
<th></th>
<th>-3 - +3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>0*</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>0*</td>
</tr>
<tr>
<td>Transparency</td>
<td>0*</td>
</tr>
<tr>
<td>Covers</td>
<td>0*</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>0*</td>
</tr>
<tr>
<td>Label</td>
<td>0*</td>
</tr>
<tr>
<td>Coated</td>
<td>0*</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>0*</td>
</tr>
<tr>
<td>Envelope</td>
<td>0*</td>
</tr>
</tbody>
</table>
**Adjust Fuser**

**NOTICE:** The print quality changes depending on the setting values you select for this item.

**Purpose:**

To specify the temperature settings value for the fuser unit.

**Values:**

<table>
<thead>
<tr>
<th>Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Transparency</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Covers</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Label</td>
<td>-2 - +2</td>
</tr>
<tr>
<td>Coated</td>
<td>-2 - +2</td>
</tr>
</tbody>
</table>
**Auto Reg Adjust**

**Purpose:**

To adjust the registration automatically.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Adjusts the registration automatically.</td>
</tr>
<tr>
<td><strong>Off</strong>*</td>
<td>Does not adjust the registration automatically.</td>
</tr>
</tbody>
</table>

**Color Reg Adjust**

**Purpose:**

To print the color registration chart and to adjust the color registration by using the chart. This function is required after the multifunction printer is set up or moved.

**Values:**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On</strong></td>
<td>Adjusts the registration automatically.</td>
</tr>
<tr>
<td><strong>Off</strong>*</td>
<td>Does not adjust the registration automatically.</td>
</tr>
<tr>
<td>Auto Correct</td>
<td>Adjusts color registration automatically.</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td><strong>Color Reg Chart</strong></td>
<td>Prints the color registration chart.</td>
</tr>
<tr>
<td><strong>Enter Number</strong></td>
<td><strong>Y</strong> -9--+9 Specifies the values that are found in the color registration chart for Yellow.</td>
</tr>
<tr>
<td></td>
<td><strong>M</strong> -9--+9 Specifies the values that are found in the color registration chart for Magenta.</td>
</tr>
<tr>
<td></td>
<td><strong>C</strong> -9--+9 Specifies the values that are found in the color registration chart for Cyan.</td>
</tr>
</tbody>
</table>

**Initialize NVM**

**Purpose:**

To initialize the NVM. After executing this function and rebooting the multifunction printer, all the default settings are reset to their default values.

**Values:**

<table>
<thead>
<tr>
<th>User Section</th>
<th>Initializes the user section.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System Section</strong></td>
<td>Initializes the system section.</td>
</tr>
</tbody>
</table>

**Init Print Meter**

**Purpose:**

To initialize the data for the print meter. When initializing the data on the print meter, the value of the meter resets to 0.

**Clear Storage**

**Purpose:**

To clear all files that are stored as Secure, Store, and Proof Print in the RAM disk.

**NOTE:** The Clear Storage menu is only displayed when 256 MB or more of additional print memory is installed on the multifunction printer and then the RAM Disk menu is set to Enable.
**Non-DELL Toner**

**NOTICE:** When Non-Dell toner is used, the multifunction printer may be severely damaged and may not be covered by your warranty.

**Purpose:**

To specify whether to use the refilled print cartridge or not. When this setting is on, you can use print cartridges provided by other companies.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Enables the use of refilled print cartridges.</td>
</tr>
<tr>
<td>Off*</td>
<td>Disables the use of refilled print cartridges.</td>
</tr>
</tbody>
</table>

**Adjust Altitude**

**Purpose:**

To adjust the height of the installation location of the multifunction printer.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0m*</td>
<td>Selects the value close to the height of the installation location of the multifunction printer.</td>
</tr>
<tr>
<td>1000m</td>
<td></td>
</tr>
<tr>
<td>2000m</td>
<td></td>
</tr>
<tr>
<td>3000m</td>
<td></td>
</tr>
</tbody>
</table>

**Secure Settings**

Use the Secure Settings menu to set a password to limit access to the menus. This prevents items from being change accidentally.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**See also:**
Panel Lock/Panel Lock Set

Purpose:

To limit access to the **Admin** menu.

Values:

<table>
<thead>
<tr>
<th>Disable*</th>
<th>Does not limit access to the <strong>Admin</strong> menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Limits access to the <strong>Admin</strong> menu.</td>
</tr>
</tbody>
</table>

Panel Lock/Change Password

Purpose:

To set a password to limit access to the **Admin** menu.

Values:

<table>
<thead>
<tr>
<th>0000-9999</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000*</td>
</tr>
</tbody>
</table>

Copy/Scan/Fax Lock/Copy/Scan/Fax Set

**NOTE:** Before enabling COPY/Scan/Fax Lock, ensure that Panel Lock is enabled.

Purpose:

To limit access to the **Copy**, **Scan**, and **Fax** menus.

Values:
<table>
<thead>
<tr>
<th>Disable*</th>
<th>Does not limit access to the <strong>Copy</strong>, <strong>Scan</strong>, and <strong>Fax</strong> menus.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Limits access to the <strong>Copy</strong>, <strong>Scan</strong>, and <strong>Fax</strong> menus.</td>
</tr>
</tbody>
</table>

**Copy/Scan/Fax Lock/Change Password**

**Purpose:**

To set a password to limit access to the **Copy**, **Scan**, and **Fax** menus.

**Values:**

<table>
<thead>
<tr>
<th>0000-9999</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000*</td>
</tr>
</tbody>
</table>

**Secure Receive/Secure Receive Set**

**NOTE:** Before enabling **Secure Receive**, ensure that **Panel Lock** is enabled.

**Purpose:**

To set a password when you print received fax documents.

**Values:**

<table>
<thead>
<tr>
<th>Disable*</th>
<th>Does not limit when you print received fax documents.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>Limits when you print received fax documents.</td>
</tr>
</tbody>
</table>

**Secure Receive/Change Password**

**Purpose:**

To set a password when you receive a fax.

**Values:**
Admin Reports

Use the Admin Reports menu to print various types of Admin Menu reports and lists.

Speed Dial

Purpose:
To print the Speed Dial report.

Protocol Monitor

Purpose:
To print Protocol Monitor report.

Address Book

Purpose:
To print Address Book report.

Server Address

Purpose:
To print server address report.

Fax Activity

Purpose:
To print fax activity report.
Fax Pending

Purpose:

To print pending faxes report.

Print Meter

Purpose:

To print the reports for the total number of pages printed. When printed using either the printer control panel or Dell Printer Configuration Web Tool, the report will be titled Print Volume Report.

Panel Language

Purpose:

To determine the language of the text on the operator panel screen.

Values:

<table>
<thead>
<tr>
<th>Language</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>English*</td>
<td>French</td>
</tr>
<tr>
<td>Italian</td>
<td>German</td>
</tr>
<tr>
<td>Spanish</td>
<td>Danish</td>
</tr>
<tr>
<td>Dutch</td>
<td>Norwegian</td>
</tr>
<tr>
<td>Swedish</td>
<td></td>
</tr>
</tbody>
</table>

Setting of Panel Lock

This feature prevents unauthorized personnel from changing settings made by the printer administrator. For regular printing, items can be selected from the menu and printer settings remain unchanged. For regular printing, items can be configured using the printer driver.
**NOTE:** Disabling the operator panel menus does not prevent access to the Stored Print and Tray Settings menus.

1. Press ▼ until >SETUP appears, and then press ✔.
2. Press ▼ until >Admin Menu appears, and then press ✔.
3. Press ▼ until >Secure Settings appears, and then press ✔.
4. Panel Lock is displayed. Press ✔.
5. Press ▼ until Enable appears, and then press ✔.
6. Press Back to return to the previous menu.
7. Press ▼ until >Change Password appears, and then press ✔.
8. Reenter the password to confirm the password that you entered, and then press ✔. The password has been changed.

**NOTE:** If you forget your password, turn off the multifunction printer. Then, while holding Menu, turn on the multifunction printer. Continue to hold Menu until the display indicates Ready to Init. This will recover the factory default panel password. Note that the password for Panel Lock, COPY/SCAN/FAX Lock, and Secure Lock is disabled. Also note that the settings for AddressBook and FAX are cleared.

**NOTE:** If panel lock is Enable, the factory-default panel password is 0000.

See also:

"Panel Lock/Change Password"

**Disabling Panel Lock**

**NOTE:** Before disabling Panel Lock, ensure that Copy/Scan/Fax Lock and Secure Receive is disabled.

1. Press ▼ until >SETUP appears, and then press ✔.
2. Press ▼ until >Admin Menu appears, and then press ✔.
3. Press ▼ until >Secure Settings appears, and then press ✔.
4. Panel Lock is displayed. Press ✔.
5. Panel Lock Set is displayed. Press ✔.
6. Press ➤ until Disable appears, and then press ✓.
Understanding Your Multifunction Printer Software

Printer Settings Utility

Use the *Drivers and Utilities* CD that came with your multifunction printer to install a combination of software programs, depending on your operating system.

The following software programs can only operate on Windows. They cannot operate on Macintosh, UNIX, or Linux.

Printing Status Window

The *Printing Status Window* alerts you when an error or warning occurs, for example, when a paper jam occurs or toner is running low.

You can select whether to display the *Printing Status Window* when printing. When an error occurs, the error message appears on the *Printing Status Window*.

Status Window

On the *Status Window*, you can check how much toner and paper are remaining or the configuration of options for the local printer.

Status Monitor Console

Use the *Status Monitor Console* to manage multiple *Status Window*.

- Select a multifunction printer from the list view (or *Printer Selection*) by clicking its name to open a *Status Window* or *Dell Printer Configuration Web Tool* for a particular printer.

- The *Status Monitor Console* displays the *Status Window* for local connections, or the *Dell Printer Configuration Web Tool* for network connections.

Dell Supplies Management System™
You can launch the **Dell Supplies Management System** dialog box from the **Printing Status window**, the **All Programs** menu, or the desktop icon. You can also launch it from the **Status Window** when a toner error occurs.

You can order consumables by phone or from the web.

1. Click **Start** ➔ **All Programs** ➔ **Dell Printers** ➔ **Additional Color Laser Software** ➔ **Dell Supplies Management System**.

   The **Dell Supplies Management System** window appears.

2. Select your multifunction printer from the **Select Printer Model** list.

3. If ordering from the Web:
   a. When you cannot get information from the multifunction printer automatically by two-way communication, a window that prompts you to type the Service Tag number appears. Type your Dell printer Service Tag number in the field provided. Your Service Tag number is located inside the front door of your multifunction printer.
   
   b. Select an URL from the **Select Reorder URL** list.
   
   c. Click **Visit Dell printer supplies ordering web site**.

4. If ordering by phone, call the number that appears under the **By Telephone** heading.

### User Setup Disk Creating Tool

The **User Setup Disk Creating Tool** program located in the **MakeDisk** folder of the **Utilities** folder on the **Drivers and Utilities** CD and the printer drivers located on the **Drivers and Utilities** CD are used to create driver installation packages that contain custom driver settings. A driver installation package can contain a group of saved printer driver settings and other data for things such as:

- Print orientation and Multiple Up (document settings)
- Watermarks
- Font references

If you want to install the printer driver with the same settings to multiple computers running the same operating system, create a setup disk in a floppy disk or in a server on the network. Using the setup disk that you have created will reduce the amount of work required when installing the printer driver.

- Install in advance the Dell™ Multifunction Color Laser Printer 3115cn printer driver in the computer on which the setup disk is to be created.
- The setup disk can only be used on the operating system on which the disk was created or computers
Running the same operating system. Create a separate setup disk for different types of operating systems.

**Software Update**

The firmware and/or driver updates can be downloaded from [http://support.dell.com](http://support.dell.com).

**Printer Settings Utility**

Using the Dell MFP Laser 3115cn Launcher window, you can set up scan system data options, and create and edit **Address Book** entries from your computer. You can also use Dell ScanCenter to organize, access, share, and manage documents and image files on your computer.

When you install the Dell software, the Dell MFP Laser 3115cn Launcher is automatically installed.

For information about installing the software, see "Networking".

**NOTE:** The computer must be connected to the device by USB in order to be able to retrieve address lists from the device.

To open the Dell MFP Laser 3115cn Launcher window:

1. Click **Start** → **Programs** → **Dell Printers** → **Dell MFP Color Laser Printer 3115cn** → **Launcher**.

   The Dell MFP Laser 3115cn Launcher window opens.

2. The Dell MFP Laser 3115cn Launcher window provides three buttons; **Address Book Editor**, **ScanButton Manager**, and **Dell ScanCenter**.

   To exit, click the X button at the top-right of the window.

   For details, click the **Help** button of each application.
Address Book Editor

Click the Address Book Editor button to create and edit *Address Book* entries.

1 Read the *Address Book* entries from the multifunction printer to the Address Book Editor.

2 Allows you to edit a selected *Address Book* entry in the edit dialog box.

3 Deletes a selected *Address Book* entry.

4 Displays *Address Book* entries.

ScanButton Manager

Click the ScanButton Manager button to configure the scan destination list that appears on the operator panel display when you press the *Start* button on the operator panel.
Dell ScanCenter

Dell ScanCenter is a PaperPort application that enables you to scan items and send them directly to PaperPort or other programs on your computer without first running PaperPort. For more information about using Dell ScanCenter, refer to PaperPort's Help menu.
Printing

This chapter covers tips for printing, how to print certain lists of information from your multifunction printer, and how to cancel a job.

- **Tips for Successful Printing**
- **Sending a Job to Print**
- **Canceling a Print Job**
- **Printing a Report Page**
- **Using the Print and Hold Function**

---

**Tips for Successful Printing**

**Tips on Storing Print Media**

Store your print media properly. For more information, see "Storing Print Media."

**Avoiding Jams**

- **NOTE:** Dell recommends that you try a limited sample of any print media you are considering using with the multifunction printer before purchasing large quantities.

By selecting appropriate print media and loading it properly, you are able to avoid most jams. See the following for instructions on loading print media:

- "Loading Print Media in Standard and Optional Trays" (which includes the standard 250-sheet tray and the optional 550-sheet paper feeder)
- "Loading the Multipurpose Feeder"
- "Avoiding Jams"

If you experience a jam, see "Clearing Jams" for instructions.

---

**Sending a Job to Print**

To support all of the printer features, use the printer driver. When you choose **Print** from a software program, a window representing the printer driver opens. Select the appropriate settings for the specific job you are sending to print. Print settings selected from the driver override the default menu settings selected from the printer operator panel.
You may need to click **Properties** or **Setup** from the initial Print box to see all of the available system settings you can change. If you are not familiar with a feature in the printer driver window, open the online Help for more information. Changing paper size or type that is different from type setting in the operator panel will require a user to change the operator panel tray setting before the job will print.

To print a job from a typical Windows application:

1. Open the file you want to print.
2. From the **File** menu, select **Print**.
3. Verify that the correct printer is selected in the dialog box. Modify the system settings as appropriate (such as the pages you want to print or the number of copies).
4. Click **Properties** or **Setup** to adjust system settings not available from the first screen, and then click **OK**.
5. Click **OK** or **Print** to send the job to the selected printer.

---

**Canceling a Print Job**

There are several methods for canceling a print job.

**Canceling From the Printer Operator Panel**

To cancel a print job after it has started printing:

1. Press **Cancel**.
2. Press ▲ or ▼ until >Print appears in the Job List screen, and then press ✔. Printing is canceled only for the current print job. All the following print jobs will continue to print.

**Canceling a Job From the Computer Running Windows**

**Canceling a Job From the Taskbar**

When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1. Double-click the printer icon.
   A list of print jobs appears in the printer window.
2. Select the job you want to cancel.
3. Press **Delete** on the keyboard.
Canceling a Job From the Desktop

1. Minimize all programs to reveal the desktop.

2. Click **Start**→**Printers and Faxes**.
   Click **Start**→**Control Panel**→**Hardware and Sound**→**Printers** (for Windows Vista).
   A list of available printers appears.

3. Double-click the multifunction printer you selected when you sent the job.
   A list of print jobs appears in the printer window.

4. Select the job you want to cancel.

5. Press **Delete** on the keyboard.

Printing a Report Page

By using the **Report** menu, you can print a various of settings for your multifunction printer including system settings, panel setting, and font list. The following describes two examples of printing from the **Report** menu.

**Printing a System Settings Page**

To verify detailed system settings, print a system settings page. A printed system settings page also allows you to verify whether or not options have been installed properly.

See "Understanding Menus" to identify the display and operator panel buttons if you need help.

1. Press ▼ until >SETUP appears, and then press ✓.

2. Press ▼ until >Reports appears, and then press ✓.

3. System Settings is displayed. Press ✓.

   The system settings page is printed.

The message System Settings Printing appears while the page prints. The multifunction printer returns to the standby mode after the system settings page prints.

If any other message appears when you print this page, see "Understanding Multifunction Printer Messages" for more information.

**Printing a Font Sample List**
To print samples of all the fonts currently available for your multifunction printer:

1. Press ▼ until >SETUP appears, and then press ✓.

2. Press ▼ until >Reports appears, and then press ✓.

3. Press ▶ until either PCL Fonts List or PS Fonts List appears.
   - Select PCL Fonts List to print a listing of the fonts available to the PCL.
   - Select PS Fonts List to print a listing of the fonts available to the Adobe PostScript 3™.

4. Press ✓.

The message PCL Fonts List Printing or PS Fonts List Printing appears and remains on the operator panel until the page prints. The multifunction printer returns to the standby mode after the font sample list prints.

---

**Using the Print and Hold Function**

When you send a job to the multifunction printer, you can specify in the driver that you want the multifunction printer to hold the job in memory. When you are ready to print the job, you must go to the multifunction printer and use the operator panel menus to identify which job in the memory you want to print. You can use this function to print a confidential job (Secure Print), or verify one copy before printing additional copies (Proof Print).

- **NOTE:** The multifunction printer holds the job until you delete it by using the operator panel or you turn off the multifunction printer. The data on memory is cleared when the multifunction printer is turned off.
- **NOTE:** Print and Hold functions require a minimum of 384 MB available print memory. Also, you need to configure the RAM disk settings on both the operator panel and the printer driver.
- **NOTE:** Depending on the documents, its job may be too big for the available memory. In this case, an error occurs.
- **NOTE:** If a document name is not assigned to your print job in the print driver, the job's name will be identified using the PC’s time and date of submission to distinguish it from other jobs you have stored under your name.

**Printing and Deleting Held Jobs**

Once held jobs are stored in print memory, you can use the printer operator panel to specify what you want to do with one or more of the jobs. You can select either Secure Print and Proof Print from "Stored Print". Then, you select your user name from a list. If you select Secure Print, you must type the password you specified in the driver when you sent the job. See "Secure Print" for more information.
From either the Secure Print or Proof Print menu items, you have three choices:

- Del after Print
- Print and Save
- Delete

**NOTE:** To send a job to print as Secure Printing or Proof Printing, select Secure Printing or Proof Printing in Job Type in the Paper/Output tab of the Properties dialog box.

**Printing Held and Proof Print Jobs**

1. Press ▼ until >SETUP appears, and then press ✔.
2. Press ▼ until >Reports appears, and then press ✔.
3. Press ▼ until >Stored Documents appears, and then press ✔.

**Store Print**

If you send a Store Print job, the multifunction printer does not print the job immediately, but stores the job in memory so you can print the job later. See "Printing and Deleting Held Jobs" for more information.

**NOTE:** The multifunction printer holds the job until you delete it by using the operator panel or you turn off the multifunction printer.

**NOTE:** When you select Del after Print, the held job is automatically deleted after printing.

**Proof Print**

If you send a Proof Print job, the multifunction printer prints one copy and holds the remaining copies you requested from the driver in print memory. Use Proof Print function to examine the first copy to see if it is satisfactory before printing the remaining copies.

See "Printing and Deleting Held Jobs" if you need help printing the additional copies stored in memory.

**NOTE:** The multifunction printer holds the job until you delete it by using the operator panel or you turn off the multifunction printer. The data on memory is cleared when the multifunction printer is turned off.

**NOTE:** When you select Del after Print, the held job is automatically deleted after printing.

**Secure Print**
When you send a job to the multifunction printer, you can specify a password from the driver. The password must be between 1 and 12 digits using numbers 0-9. The job is then held in print memory until you enter the same numeric password from the printer operator panel and choose to print or delete the job. This function is called "Store Print". This ensures that the job does not print until you are there to retrieve it, and no one else using the multifunction printer can print the job.

When you select Secure Print from Stored Print after selecting your user name, the following prompt is displayed:

Use Ten Key
[XXXXXXXXXXXXXXXXX]

Use the buttons on the operator panel to enter the numeric password associated with your confidential job. As you enter the password, the password you entered is displayed to ensure confidentiality.

If you enter an invalid password, the message Wrong Password appears. Wait three seconds, or Press ✓ or Cancel to return to the screen for user selection.

When you enter a valid password, you have access to all print jobs matching the user name and password you entered. The print jobs matching the password you entered appear on the screen. You can then choose to print or delete jobs matching the password you entered. (See "Printing and Deleting Held Jobs" for more information.)

- **NOTE:** The multifunction printer holds the job until you delete it by using the operator panel or you turn off the multifunction printer. The data on memory is cleared when the multifunction printer is turned off.

- **NOTE:** When you select Del after Print, the held job is automatically deleted after printing.
Copying

- Loading Paper for Copying
- Selecting Paper Tray
- Preparing a Document
- Making Copies From the Document Feeder Glass
- Making Copies From the ADF
- Setting Copy Options
- Changing the Default Settings
- Setting the Power Saver Timer Option

Loading Paper for Copying

The instructions for loading print materials are the same whether you are printing, faxing, or copying. For further details, see "Print Media Guidelines".

Selecting Paper Tray

After loading the print media for copy output, you have to select the paper tray you will use for the copy job.

1. Press ▲ until >COPY appears, and then press ✔.
2. Press ▼ until Paper Tray appears.
3. Press ◀ or ▶ until the desired tray appears, and then press ✔. You can select from Tray1, Tray2 (option) and Multipurpose Feeder.

Preparing a Document

You can use the document feeder glass or the Automatic Document Feeder (ADF) to load an original document for copying, scanning and sending a fax. Using the ADF, you can load up to 50 sheets of 75 g/m² (20 lb) documents for one job. Using the document feeder glass, you can load one sheet at a time.

**NOTE:** To get the best scan quality, especially for color or gray scale images, use the document feeder glass instead of the ADF.

When you use the ADF:
Do not load documents smaller than 5.59 by 5.83 in. (142 by 148 mm) or larger than 8.5 by 14 in. (216 by 356 mm).

Do not attempt to feed the following types of documents:

- Carbon-paper or carbon-backed paper
- Coated paper
- Onion skin or thin paper
- Wrinkled or creased paper
- Curled or rolled paper
- Torn paper

Remove all staples and paper clips before loading documents.

Ensure any glue, ink or correction fluid on the paper is completely dry before loading documents.

Do not load documents containing different sizes or weights of paper.

Do not load booklets, pamphlets, transparencies or documents having other unusual characteristics.

---

Making Copies From the Document Feeder Glass

**NOTE:** A computer connection is not required for copying.

**NOTE:** Remove any documents from the ADF before copying from the document feeder glass.

**NOTE:** Contaminants on the document feeder glass may cause black spots on the printout. For best results, clean the document feeder glass before use. See "Cleaning the scanner".

To make a copy from the document feeder glass:

1. Lift and open the document cover.
2. Place the document face down on the document feeder glass and align it with the registration guide on the top left corner of the glass.

3. Close the document cover.

**NOTE:** Leaving the cover open while copying may affect the copy quality and toner consumption.

**NOTE:** If you are copying a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then close the cover. If the book or magazine is thicker than 30 mm, start copying with the cover open.

4. Customize the copy settings including the number of copies, copy size, the contrast, and the image quality. See "Setting Copy Options". To clear the settings, use the **Cancel** button.

5. Press **Start**.
NOTE: You can cancel the copy job at any time. Press ▲ or ▼ to select >COPY in the Job List screen, and then press ✔.

## Making Copies From the ADF

**NOTICE:** Do not load more than 50 sheets into the ADF or allow more than 50 sheets to be fed to the ADF output tray. The ADF output tray should be emptied before it exceeds 50 sheets or your original documents may be damaged.

**NOTE:** A computer connection is not required for copying.

1. Load up to 50 sheets of 75 g/m² (20 lb) documents face up on the ADF with top edge of the documents in first. Then adjust the document guides to the correct document size.

2. Customize the copy settings including the number of copies, copy size, contrast, and image quality. See "Setting Copy Options". To clear the settings, use Cancel.

3. Press Start.

## Setting Copy Options

Set the following options for the current copy job before pressing Start to make copies.
NOTE: The copy options automatically return to their default status after copying.

Number of Copies

You can select the number of copies from 1 to 99.

1. Load the document(s) face up with top edge in first into the ADF.
   OR
   Place a single document face down on the document feeder glass.
   For details about loading a document, see "Loading an Original Document".
2. Press ▲ until >COPY appears, and then press ✔.
3. Press ▼ until Number of Copies appears.
4. Press ► to select the desired settings, and then press ✔.
5. Press Start to begin copying.

Color

You can select color or black and white copying.

1. Load the document to be copied on the document feeder glass, and close the cover.
2. Press ▲ until >COPY appears, and then press ✔.
3. Press ▼ until Color appears, and then press ✔.
4. Press ► to select the desired settings, and then press ✔.

<table>
<thead>
<tr>
<th>Color</th>
<th>Prints in the color mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black&amp;White</td>
<td>Prints in the black and white mode.</td>
</tr>
</tbody>
</table>
5. Press Start to begin copying.

Reduce/Enlarge

You can reduce or enlarge the size of a copied image, from 25 percent to 400 percent when you copy original documents from the document feeder glass or ADF.
NOTE: When you make a reduced copy, black lines may appear at the bottom of your copy.

To select from the predefined copy sizes:

1. Load the document to be copied on the document feeder glass, and close the cover.
2. Press ▲ until >COPY appears, and then press ✓ .
3. Press ▼ until Reduce/Enlarge appears.
4. Press ► to select the desired settings, and then press ✓ .

<table>
<thead>
<tr>
<th><strong>100%</strong></th>
<th><strong>Custom 100% (25-400%)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>129% (in inch), 129% (in mm)</td>
<td>50%</td>
</tr>
<tr>
<td>154% (in inch), 141% (in mm)</td>
<td>70% (in inch), 64% (in mm)</td>
</tr>
<tr>
<td>200%</td>
<td>78% (in inch), 81% (in mm)</td>
</tr>
</tbody>
</table>

NOTE: You can set the value in a percent for Custom.

5. Press Start to begin copying.

**Original Type**

The Original Type setting is used to improve the image quality by selecting the document type for the current copy job.

To select the image quality:

1. Load the document to be copied on the document feeder glass, and close the cover.
2. Press ▲ until >COPY appears, and then press ✓ .
3. Press ▼ until Original Type appears.
4. Press ► to select the desired settings, and then press ✓ .

| **Text&Photo** | Uses for documents with both text and photo/gray tones. |
| **Photo** | Uses for documents with photo or gray tones. |
| **Best** | Uses for documents with fine text of high resolution. |
| **Text** | Uses for documents with text. |
5. Press **Start** to begin copying.

**Lighter/Darker**

Adjust the contrast to make the copy lighter or darker than the original.

To adjust the contrast:

1. Load the document to be copied on the document feeder glass, and close the cover.
2. Press ‡ until >COPY appears, and then press ✓.
3. Press ‡ until Lighter/Darker appears.
4. Press ‡ to select the desired settings, and then press ✓.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Normal</strong>*</td>
<td>Works well with standard typed or printed documents.</td>
</tr>
<tr>
<td><strong>Darker1</strong></td>
<td>Works well with light print or faint pencil markings.</td>
</tr>
<tr>
<td><strong>Darker2</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Darker3</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Lighter3</strong></td>
<td>Works well with dark print.</td>
</tr>
<tr>
<td><strong>Lighter2</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Lighter1</strong></td>
<td></td>
</tr>
</tbody>
</table>

5. Press **Start** to begin copying.

**Sharpness**

Adjust the sharpness to make the copy sharper or softer than the original.

To adjust the sharpness:

1. Load the document to be copied on the document feeder glass, and close the cover.
2. Press ‡ until >COPY appears, and then press ✓.
3. Press ‡ until Sharpness appears.
4. Press ‡ to select the desired settings, and then press ✓.
### Sharpness

<table>
<thead>
<tr>
<th>Normal*</th>
<th>Does not make the copy sharper or softer than the original.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sharper</td>
<td>Makes the copy sharper than the original.</td>
</tr>
<tr>
<td>Softer</td>
<td>Makes the copy softer than the original.</td>
</tr>
</tbody>
</table>

5. Press **Start** to begin copying.

### Color Saturation

Adjusts the amount of color to make the colors deeper or lighter than the original.

To adjust the sharpness:

1. Load the document to be copied on the document feeder glass, and close the cover.
2. Press ▲ until >COPY appears, and then press ✔️.
3. Press ▼ until Color Saturation appears.
4. Press ► to select the desired settings, and then press ✔️.

<table>
<thead>
<tr>
<th>Normal*</th>
<th>Does not adjust the amount of color in a specified hue to make the colors deeper or lighter than the original.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Higher</td>
<td>Adjusts the amount of color in a specified hue to make the colors deeper than the original.</td>
</tr>
<tr>
<td>Lower</td>
<td>Adjusts the amount of color in a specified hue to make the colors lighter than the original.</td>
</tr>
</tbody>
</table>

5. Press **Start** to begin copying.

### Auto Exposure

Adjust the overall brightness to make the copy overexposed than the original.

To make the Auto Exposure copying:

1. Load the document to be copied on the document feeder glass, and close the cover.
2. Press ▲ until >COPY appears, and then press ✔️.
3. Press ▼ until Auto Exposure appears.
4. Press ► to select **On**, and then press ✔️.
3. Press **Start** to begin copying.

### Auto Fit

Automatically reduces or enlarges the original image to fit on the paper currently loaded in the multifunction printer.

This special copy mode can be applied when you load a document using only the document feeder glass. When this mode is On, a document loaded on the ADF cannot be copied. Set this mode to Off, if you want to copy documents loaded on the ADF.

**NOTE:** You cannot adjust the copy size using the Reduce/Enlarge menu item while the Auto Fit copying is enabled.

To make the Auto Fit copying:

1. Press ▲ until >COPY appears, and then press ✔.
2. Press ▼ until Auto Fit appears.
3. Press ▶ to select On, and then press ✔.
4. If necessary, customize the copy settings including the number of copies, contrast, and image quality. See "Setting Copy Options".
5. Press **Start** to begin copying.

### 2Sided

Print a two-sided original document onto one sheet of paper.
When you copy using this feature, the multifunction printer prints one side on the upper half of the paper and the other side on the lower half without reducing the original.

If the original document is larger than the printable area, some portions may not be printed.

To make the 2Sided copying:

1. Load the document(s) face up with top edge in first into the ADF.
   OR
   Place a single document face down on the document feeder glass.
   For details about loading a document, see "Loading an Original Document".

2. Press ▲ until >COPY appears, and then press ✔.

3. Press ▼ until 2Sided appears.

4. Press ▶ to select the desired setting, and then press ✔.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-&gt;1Sided*</td>
<td>Does not print a two-sided original document onto one sheet of paper.</td>
</tr>
<tr>
<td>LongEdgeBinding</td>
<td>Uses for long-edge binding when you perform duplex printing.</td>
</tr>
<tr>
<td>ShortEdgeBinding</td>
<td>Uses for short-edge binding when you perform duplex printing.</td>
</tr>
</tbody>
</table>

5. If necessary, customize the copy settings including the number of copies, contrast, and image quality. See "Setting Copy Options".

6. Press Start to begin copying.
   For the document loaded on the document feeder glass, the display asks if you want to load another page. Press ▶ to select Yes or No, and then press ✔.

7. If you select Yes, press ▶ to select Continue or Cancel, and then press ✔.

**NOTE:** If you press the Cancel button or if no buttons are pressed for about 60 seconds, the multifunction printer proceeds the copy job and returns to the standby mode.

**Multiple-Up**
Print two original images to fit onto one sheet of paper.

To make the Multiple-Up copying:

1. Load the document(s) face up with top edge in first into the ADF. OR
   Place a single document face down on the document feeder glass.
   For details about loading a document, see "Loading an Original Document".

2. Press ▲ until >COPY appears, and then press ✔.

3. Press ▼ until Multiple-Up appears.

4. Press ► to select the desired setting, and then press ✔.
<table>
<thead>
<tr>
<th>Off*</th>
<th>Does not perform multiple-up printing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Automatically reduces the original pages to fit onto one sheet of paper.</td>
</tr>
<tr>
<td>ID Copy</td>
<td>Prints the original pages onto one sheet of paper in the original size.</td>
</tr>
<tr>
<td>Manual</td>
<td>Prints the original pages onto the one sheet of paper in the size specified in Reduce/Enlarge.</td>
</tr>
</tbody>
</table>

5. If necessary, customize the copy settings including the number of copies, contrast, and image quality. See "Setting Copy Options".

6. Press Start to begin copying.
For the document loaded on the document feeder glass, the display asks if you want to load another page. Press ▶ to select Yes or No, and then press✔.

**Poster Copying**

Print an image onto several sheets of paper. You can paste the printed pages together to make one poster-size document.

This special copy mode can be applied when you load a document using only the document feeder glass.

**NOTE:** You cannot adjust the copy size using the Reduce/Enlarge option for making a poster.

To make the Poster copying:

1. Load the documents to be copied on the document feeder glass and close the cover.

2. Press ▲ until >COPY appears, and then press✔.
3. Press ▼ until Poster appears.

4. Press ► to select the desired setting, and then press ✓.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off*</td>
<td>Does not print an image onto several sheets of paper.</td>
</tr>
<tr>
<td>2 x 2</td>
<td>Prints an image onto 4 sheets of paper (2 by 2).</td>
</tr>
<tr>
<td>3 x 3</td>
<td>Prints an image onto 9 sheets of paper (3 by 3).</td>
</tr>
<tr>
<td>4 x 4</td>
<td>Prints an image onto 16 sheets of paper (4 by 4).</td>
</tr>
</tbody>
</table>

5. If necessary, customize the copy settings including the number of copies, contrast, and image quality. See "Setting Copy Options".

6. Press Start to begin copying. Your original document is divided into 9 portions. Each portion is scanned and printed one by one in the following order:

   1  2  3
   4  5  6
   7  8  9

**Image Repeat**

Print multiple image copies from the original document on a single page. The number of images is automatically determined by the original image and paper size.
This special copy mode can be applied when you load a document using only the document feeder glass.

**NOTE:** You cannot adjust the copy size using the Reduce/Enlarge menu item while the Image Repeat copying is enabled.

To make the Image Repeat copying:

1. Press ▲ until >COPY appears, and then press ✓.
2. Press ▼ until Image Repeat appears.
3. Press ▶ to select On, and then press ✓.
4. If necessary, customize the copy settings including number of copies, contrast, and image quality. See "Setting Copy Options".
5. Press Start to begin copying.

**Margin**

Specify the margin of the copy.

To make the Margin copying:

1. Load the document to be copied on the document feeder glass, and close the cover.
2. Press ▲ until >COPY appears, and then press ✓.
3. Press ▼ until Margin appears.
4. Press ▶ to select On, and then press ✓.
5. Press Start to begin copying.

**Collated**

Sort the copy job. For example, if you make two copies of three page documents, one complete three page document will print followed by the second complete document.

**NOTE:** Copy collate is only available when optional memory card is installed.
1. Load the document(s) face up with top edge in first into the ADF. OR
   Place a single document face down on the document feeder glass.
   For details about loading a document, see "Loading an Original Document".
2. Press ▲ until >COPY appears, and then press ✔.
3. Press ▼ until Collated appears.
4. Press ► to select Collated, and then press ✔.
5. If necessary, customize the copy settings including the number of copies, contrast, and image quality.
   See "Setting Copy Options".
6. Press Start to begin copying.
   For the document loaded on the document feeder glass, the display asks if you want to load another page. Press ► to select Yes or No, and then press ✔.
7. If you select Yes, press ► to select Continue or Cancel, and then press ✔.

---

### Changing the Default Settings

The Copy menu options, including contrast, and image quality can be set to the most frequently used modes. When you copy a document, the default settings are used unless they are changed by using the corresponding buttons on the operator panel.

**NOTE:** While you set copy options, pressing Cancel cancels the changed settings and returns to the default status.

To create your own default settings:

1. Press ▲ until >COPY appears, and then press ✔.
2. Press ▼ until >Copy Defaults appears, and then press ✔.
3. Press ▼ until the desired menu item appears.
4. Press ► to change the setting, and then press ✔.
5. Repeat steps 3 to 4, as needed.
6. To return to the standby mode, press Cancel.
Setting the Power Saver Timer Option

You can set the power saver timer for the multifunction printer. The multifunction printer waits before it restores the default copy settings, if you do not start copying after changing them on the operator panel.

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >System Settings appears, and then press ✓.
4. Press ▼ until >Power Saver Timer appears, and then press ✓.
5. Press ► to select Mode1 or Mode2, and then press ✓.

You can select from 5-60 minutes in Mode1 or 1-6 minutes in Mode2. Selecting Disable in Power Saver Mode2 means that the multifunction printer does not restore the default settings until you press Start to begin copying, or Cancel to cancel.

6. To return to the standby mode, press Cancel.
Scanning

- Scanning Overview
- Scanning From Operator Panel
- Scanning Using the TWAIN Driver
- Scanning Using the Windows Image Acquisition (WIA) Driver
- Using a Scanner on the Network
- Sending an E-Mail with the Scanned Image

Scanning Overview

Use your Dell™ Multifunction Color Laser Printer 3115cn to turn pictures and text into editable images on your computer.

PaperPort is a program that you organize, find and share all your paper and digital documents, and is supplied with your multifunction printer.

The resolution setting to use when you scan an item depends on the item type and how you plan to use the image or document after you scan it in to your computer. For the best results, use these recommended settings.

<table>
<thead>
<tr>
<th>Type</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents</td>
<td>300 dpi black-and-white or 200 dpi grayscale or color</td>
</tr>
<tr>
<td>Documents of poor quality or that contain small text</td>
<td>400 dpi black-and-white or 300 dpi grayscale</td>
</tr>
<tr>
<td>Photographs and pictures</td>
<td>100-200 dpi color or 200 dpi grayscale</td>
</tr>
<tr>
<td>Images for an inkjet printer</td>
<td>150-300 dpi</td>
</tr>
<tr>
<td>Images for a high-resolution printer</td>
<td>300-600 dpi</td>
</tr>
</tbody>
</table>

Scanning above these recommended resolutions may exceed the capabilities of the application. If you require a resolution above those recommend in the above table, you should reduce the size of the image by previewing (or pre-scan) and cropping before scanning the image.

**NOTE:** You can use PaperPort’s built-in OCR software to copy text from scanned documents so that you can use and edit the text in any text editing, word processing, or spreadsheet program. The OCR process requires textual images scanned at 150-600 dpi and 300 dpi or 600 dpi is recommended for graphics.

If you prefer to use another application, such as Adobe PhotoShop, you must assign the application to the multifunction printer by selecting it from the list of available applications via the Select Software button each time you start scanning. If you do not assign an application to the Select Software button, PaperPort is automatically selected when you start scanning. Refer to "Printer Settings Utility".
**NOTE:** PaperPort application for Microsoft Windows Vista may not be available, for more information see the Dell Support website at [www.support.dell.com](http://www.support.dell.com).

Dell ScanCenter is a PaperPort application that enables you to scan items and send them directly to PaperPort or other programs on your computer without first running PaperPort. Dell ScanCenter runs as a separate application from the Windows Start menu and displays the Dell ScanCenter bar. For more information about using Dell ScanCenter, refer to the PaperPort's Help menu.

Icons on the Dell ScanCenter bar represent the programs that are limited to PaperPort and to Dell ScanCenter. To scan and send an item to a program, click the program icon and then scan the item. Dell ScanCenter automatically starts the selected program when the scan is complete.

---

**Scanning From Operator Panel**

**NOTE:** Ensure that the multifunction printer is connected to the computer by using the USB cable.

1. Load the document(s) face up with top edge in first into the ADF.  
   OR  
   Place a single document face down on the document feeder glass.  
   For details about loading a document, see "Loading an Original Document ".

2. Do either of the following:
   - Scanning from the document feeder glass  
     Select **Document Glass** from ScanButton Manager.
   - Scanning from the ADF  
     Select **Document Feeder** from ScanButton Manager.

3. Press ▼ until >SCAN appears, and then press ✔ .

4. Press ▼ until >Scan to Application, and then press ✔ .

5. Press ▲ to select an application file to which you want to send the scanned image, and then press ✔ .

6. Press **Start**. The selected application window opens. Adjust the scan settings and start scan. For details, refer to the user's guide of the application.

**NOTE:** If the following dialog box appears on your PC, select **3115cn MFP Scan Button Manager**, and then click **OK**.
Scanning Using the TWAIN Driver

Your multifunction printer supports the TWAIN driver for scanning images. TWAIN is one of the standard components provided by Microsoft® Windows® 2000, Windows XP, Windows Server® 2003, Windows Server 2008, and Windows Vista®, and works with various scanners.

To scan an image from the drawing software:

1. Load the document(s) face up with top edge in first into the ADF.
   OR
   Place a single document face down on the document feeder glass.
   For details about loading a document, see "Loading an Original Document ".

2. Start the drawing software, such as Imaging for Windows.

   **NOTE:** When you use Windows XP, Windows Server 2003, or Windows Vista, use PaperPort instead of Imaging.

3. Click File → Scan or Get Photo...

   The Available Scanner dialog box appears.

   **NOTE:** If the Available Scanner dialog box does not appear, click the Select... button in the left pane of the Scan or Get Photo window.

4. In the Available Scanner dialog box, select Dell MFP Laser 3115cn Scanner, and then click OK.

5. In the left pane of the Scan or Get Photo window, select the Display scanner dialog box check box, and then click Scan.
The **Dell MFP Laser 3115cn Scanner** window appears.

![Scanner Window](image)

**NOTE:** The illustration may vary for different operating systems.

6. Select your scanning preferences and click **Preview** to display the preview image.

7. Select the desired properties from the **Image Quality** and **Image Options** tabs.

8. Click **Scan** to start scanning.

9. Enter a picture name, and select a file format and destination to save the picture.

10. Follow the on-screen instructions to edit the picture after it is copied to your computer.

---

**Scanning Using the Windows Image Acquisition (WIA) Driver**

Your multifunction printer also supports the WIA driver for scanning images. WIA is one of the standard components provided by Microsoft® Windows Vista®, Windows® XP and works with digital cameras and scanners. Unlike the TWAIN driver, the WIA driver allows you to scan an image and easily manipulate those images without using additional software.

**NOTE:** WIA is not available for Windows 2000.

**NOTE:** Ensure that the multifunction printer is connected to the computer by using the USB cable.

To scan an image from the drawing software:
1. Load the document(s) face up with top edge in first into the ADF.
   OR
   Place a single document face down on the document feeder glass.
   For details about loading a document, see "Loading an Original Document ".

2. Start the drawing software, such as Microsoft Paint.


3. Click File → From Scanner or Camera. 
   The Scan using Dell MFP Laser 3115cn window appears.

   ![Scan using Dell MFP Laser 3115cn window](image)

   NOTE: The illustration may vary for different operating systems.

4. Select your scanning preferences and click Adjust the quality of the scanned picture to display the Advanced Properties dialog box.

5. Select the desired properties including brightness and contrast, and then click OK.

6. Click Scan to start scanning.

7. Enter a picture name, and select a file format and destination to save the picture.

8. Follow the on-screen instructions to edit the picture after it is copied to your computer.

To scan an image from Control Panel:

1. Load the document(s) face up with top edge in first into the ADF.
   OR
   Place a single document face down on the document feeder glass.
   For details about loading a document, see "Loading an Original Document ".

2. Click **Start → Control Panel → Printers and Other Hardware → Scanners and Cameras**.

3. Double-click the printer icon. The **Welcome to Scanners and Camera Wizard** launches.

4. Click **Next** to display the **Scanner and Camera Wizard**.

![Scanner and Camera Wizard](image)

**NOTE:** The illustration may vary for different operating systems.

5. Select your scanning preferences and click **Next**.

6. Enter a picture name, and select a file format and destination to save the picture.

7. Click **Next** to start scanning.

8. Follow the on-screen instructions to edit the picture after it is copied to your computer.

---

**Using a Scanner on the Network**

The Scan to Server/Computer feature allows you to scan a document from the Dell MFP 3115cn and store it in a folder on your computer through File Transfer Protocol (FTP) or Server Message Block (SMB). To retrieve the scanned document from the computer:

1. Create a shared folder in your computer for Scan to Computer. See "Sharing a Folder From Your Computer " for more details.

2. Setup the address book through the **Dell Printer Configuration Web Tool**. See "Setting Up the Address Book " for more details.

3. Create a shared folder with sub-folder in your computer for Scan to Computer. See "Sharing a Folder With Sub-folder From Your Computer " for more details.

5. Start to send the scanned file on the network. See "Start to send the scanned file on the Network " for more details.

Here are some additional instructions if you need to create a password for your user account or locate the IP address of your computer.

- Create a Password For Your User Login Account.
- Locate the IP Address Of Your Computer.

**Sharing a Folder From Your Computer**

If you are using Microsoft® Windows® XP or Windows 2000, you can share a folder with the following instructions:

1. Create a folder in the desired directory on your computer (Example of folder name, MyShare ).
2. Right-click on the folder, and then select **Properties** .
3. The **Properties** dialog box appears, click on the **Sharing** tab, and then select **Share this folder** .
4. Enter a shared name in the **Share name** box.

**NOTE:** Write down this shared name because you will use this name in the next setting procedure.
5. Click on **Permissions** to create a write permission for this folder.

6. Click **Add**.

7. Enter your user login name in the **Enter the object names to select** box (Example of user login name, **Myself**).

   **NOTE:** User login account with empty password will be rejected in the Scan to Folder authentication. Ensure that all user login accounts have a valid and non-empty password. See "Create a Password for Your User Login Account" for details on how to assign a password for your user login account.

8. Click **OK**.

   **NOTE:** Do not use **Everyone** as the user login name.
9. Click on the user login name that you have just entered. Select **Full Control** check box. This will grant you permission to send the document into this folder.

If you are using Windows Vista® or Windows Server 2008, you can share a folder with the following or similar instructions:

1. Create a folder in the desired directory on your computer (Example of folder name, MyShare).
2. Right-click on the folder, and then select **Properties**.
3. The **Properties** dialog box appears, click on the **Sharing** tab, and then select **Advanced Sharing**.
4. Select the **Share this folder** check box.

5. Enter a shared name in the **Share name** box.

**NOTE:** Note down the shared name as you need to use this name in the next setting procedure.

6. Click on **Permissions** to create a write permission for this folder.
7. Click **Add**.

8. Enter your user login name in the **Enter the object names to select** box (Example of user login name, Myself).

![Select Users or Groups dialog box](image1.png)

**NOTE:** User login account with empty password will be rejected in the Scan to Folder authentication. Ensure that all user login accounts have a valid and non-empty password. See "Create a Password for Your User Login Account" for details on how to assign a password for your user login account.

9. Click **OK** when you are done.

10. Click on the user login name that you have just entered. Select **Full Control** check box. This will grant you permission to send the document into this folder.

![Permissions for MyShare dialog box](image2.png)

**NOTE:** Do not use **Everyone** as the user login name.
Setting Up the Address Book

To setup the Scan to Server/Computer address book through the network, you will first need to locate the IP address of the Dell MFP Laser 3115cn. You can obtain this IP address from the System Settings report by performing the following steps from the operator panel:

1. When the printer is Ready (Copy, Scan, Fax appears in the LCD), press ▼ until SETUP is indicated, then press ✓.
2. Press ▼ until Reports appears, then press ✓.
3. When System Settings is indicated, then press ✓ and a System Settings report will be printed.

Once you have obtained the IP address of the Dell MFP Laser 3115cn, you can setup the Address book by performing the following steps from a web browser.

1. Open a web browser.
2. Type in the IP address of the printer and click Go. The printer’s web page appears.
3. Click Address Book, then click the Server Address tab, then click the Create button. If a security login dialog box appears, type in the correct User name and Password. If you access the Address Book first time, enter the following defaults value:

   User name: Enter "admin".
   Password: Leave blank.
To fill in the fields, enter the information as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td>Enter a friendly name that you want it to appear on the address book.</td>
</tr>
<tr>
<td>Server Type:</td>
<td>Select SMB if you storing the document in a shared folder from your Microsoft Windows operating system. Select FTP if you have a FTP server.</td>
</tr>
<tr>
<td></td>
<td>NOTE: FTP Server depends on Microsoft Internet Information Services (IIS) and may not be installed on your computer. Please refer to Microsoft document for detailed instructions on how to setup FTP server.</td>
</tr>
<tr>
<td>Server Address:</td>
<td>Enter the IP address of the computer or the FTP server that you have shared out. (Refer to &quot;Locate the IP Address of Your Computer &quot; for more information)</td>
</tr>
<tr>
<td>Server Port Number:</td>
<td>Enter the Server Port Number. If you are unsure, you can enter the default value of 139 for SMB and 21 for FTP.</td>
</tr>
<tr>
<td>Login Name:</td>
<td>Enter the user account name that has access to the shared folder on your computer or FTP server.</td>
</tr>
<tr>
<td>Login Password:</td>
<td>Check on Enable Password and enter the password corresponding to the above login name.</td>
</tr>
<tr>
<td></td>
<td>NOTE: Empty password is not valid in the Scan to Computer feature. Please ensure that the password is set correctly.</td>
</tr>
</tbody>
</table>
that you have a valid password for the user login account. (Refer to "Create a Password for Your User Login Account" for details on how to add a password in your user login account).

**Share Name:** Enter the name of the shared folder on the recipient computer. For SMB only.

**Server Path:** Enter the path where you want the scanned document to be stored. Ensure that the path is already created in the shared folder or FTP server.

4. Click the **Apply New Settings** button.

Example of an entry for Scan to Computer, SMB.

```plaintext
Server Address

<table>
<thead>
<tr>
<th>ID</th>
<th>11 (New Registration)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>MyShareName</td>
</tr>
<tr>
<td>Server Type</td>
<td>FTP</td>
</tr>
<tr>
<td>Server Address</td>
<td>10.10.10.10</td>
</tr>
<tr>
<td>Server Port Number</td>
<td>FTP(21), SMB(135)</td>
</tr>
<tr>
<td>Login Name</td>
<td>Myself</td>
</tr>
<tr>
<td>Login Password</td>
<td>*****</td>
</tr>
<tr>
<td>Share Name</td>
<td>MyShare</td>
</tr>
<tr>
<td>Server Path</td>
<td>FTP(21: pubshare), SMB(135: finance)</td>
</tr>
</tbody>
</table>
```

Example of an entry for Scan to Server, FTP.
NOTE: Ensure that you enter an IP address in the **Server Address** box correctly.

### Scan to Computer/Server Through Wireless Setup

**NOTE:** This step can be performed only if you have the Wireless Network Card (Sold separately).

If you are intending to perform Scan to Computer/Server through your wireless network connection, you will need to configure the scan network path as follows:

1. Open a web browser.
2. Type in the IP address of the printer and click **Go**. The printer's web page appears.
3. Click **Printer Settings**, then click the **Printer Settings** tab, then click the **Scan Defaults** button. If a security login dialog box appears, type in the correct User name and Password.
4. Change from **Wired** to **Wireless** in the **Network Port** entry.
Sharing a Folder With Sub-folder From Your Computer

To create and share a folder, follow the steps found in "Sharing a Folder From Your Computer ". To add sub-folder, you will need to create a sub-folder from your share folder.

1. Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2. From the folder, create your desired sub-folder. (Example of sub-folder name, MyPic\John. You should now see MyShare\MyPic\John in your directory)

After you have created a folder and sub-folder, you will now need to setup the Address Book. See "Setting Up the Address Book " for the details.

Example of an entry for Scan to Computer with sub-folder, SMB.
**NOTE:** Ensure that you enter an IP address in the **Server Address** box correctly.

**Start to send the scanned file on the Network**

1. From the operator panel, press ▼ until >SCAN appears, and then press ✓.

2. Press ▼ until Scan to Network appears.

3. Press ◄ or ► to select the option you selected in "Setting Up the Address Book ", and then press ✓.
   
   **Server:** Stores the scanned image on the server by using the FTP protocol.
   
   **Computer:** Stores the scanned image on the computer by using the SMB protocol.
   
   **Search Address:** Select the server address registered in Address Book.

   **NOTE:** Users need to be registered before you can select Server/Computer on the operator panel.

4. Press **Start** to send the scanned files.
Setting Problems

| SMB/FTP Error 016-781 Scan Press | · Ensure the server address is correct.  
|                                   | · If the server address is correct, then change the settings for the firewall. |
| Login Error 016-782 Scan Press | · Ensure the shared name or password is correct. |
| SMB/FTP Error 016-783 Scan Press | · Ensure the specified server path name and access right to the folder are correct.  
|                                   | · Ensure the server path is set correctly. |
| SMB/FTP Error 016-784 Scan Press | · Change the access rights for the shared folder. |

Create a Password for Your User Login Account

The Scan to Computer/Server feature requires a user login account with a valid and non-empty password for authentication. If you do not use a password for your user login, you can create a password on your User Login Account with the following instructions.

For Microsoft Windows XP and Windows 2000:

1. Click **Start** → **Control Panel** → **User Accounts**.
2. Click **Change an account**.
3. Click **Create a password** and add in a password for your user login account.

For Windows Vista:

1. Click **Start** → **Control Panel**.
2. Click **User Accounts and Family Safety**.
3. Click **User Accounts**.
4. Click **Create a password for your account** and add in a password for your user login account.

For Windows Server 2008:

1. Click **Start** → **Control Panel**.
2. Double-click **User Accounts**.
3. Click **Create a password** for your account and add in a password for your user login account.
Locate the IP Address of Your Computer

You can locate the IP address of your computer with the following instructions.

1. For Windows 2000/Windows Server 2003/Windows Server 2008: Click **Start** → **Run**.
   For Windows Vista: Click **Start** → **All Programs** → **Accessories** → **Run**.

2. Type `cmd` in the text field and click **OK**. A command prompt window will open.

3. Type `ipconfig` and press **Enter**.

4. Locate IP Address and note down the IP Address XXX.XXX.XXX.XXX

Sending an E-Mail with the Scanned Image

To send an e-mail attached with the scanned image from your multifunction printer, follow the steps below:

- Set E-Mail Alert
- Register a user
- Start to send e-mail with the scanned file

Setting E-Mail Alert

1. Form the Dell Printer Configuration Web Tool, click **E-Mail Alert**.

   The E-mail Server Alert Settings page appears.

   ![E-Mail Server Settings](image)

   - Specify the settings for E-Mail Alert as follows:

     Primary SMTP gateway: Enter the IP address of the e-mail server.

     E-Mail Send Authentication: Specify Invalid to enable the e-mail server.

   **NOTE:** If the error message including 016-506 or 016-764 is displayed, contact your server administrator for the settings for E-Mail Send Authentication.
3. Click the **Apply New Settings** button.

### Registering a New User

1. Form the Dell Printer Configuration Web Tool, click **Address Book**, and then click the **E-Mail Address** tab.
2. Click the **Create** button.

The E-mail Server Settings page for registering a new user appears.

3. Enter the following:
   - Name
   - Address
4. Click the **Apply New Settings** button.

### Start to send e-mail with the scanned file

1. From the operator panel, press ▼ until >SCAN appears, and then press ✔.
2. Press ▼ until Scan to E-Mail appears, and then press ✔.
3. Press ▲ or ▼ to select the setting listed below, and then press ✔.
   - Enter E-Mail: Type the e-mail address directly.
   - Address Book: Select the e-mail address registered in the **Address Book**.

**NOTE:** Users need to be registered before you can select Address Book on the operator panel.

4. Press ▶ to select <TO> or <BCC>.
5. Press **Start** to send e-mail.
## Setting Problems

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail Size Limits 016-985</td>
<td>Change the file format and resolution.</td>
</tr>
<tr>
<td>SMTP Error 016-764</td>
<td>Ensure the SMTP server address is correct.</td>
</tr>
<tr>
<td>Address Error 016-767</td>
<td>Ensure the e-mail address is correct.</td>
</tr>
</tbody>
</table>
Faxing

- FAX Languages Setting Procedure
- Setting the Machine ID
- Using the Number Keypad to Enter Characters
- Setting the Time and Date
- Changing the Clock Mode
- Setting Sounds
- Sending a Delayed Fax
- Specifying the Fax Settings
- Sending a Fax
- Sending a Fax from the driver (Direct Fax)
- Receiving a Fax
- Color Fax
- Automatic Dialing
- Other Ways to Fax

FAX Languages Setting Procedure

1. Using Fax Initial Setup in Windows Installer is recommended. Please follow to the procedure of the display.

2. When you are not using Windows OS, set directly from the operator panel. Please follow to the procedure bellow.

   a. Press \downarrow\ until >Country appears from Fax Settings, and then press ✔.

   b. Select the country you use. (Factory default value: United States)

Initialization is required after you set the country. When the restart verification of system is displayed, please select YES. After restart, the printer returns to the main screen.

   c. Press \downarrow\ until >Clock Settings appears from System Settings, and then press ✔.

   d. Specify the date using the number keypad.

   e. Specify the time using the number keypad.

   f. Specify the TimeZone using \rightarrow\ or \leftarrow. (Factory default value: -5:00)

   **NOTE:** In case of either one, when you configure the languages setting, the information, which is registered to the device, is initialized.
Setting the Machine ID

In most countries, you are required by law to indicate your fax number on any fax you send. The Machine ID, containing your telephone number and name or company name, will be printed at the top of each page sent from your multifunction printer.

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >Fax Settings appears, and then press ✓.
4. Press ▼ until >G3ID appears, and then press ✓.
5. Enter your fax number using the number keypad.

NOTE: If you make a mistake while entering numbers, press ◀ to delete the last digit.

6. Press ✓ when the number on the display is correct.
7. Press ▼ until >Send Header Name appears, and then press ✓.
8. Enter your name or company name using the number keypad.
   You can enter alphanumeric characters using the number keypad, including special symbols by pressing the 0 button.
   For details on how to use the number keypad to enter alphanumeric characters, see "Using the Number Keypad to Enter Characters ".
9. Press ✓ when the name on the display is correct.
10. Press Cancel to return to the standby mode.

Using the Number Keypad to Enter Characters

As you perform various tasks, you may need to enter names and numbers. For example, when you set up your multifunction printer, you enter your name or your company’s name and telephone number. When you store speed dial or group dial numbers, you may also need to enter the corresponding names.
When prompted to enter a letter, press the appropriate button until the correct letter appears on the display.
For example, to enter the letter O, press 6.

Each time you press 6, the display shows a different letter, M, N, O and finally 6.

To enter additional letters, repeat the first step.

Press ✓ when you are finished.

### Keypad Letters and Numbers

<table>
<thead>
<tr>
<th>Key</th>
<th>Assigned numbers, letters or characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>@ : . / 1</td>
</tr>
<tr>
<td>2</td>
<td>a b c A B C 2</td>
</tr>
<tr>
<td>3</td>
<td>d e f D E F 3</td>
</tr>
<tr>
<td>4</td>
<td>g h I G H I 4</td>
</tr>
<tr>
<td>5</td>
<td>j k l J K L 5</td>
</tr>
<tr>
<td>6</td>
<td>m n o M N O 6</td>
</tr>
<tr>
<td>7</td>
<td>p q r s P Q R S 7</td>
</tr>
<tr>
<td>8</td>
<td>t u v T U V 8 t</td>
</tr>
<tr>
<td>9</td>
<td>w x y z W X Y Z 9 w</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>*</td>
<td>_ ~</td>
</tr>
<tr>
<td>#</td>
<td>@ . \ _ ! &quot; # $ % &amp; ' ~</td>
</tr>
</tbody>
</table>

### Changing Numbers or Names

If you make a mistake while entering a number or name, press ← to delete the last digit or character. Then enter the correct number or character.
**Inserting a Pause**

For some telephone systems, it is necessary to dial an access code and listen for a second dial tone. A pause must be entered in order for the access code to function. For example, enter the access code 9 and then press **Pause** before entering the telephone number. "-" appears on the display to indicate when a pause is entered.

---

**Setting the Time and Date**

**NOTE:** It may be necessary to reset the correct time and date if loss of power to the multifunction printer occurs.

To set the time and date:

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >System Settings appears, and then press ✓.
4. Press ▼ until >Clock Settings appears, and then press ✓.
5. Press ▼ until >Set Date appears, and then press ✓.
6. Enter the correct date using the number keypad.

**NOTE:** If you make a mistake while entering numbers, press ◀ to reenter the digit.

7. Press ✓ when the date on the display is correct.
8. Press ▼ until >Set Time appears, and then press ✓.
9. Enter the correct time using the number keypad.
10. Press ✓ when the time on the display is correct.
11. Press Cancel to return to the standby mode.

**NOTE:** The multifunction printer beeps and does not allow you to proceed to the next step if a wrong number is entered.

---

**Changing the Clock Mode**
You can set the current time using either the 12-hour or the 24-hour format.

1. Press ▼ until SETUP appears, and then press ✓.

2. Press ▼ until >Admin Menu appears, and then press ✓.

3. Press ▼ until >System Settings appears, and then press ✓.

4. Press ▼ until >Clock Settings appears, and then press ✓.

5. Press ▼ until >Time Format appears, and then press ✓.

6. Press ▲ until the desired format appears, and then press ✓.

7. Press Cancel to return to the standby mode.

---

**Setting Sounds**

**Speaker, Ringer, Key Sounds and Alarm Sounds**

1. Press ▼ until SETUP appears, and then press ✓.

2. Press ▼ until >Admin Menu appears, and then press ✓.

3. Press ▼ until >System Settings appears, and then press ✓.

4. Press ▼ until >Alert Tone appears, and then press ✓.

5. Press ▼ until the desired tone appears, and then press ✓.

6. Press ▲ until the desired volume appears, and then press ✓.
   The multifunction printer works normally even if the ringer is turned off.

7. Press Cancel to return to the standby mode.

---

**Speaker Volume**

⚠️ **NOTE:** You can turn on/off the speaker only when the telephone line is connected.

1. Press ▼ until >FAX appears, and then press ✓.

2. Press ▼ until >OnHook appears.
3. Press \( \text{Towards} \) to select \( \text{On} \), and then press \( \checkmark \).

4. Press \textbf{Cancel} to return to the standby mode.

---

**Sending a Delayed Fax**

The Delayed Start mode can be used to save scanned documents for transmission at a specified time in order to take advantage of lower long distance rates.

1. Load the document(s) face up with top edge in first into the ADF.
   OR
   Place a single document face down on the document feeder glass.
   For details about loading a document, see "Loading an Original Document".

2. Press \( \downarrow \) until \( >\text{FAX} \) appears, and then press \( \checkmark \).

3. Adjust the document resolution to suit your fax needs (see "Adjusting the Document Resolution"). If you need to change the contrast, see "Lighter/Darker".

4. Press \( \downarrow \) until \( >\text{Delayed Start} \) appears.

5. Press \( \rightarrow \) to select \( \text{On} \), and then press \( \checkmark \).

6. Enter the start time using the number keypad.

7. Enter the number of the remote machine using the number keypad, and then press \( \checkmark \).
   To enter the number, you can use speed dial or group dial numbers. For details, see "Automatic Dialing".
   Press Start to scan data.

Once Delayed Start mode is activated, your multifunction printer stores all of the documents to be faxed into its memory and sends them at the programmed time. After faxing in the Delayed Start mode is complete, the data in the memory is cleared.

---

**Specifying the Fax Settings**

**Changing the Fax Settings Options**

1. Press \( \downarrow \) until \( >\text{SETUP} \) appears, and then press \( \checkmark \).

2. Press \( \downarrow \) until \( >\text{Admin Menu} \) appears, and then press \( \checkmark \).

3. Press \( \downarrow \) until \( >\text{Fax Settings} \) appears, and then press \( \checkmark \).

4. Press \( \downarrow \) until the desired menu item appears, and then press \( \checkmark \).
5. Use \( \uparrow \) to find the status or use the number keypad to enter the value for the option you have selected.

6. Press \( \checkmark \) to save the selection.

7. Press Back to return to the previous screen.

8. If necessary, repeat steps 4 through 7.

9. To return to the standby mode, press Cancel.

**Available Fax Settings Options**

You can use the following settings options for configuring the fax system:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interval Timer</strong></td>
<td>You can specify the interval time (3-255 minutes) of the resend attempts.</td>
</tr>
<tr>
<td><strong>Number of Redial</strong></td>
<td>You can specify the number of redial attempts, 0-9. If you enter 0, the multifunction printer will not redial.</td>
</tr>
<tr>
<td><strong>Int. of Redial</strong></td>
<td>Your multifunction printer can automatically redial a remote fax machine if it was busy. Intervals from 1-15 minutes can be entered.</td>
</tr>
<tr>
<td><strong>Ans Select</strong></td>
<td>You can select the default fax receiving mode.</td>
</tr>
<tr>
<td></td>
<td>· TEL Mode (manual receive mode): Automatic fax reception is turned off. You can receive a fax by picking up the handset of the external telephone and then pressing the remote receive code, or by setting OnHook to On (you can hear voice or fax tones from the remote machine) and then pressing Start.</td>
</tr>
<tr>
<td></td>
<td>· FAX Mode (automatic receive mode)</td>
</tr>
<tr>
<td></td>
<td>· TEL/FAX Mode: When the multifunction printer receive an incoming a fax, the external telephone rings for the time specified in Auto Ans. TEL/FAX, and then the multifunction printer automatically receive a fax. If incoming data is not a fax, the multifunction printer beeps from the internal speaker.</td>
</tr>
<tr>
<td></td>
<td>· Ans/FAX Mode: The multifunction printer can share one telephone line with an answering machine. In this mode, the multifunction printer will monitor the fax signal and pick up the line if there are fax tones. If the phone communication in your country is serial, this mode is not available.</td>
</tr>
<tr>
<td></td>
<td>· DRPD Mode: Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive ring service must be installed on your telephone line by the telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern.</td>
</tr>
<tr>
<td><strong>Auto Answer Fax</strong></td>
<td>The multifunction printer answers an incoming call and automatically goes into the receive mode. The number of rings before the multifunction printer answers can be set in the Auto Answer Fax option. If the user memory is full, the multifunction printer is changed to the Tel mode.</td>
</tr>
<tr>
<td><strong>Auto Ans. TEL/FAX</strong></td>
<td>The multifunction printer can share one telephone line with an external telephone. In this mode, the multifunction printer will monitor the fax signal and pick up the line if there are fax tones. If the phone communication in your country is serial, this mode is not available.</td>
</tr>
<tr>
<td><strong>Auto Ans.</strong></td>
<td>The multifunction printer can share one telephone line with an answering machine. In this mode, the multifunction printer will monitor the fax signal and pick up the line if there are fax tones. If the phone communication in your country is serial, this mode is not available.</td>
</tr>
<tr>
<td><strong>Ans/FAX</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Line Monitor</strong></td>
<td>You can specify the volume of the internal speaker.</td>
</tr>
<tr>
<td><strong>Ring Tone Volume</strong></td>
<td>You can specify the volume for the incoming faxes.</td>
</tr>
</tbody>
</table>
| **Line Type** | You can select the default line type.  
- PSTN  
- PBX |
| **Dialing Type** | You can select the dialing type.  
- PB  
- DP (10PPS)  
- DP (20PPS) |
| **DM Prevention** | Using the DM Prevention feature, the system only accepts faxes from the remote stations registered in the speed dial. This feature is useful for blocking any unwanted faxes.  
Select **off** to turn the feature off. Anybody can send you a fax.  
Select **on** to turn the feature on. |
| **Remote Receive** | You can receive a fax by pressing the remote receive code on the external telephone after picking up the handset of the telephone. |
| **Remote Rcv Tone** | You can specify the tone when Remote Receive is set to **On**. |
| **Duplex Print** | You can use duplex printing when you receive a fax. This option is available only when the optional duplexer is installed on your multifunction printer. |
| **Send Header** | Prints the sender record at the head of the fax.  
Select **off** to turn this feature off.  
Select **on** to turn this feature on. |
| **Send Header Name** | Specifies the sender name in the sender report. |
| **G3ID** | Contains your telephone number, which is printed at the top of each page sent from your multifunction printer. This feature is available when you set Send Header to **On**. |
| **Local Name** | Contains your name or company name, which is printed on the report sheet. |
| **DRPD Pattern** | Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive ring service must be installed on your telephone line by the telephone company. After the telephone company has provided a separate number for faxing with a distinctive ring pattern, configure the fax setup to monitor for that specific ring pattern. |
| **Forward Settings** | You can set your multifunction printer to forward incoming faxes to another fax number during a specified time period. When a fax arrives at your multifunction printer, it is stored in the memory. Then, the multifunction printer dials the fax number that you have specified and sends the fax.  
Select **Trans. at Error** to forward the incoming faxes when an error occurs. |
Select **Trans. Always** to always forward the incoming faxes. Select **Not Trans.** not to forward incoming faxes. You can set the fax number to which faxes are forwarded. Then, you can enter the start time and/or the end time. The Print Local Copy option allows you to set the multifunction printer to print the fax, if fax forwarding is completed with no error.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fwd. Settings Num</strong></td>
<td>You can set the number of the multifunction printer to always forward all of the incoming faxes to the specified destination.</td>
</tr>
<tr>
<td><strong>Fwd. Set Print</strong></td>
<td>Prints all of the ongoing faxes when you can set the multifunction printer to always forward the faxes to the specified destination.</td>
</tr>
<tr>
<td><strong>Prefix Dial</strong></td>
<td>You can select whether or not to add the prefix number when you send a fax.</td>
</tr>
<tr>
<td><strong>Prefix Dial Num</strong></td>
<td>You can set a prefix dial number up to five digits. This number dials before any auto dial number is started. It is useful for accessing the PABX exchange.</td>
</tr>
<tr>
<td><strong>Discard Size</strong></td>
<td>When receiving a document as long as or longer than the paper installed in your multifunction printer, you can set the multifunction printer to discard any excess at the bottom of the page. If the received page is outside the margin you set, it will print on two sheets of paper at the actual size. When the document is within the margin and the Auto Reduction feature is turned on, the multifunction printer reduces the document to fit it onto the appropriate sized paper and discard does not occur. If the Auto Reduction feature is turned off or fails, the data within the margin will be discarded.</td>
</tr>
<tr>
<td><strong>Color Fax</strong></td>
<td>Set whether the multifunction printer sends and receives color faxes.</td>
</tr>
<tr>
<td><strong>Extel Hook Thresh</strong></td>
<td>You can set the threshold value for the OnHook mode.</td>
</tr>
<tr>
<td><strong>Country</strong></td>
<td>You can select the country where the multifunction printer is used.</td>
</tr>
<tr>
<td><strong>Fwd. Error Print</strong></td>
<td>Prints the document failed to transfer when Forward Set Print is set to <strong>Off</strong>.</td>
</tr>
</tbody>
</table>

**NOTE:** Prefix Dial only supports the environment where you send a fax to send a fax to the external line number. To use Prefix Dial, you must do the following from the operator panel.

1. Use ▼ and ▲ to select **SETUP → Admin Menu → Fax Settings → Line Type**. Select **PBX**, and then press √.
2. Use ▼ and ▲ to select **SETUP → Admin Menu → Fax Settings → Prefix Dial**. Select **On**, and then press √.
3. Use ▼ and ▲ to select **SETUP → Admin Menu → Fax Settings → Prefix Dial Num**. Enter a maximum of five-digit prefix number from 0-9, *, and #.

### Advanced Fax Settings

**NOTE:** The advanced fax settings are only meant for advanced users. Incorrect settings on the Dell 3115cn may damage the device.
If you are experiencing fax send or receive errors, there is an advanced fax settings menu which you can access and change the settings accordingly.

To enter the Diagnostic Menu (Customer Mode), follow the instructions.

1. Turn off the Dell MFP Laser 3115cn.
2. Disconnect all network, phone line, USB and Parallel cables from the device.
3. Turn on the Dell MFP Laser 3115cn while holding down the ▼ and ▲ button. The Customer Mode menu appears.
4. After all the advanced fax settings have been made, you will need to turn off and on the Dell MFP Laser 3115cn for the new settings to be effective.

**Error Correction Mode (ECM)**

Some of the legacy fax devices do not support the Error Correction Mode. You may experience fax send or receive errors due to this feature. You can disable the ECM with the following instructions.

1. When the printer is in Customer Mode, select Fax/Scanner Diag and press button.
2. Press the ▼ button until Parameter appears, then press the button.
3. Press the ▼ button until FAX Parameter appears, then press the button.
4. Press the ▼ button until Capability ECM appears, then press the button.
5. Press the ▼ button until Disable appears, then press the button to disable ECM.

**Modem Speed**

Some of the legacy fax devices do not support the V.34 modem speed of 33,600 bits per second (bps). You may experience fax send or receive errors due to the higher modem speed. You can disable the V.34 with the following instructions.

1. When the printer is in Customer Mode, select Fax/Scanner Diag and press button.
2. Press the ▼ button until Parameter appears, then press the button.
3. Press the ▼ button until FAX Parameter appears, then press the button.
4. Press the ▼ button until Capability V34 appears, then press the button.
5. Press the ▼ button until Disable appears, then press the button to disable V.34.

You can also reduce the modem speed if you continue to experience fax communication problem.
- 14,400bps (V.17)
- 9,600bps (V.29) or
- 4,800bps (V.27ter).

You can change the modem transmission speed with the following instructions.

1. When the printer is in **Customer Mode**, select **Fax/Scanner Diag** and press ✓ button.
2. Press the ▼ button until **Parameter** appears, then press the ✓ button.
3. Press the ▼ button until **FAX Parameter** appears, then press the ✓ button.
4. Press the ▼ button until **G3M TX Modem Speed** appears, then press the ✓ button.
5. Press the ▼ button until **V17** appears, then press ✓ button to enable V.17 (14,400bps), select **V29** to enable V.29 (9,600bps), or select **V27ter** to enable V.27ter (4,800bps).

You can change the modem receive speed with the following instructions.

1. When the printer is in **Customer Mode**, select **Fax/Scanner Diag** and press ✓ button.
2. Press the ▼ button until **Parameter** appears, then press the ✓ button.
3. Press the ▼ button until **FAX Parameter** appears, then press the ✓ button.
4. Press the ▼ button until **G3M RX Modem Speed** appears, then press the ✓ button.
5. Press the ▼ button until **V27ter+V29+V33+V17** appears, then press the ✓ button to enable V.17 (14,400bps), select **V27ter+V29** to enable V.29 (9,600bps), or select **V27ter** to enable V.27ter (4,800bps).

**Fax Data Encoding Method**

Some of the legacy fax devices do not support the JBIG data encoding method. You may experience fax send or receive errors due to this data encoding method. You can disable the JBIG and select the MH, MR or MMR encoding with the following instructions.

You can change the modem transmission encoding with the following instructions.

1. When the printer is in **Customer Mode**, select **Fax/Scanner Diag** and press ✓ button.
2. Press the ▼ button until **Parameter** appears, then press the ✓ button.
3. Press the ▼ button until **FAX Parameter** appears, then press the ✓ button.
4. Press the ▼ button until G3M TX Coding appears, then press the ✔ button.

5. Press the ▼ button until MMR appears, then press the ✔ button to enable MMR encoding, select MR to enable MR encoding, or select MH to enable MH encoding.

You can change the modem receive encoding with the following instructions.

1. When the printer is in Customer Mode, select Fax/Scanner Diag and press ✔ button.

2. Press the ▼ button until Parameter appears, then press the ✔ button.

3. Press the ▼ button until FAX Parameter appears, then press the ✔ button.

4. Press the ▼ button until G3M RX Coding appears, then press the ✔ button.

5. Press the ▼ button until MMR appears, then press the ✔ button to enable MMR encoding, select MR to enable MR encoding, or select MH to enable MH encoding.

---

**Sending a Fax**

You can fax data from your multifunction printer. Also, you can directly fax data transferred from the computer running Windows.

**Loading an Original Document**

You can use the ADF or the document feeder glass to load an original document for faxing. Using the ADF, you can load up to 50 sheets of 75 g/m² (20 lb) paper at a time. Using the document feeder glass, you can load one sheet at a time.

- **NOTE:** Ensure that no document is in the ADF. If any document is detected in the ADF, it has priority over the document on the document feeder glass.

- **NOTE:** To get the best scan quality, especially for gray scale images, use the document feeder glass instead of the ADF.

To fax a document using the Automatic Document Feeder (ADF):

1. Place the document(s) face up on the ADF with the top edge of the documents in first. Then adjust the document guides to the correct document size.
2. Adjust the document resolution, referring to "Adjusting the Document Resolution ".

To fax a document from the document feeder glass:

1. Open the document cover.

2. Place the document face down on the document feeder glass and align it with the registration guide on the top left corner of the glass.
3. Adjust the document resolution, referring to "Adjusting the Document Resolution ".

4. Close the document cover.

**NOTE:** If you are faxing a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then close the cover. If the book or magazine is thicker than 30 mm, start faxing with the cover open.

## Adjusting the Document Resolution

Use the Document Resolution setting to improve the output quality of the original or if scanning photographic materials.

1. Press ▼ until > FAX appears, and then press ✓.

2. Press ▼ until > Resolution appears.

3. Press ► to select the desired setting, and then press ✓.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard</strong></td>
<td>Uses for documents with normal sized characters.</td>
</tr>
<tr>
<td><strong>Fine</strong></td>
<td>Uses for documents containing small characters or thin lines or documents printed using a dot-matrix printer.</td>
</tr>
<tr>
<td><strong>Super Fine</strong></td>
<td>Uses for documents containing extremely fine detail. The super fine mode is enabled only if the remote printer also supports the Super Fine resolution. See the note below.</td>
</tr>
</tbody>
</table>

**NOTE:** Faxes scanned in the Super Fine resolution transmits at the highest resolution supported by the receiving device.

## Original Type
The Original Type setting is used to improve the image quality by selecting the document type for the current fax job.

To select the image quality:

1. Load the document to be faxed on the document feeder glass, and close the cover.
2. Press ▼ until >FAX appears, and then press ✓.
3. Press ▼ until >Original Type appears.
4. Press ▶ to select the desired setting, and then press ✓.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text&amp;Photo</td>
<td>Uses for documents with both text and photo/gray tones.</td>
</tr>
<tr>
<td>Photo</td>
<td>Uses for documents with photo or gray tones.</td>
</tr>
<tr>
<td>Text*</td>
<td>Uses for documents with text.</td>
</tr>
</tbody>
</table>

5. Press Start to begin faxing.

**Lighter/Darker**

Adjust the contrast to make the fax lighter or darker than the original.

To adjust the contrast:

1. Load the document to be faxed on the document feeder glass, and close the cover.
2. Press ▼ until >FAX appears, and then press ✓.
4. Press ▶ to select the desired setting, and then press ✓.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal*</td>
<td>Works well with standard typed or printed documents.</td>
</tr>
<tr>
<td>Darker1</td>
<td>Works well with light print or faint pencil markings.</td>
</tr>
<tr>
<td>Darker2</td>
<td></td>
</tr>
<tr>
<td>Darker3</td>
<td></td>
</tr>
<tr>
<td>Lighter3</td>
<td>Works well with dark print.</td>
</tr>
<tr>
<td>Lighter2</td>
<td></td>
</tr>
<tr>
<td>Lighter1</td>
<td></td>
</tr>
</tbody>
</table>

5. Press Start to begin faxing.
Sending a Fax Automatically

1. Load the document(s) face up with top edge in first into the ADF.
   OR
   Place a single document face down on the document feeder glass.
   For details about loading a document, see "Loading an Original Document ".

2. Press ▼ until >FAX appears, and then press ✓.

3. Adjust the document resolution to suit your fax needs (see "Adjusting the Document Resolution ").
   If you need to change the contrast, see "Lighter/Darker ".

4. Press ▼ until >Phone Book appears, and then press ✓.
   You can use speed or group dial numbers. For details, see "Automatic Dialing ".

5. Press ▼ until the desired number appears.

6. Press Start .
   For the document loaded on the document feeder glass, the display asks if you want to load another page. Press ▷ to select Yes or No, and then press ✓.
   After all of the pages are scanned, select No when the display shows "Another Page? "

7. The number is dialed and then the multifunction printer begins sending the fax when the remote fax machine is ready.

   NOTE: Press Cancel to cancel the fax job at any time while sending the fax.

Sending a Fax Manually

1. Load the document(s) face up with top edge in first into the ADF.
   OR
   Place a single document face down on the document feeder glass.
   For details about loading a document, see "Loading an Original Document ".

2. Press ▼ until >FAX appears, and then press ✓.

3. Adjust the document resolution to suit your fax needs (see "Adjusting the Document Resolution ").
   If you need to change the contrast, see "Lighter/Darker ".

4. Press ▼ until >Phone Number appears.

5. Enter the remote fax machine's fax number using the number keypad.

6. When you hear a high-pitched fax tones from the remote fax machine:
   - If the document is loaded on the ADF, press Start.
   - If the document is not loaded on the ADF, press ▷ until the desired setting appears, and then press ✓.
NOTE: Press Cancel and ✔️ to cancel the fax job at any time while sending the fax.

Confirming Transmissions

When the last page of your document has been sent successfully, the multifunction printer beeps and returns to the standby mode.

If something goes wrong while sending your fax, an error message appears on the display. For a listing of error messages and their meanings, see "Understanding Multifunction Printer Messages ".

If you receive an error message, press Cancel to clear the message and try to send the document again.

You can set your multifunction printer to print a confirmation report automatically after each fax transmission. For further details, see "Printing a Report ".

Automatic Redialing

If the number you have dialed is busy or there is no answer when you send a fax, the multifunction printer will automatically redial the number every minute based on the number set in the redial settings.

To change the time interval between redials and the number of redial attempts, see "Available Fax Settings Options ".

Sending a Fax from the driver (Direct Fax)

You can send a fax directly from your computer by using the driver.

NOTE: Only black and white faxes can be sent using Direct Fax.

Example

![Send data via the Dell MFP Laser 3115cn fax driver Send fax Sending machine (Dell Multifunction Color Laser Printer 3115cn) Receiving machine (faxmachine/multifunction printer)]

Procedure

NOTE: The names of the dialog boxes and the buttons may be different from those given in the following procedure depending on the application you are using.
1. Open the file you want to send by fax.

2. Open the print dialog box from the application, and then select **Dell MFP Laser 3115cn Fax**.

3. Click **Preferences**.

4. The Printing Preferences dialog box opens. You can use the FAX Settings to set the following settings.

   **NOTE:** The settings done here are only applied to a single fax job.
a. Transmission image quality

Purpose:
To set the output quality.

Values:

<table>
<thead>
<tr>
<th>Standard</th>
<th>For documents with normal sized characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Quality*</td>
<td>For documents containing small characters or thin lines or documents printed using a dot-matrix printer.</td>
</tr>
<tr>
<td>Super-high image quality</td>
<td>For documents containing extremely fine detail. The super fine mode is enabled only if the remote printer also supports Super Fine resolution. See the notes below.</td>
</tr>
</tbody>
</table>

NOTE: Faxes printed in the Super-high image quality by Direct Fax driver transmits at the highest resolution supported by the receiving device.

b. Transmission Report

Purpose:
To specify the communication result for the fax transmission.

Values:
### Output regularly
Always prints the report for the fax transmission.

### Output for non-transmission*
Prints the report when a communication error is detected.

### Do not output
Does not print the report.

---

**c. Record of senders**

Prints the sender record at the head of the fax. Select Off to turn this feature off. Select On to turn this feature on.

5. Click **OK** to close the Printing Preferences dialog box.

6. Click **Print**. The Set/Check Fax Transmission: dialog box opens.

7. Enter the destination for the recipient. The following procedure is for entering the destination. For details on how to enter the destination, please refer to the Help file for the driver.

   a. Enter the name and phone number directly.

   b. Specify a destination that is saved to the Phone Book on the PC.

   c. Specify a destination that is saved to the Address Book on the Dell Multifunction Color Laser Printer 3115cn.*

---

* This can only be used if the PC and the Dell Multifunction Color Laser Printer 3115cn are connected with a USB cable.
NOTE: Enter the password in the Password field in the Authorization area before sending a fax from the Dell MFP Laser 3115cn Fax if the Scan/Fax Set (Setup → Admin menu → Secure Settings) settings on the Dell Multifunction Color Laser Printer 3115cn have been set. If you do not enter the correct password, the fax will not be sent. You can check whether or not the fax was correctly sent on the Job History Report (Setup → Reports → Job History).

Receiving a Fax

About Receiving Modes

NOTE: To use the TEL/FAX or Ans/Fax mode, attach an answering machine to the Phone connector (📞) on the back of your multifunction printer.

When the memory is full, the fax is received in the TEL mode.

Loading Paper for Receiving Faxes

The instructions for loading paper in the paper tray are the same whether you are printing, faxing, or copying, except that faxes can only be printed on Letter-, A4-, or Legal-sized paper. For details about loading paper, see "Loading Print Media". For details about setting the paper type and size in the tray, see "Print Media Guidelines".

Receiving Automatically in the Fax Mode

Your multifunction printer is preset to the fax mode at the factory.

When you receive a fax, the multifunction printer answers the call on a specified number of rings and automatically receives the fax.

To change the number of rings, see "Available Fax Settings Options".

If you want to adjust the ringer volume, see "Setting Sounds".

Receiving Manually in the Tel Mode

You can receive a fax by picking up the handset of the external telephone and then pressing the remote receive code (see "Available Fax Settings Options"), or by setting OnHook to On (you can hear voice or fax tones from the remote machine) and then pressing Start.

The multifunction printer begins receiving a fax and returns to the standby mode when the reception is completed.

Receiving Automatically in the TEL/FAX or Ans/FAX Mode

To use the TEL/FAX or Ans/Fax mode, you must attach an answering machine to the Phone connector (📞) on the back of your multifunction printer.
If the caller leaves a message, the answering machine stores the message as it would normally. If your multifunction printer hears a fax tone on the line, it automatically starts to receive fax.

**NOTE:** If you have set your multifunction printer to the Ans/FAX mode and your answering machine is switched off, or no answering machine is connected to your multifunction printer, your multifunction printer will automatically go into the Fax mode after a predefined number of rings.

### Receiving Manually Using an External Telephone

This feature works best when you are using an external telephone connected to the Phone connector (ランス) on the back of your multifunction printer. You can receive a fax from someone you are talking to on the external telephone without having to go to the fax machine.

When you receive a call on the external telephone and hear fax tones, press the two-digit keys on the external telephone.

The multifunction printer receives the document.

Press the buttons slowly in sequence. If you still hear the fax tone from the remote machine, try pressing the two-digit keys once again.

The remote receive code is set to **Off** at the factory. The first and the last asterisks are fixed, but you can change the middle number to whatever you choose. For details on changing the code, see "Available Fax Settings Options".

### Receiving Faxes Using the DRPD Mode

The DRPD mode is a telephone company service which enables a user to use a single telephone line to answer several different telephone numbers. The particular number someone uses to call you on is identified by different ringing patterns, which consist of various combinations of long and short ringing sounds.

Before using the Distinctive Ring Pattern Detection option, Distinctive Ring service must be installed on your telephone line by the telephone company. To set up Distinctive Ring Pattern Detection, you will need another telephone line at your location, or someone available to dial your FAX number from outside.

To set up the DRPD mode:

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >Fax Settings appears, and then press ✓.
4. Press ▼ until >DRPD Pattern appears.
5. Use ► to select the desired setting, and then press ✓.
6. To return to the standby mode, press Cancel.

To receive faxes in the DRPD mode, you need to set the menu to DRPD; see "Available Fax Settings Options".
Your multifunction printer provides five DRPD patterns. If this service is available from your telephone company, ask your telephone company which pattern you need to select to use this service.

**Receiving Faxes in the Memory**

Since your multifunction printer is a multi-tasking device, it can receive faxes while you are making copies or printing. If you receive a fax while you are copying, printing, or run out of paper or toner, your multifunction printer stores incoming faxes in the memory. Then, as soon as you finish copying, printing, or re-supply the consumables, the multifunction printer automatically prints the fax.

**Polling Receive**

You can receive faxes from the remote fax machine when you want to receive it.

1. Press ▼ until >FAX appears, and then press ✔.
2. Press ▼ until >Polling Receive appears.
3. Press ▶ to select On, and then press ✔.

**Color Fax**

You can use the color fax function on your multifunction printer.

**Conditions faxing in color**

To send and receive color faxes you need to check the following conditions.

- Check that the sending or receiving party's fax is set for color faxes.
- You can only send one page if you send a fax using the document feeder glass.
- If the sender or the receiver is not a Dell Multifunction Color Laser Printer 3115cn, the color fax function may not operate well. If this is the case, send the fax as black and white.
- Color faxes cannot be sent while a fax is being sent or received.
- Automatic redial is not done if a transmission error occurs while a color fax is being transmitted.
- Color faxes are not forwarded even if the Forward Settings are set.
- Color faxes cannot be sent using direct fax.
- Color faxes cannot send document to multiple destinations at the same time.

**Setting the Color Fax Function**
To use the color fax function, turn on the color fax function. The factory default setting is off.

How to set the color fax function:

1. Press ▼ until >Setup appears, and then press ✓.
2. Press ▼ until >Admin menu appears, and then press ✓.
3. Press ▼ until >Fax Settings appears, and then press ✓.
4. Press ▼ until >Color Fax appears, and then press ✓.
5. Press ➤ to select On, and then press ✓.

Changes in the menu for color fax settings

The fax menu on the operator panel changes when Color Fax is turned on or off.

<table>
<thead>
<tr>
<th>When color fax is off</th>
<th>When color fax is on</th>
</tr>
</thead>
<tbody>
<tr>
<td>When &quot;Black &amp; White&quot; is selected in the Fax menu</td>
<td>When &quot;Color&quot; is selected in the Fax menu</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Phone Number</td>
</tr>
<tr>
<td>Speed Dial</td>
<td>Speed Dial</td>
</tr>
<tr>
<td>Phone Book</td>
<td>Phone Book</td>
</tr>
<tr>
<td>Add PhoneBook Entry</td>
<td>Add PhoneBook Entry</td>
</tr>
<tr>
<td>Group Dial</td>
<td>Group Dial</td>
</tr>
<tr>
<td>Resolution</td>
<td>Resolution</td>
</tr>
<tr>
<td>Original Type</td>
<td>Original Type</td>
</tr>
<tr>
<td>Lighter/Darker</td>
<td>Lighter/Darker</td>
</tr>
<tr>
<td>OnHook</td>
<td>OnHook</td>
</tr>
<tr>
<td>Polling Receive</td>
<td>Polling Receive</td>
</tr>
<tr>
<td>Delayed Start</td>
<td>Delayed Start</td>
</tr>
</tbody>
</table>

Checking whether or not a fax was sent in color

Even if you send a color fax, if the receiver does not have a color fax function or if their color fax function is turned off, the fax is sent in black and white. The following procedure explains how to check if a fax was sent in color or black and white.

Check on the panel:

Color or Black & White is displayed on the operator panel while a fax is sending.
While a fax is sending in color, Color appears on the fourth line of the LCD panel.

While a fax is sending in black and white, Black & White appears on the fourth line of the LCD panel.

**Check on the activity report:**

You can check the Mode field on the activity report.

- If the fax was sent in color, "Color" is output on the report.
- If the fax was sent in black and white, G3, SG3 or ECM is output on the report.
- If a fax sent as color is changed to black and white, *G3, *SG3, or *ECM is output on the report.

**Check on the monitor report:**

You can check in the mode field on the monitor report if a monitor report is set to be output by Fax Transmit (Setup → Admin menu → System Settings).

<table>
<thead>
<tr>
<th>Not Print</th>
<th>Does not print the report.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print at Error*</td>
<td>Prints the report when a communication error is detected.</td>
</tr>
<tr>
<td>Print Always</td>
<td>Always prints the report for the fax transmission.</td>
</tr>
</tbody>
</table>

- If the fax was sent in color, "Color" is output on the report.
- If the fax was sent in black and white, G3, SG3 or ECM is output on the report.
- If a fax sent as color is changed to black and white because the receiver could not accept a color fax, *G3, *SG3, or *ECM is output on the report.

---

**Automatic Dialing**

**Speed Dialing**

You can store up to 200 frequently dialed numbers in speed dial locations (001-200).

When the speed dial job specified in the delayed fax or redial exists and you change the speed dial number from the operator panel or Dell Printer Configuration Web Tool, the destination of the fax may be changed.

**Storing a Number for Speed Dialing**

1. Press ▼ until >FAX appears, and then press ✓.

2. Press ▼ until >Add PhoneBook Entry appears, and then press ✓.
3. Press ▼ until >Speed Dial appears, and then press ✓.

4. Enter the three-digit speed dial number between 001 and 200, using the number keypad, and then press ✓.

5. Enter the settings for Name, Phone Number, and Delete Dial by using ▼, ✓ and number keys. If a number is already stored in the location you chose, the display shows the number to allow you to change it. To start over with another speed-dial number, press Back.

6. Enter the number you want to store using the number keypad, and then press ✓.
To insert a pause between numbers, press Pause. "-" appears on the display.

7. To assign a name to the number, enter the name. For details about how to enter names, see "Using the Number Keypad to Enter Characters". If you do not want to assign a name, skip this step.

8. Press Back when the name appears correctly or without entering a name.

9. To store more fax numbers, repeat steps 4 through 6. To return to the standby mode, press Cancel.

Sending a Fax Using a Speed Dial

1. Load the document(s) face up with top edge in first into the ADF.
   OR
   Place a single document face down on the document feeder glass. For details about loading a document, see "Loading an Original Document".

2. To enter the speed dial number do either of the following:
   a. Press ▼ until >FAX appears, and then press ✓.
   b. Press ▼ until >Speed Dial appears.
   c. Use the Keypad buttons to enter the three-digit speed dial number between 001 and 200, using the number keypad, and then press ✓.

   The corresponding entry’s name briefly displays. To confirm the name again, press ✓.

3. Adjust the document resolution to suit your fax needs (see "Adjusting the Document Resolution"). If you need to change the contrast, see "Lighter/Darker".

4. The document scans into the memory. When the document is loaded on the document feeder glass, the LCD display asks if you want to send another page. Press ▶ to select Yes to add more documents or to select No to begin sending the fax immediately, and then press ✓.

5. The fax number stored in the speed dial location is automatically dialed. The document is sent when the remote fax machine answers.
NOTE: Using the asterisk (*) in the first digit, you can send a document to multiple locations. For example, if you enter 00*, you can send a document to the locations registered between 001 and 009.

### Group Dialing

If you frequently send the same document to several destinations, you can create a group of these destinations and set them under a two-digit group dial location. This enables you to use a group dial number setting to send the same document to all the destinations in the group.

NOTE: You cannot include one group dial number within another group dial number.

### Setting Group Dial

1. Press ▼ until >FAX appears, and then press ✔.
2. Press ▼ until >Add PhoneBook Entry appears, and then press ✔.
3. Press ▼ until >Group Dial appears, and then press ✔.
4. Enter the one-digit speed dial number between 1 and 6, using the number keypad, and then press ✔. If a number is already stored in the location you chose, the display shows the number to allow you to change it. To start over with another speed-dial number, press Back.
5. Enter the number you want to store using the number keypad, and then press ✔. To insert a pause between numbers, press Pause. "-" appears on the display.
6. To assign a name to the number, press Pause. For details about how to enter names, see "Using the Number Keypad to Enter Characters". If you do not want to assign a name, skip this step.
7. Press Back when the name appears correctly or without entering a name.
8. To store more fax numbers, repeat steps 4 through 6. To return to the standby mode, press Cancel.

### Editing Group Dial Numbers

You can delete a specific speed dial number from a selected group or add a new number to the selected group.

1. Press ▼ until >FAX appears, and then press ✔.
2. Press ▼ until >Add PhoneBook Entry appears, and then press ✔.
3. Press ▼ until >Group Dial appears, and then press ✔.
4. Enter the one-digit speed dial number between 1 and 6, using the number keypad, and then press ✔.
**NOTE:** When you delete the last speed dial in a group, the group itself is not deleted.

5. Press **Back**.

6. If you want to edit another group, repeat from step 4.
   To return to the standby mode, press **Cancel**.

**Sending a Fax Using Group Dialing (Multi-address Transmission)**

You can use group dialing for Broadcasting or Delayed transmissions.

Follow the procedure of the desired operation (For Delayed transmission, see "Sending a Delayed Fax").

You can use one or more group numbers in one operation. Then continue the procedure to complete the desired operation.

Your multifunction printer automatically scans the document loaded in the Automatic Document Feeder or on the document feeder glass into the memory. The multifunction printer dials each of the numbers included in the group.

**Printing a Speed Dial List**

You can check your automatic dial setting by printing a Speed Dial list.

1. Press ▼ until >SETUP appears, and then press ✓.

2. Press ▼ until >Admin Menu appears, and then press ✓.

3. Press ▼ until >Admin Reports appears, and then press ✓.

4. Press ▶ until >Speed Dial appears, and then press ✓.
   A list showing your speed dial entries prints out.

**Other Ways to Fax**

**Using the Secure Receiving Mode**

You may need to prevent your received faxes from being accessed by unauthorized people. You can turn on the secure fax mode using the Secure Receive option to restrict printing out all of the received faxes when the multifunction printer is unattended. In the secure fax mode, all incoming faxes will go in memory. When the mode turns off, any faxes stored will be printed.
NOTE: Before operation, ensure Panel Lock is enabled.

To turn the secure receiving mode on:

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >Secure Settings appears, and then press ✓.
4. Press ▼ until >Secure Receive appears, and then press ✓.
5. Press ▼ until >Secure Receive Set appears, and then press ✓.
6. Press ◀ to select Enable, and then press ✓.
7. Press ▼ to select Change Password, and then press ✓.
8. Enter a four-digit passcode you want to use, using the number keypad and press ✓.

NOTE: When you set Secure Receive Set to Enable, 0000 is set by default.

9. To return to the standby mode, press Cancel.

When a fax is received in the secure receiving mode, your multifunction printer stores it into memory and the JOB STATUS screen displays "Secure Receive" to let you know that there is a fax stored.

To print received documents:

1. Press ▼ until >JOB STATUS appears, and then press ✓.
2. Press ▼ until >Secure Receive appears, and then press ✓.
3. Enter the password, and then press ✓.
The faxes stored in memory are printed.

To turn the secure receiving mode off:

1. Access the Secure Receive menu by following steps 1 to 5 in "To turn the secure receiving mode on:"
2. Press ▼ to select Disable, and then press ✓.
3. To return to the standby mode, press Cancel.

**Printing Reports**
The following reports are available:

**Speed Dial**
This list shows all of the numbers currently stored in the printer's memory as speed dial numbers.
You can print this Speed Dial list from the operator panel; see "Printing a Speed Dial List ".

**Address Book**
This list shows all of the numbers currently stored in the printer's memory as Address Book information.

**Server Address**
This list shows all of the numbers currently stored in the printer's memory as Server Address information.

**Fax Activity**
This report shows information about the faxes you recently received or sent.

**Fax Pending**
This list shows the status of pending faxes. You may print this list to confirm your changes after changing any settings.

**Printing a Report**

1. Press ▼ until SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >Admin Reports appears, and then press ✓.
4. Press ▶ to select the report or list you want to print.
   A list showing your speed dial entries prints out.
   Speed Dial: Speed Dial list
   Address Book: Address Book list
   Server Address: Server Address list
   Fax Activity: Fax activity information
   Fax Pending: Pending faxes
   Print Meter: Print volume report
5. Press ✓.
   The selected information prints out.

**Changing Setting Options**
1. Press ▼ until >FAX appears, and then press ✓.

2. Press ▼ until >Fax Defaults appears, and then press ✓.

3. Press ▼ to select the desired menu item, and then press ✓.

4. When the option you want appears on the display, press ▶ to select the desired status or enter the desired value using the number keypad.

5. Press ✓ to save the selection.

6. You can exit from the setup mode at any time by pressing Cancel.

**Using an Answering Machine**

You can connect a telephone answering device (TAD) directly to the back of your multifunction printer as shown above.

- Set your multifunction printer to the Ans/FAX mode and set Auto Ans. Ans/FAX to specify the time for the TAD.
- When the TAD picks up the call, the multifunction printer monitors and takes the line if fax tones are received and then starts receiving the fax.
- If the answering device is off, the multifunction printer automatically goes into the Fax mode after a predefined number of rings.
- If you answer the call and hear fax tones, the multifunction printer will answer the fax call if you
  
  ➔ Set OnHook to On (you can hear voice or fax tones from the remote machine), and then press Start and hang up the receiver.
  OR

  ➔ Press the two-digit remote receive code and hang up the receiver.

**Using a Computer Modem**
If you want to use your computer modem for faxing or for a dial-up internet connection, connect the computer modem directly to the back of your multifunction printer with the TAD as shown above.

- Set your multifunction printer to the Ans/FAX mode and set Auto Ans. Ans/FAX to specify the time for the TAD.
- Turn off the computer modem's fax-receive feature.
- Do not use the computer modem if your multifunction printer is sending or receiving a fax.
- Follow the instructions provided with your computer modem and fax application to fax via the computer modem.
- If you want to capture images using your multifunction printer and Dell ScanDirect™, send images using your fax application with the computer modem.
Networking

- About Sharing the Multifunction Printer on a Network
- Setting Up the Locally Shared Printer
- Point and Print
- Peer-to-Peer
- Setting Up a Network-connected Printer
- Printing a Network Configuration Page
- Setting Network Protocols
- Static Addressing
- Dynamic Addressing (BOOTP/DHCP)
- Restoring the Network Configuration
- Resetting the Network Interface Card

About Sharing the Multifunction Printer on a Network

Locally-shared Printer

You can connect the multifunction printer directly to a selected computer, which is called the "host computer" on the network. The multifunction printer can then be shared by other users on the network through a Windows® 98, Windows Me, Windows 2000, Windows XP, Windows Vista®, Windows Server® 2003, Windows Server 2008, or Windows NT 4.0 network printer connection.

Wired Network-connected Printer

Your multifunction printer has a built-in network interface. For details, see "Connecting the Multifunction Printer to the Network".

Printing Across a Network

Whether the multifunction printer is locally connected or network-connected, you need to install the Dell™ Multifunction Color Laser Printer 3115cn software on each computer that prints documents using the multifunction printer.

Setting Up the Locally Shared Printer

You can share your new printer on the network using the Drivers and Utilities CD that shipped with your
multifunction printer, or using Microsoft's point and print or peer-to-peer method. However, if you use one of
the Microsoft methods, you will not have all of the features, such as the status monitor and other printer
utilities, that are installed with the Drivers and Utilities CD.

To share a locally-attached printer on the network, you need to share the multifunction printer, and then
install the shared printer on network clients:

2. Right-click this printer icon and select Properties.
3. From the Sharing tab, check the Shared this printer (Shared for Windows 2000) check box, and
   then type a name in the Shared name (Share as for Windows 2000) text box.
4. Click Additional Drivers and select the operating systems of all network clients printing to this
   multifunction printer.
5. Click OK.
   If you are missing files, you are prompted to insert the server operating system CD.

For Windows Vista:

1. Click Start→Control Panel→Hardware and Sound→Printers.
2. Right-click the printer's icon and select Sharing.
3. Click the Change sharing options button.
4. The dialog box displaying "Windows needs your permission to continue" appears.
5. Click the Continue button.
6. Check the Share this printer check box, and then type a name in the Share name text box.
7. Click Additional Drivers and select the operating systems of all network clients printing to this
   printer.
8. Click OK.

For Windows Server 2008:

1. Click Start→Control Panel→Printers.
2. Right-click the printer icon and select Sharing.
3. Check the Share this printer check box, and then type a name in the Share name text box.
4. Click Additional Drivers and select the operating systems of all network clients printing to this
   printer.
5. Click OK.
The PCL driver supports an Additional Driver for Windows Vista (not including Itanium). To register the Additional Driver, follow the instructions below.

1. Click Start → Control Panel → Hardware and Sound → Printers.
2. Right-click the printer's icon and select Sharing.
3. Click the Change sharing options button.
4. Click the Continue button.
5. Click Additional Drivers and select the processors of all the network clients printing with this printer.
6. Click OK.
7. Click the Browse button and locate the driver in the Drivers and Utilities CD

To check that the multifunction printer was successfully shared:

- Ensure the printer object in the Printers and Faxes (Printers for Windows 2000) folder shows it is shared. For example, in Windows 2000, a hand is shown underneath the printer icon.
- Browse My Network Places (Network Neighborhood for Windows 2000). Find the host name of the server and look for the shared name you assigned to the multifunction printer.

Now that the multifunction printer is shared, you can install the multifunction printer on network clients using the point and print method or the peer-to-peer method.

## Point and Print

This method is usually the best use of system resources. The server handles driver modifications and print job processing. This lets network clients return to their programs much faster.

If you use the point and print method, a subset of driver information is copied from the server to the client computer. This is just enough information to send a print job to the multifunction printer.

2. Locate the host name of the server computer, and then double-click the host name.
3. Right-click the shared printer name, and then click Install. Wait for the driver information to copy from the server computer to the client computer, and for a new printer object to be added to the Printers and Faxes (Printers for Windows 2000) folder. The time this takes varies, based on network traffic and other factors. Close My Network Places (Network Neighborhood for Windows 2000).
4. Print a test page to verify print installation.
6. Select the multifunction printer you just created.

7. Click **File ➔ Properties**.

8. From the **General** tab, click **Print Test Page (Print a Test Page for Windows 2000)**.

   When a test page prints successfully, printer installation is complete.

**For Windows Vista and Windows Server 2008:**

1. On the Windows desktop of the client computer, click **Start ➔ Network**.

2. Locate the host name of the server computer, and then double-click the host name.

3. Right-click the shared printer name, and then click **Connect**.

4. Click **Install driver**.

5. Click **Continue** in the User Account Control dialog box (You can skip this step in Windows Server 2008).

6. Wait for the driver information to copy from the server computer to the client computer, and for a new printer object to be added to the **Printers** dialog box. The time this takes varies, based on network traffic and other factors.

7. Print a test page to verify printer driver installation.

8. Click **Start ➔ Control Panel ➔ Hardware and Sound ➔ Printers (Start ➔ Control Panel ➔ Printers for Windows Server 2008)**.

9. Right-click the printer you just created and select **Properties**.

10. From the **General** tab, click **Print Test Page**.

If the test page prints successfully, the printer driver installation is complete.

---

**Peer-to-Peer**

If you use the peer-to-peer method, the printer driver is fully installed on each client computer. Network clients retain control of driver modifications. The client computer handles the print job processing.

1. Click **Start ➔ Settings ➔ Printers and Faxes (Printers for Windows 2000)**.

2. Click **Add Printer** to launch the **Add Printer** wizard.

3. Click **Next (Network Print Server for Windows 2000)**.

4. Select **A network printer** or **a printer attached to another computer**, and then click **Next** (For Windows 2000, select the network printer from the **Shared printers** list). If the multifunction printer is not listed, type in the path of the multifunction printer in the text box.
For example: \\<server host name>\<shared printer name>
The server host name is the name of the server computer that identifies it to the network. The shared
printer name is the name assigned during the server installation process.

5. Click **Browse for a printer**, and then click **Yes** (For Windows 2000, click **OK**). If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will need to provide a path to available drivers.

6. Select whether you want this multifunction printer to be the default printer for the client, click **Next**, and then click **Finish** (For Windows 2000, click **Finish**).

7. Print a test page to verify printer installation:
   a. Click **Start**→**Settings**→**Printers and Faxes** (**Printers for Windows 2000**).
   b. Select the multifunction printer you just created.
   c. Click **File**→**Properties**.
   d. From the **General** tab, click **Print Test Page** (**Print a Test Page for Windows 2000**). When a test page prints successfully, printer installation is complete.

For Windows Vista and Windows Server 2008

1. Click **Start**→**Control Panel**→**Hardware and Sound**→**Printers** (**Start**→**Control Panel**→**Printers** for Windows Server 2008).

2. Click **Add a printer** to launch the **Add Printer** wizard.

3. Select **Add a network, wireless or Bluetooth printer**, and then click **Next**. If the printer is listed, select the printer and click **Next**, or select **The printer that I want isn’t listed** and type in the path of the printer in the **Select a shared printer by name** text box and click **Next**.

For example: \\<server host name>\<shared printer name>
The server host name is the name of the server computer that identifies it to the network. The shared printer name is the name assigned to the printer during the server installation process.

4. If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will need to provide a path to available drivers.

5. Select whether you want this printer to be the default printer for the client, click **Next**.

6. If you want to verify printer driver installation then click **Print a test page**.

7. Click **Finish**.

---

**Setting Up a Network-connected Printer**

You must set up the network protocols on the multifunction printer to use it as your network printer. Setting
protocols can be accomplished by using the supplied network program.

You can configure the basic network parameters through the multifunction printer's operator panel. Use the printer operator panel to do the following:

- Print a Network Configuration Page
- Configure TCP/IP

### Configuring Network Parameters on the Operator Panel

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Interface</td>
<td>10/100 Base-TX</td>
</tr>
<tr>
<td>Network Protocols</td>
<td>· TCP/IP on Windows</td>
</tr>
<tr>
<td>Dynamic Addressing Server</td>
<td>· DHCP</td>
</tr>
<tr>
<td></td>
<td>· BOOTP</td>
</tr>
</tbody>
</table>

### Printing a Network Configuration Page

The Network Configuration page shows how the network interface card on your multifunction printer is configured. The default settings are suitable for most applications.

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >Admin Reports appears, and then press ✓.
4. Press ▼ until >Server Address appears, and then press ✓.

The Network Configuration page prints out.

### Setting Network Protocols

When you first install the multifunction printer, all supported network protocols are enabled when you power the multifunction printer on. If a network protocol is enabled, the multifunction printer may actively transmit
on the network even when the protocol is not in use. This may slightly increase network traffic. To eliminate unnecessary traffic, you can disable unused protocols.

1. Press \( \downarrow \) until \( >\text{SETUP} \) appears, and then press \( \checkmark \).
2. Press \( \downarrow \) until \( >\text{Admin Menu} \) appears, and then press \( \checkmark \).
3. Press \( \downarrow \) until \( \text{Wired Net} \) or \( \text{Wireless Net} \) appears, and then press \( \checkmark \).
4. Press \( \downarrow \) until \( \text{Protocol} \) appears, and then press \( \checkmark \).
5. Press \( \uparrow \) to select the desired settings, and then press \( \checkmark \).
   - Port9100
   - FTP
   - SNMP UDP
   - E-Mail Alert
   - EWS

**Configuring TCP/IP**

- **Static Addressing**: TCP/IP address is assigned manually by the system administrator.
- **Dynamic Addressing BOOTP/DHCP (default)**: TCP/IP address is assigned automatically by a DHCP or BOOTP server on your network.

---

**Static Addressing**

To enter the TCP/IP address from your multifunction printer's operator panel, take the following steps:

1. Press \( \downarrow \) until \( >\text{SETUP} \) appears, and then press \( \checkmark \).
2. Press \( \downarrow \) until \( >\text{Admin Menu} \) appears, and then press \( \checkmark \).
3. Press \( \downarrow \) until \( \text{Wired Net} \) or \( \text{Wireless Net} \) appears, and then press \( \checkmark \).
4. Press \( \downarrow \) until \( \text{TCP/IP} \) appears, and then press \( \checkmark \).
5. Press \( \downarrow \) until \( >\text{IP Address} \) appears, and then press \( \checkmark \).

An IP address consists of 4 bytes.
IP Address
* 0. 0. 0. 0.

Enter a number between 0 and 255 for each octet.

6. Enter the numbers from the keypad, and then press ▶ to move between octets and press ✔.
7. Repeat 5 to complete the address from the 1st byte to the 4th byte.
8. Repeat 5 through step 8 to configure the other TCP/IP parameters.

---

**Dynamic Addressing (BOOTP/DHCP)**

To assign the TCP/IP address automatically using a DHCP or BOOTP server on your network, take the following steps:

1. Press ▼ until >SETUP appears, and then press ✔.
2. Press ▼ until >Admin Menu appears, and then press ✔.
3. Press ▼ until >Wired Net or >Wireless Net appears, and then press ✔.
4. Press ▼ until >TCP/IP appears, and then press ✔.
5. Press ▶ until >DHCP or >BOOTP appears, and then press ✔.

---

**Restoring the Network Configuration**

You can return the network configuration to its default settings.

1. Press ▼ until >SETUP appears, and then press ✔.
2. Press ▼ until >Admin Menu appears, and then press ✔.
3. Press ▼ until >Wired Net or >Wireless Net appears, and then press ✔.
4. Press ▼ until >Initialize NVM appears, and then press ✔.
5. Press ▼ to select Yes, and then press ✔.

The network configuration is restored.
6. Power the multifunction printer off and back on or reset the network interface card.

---

**Resetting the Network Interface Card**

You can reset the network interface card when a network problems occurs.

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >Wired Net appears, and then press ✓.
4. Press ▼ until >Initialize NVM appears, and then press ✓.
5. Press ► to select Yes, and then press ✓.
Understanding Fonts

- Typefaces and fonts
- Bitmapped and Scalable Fonts
- Resident Fonts
- Symbol Sets

Typefaces and fonts

A font is a set of characters and symbols created with a distinct design. The distinct design is called a typeface. The typefaces you select add personality to a document. Well-chosen typefaces make a document easier to read.

The multifunction printer has numerous resident fonts in PCL 5/PCL 6 and Adobe PostScript 3. See "Resident Fonts" for a listing of all resident fonts.

Weight and style

Typefaces are often available in different weights and styles. These variations modify the original typeface so you can, for example, emphasize important words in text or highlight book titles. The different weights and styles are designed to complement the original typeface.

Weight refers to the thickness of the lines that form the characters. Thicker lines result in darker characters. Some words commonly used to describe the weight of a typeface are bold, medium, light, black, and heavy.

Style refers to other typeface modifications, such as tilt or character width. Italic and oblique are styles where the characters are tilted. Narrow, condensed, and extended are three common styles that modify the character widths.

Some fonts combine several weight and style modifications; for example, Helvetica Narrow Bold Oblique. A group of several weight and style variations of a single typeface is called a typeface family. Most typeface families have four variations: regular, italic (oblique), bold, and bold italic (bold oblique). Some families have more variations, as the following illustration for the Helvetica typeface family shows:
**Pitch and Point Size**

The size of a font is specified as either a pitch or point size, depending on whether the font is fixed space or proportional.

In fixed space fonts, each character has the same width. Pitch is used to specify the size of fixed space fonts. It is a measure of the number of characters that will print in one horizontal inch of type. For example, all 10-pitch fonts print 10 characters per inch (cpi) and all 12-pitch fonts print 12 cpi:

```
Courier 10 Pitch 1234567890
Courier-Bold 10 Pitch 1234567890
```

In proportional (or typographic) fonts, every character can have a different width. Since proportional fonts have characters with different widths, the font size is specified in point size, not pitch. Point size refers to the height of the characters in the font. A point is defined as 1/72 inch. The characters in a font printed at 24 point will be twice as large as the characters in the same font printed at 12 point.

The following illustration shows samples of a font printed in different point sizes:

```
48 point 36 point
```

24 point 18 point 12 point 10 point

The point size of a font is defined as the distance from the top of the tallest character in the font to the bottom of the lowest character in the font. Due to the definition of point size, different fonts printed at the same point size may appear quite different in size. This is because there are other font parameters that affect how the font looks. However, the point size of a font is an excellent specification of the relative size of a font. The following examples illustrate two very different proportional fonts at 14 point:
**Bitmapped and Scalable Fonts**

The multifunction printer uses both bitmapped and scalable fonts.

Bitmapped fonts are stored in print memory as predefined patterns of bits that represent a typeface at a specific size, style, and resolution. The following illustration shows an example of a character from a bitmapped font.

![Bitmapped Font Example](image1.png)

Bitmapped fonts are available in different type styles and point sizes as downloadable fonts.

Scalable fonts (also called outline fonts) are stored as computer programs that define the outlines of the characters in the font. Each time you print characters from a scalable font, the multifunction printer creates a bitmap of the characters at the point size you choose and saves it temporarily in print memory.

![Scalable Font Example](image2.png)

These temporary bitmapped fonts are deleted when you turn off or reset the multifunction printer. Scalable fonts provide the flexibility of printing in many different point sizes.

Your multifunction printer uses different scalable font formats for downloading fonts to the multifunction printer. PCL 5/PCL 6 uses Intellifont and TrueType scalable fonts. Adobe PostScript 3 uses Type 1 and TrueType scalable fonts. There are thousands of different scalable fonts available in these different font formats from numerous font suppliers.
If you plan to use many downloadable bitmapped or scalable fonts or if you plan to use many different sizes of scalable fonts, you may need to purchase additional memory for your multifunction printer.

## Resident Fonts

Your multifunction printer is equipped with resident fonts stored permanently in print memory. Different fonts are available in PCL 5/PCL 6 and Adobe PostScript 3. Some of the most popular typefaces, like Courier and TimesNew (PCL 5/PCL 6)/Times New Roman (Adobe PostScript 3), are available for all printer languages.

The following table lists all the fonts resident in your multifunction printer. See "Printing a Font Sample List" for instructions on how to print samples of the fonts. You can select the resident fonts from your software program. You can also select the fonts from the operator panel if you are using PCL 5.

<table>
<thead>
<tr>
<th>Resident scalable fonts</th>
<th>PCL 5/PCL 6</th>
<th>PostScript 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>CG Times</td>
<td>Albertus</td>
<td></td>
</tr>
<tr>
<td>CG Times It</td>
<td>Albertus Italic</td>
<td></td>
</tr>
<tr>
<td>CG Times Bd</td>
<td>Albertus Light</td>
<td></td>
</tr>
<tr>
<td>CG Times BdIt</td>
<td>Antique Olive Roman</td>
<td></td>
</tr>
<tr>
<td>Univers Md</td>
<td>Antique Olive Italic</td>
<td></td>
</tr>
<tr>
<td>Univers MdIt</td>
<td>Antique Olive Bold</td>
<td></td>
</tr>
<tr>
<td>Univers Bd</td>
<td>Antique Olive Compact</td>
<td></td>
</tr>
<tr>
<td>Univers BdIt</td>
<td>Apple Chancery</td>
<td></td>
</tr>
<tr>
<td>Univers MdCd</td>
<td>Arial</td>
<td></td>
</tr>
<tr>
<td>Univers MdCdIt</td>
<td>Arial Italic</td>
<td></td>
</tr>
<tr>
<td>Univers BdCd</td>
<td>Arial Bold</td>
<td></td>
</tr>
<tr>
<td>Univers BdCdIt</td>
<td>Arial Bold Italic</td>
<td></td>
</tr>
<tr>
<td>AntiqueOlv</td>
<td>ITC Avant Garde Gothic Book</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ITC Avant Garde Gothic Book Oblique</td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>Style</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------</td>
<td></td>
</tr>
<tr>
<td>AntiqueOlv It</td>
<td>ITC Avant Garde Gothic Demi</td>
<td></td>
</tr>
<tr>
<td>AntiqueOlv Bd</td>
<td>ITC AvantGarde Gothic Demi Oblique</td>
<td></td>
</tr>
<tr>
<td>Bodoni Roman</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CG Omega</td>
<td>Bodoni Italic</td>
<td></td>
</tr>
<tr>
<td>CG Omega It</td>
<td>Bodoni Bold</td>
<td></td>
</tr>
<tr>
<td>CG Omega Bd</td>
<td>Bodoni Bold Italic</td>
<td></td>
</tr>
<tr>
<td>CG Omega BdIt</td>
<td>Bodoni Poster</td>
<td></td>
</tr>
<tr>
<td>Bodoni Poster Compressed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Garamond Antiqua</td>
<td>ITC Bookman Light</td>
<td></td>
</tr>
<tr>
<td>Garamond Krsv</td>
<td>ITC Bookman Light Italic</td>
<td></td>
</tr>
<tr>
<td>Garamond Hlb</td>
<td>ITC Bookman Demi</td>
<td></td>
</tr>
<tr>
<td>Garamond KrsvHlb</td>
<td>ITC Bookman Demi Italic</td>
<td></td>
</tr>
<tr>
<td>Carta</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Courier</td>
<td>Chicago</td>
<td></td>
</tr>
<tr>
<td>Courier It</td>
<td>Clarendon Roman</td>
<td></td>
</tr>
<tr>
<td>Courier Bd</td>
<td>Clarendon Bold</td>
<td></td>
</tr>
<tr>
<td>Courier BdIt</td>
<td>Clarendon Light</td>
<td></td>
</tr>
<tr>
<td>Cooper Black</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LetterGothic</td>
<td>Cooper Black Italic</td>
<td></td>
</tr>
<tr>
<td>LetterGothic It</td>
<td>Cooper Gothic 32BC</td>
<td></td>
</tr>
<tr>
<td>LetterGothic Bd</td>
<td>Cooper Gothic 33BC</td>
<td></td>
</tr>
<tr>
<td>Coronet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Albertus Md</td>
<td>Courier</td>
<td></td>
</tr>
<tr>
<td>Albertus X Bd</td>
<td>Courier Oblique</td>
<td></td>
</tr>
<tr>
<td>Clarendon Cd</td>
<td>Courier Bold Oblique</td>
<td></td>
</tr>
<tr>
<td>Eurostile Medium</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coronet</td>
<td>Eurostile Bold</td>
<td></td>
</tr>
<tr>
<td>Font Name</td>
<td>Font Name</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------</td>
<td></td>
</tr>
<tr>
<td>Eurostile</td>
<td>Eurostile Extended No. 2</td>
<td></td>
</tr>
<tr>
<td>Marigold</td>
<td>Eurostile Bold Extended No. 2</td>
<td></td>
</tr>
<tr>
<td>Arial</td>
<td>Gill Sans</td>
<td></td>
</tr>
<tr>
<td>Arial It</td>
<td>Gill Sans Italic</td>
<td></td>
</tr>
<tr>
<td>Arial Bd</td>
<td>Gill Sans Bold</td>
<td></td>
</tr>
<tr>
<td>Arial BdIt</td>
<td>Gill Sans Bold Italic</td>
<td></td>
</tr>
<tr>
<td>Gill Sans</td>
<td>Gill Sans Light</td>
<td></td>
</tr>
<tr>
<td>TimesNew</td>
<td>Gill Sans Light Italic</td>
<td></td>
</tr>
<tr>
<td>TimesNew It</td>
<td>Gill Sans Extra Bold</td>
<td></td>
</tr>
<tr>
<td>TimesNew Bd</td>
<td>Gill Sans Condensed</td>
<td></td>
</tr>
<tr>
<td>TimesNew BdIt</td>
<td>Gill Sans Condensed Bold</td>
<td></td>
</tr>
<tr>
<td>Goudy Oldstyle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symbol</td>
<td>Goudy OldstyleItalic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Goudy Bold</td>
<td></td>
</tr>
<tr>
<td>Wingdings</td>
<td>Goudy Bold Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Goudy Extra Bold</td>
<td></td>
</tr>
<tr>
<td>Line Printer</td>
<td>Helvetica</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Helvetica Oblique</td>
<td></td>
</tr>
<tr>
<td>Times Roman</td>
<td>Helvetica Bold</td>
<td></td>
</tr>
<tr>
<td>Times It</td>
<td>Helvetica Bold Oblique</td>
<td></td>
</tr>
<tr>
<td>Times Bd</td>
<td>Helvetica Narrow</td>
<td></td>
</tr>
<tr>
<td>Times BdIt</td>
<td>Helvetica Narrow Oblique</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Helvetica Narrow Bold</td>
<td></td>
</tr>
<tr>
<td>Helvetica</td>
<td>Helvetica Narrow Bold Oblique</td>
<td></td>
</tr>
<tr>
<td>Helvetica Ob</td>
<td>Helvetica Condensed</td>
<td></td>
</tr>
<tr>
<td>Helvetica Bd</td>
<td>Helvetica Condensed Oblique</td>
<td></td>
</tr>
<tr>
<td>Helvetica BdOb</td>
<td>Helvetica Condensed Bold</td>
<td></td>
</tr>
<tr>
<td>Font Style</td>
<td>Font Name</td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------</td>
<td></td>
</tr>
<tr>
<td>Helvetica Condensed Bold Oblique</td>
<td>Hoefler Condensed Bold Oblique</td>
<td></td>
</tr>
<tr>
<td>CourierPS</td>
<td>Hoefler Text</td>
<td></td>
</tr>
<tr>
<td>CourierPS Ob</td>
<td>Hoefler Text Oblique</td>
<td></td>
</tr>
<tr>
<td>CourierPS Bd</td>
<td>Hoefler Text Black</td>
<td></td>
</tr>
<tr>
<td>CourierPS BdOb</td>
<td>Hoefler Text Black Oblique</td>
<td></td>
</tr>
<tr>
<td>SymbolPS</td>
<td>Joanna</td>
<td></td>
</tr>
<tr>
<td>Joanna</td>
<td>Joanna Italic</td>
<td></td>
</tr>
<tr>
<td>Palatino Roman</td>
<td>Joanna Bold</td>
<td></td>
</tr>
<tr>
<td>Palatino It</td>
<td>Joanna Bold Italic</td>
<td></td>
</tr>
<tr>
<td>Palatino Bd</td>
<td>Letter Gothic</td>
<td></td>
</tr>
<tr>
<td>Palatino BdIt</td>
<td>Letter Gothic Slanted</td>
<td></td>
</tr>
<tr>
<td>ITCBookman Lt</td>
<td>ITC Lubalin Graph Book</td>
<td></td>
</tr>
<tr>
<td>ITCBookman LtIt</td>
<td>ITC Lubalin Graph Book Oblique</td>
<td></td>
</tr>
<tr>
<td>ITCBookmanDm</td>
<td>ITC Lubalin Graph Demi</td>
<td></td>
</tr>
<tr>
<td>ITCBookmanDm It</td>
<td>ITC Lubalin Graph Demi Oblique</td>
<td></td>
</tr>
<tr>
<td>HelveticaNr</td>
<td>Marigold</td>
<td></td>
</tr>
<tr>
<td>HelveticaNr Ob</td>
<td>Monaco</td>
<td></td>
</tr>
<tr>
<td>HelveticaNr Bd</td>
<td>ITC Mona Lisa Recut</td>
<td></td>
</tr>
<tr>
<td>HelveticaNr BdOb</td>
<td>New Century Schoolbook Roman</td>
<td></td>
</tr>
<tr>
<td>N C Schbk Roman</td>
<td>New Century Schoolbook Bold</td>
<td></td>
</tr>
<tr>
<td>N C Schbk It</td>
<td>New Century Schoolbook Bold Italic</td>
<td></td>
</tr>
<tr>
<td>N C Schbk Bd</td>
<td>NewYork</td>
<td></td>
</tr>
<tr>
<td>N C Schbk BdIt</td>
<td>Optima Roman</td>
<td></td>
</tr>
<tr>
<td>Optima</td>
<td>Optima Italic</td>
<td></td>
</tr>
<tr>
<td>Font Style</td>
<td>Font Style</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>------------------</td>
<td></td>
</tr>
<tr>
<td>ITC A G Go Bk</td>
<td>Optima Bold</td>
<td></td>
</tr>
<tr>
<td>ITC A G Go BkOb</td>
<td>Optima Bold Italic</td>
<td></td>
</tr>
<tr>
<td>ITC A G Go Dm</td>
<td>Oxford</td>
<td></td>
</tr>
<tr>
<td>ITC A G Go DmOb</td>
<td>Palatino Roman</td>
<td></td>
</tr>
<tr>
<td>ZapfC MdIt</td>
<td>Palatino Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Palatino Bold Italic</td>
<td></td>
</tr>
<tr>
<td>ZapfDingbats</td>
<td>Stempel Garamond Roman</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stempel Garamond Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stempel Garamond Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stempel Garamond Bold Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Symbol</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tekton Regular</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times Roman</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times Bold Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times New Roman</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times New Roman Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times New Roman Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Times New Roman Bold Italic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 45 Light</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 45 Light Oblique</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 55</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 55 Oblique</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 65 Bold</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 65 Bold Oblique</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Univers 57 Condensed</td>
<td></td>
</tr>
</tbody>
</table>
Symbol Sets

A symbol set is the collection of alphabetic and numeric characters, punctuation, and special characters available in the font you select. Symbol sets support the requirements for different languages or specific applications, such as math symbols used for scientific text.

In PCL 5/PCL 6, a symbol set also defines which character will print for each key on the keyboard (or more specifically, for each code point). Some applications require different characters at some code points. To support multiple applications and languages, your multifunction printer has 36 symbol sets for the resident PCL 5/PCL 6 fonts.

**Symbol Sets for PCL 5/PCL 6**

Not all font names support all of the symbol sets listed.
<table>
<thead>
<tr>
<th>Font Style</th>
<th>Code 1</th>
<th>Code 2</th>
<th>Code 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roman 8 (Default)</td>
<td>ISO 8859-1 Latin 1</td>
<td>ISO 8859-2 Latin 2</td>
<td></td>
</tr>
<tr>
<td>ISO 8859-9 Latin 5</td>
<td>ISO 8859-10 Latin 6</td>
<td>PC-8</td>
<td></td>
</tr>
<tr>
<td>PC-8 DN</td>
<td>PC-775 Baltic</td>
<td>PC-850 Multilingual</td>
<td></td>
</tr>
<tr>
<td>PC-852 Latin 2</td>
<td>PC-1004 OS/2</td>
<td>PC Turkish</td>
<td></td>
</tr>
<tr>
<td>Windows 3.1 Latin 1</td>
<td>Windows 3.1 Latin 2</td>
<td>Windows 3.1 Latin 5</td>
<td></td>
</tr>
<tr>
<td>DeskTop</td>
<td>PS Text</td>
<td>MC Text</td>
<td></td>
</tr>
<tr>
<td>Microsoft Publishing</td>
<td>Math 8</td>
<td>PS Math</td>
<td></td>
</tr>
<tr>
<td>Pi Font</td>
<td>Legal</td>
<td>ISO 4 United Kingdom</td>
<td></td>
</tr>
<tr>
<td>ISO 6 ASCII</td>
<td>ISO 11 Swedish:names</td>
<td>ISO 15 Italian</td>
<td></td>
</tr>
<tr>
<td>ISO 17 Spanish</td>
<td>ISO 21 German</td>
<td>ISO 60 Norwegian v1</td>
<td></td>
</tr>
<tr>
<td>ISO 69 French</td>
<td>Windows 3.0 Latin 1</td>
<td>Windows Baltic</td>
<td></td>
</tr>
<tr>
<td>Symbol</td>
<td>Wingdings</td>
<td>ITC ZapfDingbats MS</td>
<td></td>
</tr>
</tbody>
</table>
Understanding Multifunction Printer Messages

The printer operator panel displays messages describing the current state of the multifunction printer and indicates possible printer problems you must resolve. This topic provides a list of all printer messages, explains what they mean, and tells you how to clear the messages.

![LCD Panel Diagram]

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LCD Panel</td>
<td>6</td>
<td>(Start) button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>(Back) button</td>
<td>7</td>
<td>button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>buttons</td>
<td>8</td>
<td>(Cancel) button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>(Menu) button</td>
<td>9</td>
<td>Number pad</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>buttons</td>
<td>10</td>
<td>(Pause) button</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** The first and second lines are displayed together. The third and forth lines blink every second.

<table>
<thead>
<tr>
<th>Message</th>
<th>What this message means</th>
<th>What you can do</th>
</tr>
</thead>
</table>


<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>NNN-NNN</td>
<td>Restart Printer&lt;br&gt;Contact Support&lt;br&gt;IfMessageReturns</td>
<td>Error NNN-NNN relates to printer problems.</td>
</tr>
<tr>
<td>NNN-NNN</td>
<td>Restart Printer&lt;br&gt;Reseat Fuser&lt;br&gt;Contact Support</td>
<td>The outer levers on both sides of the fuser unit are not securely locked.&lt;br&gt;Error NNN-NNN relates to printer problems.</td>
</tr>
<tr>
<td>016-316</td>
<td>Restart Printer&lt;br&gt;Reseat Memory&lt;br&gt;Contact Support</td>
<td>The multifunction printer detected an unsupported additional memory module in the memory slot.</td>
</tr>
<tr>
<td>016-318</td>
<td>Restart Printer&lt;br&gt;Reseat Memory&lt;br&gt;Contact Support</td>
<td>The additional memory module is not fully inserted into the slot.</td>
</tr>
<tr>
<td>016-340</td>
<td>Restart Printer&lt;br&gt;Contact Support&lt;br&gt;IfMessageReturns</td>
<td>A communication error occurred in the control card.</td>
</tr>
<tr>
<td>016-330</td>
<td>Restart Printer&lt;br&gt;Reseat MPC&lt;br&gt;Contact Support</td>
<td>A communication card error occurred between the network interface card and control card.</td>
</tr>
<tr>
<td>016-338</td>
<td>Restart Printer&lt;br&gt;Reseat Wireless&lt;br&gt;Contact Support</td>
<td>An error occurred in the wireless printer adapter.</td>
</tr>
<tr>
<td>NNN-NNN</td>
<td>Restart Printer&lt;br&gt;Reseat XXX&lt;br&gt;Contact Support</td>
<td>XXX is not fully inserted.&lt;br&gt;Error NNN-NNN relates to printer problems.</td>
</tr>
<tr>
<td>Paper Jam</td>
<td>077-901&lt;br&gt;Open Front Cover&lt;br&gt;Remove Paper</td>
<td>The multifunction printer detects a paper jam.&lt;br&gt;XXX and YYY indicates a position that you open.</td>
</tr>
<tr>
<td>Error</td>
<td>Description</td>
<td>Solution</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Paper Jam 077-907</td>
<td>Error NNN-NNN relates to printer problems.</td>
<td>See &quot;Clearing Jams&quot;.</td>
</tr>
<tr>
<td>Open Front Cover &amp;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Belt Unit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Jam NNN-NNN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open XXX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open YYY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Jam 077-903</td>
<td>The multifunction printer detects a paper jam. N indicates the tray number.</td>
<td>Pull out the specified tray and clear the paper path. See &quot;Clearing Jams&quot;.</td>
</tr>
<tr>
<td>Remove Paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open &amp; close Front</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cover</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert PrintCart NNN-NNN</td>
<td>The specified print cartridge is either missing or not fully inserted into the multifunction printer. XXX is one of the following: Black, Cyan, Yellow, Magenta</td>
<td>Reinsert the specified print cartridge. See &quot;Replacing Print Cartridges&quot;.</td>
</tr>
<tr>
<td>Insert XXX Cartridge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replace Cart. NNN-NNN</td>
<td>The print cartridge is low on toner. XXX is one of the following: Black, Cyan, Yellow, Magenta</td>
<td>Remove the specified print cartridge and install a new one. NOTE: If you do not replace the print cartridge, print quality problems may occur. Order a new print cartridge at the website (<a href="http://www.dell.com/supplies">www.dell.com/supplies</a> or <a href="http://www.euro.dell.com/supplies">www.euro.dell.com/supplies</a>). See &quot;Replacing Print Cartridges&quot;.</td>
</tr>
<tr>
<td>Replace XXX Cartridge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error XXX Cart. 093-NNN</td>
<td>The density of the print cartridge is not enough. XXX is one of the following: Yellow Print, Cyan Print, Magenta Print, Black Print</td>
<td>Confirm that the toner seal is removed from the specified print cartridge and the cartridge is installed correctly. If this does not solve the problem, contact Dell. See &quot;Replacing Print Cartridges&quot;. See &quot;Contacting Dell&quot; in the Owner's Manual or in this manual.</td>
</tr>
<tr>
<td>Check XXX Cart.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contact Support</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close Front Cover 077-300</td>
<td>Printer cover is open.</td>
<td>Close the specified cover.</td>
</tr>
<tr>
<td>Front Cover Is Open</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error Code</td>
<td>Description</td>
<td>Instructions</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Load XXX NNN-NNN</td>
<td>Incorrect paper size is loaded in the specified tray. XXX indicates the number of the tray or multipurpose feeder. YYY indicates a paper size. yyy indicates paper quality. Error NNN-NNN relates to printer problems.</td>
<td>Load the specified paper in the specified trays. See &quot;Loading Print Media in Standard and Optional Trays&quot;.</td>
</tr>
<tr>
<td>PDL Request 016-720 Data Violation Press ✓</td>
<td>Error relating to PDL emulation problems occurs.</td>
<td>Press ✓ to clear the message, cancel the current print job, and conduct the next print job, if any. Press Cancel to cancel the print job.</td>
</tr>
<tr>
<td>Invalid Job 016-799 Data Violation Press ✓</td>
<td>When the configuration of the multifunction printer on the printer driver does not conform to the multifunction printer you are using, this message appears.</td>
<td>Press Cancel to cancel the print job. Press ✓ to clear the message, cancel the current print job, and conduct the next print job, if any. Ensure that the printer configuration on the printer driver conforms to the multifunction printer you are using.</td>
</tr>
<tr>
<td>Over Heat 042-700 Cooling down Please Wait...</td>
<td>Since it is abnormally hot inside the multifunction printer, printing is paused.</td>
<td>Wait for a while with the multifunction printer on until the error disappears.</td>
</tr>
<tr>
<td>Memory Full 017-970 FaxJob Failure Press ✓</td>
<td>The fax memory is full and cannot continue processing the current fax job.</td>
<td>Press ✓ to clear the message. The fax memory is full and fax job is terminated. Print the received images, or wait for a while until sending images is completed.</td>
</tr>
<tr>
<td>Memory Full 033-788 Fax Job Failure Press ✓</td>
<td>The fax memory is full and cannot continue processing the current fax job.</td>
<td>Press ✓ to clear the message. The fax memory is full. Remove the received images, or wait for a while until sending images is completed.</td>
</tr>
<tr>
<td>Accumulation Limit Not Stored For Last Sheet Press ✓</td>
<td>Exceeds the maximum sheets of paper at a time when you send a fax.</td>
<td>Press ✓ to clear the message. The maximum sheets of paper at a time are loaded. Load up to 50 sheets of paper at a time.</td>
</tr>
<tr>
<td>No Answer 035-701 Fax Job Failure Press ✓</td>
<td>No answer is received from the remote machine. (T1 timeout on sending data)</td>
<td>Press ✓ to clear the message. No answer is received from the remote machine. Check the status of the remote machine.</td>
</tr>
<tr>
<td>Communication 035-702 Fax Job Failure Press ✓</td>
<td>The communication was shut by the remote machine. (Received DCN)</td>
<td>Press ✓ to clear the message. The communication was shut by the remote machine. Check the status of the remote machine.</td>
</tr>
<tr>
<td>Error Code</td>
<td>Description</td>
<td>Resolution</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>------------</td>
</tr>
</tbody>
</table>
| No Answer 035-718 Fax Job Failure Press ✓ | No answer is received from the remote machine. (T1 timeout on receiving data) | - Press ✓ to clear the message.  
- No answer is received from the remote machine. Check the status of the remote machine. |
| Communication 035-720 Fax Job Failure Press ✓ | The remote machine cannot receive data. | - Press ✓ to clear the message.  
- The remote machine cannot receive data. Check the features of the remote machine. |
| No Dial Tone 035-746 Fax Job Failure Press ✓ | Cannot detect a dial tone before dialing the number. | - Press ✓ to clear the message.  
- A dial tone cannot be detected. Check the communication line. |
| Busy 035-781 Fax Job Failure Press ✓ | The busy tone was detected after dialing the number. | - Press ✓ to clear the message.  
- The busy tone was detected. Wait for a while and redial the number. |
| No Dial Tone 035-749 Fax Job Failure Press ✓ | The remote machine does not respond after dialing the number. | - Press ✓ to clear the message.  
- The remote machine does not respond. Check the status of the remote machine. |
| Communication 033-513 Fax Job Failure Press ✓ | The fax memory is full and the communication was disconnected. | - Press ✓ to clear the message.  
- The fax memory is full and the communication was disconnected. Print the received images, or wait for a while until sending images is completed. |
| Paper Jam 005-121 Open ADF Cover and Clear Jam | Paper jam is detected in the ADF. | Remove the jammed paper. |
| Paper Jam 005-110 Open ADF Cover and Clear Jam | Paper jam is detected in the ADF. | Remove the jammed paper. |
| Cover Open 005-301 Close ADF Cover | The cover of the ADF is open. | Close the cover of the ADF. |
| Memory Full 033-503 Fax Job Failure Press ✓ | The fax memory is full. | - Press ✓ to clear the message.  
- The fax memory is full. Print the received images, or wait for a while until sending images is completed. |
<table>
<thead>
<tr>
<th>Error Type</th>
<th>Description</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMB/FTP Error 016-781</td>
<td>Cannot connect the server to which you transfer files.</td>
<td>Press ✅ to clear the message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensure settings for the server address are correct. If the server address is correct, contact your network administrator for the network and server environments.</td>
</tr>
<tr>
<td>SMTP Error 016-764</td>
<td>An error occurred when you connect the SMTP server.</td>
<td>Press ✅ to clear the message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensure the settings for the SMTP server are correct. If the settings are correct, contact your SMTP server administrator.</td>
</tr>
<tr>
<td>Network Error 016-770</td>
<td>The MPC firmware of this version does not support Scan To EMail and SMB/FTP.</td>
<td>Press ✅ to clear the message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Upgrade the MPC firmware.</td>
</tr>
<tr>
<td>Login Error 016-782</td>
<td>Cannot log in the server to which you transfer files.</td>
<td>Press ✅ to clear the message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensure the server name, login user name, and password are correct.</td>
</tr>
<tr>
<td>SMB/FTP Error 016-783</td>
<td>Cannot find the specified path of the server to which you transfer files.</td>
<td>Press ✅ to clear the message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensure the specified server path name and access right to the folder are correct.</td>
</tr>
<tr>
<td>SMB/FTP Error 016-784</td>
<td>Cannot create a directory.</td>
<td>Press ✅ to clear the message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check you have the right to create a directory.</td>
</tr>
<tr>
<td>SMB/FTP Error 016-787</td>
<td>An error occurred when you transfer data to the server.</td>
<td>Press ✅ to clear the message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensure the directory in the server is not full or you have the access right to the directory.</td>
</tr>
<tr>
<td>SMB/FTP Error 016-789</td>
<td>Cannot transfer the file.</td>
<td>Press ✅ to clear the message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensure you have the right to rename/delete files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensure SP1 is already installed in the Windows Server 2003. If it is not installed, install SP1.</td>
</tr>
<tr>
<td>SMB/FTP Error</td>
<td>Files of the same name exist.</td>
<td>Press ✅ to clear the message.</td>
</tr>
<tr>
<td>Error Code</td>
<td>Error Message</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>016-788</td>
<td>NOTE:</td>
<td>This incident occurs when you scan data in the format of pdf and YYMMDDHHMMSS from the remote machine and 10000 numbers of files (img-YYMMDDHHMMSS, img-YYMMDDHHMMSS-0001.pdf, ... img-YYMMDDHHMMSS-9999.pdf) exist on the server. This also occurs when you create other multiple page files.</td>
</tr>
<tr>
<td>016-786</td>
<td>Network Error</td>
<td>A time-out error occurred when you send or receive scanned data.</td>
</tr>
<tr>
<td>016-785</td>
<td>Server Full</td>
<td>Cannot transfer files because the hard disk on the FTP/SMB server is full.</td>
</tr>
<tr>
<td>016-765</td>
<td>SMTP Server Full</td>
<td>The SMTP server is full.</td>
</tr>
<tr>
<td>016-767</td>
<td>Address Error</td>
<td>The e-mail address of the destination is not correct.</td>
</tr>
<tr>
<td>016-768</td>
<td>From Address Error</td>
<td>The e-mail address of the sender is not correct.</td>
</tr>
<tr>
<td>016-507</td>
<td>SMTP Login Error</td>
<td>Cannot log in the SMTP server to which you send e-mail.</td>
</tr>
<tr>
<td>016-506</td>
<td>SMTP Login Error</td>
<td>There are unspecified settings.</td>
</tr>
</tbody>
</table>

- If files of the same name already exist, overwrite existing files, or save them as new names.
- Delete existing files of the same name.
- Press to clear the message.
- Ensure the network cable is not disconnected. If the network cable is connected correctly, contact your server administrator.
- Press to clear the message.
- Delete unnecessary data in the hard disk to ensure a free space.
- Press to clear the message.
- Contact your SMTP server administrator.
- Press to clear the message.
- Check the e-mail address, and then scan data again.
- Press to clear the message.
- Check the e-mail address, and then scan data again.
- Press to clear the message.
- Ensure the user name and password used in the SMTP server are correct.
- Press to clear the message.
- Ensure the SMTP server or POP3 server is already specified from the Dell Printer Configuration Web Tool.
<table>
<thead>
<tr>
<th>Error Code</th>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
</table>
| POP login Error 016-505 | Cannot log in the POP3 server to which you send e-mail. | - Press ✔ to clear the message.  
- Ensure the settings for the SMTP server or POP3 server are correct from the Dell Printer Configuration Web Tool. |
| SMTP Error 016-503 | Cannot resolve the name of the SMTP server to which you send e-mail. | - Press ✔ to clear the message.  
- Ensure the settings for the SMTP server are correct from the Dell Printer Configuration Web Tool.  
- Ensure the settings for the DNS server are correct. |
| POP Error 016-504 | Cannot resolve the name of the POP3 server to which you send e-mail. | - Press ✔ to clear the message.  
- Ensure that the settings for the POP3 server are correct from the Dell Printer Configuration Web Tool.  
- Ensure the settings for the DNS server are correct. |
| SMTP Error 016-766 | An error occurred in the SMTP server. | - Press ✔ to clear the message.  
- Contact your SMTP server administrator. |
| Network Not Ready 016-790 | The settings for the network environment required for scanning are not prepared. | - Press ✔ to clear the message.  
- Ensure the network cable is not disconnected. If the network cable is connected correctly, retry to log in. |
| File size limits 016-986 | After you convert data to the specified format, the size of data exceeds the maximum specified in each format. | - Press ✔ to clear the message.  
- Reduce the image quality, for example, change the scan resolution, or change the file format to reduce the file size. |
| Mail Size Limits 016-985 | The size of e-mail specified in Menu exceeds the maximum. | - Press ✔ to clear the message.  
- Reduce the image quality, for example, change the scan resolution, or change the file format to reduce the file size. |
| PCScan Time Out 017-988 | The connection to the host computer is timed out and Scan To Application cannot start. | - Press ✔ to clear the message.  
- Ensure your computer starts up and the USB cable is connected securely.  
- Ensure the required software is installed. For details, see "Scanning". |
Clearing Jams

Careful selection of appropriate print media and proper loading allow you to avoid most jams. See "Print Media Guidelines" for more information.

- Avoiding Jams
- Identifying the Location of Paper Jams
- Removing Print Jams from the ADF
- Removing Print Jams From the Multipurpose Feeder
- Removing Print Jams From the Standard Tray
- Removing Print Jams From the Fuser Unit
- Removing Print Jams From the Optional Duplexer
- Removing Print Jams From the Optional Feeder

NOTE: Before buying large quantities of any print media, Dell recommends trying a sample first.

Avoiding Jams

- Use only recommended print media. See "Print Media Guidelines" for more information.

- See "Loading Print Media in Standard and Optional Trays" and "Loading the Multipurpose Feeder" to load printer media properly.

- Do not overload the print media sources. Ensure the stack print media height does not exceed the maximum height indicated by the load line labels in the trays.

- Do not load wrinkled, creased, damp, or curled print media.

- Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at a time through the multipurpose feeder.

- Do not use print media that you have cut or trimmed yourself.

- Do not mix print media sizes, weights, or types in the same print media source.

- Ensure the recommended print side is face up when you insert the print media. However, the recommended print side should be face down when using the multipurpose feeder.

- Keep print media stored in an acceptable environment. For more information, see "Storing Print Media".

- Do not remove the feeding tray during a print job.

- Push all trays in firmly after loading them.

- Ensure all cables that connect to the multifunction printer are correctly attached.

- Overtightening the guides may cause jams.

- Wipe the feeder rollers in the trays or multipurpose feeder with a cloth that is slightly dampened with
water if jams caused by misfeeding paper occur frequently.

Identifying the Location of Paper Jams

The following illustration shows where paper jams may occur along the print media path.

⚠️ CAUTION: Do not attempt to clear any jams using tools or instruments. This may permanently damage the multifunction printer.
Removing Print Jams from the ADF

When a document jams while it passes through the Automatic Document Feeder (ADF), remove jams in the following procedure.

⚠️ **NOTE:** To prevent document jams, use the document feeder glass for thick, thin or mixed documents.

1. Remove the remaining documents from the ADF.

   If the document is jammed in the paper feed area:
   
   a. Open the ADF cover.

   b. Remove the document by gently pulling it straight up.
If you find it difficult to pull the document, turn the dial behind the cover.

a. Close the ADF cover. Then reload the document into the ADF.

If the document is jammed in the paper exit area:

a. Open the document cover and turn the dial to remove the misfed documents from the ADF output tray.

b. Close the document cover. Then load the documents back into the ADF.

2. If you cannot see the paper or the paper does not move when you pulled, open the document cover.

3. Remove the document from the roller or the feed area by carefully pulling it gently to the right.

4. Close the document cover. Then load the documents back into the ADF.

---

**Removing Print Jams From the Multipurpose Feeder**

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.
NOTE: To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Pull the jammed paper out of the multipurpose feeder. If no jammed paper can be found or it is hard to remove the paper, close the multipurpose feeder and go to the next step to remove the jammed paper from the inside of the multifunction printer.

2. Remove the 250-sheet tray from the multifunction printer, and then pull out the jammed paper remaining inside the multifunction printer. If no jammed paper can be found or it is hard to remove the paper, go to the next step to remove the jammed paper from the inside of the multifunction printer.
3. Open the front cover by pushing the button (right side) and remove the jammed paper. Then, confirm that there are no scraps of paper remaining inside the multifunction printer.

4. Insert the tray back into the multifunction printer, and push until it stops.

5. Open and close the front cover.

---

Removing Print Jams From the Standard Tray
**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.

**NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Pull the tray out of the multifunction printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the multifunction printer.

2. Remove all the jammed and/or creased paper from the tray.

3. Pull the jammed paper out carefully to avoid tearing it. If it is still hard to remove the paper, go to the next step to remove the jammed paper from the inside of the multifunction printer.
4. Open the front cover by pushing the button (right side) and remove the jammed paper. Then, confirm that there are no scraps of paper remaining inside the multifunction printer.

5. Close the front cover.
6. Insert the tray into the multifunction printer, and push until it stops.

**CAUTION:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the multifunction printer.

---

**Removing Print Jams From the Fuser Unit**

**NOTICE:** Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, or oil from your hands on the film of the transfer belt unit may reduce print quality.
**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.

**NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Turn off the multifunction printer and wait for 30 minutes.
2. Push the button (right side) and open the front cover.

3. Lift the levers at both ends of the fuser unit, and remove the jammed paper. If any jammed paper cannot be found, go to the next step.
CAUTION: The fuser unit is hot. Do not touch it, doing so may cause burns.

4. Open the cover of the fuser unit and remove the jammed paper.

5. Close the cover of the fuser unit and press down the levers at both ends of the fuser unit.
6. Confirm that there are no scraps of paper remaining inside the multifunction printer, and then close the front cover.

---

**Removing Print Jams From the Optional Duplexer**

**NOTICE:** Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, or oil from your hands on the film of the transfer belt unit may reduce print quality.

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.
**NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Push the button (right side) and open the front cover.

![Image showing the front cover being opened](image1.png)

2. Pull out the jammed paper from the duplexer. If jammed paper cannot be found, go to the next step.

![Image showing the jammed paper being pulled out](image2.png)

3. Pull up on the belt release levers and rotate the transfer belt unit up as shown in the illustration.

![Image showing the transfer belt unit being rotated](image3.png)
4. Remove the jammed paper and close the transfer belt unit.

5. Close the front cover.
Removing Print Jams From the Optional Feeder

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.

**NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Pull the tray out of the multifunction printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the multifunction printer.

**NOTE:** Paper in the optional 550-sheet paper feeder feeds to the multifunction printer from the front of the 250-sheet tray, therefore paper jammed in the 250-sheet tray can block the optional tray module in the multifunction printer, preventing you from opening them. Look for the jammed paper sequentially, starting with the optional 550-sheet paper feeder.
2. Remove all jammed and/or creased paper from the tray.

3. Pull the jammed paper out carefully to avoid tearing it. If it is still hard to remove the paper, go to the next step to remove the jammed paper from the inside of the multifunction printer.
4. Open the front cover by pushing the button (right side) and remove the jammed paper. Then, confirm that there are no scraps of paper remaining inside the multifunction printer.

5. Close the front cover.
**NOTE:** If the paper jam message is not cleared after closing the front cover, pull out the 250-sheet tray from the multifunction printer and remove the jammed paper.

6. Insert the tray back into the multifunction printer, and push until it stops.

**CAUTION:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the multifunction printer.
Troubleshooting

Troubleshooting Guide

This section consists of the following instructions:

1. Configuration of your printer instructions:
   A. **User Settings**
      - **Setup Menus**
      - Setup printing Letter Plain from Multipurpose Feeder
      - Setup printing Letter Plain from Tray1
      - Setup printing Letter Plain from Tray2
      - Setup printing Letter Transparency from Multipurpose Feeder
      - Setup printing Envelope from Multipurpose Feeder
      - Setup Paper Size
      - Setup Paper Type
   B. **Configuration**
      - Parallel Printing
      - USB Printing
      - Setup Network
      - Setup Security

2. **Troubleshooting Instructions**:
   - Diagnostic Menu Map (Customer Mode)
   - Testing "Print Quality"
   - Testing "TonerPalletCheck" or "ContaminationChk"

3. **Other Problems**:
   - How to replace Print cartridges
How to replace the Fuser Unit

How to replace Rollers

Removing the Used Transfer Belt Unit

The section will help you solve problems with the multifunction printer, options, or print quality.

Troubleshooting Guide
Basic Printer Problems
Display Problems
Printing Problems
Print Quality Problems
Copy Problems
Fax Problems
Scanning Problems
Option Problems
Other Problems
Contacting Service
Troubleshooting Guide
Installing Printer Drivers

Basic Printer Problems

Some printer problems can be easy to resolve. If a problem occurs with your multifunction printer, check each the following:

- If a message displays on the operator panel, see "Understanding Multifunction Printer Messages."
- The printer power cable is plugged into the multifunction printer and a properly grounded electrical outlet.
- The printer power is on.
- The electrical outlet is not turned off at any switch or breaker.
- Other electrical equipment plugged into the outlet is working.
- All options are properly installed.
- If you have checked all of the above and still have a problem, turn off the multifunction printer, wait for 10 seconds, and then turn on the multifunction printer. This often fixes the problem.
NOTICE: If an error message appears, see "Understanding Multifunction Printer Messages."

## Display Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
</table>
| Operator panel displays only diamonds or is blank. | · Turn off the multifunction printer, wait for 10 seconds, and turn on the multifunction printer.  
· Self Test Message appears on the operator panel. When the test is completed, **Print** is displayed. |  
| Menu settings changed from the operator panel have no effect. | Settings in the software program, the printer driver, or the printer utilities are overriding the settings made on the operator panel.  
· Change the menu settings from the printer driver, the printer utilities, or the software program instead of the operator panel. |

## Printing Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
</table>
| Job did not print or incorrect characters printed. | Ensure **Print** appears on the operator panel before you send a job to print. Press Menu to return to **Print**.  
Ensure print media is loaded in the multifunction printer. Press Menu to return to **Print**.  
Verify the multifunction printer is using the correct page description language (PDL).  
Verify that you are using the correct printer driver.  
Ensure you are using the correct Ethernet, USB, IEEE cable, or wireless printer adapter and that it is securely connected to the multifunction printer.  
Verify that the correct print media size is selected.  
If using a print spooler, verify that the spooler has not stalled. |
| Print media misfeeds or multiple feeds occur.      | Ensure the print media you are using meets the specifications for your multifunction printer. See "Print Media Supported" for more information.  
Flex print media before loading it in any of the sources.  
Ensure the print media is loaded correctly. |
Ensure the width and length guides on the print media sources are adjusted correctly.

Do not overfill the print media sources.

Do not force print media into the multipurpose feeder when you load it; otherwise, it may skew or buckle.

Remove any curled print media from sources.

Load the recommended print side correctly for the type of print media you are using. See "Loading Print Media in Standard and Optional Trays" for more information.

Turn the print media over or around and try printing again to see if feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom sheets of a ream before loading the print media.

Load a print media source only when it is empty.

Wipe the feeder rollers in the trays or multipurpose feeder with a cloth that slightly dampened with water.

---

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope misfeeds or multiple feeds occur.</td>
<td>Reduce the number of envelopes in the stack.</td>
</tr>
<tr>
<td>Page breaks in unexpected places.</td>
<td>Check the <strong>Time-Out</strong> in the <strong>System Settings</strong> menu. Increase the setting.</td>
</tr>
<tr>
<td>Job prints from the wrong source or on the wrong print media.</td>
<td>Check the Paper Type in the <strong>Tray Settings</strong> menu on the printer operator panel and in the printer driver.</td>
</tr>
<tr>
<td>Print media does not stack neatly in the output bin.</td>
<td>Turn the print media stack over in the tray or multipurpose feeder.</td>
</tr>
<tr>
<td>Multifunction printer does not duplex pages.</td>
<td>Ensure 2 Sided is selected in both the <strong>PCL</strong> (Printer Control Language) menu on the printer operator panel and in the printer driver.</td>
</tr>
<tr>
<td></td>
<td>Ensure you have enough print memory installed.</td>
</tr>
</tbody>
</table>

---

**Print Quality Problems**
<table>
<thead>
<tr>
<th>Issue</th>
<th>Potential Solutions</th>
</tr>
</thead>
</table>
| Print is too light. | · The print cartridges may be low or need to be replaced. Confirm the amount of toner in each print cartridge and replace it with a new one if necessary.  
· Set the **Toner Saving Mode** check box to off in the **Advanced** tab in the printer driver.  
· If you are printing on an uneven print surface, change the **Paper Type** settings in the **Tray Settings** menu. See "**System Settings**."  
· Verify that the correct print media is being used. |
| Toner smears or print comes off page. | · If you are printing on an uneven print surface, change the **Paper Type** settings in the **Tray Settings** menu. See "**System Settings**."  
· Verify that the print media is within the printer specifications.  
· The fuser unit is old or damaged. Replace the fuser unit. See "**Replacing the Fuser Unit**". |
| Toner spots appear on the page/printing is blurred. | · Check the print cartridges to ensure that they are installed correctly.  
· Change the print cartridges. See "**Replacing Print Cartridges**". |
<table>
<thead>
<tr>
<th>Issue</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entire page is white.</td>
<td>· Ensure the packaging material is removed from the print cartridges.</td>
</tr>
<tr>
<td></td>
<td>· Check the print cartridges to ensure that they are installed correctly.</td>
</tr>
<tr>
<td></td>
<td>· The print cartridges may be low or need to be replaced. Confirm the amount of toner in each print cartridge and replace it with a new one if necessary. See &quot;Replacing Print Cartridges&quot;.</td>
</tr>
<tr>
<td>Streaks appear on the page.</td>
<td>· The print cartridges may be low or need to be replaced. Confirm the amount of toner in each print cartridge and replace it with a new one if necessary. See &quot;Replacing Print Cartridges&quot;.</td>
</tr>
<tr>
<td></td>
<td>· If you are using preprinted forms, ensure that the media can withstand a temperature of 190 °C (374 °F).</td>
</tr>
<tr>
<td>Characters have jagged or uneven edges.</td>
<td>· Select On for Bitmap Text Smoothing in the Advanced tab in the printer properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>· If you are using downloaded fonts, verify that the fonts are supported by the multifunction printer, the host computer, and the software program.</td>
</tr>
<tr>
<td>Part or all of the page prints in black.</td>
<td>· Check the print cartridges to ensure that they are installed correctly.</td>
</tr>
<tr>
<td>Problem</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The job prints, but the top and side margins are incorrect.</td>
<td>· Ensure the margins are set correctly in your software program.</td>
</tr>
<tr>
<td>Printing on both ends of the transparencies is faded.</td>
<td>· This occurs when the multifunction printer is operating in a location where relative humidity reaches 85% or more. Adjust the humidity or relocate the multifunction printer to an appropriate environment.</td>
</tr>
<tr>
<td>Color registration is out</td>
<td>· Print the color registration chart and adjust the color registration from the</td>
</tr>
</tbody>
</table>
of alignment.

operator panel by using the chart. See "Color Reg Adjust" for more details.

| Colored dots are printed at regular intervals. | · Replace the print cartridge that prints the dots with a new one. |

| Partial blanks, creased paper or blotted printing. | · Condensation inside the multifunction printer causes partial blanks or creased paper. Keep the multifunction printer turned on and leave it more than one hour to get rid of the condensation. In winter, keep the multifunction printer turned on to prevent condensation from forming. In this case, you can reduce power consumption by using the energy-saving mode. If the problems still occur, contact Dell. See "Contacting Dell" in the Owner's Manual or in this manual.  
· This occurs when you print on talc paper or acid paper. Use neutralized paper. |
Vertical blanks

- A print cartridge is damaged. Replace the print cartridge with a new one.

## Copy Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A document loaded in the Automatic Document Feeder (ADF) cannot be copied</td>
<td>- Set the <strong>Auto Fit</strong> mode to Off on the operator panel.</td>
</tr>
</tbody>
</table>

## Fax Problems
<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
</table>
| The multifunction printer is not working, there is no display and the buttons are not working. | · Unplug the power cord and plug it in again.  
· Ensure that there is power to the electrical receptacle. |
| No dial tone sounds.                                                   | · Check that the phone line is connected properly. See "Connecting the Telephone Line".  
· Check that the phone socket in the wall is working by plugging in another phone. |
| The numbers stored in the memory do not dial correctly.               | · Ensure that the numbers are stored in the memory correctly.  
· Print a Phone Book list. |
| The document does not feed into the multifunction printer.            | · Ensure that the document is not wrinkled and you are putting it in correctly. Check that the document is the right size, not too thick or thin.  
· Ensure that the Automatic Document Feeder (ADF) cover is firmly closed. |
| Faxes are not received automatically.                                  | · The FAX mode should be selected.  
· Ensure that there is paper in the paper tray.  
· Check to see if the display shows "Memory Full". |
| The multifunction printer does not send.                              | · Ensure that the document is loaded in the ADF or on the document feeder glass.  
· "Sending" should show up on the display.  
· Check the other fax machine you are sending to, to see if it can receive your fax. |
| The incoming fax has blank spaces or is received in poor-quality.      | · The fax machine sending you the fax may be faulty.  
· A noisy phone line can cause line errors.  
· Check your multifunction printer by making a copy.  
· The print cartridge may be empty. Replace the print cartridge, referring to "Replacing a Print Cartridge". |
| Some of the words on an incoming fax are stretched.                    | The fax machine sending you the fax had a temporary document jam. |
| There are lines on the documents you send.                             | Check your scan glass for marks and clean it. See "Cleaning the scanner". |
| The multifunction printer dials a number, but the connection with another fax machine fails. | The other fax machine may be turned off, out of paper, or cannot answer incoming calls. Speak with the other machine operator and ask her/him to sort out the problem. |
| Documents are not stored in the memory.                               | There may not be enough memory to store the document. If the display shows a "Memory Full" message, delete any documents you no longer need from the memory and then restore the document. |
| Blank areas appear at the bottom of each page or on other pages, with a small strip of text at the top. | You may have chosen the wrong paper settings in the user option setting. See "Print Media Guidelines". |
### Scanning Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The scanner does not work.</strong></td>
<td>· Ensure that you place the document to be scanned face down from the document feeder glass, or face up in the ADF.&lt;br&gt;· There may not be enough available memory to hold the document you want to scan. Try the Prescan function to see if that works. Try lowering the scan resolution rate.&lt;br&gt;· Check that the USB cable is connected properly.&lt;br&gt;· Ensure that the USB cable is not defective. Switch the cable with a known good cable. If necessary, replace the cable.&lt;br&gt;· Check that the scanner is configured correctly. Check the application you want to use to make certain that the scanner job is being sent to the correct port.</td>
</tr>
<tr>
<td><strong>The unit scans very slowly.</strong></td>
<td>· Check if the multifunction printer is printing received data. Scan the document after the current job is completed.&lt;br&gt;· Graphics are scanned more slowly than text.&lt;br&gt;· Communication speed becomes slow in scan mode because of the large amount of memory required to analyze and reproduce the scanned image.</td>
</tr>
<tr>
<td><strong>Message appears on your computer screen:</strong></td>
<td>· There may be a copying or printing job in progress. When the current job is complete, try the job again.&lt;br&gt;· The Selected port is currently being used. Restart your computer and try again.&lt;br&gt;· The printer cable may be improperly connected or the power may be off.&lt;br&gt;· The scanner driver is not installed or an operating environment is not set up properly.&lt;br&gt;· Ensure that the port is properly connected and the power is turned on. Then restart your computer.&lt;br&gt;· Check that the USB cable is properly connected.</td>
</tr>
<tr>
<td><strong>Cannot scan using WIA on a Windows Server 2003 computer.</strong></td>
<td>Enable WIA on the computer.&lt;br&gt;To enable WIA:&lt;br&gt;1. Click <strong>Start</strong>, point to <strong>Administrative Tools</strong>, and then click <strong>Services</strong>.&lt;br&gt;2. Right-click <strong>Windows Image Acquisition (WIA)</strong>, and then click <strong>Start</strong>.</td>
</tr>
<tr>
<td><strong>Cannot scan using TWAIN or WIA on a Windows Server 2008 computer.</strong></td>
<td>Install the Desktop Experience feature on the computer.&lt;br&gt;To install Desktop Experience:&lt;br&gt;1. Click <strong>Start</strong>, point to <strong>Administrative Tools</strong>, and then click <strong>Server Manager</strong>.&lt;br&gt;2. Under <strong>Features Summary</strong>, click <strong>Add Features</strong>.&lt;br&gt;3. Select the <strong>Desktop Experience</strong> check box, click <strong>Next</strong>, and then click <strong>Install</strong>.&lt;br&gt;4. Restart the computer.</td>
</tr>
</tbody>
</table>
**Option Problems**

If an option does not operate correctly following installation or stops working:

- Turn off the multifunction printer, wait for 10 seconds, and then turn on the multifunction printer. If this does not fix the problem, unplug the multifunction printer, and check the connection between the option and the multifunction printer.

- Print the system settings page to see if the option is listed in the Installed Options list. If the option is not listed, reinstall it. See "Printing a System Settings Page".

- Ensure the option is selected in the printer driver you are using.

The following table lists printer options and corrective actions for related problems. If the suggested corrective action does not correct the problem, call customer service.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
</table>
| Optional tray          | · Ensure the optional 550-sheet paper feeder is correctly connected to the multifunction printer. Reinstall the feeder. See "Removing the Optional 550-Sheet Paper Feeder" and "Installing the Optional 550-Sheet Paper Feeder".  
                        | · Ensure the print media is loaded correctly. See "Loading Print Media in Standard and Optional Trays" for more information. |
| Duplexer               | · Ensure the duplexer is correctly installed. Reinstall the duplexer. See "Removing the Optional Duplexer" and "Installing a Duplexer". |
| Memory card            | · Ensure the memory card is securely connected to the printer system board. |
| Multi-protocol card    | · Ensure the card is securely inserted to the correct slot.  
                        | · Ensure you are using the correct card. |
| Wireless printer adapter | · Ensure that the wireless printer adapter is securely connected to the multi-protocol card. |

**Other Problems**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condensation has occurred inside the multifunction printer.</td>
<td>· This usually occurs within several hours after you heat the room in winter. This also occurs when the multifunction printer is operating in a location where relative humidity reaches 85% or more. Adjust the humidity or relocate the multifunction printer to an appropriate environment.</td>
</tr>
</tbody>
</table>
**Contacting Service**

When you call for printer service, be prepared to describe the problem you are experiencing or the error message on the display.

You need to know your printer model type and serial number. See the label on the back of the multifunction printer near the controller card for this information.

---

**Troubleshooting Guide**

**Configuration of your printer instructions**

**User Settings**

Setup Menus
* Only displayed when an optional 550-sheet paper feeder is installed on the multifunction printer.

**Setup printing Letter Plain from Multipurpose Feeder**

1. On the printer operator menu, press ▼ until >SETUP appears, and then press ✓.

2. Press ▼ until >Tray Settings appears, and then press ✓.

3. Press ▼ until >MPF appears, and then press ✓.
4. Press ▼ until >Paper Type appears, and then press ✓.
5. Press ◄ or ► until Plain appears, and then press ✓.
6. Now we have the MPF Type set to Plain.
7. Press Back to return to the previous menu.
8. Press ▼ until >Paper Size appears, and then press ✓.
9. Press ◄ or ► until Letter appears, and then press ✓.
10. Now we have the MPF Size set to Letter.
11. Now insert the Letter-sized stack of paper into the MPF.
13. Press ✓ to save this setting.
14. Now on the screen MPF/Plain will appear.
15. Press ✓ to save this setting.
16. We now have all the hardware settings on the multifunction printer correct

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go File→Print and then click the Properties button, you will get this same driver properties window.

17. Open up Word and create a new document.
18. Go to File→Print.
19. Select the Dell MFP Laser 3115cn from the printers list.
20. Click the Preferences button.
21. This brings up Printing Preferences.
22. Click the Paper/Output tab.
24. Select Paper Source to MPF.
25. Select MPF Paper Type to Plain.
26. Click OK.
27. Now the printer driver is setup correctly.
28. Click Print.
Setup printing Letter Plain from Tray1

1. On the printer operator menu, press ▼ until SETUP appears, and then press ✓.
2. Press ▼ until >Tray Settings appears, and then press ✓.
3. Press ▼ until >Tray 1 appears, and then press ✓.
4. Press ▼ until >Paper Type appears, and then press ✓.
5. Press ▼ or ▲ until Plain appears, and then press ✓.
6. Now we have the Tray1 Type set to Plain.
7. Press Back to return to the previous menu.
8. Press ▼ until >Paper Size appears, and then press ✓.
9. Press ▼ or ▲ until Auto appears, and then press ✓.
10. Now we have the Tray1 Size set to Letter.
13. Press ✓ to save this setting.
14. Now on the screen Tray 1/Plain will appear.
15. Press ✓ to save this setting.
16. We now have all the hardware settings on the multifunction printer correct.

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go File→Print and then click the Properties button, you will get this same driver properties window.

17. Open up Word and create a new document.
18. Go to File→Print.
19. Select the Dell MFP Laser 3115cn from the printers list.
20. Click the Preferences button.
21. This brings up Printing Preferences.
22. Click the Paper/Output tab.
23. Select **Paper Size** to **Letter**.

24. Select **Paper Source** to **Tray 1**.

25. Click **OK**.

26. Now the printer driver is setup correctly.

27. Click **Print**.

---

**Setup printing Letter Plain from Tray2**

1. On the printer operator menu, press ▼ until >SETUP appears, and then press ✓.

2. Press ▼ until >Tray Settings appears, and then press ✓.

3. Press ▼ until >Tray 2 appears, and then press ✓.

4. Press ▼ until >Paper Type appears, and then press ✓.

5. Press ◄ or ► until Plain appears, and then press ✓.

6. Now we have the Tray2 Type set to Plain.

7. Press **Back** to return to the previous menu.

8. Press ▼ until >Paper Size appears, and then press ✓.

9. Press ◄ or ► until Auto appears, and then press ✓.

10. Now we have the Tray2 Size set to Letter.

11. Now insert the Letter-sized stack of paper into the **Tray 2**.

12. On the screen **Tray 2/Letter** will appear.

13. Press ✓ to save this setting.

14. Now on the screen **Tray 2/Plain** will appear.

15. Press ✓ to save this setting.

16. We now have all the hardware settings on the multifunction printer correct.

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go **File→Print** and then click the **Properties** button, you will get this same driver properties window.

17. Open up Word and create a new document.

18. Go to **File→Print**.
19. Select the **Dell MFP Laser 3115cn** from the printers list.

20. Click the **Preferences** button.

21. This brings up Printing Preferences.

22. Click the **Paper/Output** tab.

23. Select **Paper Size** to **Letter**.

24. Select **Paper Source** to **Tray 2**.

25. Click **OK**.

26. Now the printer driver is setup correctly.

27. Click **Print**.

**Setup printing Letter Transparency from Multipurpose Feeder**

1. On the printer operator menu, press ▼ until >SETUP appears, and then press ✔.

2. Press ▼ until >Tray Settings appears, and then press ✔.

3. Press ▼ until >MPF appears, and then press ✔.

4. Press ▼ until >Paper Type appears, and then press ✔.

5. Press ◀ or ► until Transparency appears, and then press ✔.

6. Now we have the MPF Type set to Transparency.

7. Press **Back** to return to the previous menu.

8. Press ▼ until >Paper Size appears, and then press ✔.

9. Press ◀ or ► until Letter appears, and then press ✔.

10. Now we have the MPF Size set to Letter.

11. Now insert the Letter-sized stack of paper into the MPF.

12. On the screen **MPF/Letter** will appear.

13. Press ✔ to save this setting.


15. Press ✔ to save this setting.

16. We now have all the hardware settings on the multifunction printer correct.
Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go File→Print and then click the Properties button, you will get this same driver properties window.

17. Open up Word and create a new document.
18. Go to File→Print.
19. Select the Dell MFP Laser 3115cn from the printers list.
20. Click the Preferences button.
21. This brings up Printing Preferences.
22. Click the Paper/Output tab.
24. Select Paper Source to MPF.
25. Select MPF Paper Type to Transparency.
26. Click OK.
27. Now the printer driver is setup correctly.
28. Click Print.

Setup printing Envelope from Multipurpose Feeder

1. On the printer operator menu, press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Tray Settings appears, and then press ✓.
3. Press ▼ until >MPF appears, and then press ✓.
4. Press ▼ until >Paper Type appears, and then press ✓.
5. Press ◀ or ▶ until Envelope appears, and then press ✓.
6. Now we have the MPF Type set to Envelope.
7. Press Back to return to the previous menu.
8. Press ▼ until >Paper Size appears, and then press ✓.
9. Press ◀ or ▶ until Envelope appears, and then press ✓.
10. Now we have the MPF Size set to Envelope.
11. Now insert the Envelope-sized stack of paper into the MPF.
13. Press ✔️ to save this setting.


15. Press ✔️ to save this setting.

16. We now have all the hardware settings on the multifunction printer correct.

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go File→Print and then click the Properties button, you will get this same driver properties window.

17. Open up Word and create a new document.

18. Go to File→Print.

19. Select the Dell MFP Laser 3115cn from the printers list.

20. Click the Preferences button.

21. This brings up Printing Preferences.

22. Click the Paper/Output tab.

23. Select MPF Paper Type to Envelope.

24. Select Paper Source to MPF.

25. Select Paper Size to Envelope.

26. Click OK.

27. Now the printer driver is setup correctly.

28. Click Print.

**Setup Paper Size**

1. On the printer operator menu, press ▼ until SETUP appears, and then press ✔️.

2. Press ▼ until Tray Settings appears, and then press ✔️.

3. Press ▼ until the appropriate paper source (MPF) appears, and then press ✔️.

4. Press ▼ until Paper Type appears, and then press ✔️.

5. Press ◀ or ▶ until the appropriate paper type (Plain) appears, and then press ✔️.

6. Now we have the MPF Type set to Plain.

7. Press Back to return to the previous menu.
8. Press ▼ until >Paper Size appears, and then press √.

9. Press ◀ or ▶ until the appropriate paper size (Letter) appears, and then press √.

10. Now we have the MPF Size set to Letter.

11. Now insert the Letter-sized stack of paper into the MPF.


13. Press √ to save this setting.

14. Now on the screen MPF/Plain will appear.

15. Press √ to save this setting.

16. We now have all the hardware settings on the multifunction printer correct.

Now, all software settings screen shots are from WORD, this was done in Word 2003. However if in any application, you go File→Print and then click the Properties button, you will get this same driver properties window.

17. Open up Word and create a new document.

18. Go to File→Print.

19. Select the Dell MFP Laser 3115cn from the printers list.

20. Click the Preferences button.

21. This brings up Printing Preferences.

22. Click the Paper/Output tab.


24. Select Paper Source to MPF.

25. Select Paper Type to Plain.

26. Click OK.

**Setup Paper Type**
<table>
<thead>
<tr>
<th>Paper type</th>
<th>Weight (gsm)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>60-80</td>
<td>-</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>81-105</td>
<td>-</td>
</tr>
<tr>
<td>Covers</td>
<td>106-163</td>
<td>-</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>164-216</td>
<td>-</td>
</tr>
<tr>
<td>Coated</td>
<td>106-163</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>164-216</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Transparency</td>
<td>-</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Label</td>
<td>-</td>
<td>Inkjet Printer paper cannot be used.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

**Configuration**

**Parallel Printing**

A local printer is a printer attached to your computer or a print server using a USB or parallel cable. If your multifunction printer is attached to a network and not your computer, see "Setup Network".

**Installing Printer Drivers**

When you install the printer driver, also install the fax driver.

After the printer driver has been installed, you need to specify the Installable Options settings in the printer properties dialog box according to the options you have installed.

**Microsoft® Windows Vista®**

1. Insert the Drivers and Utilities CD into your computer.

   **NOTE:** Click **Continue** when the **User Account Control** dialog box appears.

2. Click **Personal Installation**.

3. Connect your printer to your computer.

   At this point, Plug and Play is activate automatically and installs the printer. If the Plug and Play is not activate, click **Install**.
When the Plug and Play is complete, the Installation goes to the next step automatically.

4. Select either the **Typical Installation** or **Custom Installation** radio button, and then click **Next**. If you select **Custom Installation**, you can select the specific software you want to install.

5. When the **Congratulations!** screen appears, click **Print Test Page** if necessary. Click **Finish**.

---


1. Connect the multifunction printer to your computer with a USB cable or a parallel cable. Then, turn on the multifunction printer.

2. When the **Found New Hardware Wizard** dialog box appears, click **Cancel**.

3. Insert the **Drivers and Utilities** CD into your computer to launch the installation software.

   **NOTE:** If the CD does not automatically launch, click **Start→Run**, and then type D:\setup.exe (where D is the drive letter of your CD), and then click **OK**.

4. Select **Personal Installation**, and then click **Next**.

5. Click **Install**.

6. When the **Found New Hardware Wizard** dialog box appears, follow the on-screen instructions to install the printer driver on your computer.

7. When the **Completing the Found New Hardware Wizard** dialog box appears, click **Finish**.

8. Select either **Typical Installation** or **Custom Installation** from the installation wizard, and then click **Install**. If you select **Custom Installation**, you can select the specific software you want to install.

9. Click **Finish** to exit the wizard when the Congratulations! screen appears. If necessary, click **Print Test Page** to print a test page.

---

**Windows NT® 4.0**

1. Connect the multifunction printer to your computer with a parallel cable. Then, turn on the multifunction printer.

2. Insert the **Drivers and Utilities** CD into your computer.

3. Select **Personal Installation**, and then click **Next**.

4. On the **Add Printer** screen, select the port name from the **Port Name** combo box, and then set the printer's options under **Printer Configuration**. Then, click **Next**.
3. Select either **Typical Installation** or **Custom Installation** from the installation wizard, and then click **Install**. If you select **Custom Installation**, you can select the specific software you want to install.

4. The Adobe License Agreement appears, click to accept the agreement and then click **Install**.

5. Click **Finish** to exit the wizard when the Congratulations! screen appears.

**USB Printing**

A local printer is a printer attached to your computer or a print server using a USB or parallel cable. If your multifunction printer is attached to a network and not your computer, see "Setup Network".

**Setup Network**

- **NOTE:** To use this multifunction printer in a UNIX or Linux environment, you need to install a UX Filter or Linux Driver. For more information on how to install and use these, refer to your User's Guide.
- **NOTE:** When using a CD drive in a Linux environment, you need to mount the CD according to your system environment. The command strings are mount/media/cdrom.

**Disable Microsoft® Windows® XP, Windows Vista®, Windows Server® 2003 (after SP1) , or Windows Server® 2008 Firewall Before Printer Software Installation**

- **NOTE:** This step may not be necessary if you have Windows XP Service Pack 2 installed.

If your multifunction printer is connected directly to a network and the built-in operating system firewall is enabled, you cannot view your networked printer(s) when you run the Dell™ printer installation software. To prevent this situation, disable the built-in operating system firewall before you install the Dell printer software. To disable or enable your built-in operating system firewall, perform the following steps:

- **NOTICE:** Dell recommends that you enable your built-in operating system firewall after you install the printer software. Enabling the built-in operating system firewall after you install the printer software does not limit the use of your network printer.

1. Click the **Start** button and click **Help and Support**.

2. In the **Search** box, type firewall and then click the green arrow.

3. In the **Pick a Task** list, click **Enable or disable Internet Connection Firewall** and then follow the instructions on the screen.

**Print and Check the System Settings Page**

1. Print the System Settings page.
a. Press ▼ until >SETUP appears, and then press ✓.

b. Press ▼ until >Reports appears, and then press ✓.

c. System Settings is displayed. Press ✓.

The system settings page is printed.

2. Under the TCP/IP heading, verify the IP address.

If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then print the System Settings page again.

**Printer Setup**

**NOTE:** When you use IPv6 Mode for network printing, you cannot install the printer driver from the Drivers and Utilities CD. Use the Add Printer wizard in Windows Vista. For details, see "Printing With Web Services for Devices (WSD)" in the User's Guide.

1. Insert the Drivers and Utilities CD into your computer to launch the installation software.

**NOTE:** If the CD does not automatically launch, click Start → Run, and then type D:\setup.exe (where D is the drive letter of your CD), and then click OK.

**NOTE:** For Windows Vista, click Continue when the User Account Control dialog box appears.

2. Select Network Installation, and then click Next.

3. Select Configure New Wired Printer, or Install Driver and Software for existing network printer, and then click Next.

4. For local installation, select Local Installation, and then click Next.

For remote installation:

a. Select Remote Installation, and then click Next.

**NOTE:** Remote installation between Windows NT and the following operating systems is not supported.
- Windows XP Professional x64 Edition
- Windows Server 2003 x64 Edition
- Windows Server 2008 x64 Edition
- Windows Vista
- Windows Vista x64

**NOTE:** Installation on Windows XP Home Edition, Windows Vista Home Basic, Windows Vista Home Premium, Windows Vista x64 Home Basic, and Windows Vista x64 Home Premium is not supported.
b. Enter the computer name, user ID, and password. Then, click Add.

c. Click Next.

5. Select the multifunction printer you want to install from the printer list, and then click Next. If the target printer is not displayed on the list, click Update to refresh the list or click Add Printer to add a multifunction printer to the list manually. You may specify the IP address and port name at this point. If you have installed this multifunction printer on the server computer, select the I am setting up this printer on a server check box.

NOTE: When using AutoIP, 0.0.0.0 is displayed in the installer. Before you can continue, you must enter a valid IP address.

6. Specify the printer settings, and then click Next.

   a. Enter the printer name.

   b. If you want other users on the network to access this multifunction printer, select Share this printer with other computers on the network, and then enter a share name that users will easily identify.

   c. If you want to set a multifunction printer as the default, select the Set this printer as default check box.

   d. If you want to restrict color printing, select the appropriate Dell ColorTrack option. Enter the password when Color-Password Enabled is selected for Dell ColorTrack.

   e. If the postscript driver is available and you want to install it, select the PostScript Driver check box.

7. Select the software and documentation you want to install, and then click Next. You can specify folders in which to install the Dell software and documentation. To change the folders, click Browser.

8. If the Adobe license agreement screen appears, click to accept the agreement and then click Install.

9. Click Finish to exit the wizard when the Congratulations! screen appears. If necessary, click Print Test Page to print a test page.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web browser.

NOTE: The Dell Printer Configuration Web Tool is not available when the multifunction printer is locally attached to a computer or a print server.

To launch the Dell Printer Configuration Web Tool, type the network printer IP address in your Web browser, and the printer configuration appears on the screen. Refer to your User's Guide for more information.

You can set up the Dell Printer Configuration Web Tool to send you an email when the multifunction printer needs supplies or intervention.
To set up e-mail alerts:

1. Launch the Dell Printer Configuration Web Tool.
2. Click **E-Mail Alert** link.
3. Under **Setup E-Mail Lists and Alerts**, enter the Primary SMTP Gateway, the Reply Address, and enter your email address or the key operator's email address in the email list box.
4. Click **Apply New Settings**.

**NOTE:** The SMTP server will display **Connection in Progress** until an error occurs.

**Determining the Wireless Network Settings**

You need to know the settings for the wireless network to set up the wireless printer. For details of the settings, contact your network administrator.

<table>
<thead>
<tr>
<th>Wireless Settings</th>
<th>Security Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSID</td>
<td>Security</td>
</tr>
<tr>
<td></td>
<td>Selects the security method from No security, WEP, WPA-PSK TKIP and WPA-PSK AES.</td>
</tr>
<tr>
<td>Network Type</td>
<td>Transmit Key</td>
</tr>
<tr>
<td></td>
<td>Specifies the transmit key from the list.</td>
</tr>
<tr>
<td></td>
<td>WEP Key</td>
</tr>
<tr>
<td></td>
<td>Specifies the WEP key set used through the wireless network only when WEP is selected for Security.</td>
</tr>
<tr>
<td></td>
<td>Pass Phrase</td>
</tr>
<tr>
<td></td>
<td>Specifies the pass phrase of alphanumeric characters from 8 to 63 bytes long only when WPA-PSK is selected for Encryption.</td>
</tr>
</tbody>
</table>

**NOTE:** To set WPA2-PSK as security, select WPA-PSK AES.

**Wireless Installation using USB connection**

**NOTE:** The optional multi-protocol card with the Wireless LAN Adapter attached must be installed on the multifunction printer.

**Step 1. Install a multifunction printer to the already-operating wireless network (When wireless setting is already set to your computer)**

1. Insert the *Drivers and Utilities* CD into your computer.
2. The *Drivers and Utilities* CD should launch the installation software automatically. If the CD does not automatically launch, click **Start→Run**, type `D:\Setup.exe` (where D is the drive...
letter of your CD), and then click **OK**.

**NOTE:** For Windows Vista, click **Continue** when the **User Account Control** dialog box appears.

3. Select the **Network Installation** option button, and then click **Next**.

4. Select the **Configure Wireless Printer using a USB connection (Recommended)** option button, and then click **Next**.

5. Reset the wireless setting of the multifunction printer following the steps on the **Reset Wireless Setting** screen.

6. In the list displayed on the **Select Printer** screen, check the check box of the target printer that you are making wireless setting for, and then click **Next**. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**. When you select the **Fixed IP** option button for **IP Address assignment**, click **Change...** and enter the IP address and subnet mask on the screen.

**NOTE:** When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

7. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

8. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the multifunction printer.

9. On the **Wireless configuration is now complete** screen, click **Next**. Since the wireless setting is already made to your computer, no operation is necessary on this screen.

10. On the **Setting-Ready Printer** screen, verify that the correct IP address is assigned to the multifunction printer to which the wireless setting is set, and then click **Install**.

**NOTE:** If your system has any of the following operating systems:
- Windows XP x64
- Windows Server® 2003 x64
- Windows Server® 2008 x64
- Windows Vista x64
- Windows Vista x86

,skip step 11 and go to step 12.

11. If you select the **I am setting up this printer on a server** check box on the **Select Printer** screen and also select the **PostScript Driver** check box on the **Enter Printer Settings** screen, the **Adobe Systems Inc. License Agreement** screen appears. Select the **I accept the terms of the license agreement** option button, and then click **Install**.

12. On the **Congratulations!** screen, click **Finish** to complete the installation. A test page will be printed with the installed printer by clicking the **Print Test Page** button.

**Step 2. Construct new wireless network environment for both computer and multifunction printer (When wireless setting needs to be set to your computer)**
1. Insert the *Drivers and Utilities* CD into your computer.

2. The *Drivers and Utilities* CD should launch the installation software automatically. If the CD does not automatically launch, click **Start**→**Run**, type `D:\Setup.exe` (where D is the drive letter of your CD), and then click **OK**.

   **NOTE:** For Windows Vista, click **Continue** when the **User Account Control** dialog box appears.

3. Select the **Network Installation** option button, and then click **Next**.

4. Select the **Configure Wireless Printer using a USB connection (Recommended)** option button, and then click **Next**.

5. Reset the wireless setting of the multifunction printer following the steps on the **Reset Wireless Setting** screen.

6. In the list on the **Select Printer** screen, check the check box of the target printer that you are making wireless setting for, and then click **Next**.

   **NOTE:** When you enter a fixed IP address, avoid the "169.254.xxxx.xxx" address used by AutoIP.

7. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**. When you select the **Fixed IP** option button for **IP Address assignment**, click **Change...** and enter the IP address and subnet mask on the screen.

8. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

9. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the multifunction printer.

10. On the **Wireless configuration is now complete** screen, create the wireless setting sent to the multifunction printer on your computer following the steps below, and then click **Next**.

    **For Windows XP and Windows Server 2003:**
    
    a. Select **Network Connections** from **Control Panel**.
    
    b. Right-click **Wireless Network Connection** and select **Properties**.
    
    c. Select the **Wireless Network** tab.
    
    d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.
    
    e. Click **Advanced**.
    
    f. Do either of the following:

    **When wireless ad-hoc mode is set to the multifunction printer:**
- Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the multifunction printer:**
- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

  g. Click **Add** to display Wireless network properties.
  h. Enter the setting that you send to the multifunction printer and click **OK**.
  i. Click **Move up** to move the setting to the top of the list.
  j. Click **OK** to close the **Property** dialog box.

**For Windows Vista:**
- a. Open **Control Panel**.
- b. Select **Network and Internet**.
- c. Select **Network and Sharing Center**.
- d. Select **Connect to a network**.
- e. Select the setting you send to the multifunction from the network items listed in **Connect to a network**.
- f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.
- g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**
- a. Open **Control Panel**.
- b. Select **Network and Sharing Center**.
- c. Select **Connect to a network**.
- d. Select the setting you send to the printer from the network items listed in **Connect to a network**.
- e. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.
- f. Click **Close** in the dialog box after confirming the connection is a success.

11. On the **Setting-Ready Printer** screen, verify that the correct IP address is assigned to the multifunction printer to which the wireless setting is set, and then click **Install**.
NOTE: If your system has any of the following operating systems:
- Windows XP x64
- Windows Server® 2003 x64
- Windows Server® 2008 x64
- Windows Vista x64
- Windows Vista x86
skip step 12 and go to step 13.

12. If you select the I am setting up this printer on a server check box on the Select Printer screen and also select the PostScript Driver check box on the Enter Printer Settings screen, the Adobe Systems Inc. License Agreement screen appears. Select the I accept the terms of the license agreement option button, and then click Install.

13. On the Congratulations! screen, click Finish to complete the installation. A test page will be printed with the installed printer by clicking the Print Test Page button.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web browser.

NOTE: The Dell Printer Configuration Web Tool is not available when the multifunction printer is locally attached to a computer or a print server.

**Wireless Installation using wireless connection**

**Step 1. Install a multifunction printer to the already-operating wireless network (When wireless setting is already set to your computer)**

1. Insert the Drivers and Utilities CD into your computer to launch the installation software.

   NOTE: If the CD does not automatically launch, click Start→Run, and then type `D:\setup.exe` (where D is the drive letter of your CD), and then click OK.

   NOTE: For Windows Vista, click Continue when the User Account Control dialog box appears.

2. Select the Network Installation option button, and then click Next.

3. Select the Configure Wireless Printer using a wireless connection (Advanced) option button, and then click Next.

4. Reset the wireless setting of the multifunction printer following the steps on the Reset Wireless Setting screen.

5. Create the wireless setting of your computer following the steps shown on the Enable Communication with Printer screen, and then click Next.

The steps are as follows:
For Windows XP and Windows Server 2003:

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

**NOTE:** Ensure that you write down the current wireless computer settings in steps d and f so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the Advanced dialog box.

g. Click the **Add** button to display Wireless network properties.

h. In the **Association** tab, enter the following information and click **OK**.

- Network name (SSID): **dell_device**
- Network Authentication: **Open**
- Data encryption: **Disabled**
- Ad hoc network: **checked**

i. Click the **Move up** button to move the newly added SSID to the top of the list.

j. Click **OK** to close the **Property** dialog box.

For Windows Vista:

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

For Windows Server 2008:
a. Open **Control Panel**.
b. Select **Network and Sharing Center**.
c. Select **Connect to a network**.
d. Select *dell_device* from the network items listed in **Connect to a network**.
e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.
f. Click **Close** in the dialog box after confirming the connection is a success.

6. On the **Enter Wireless Network Settings** screen, set each wireless setting item, and then click **Next**.

7. When you select the **Fixed IP** option button for **IP Address assignment**, click **Change...** and enter the IP address and subnet mask on the screen.

![NOTE:](image) When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

8. Set each item on the **Enter Printer Settings** screen, and then click **Next**.

9. On the **Printer Software** screen, specify the software that you want to install and installation path, and then click **Next**. At this point, the wireless setting specified on the **Enter Wireless Network Settings** screen is sent to the multifunction printer.

10. On the **Wireless configuration is now complete** screen, change the wireless setting of your computer to the same as that sent to the multifunction printer, and then click **Next**.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Network** tab.

d. Click **Advanced**.

e. Do either of the following:

*When wireless ad-hoc mode is set to the multifunction printer:*

   - Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

*When wireless infrastructure mode is set to the multifunction printer:*

   - Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.
f. Select the setting that you send to the multifunction printer in the list in **Preferred Network** group.

g. Click **Move up** to move the setting to the top of the list.

h. Click **OK** to close the **Property** dialog box.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

11. On the **Setting-Ready Printer** screen, verify that the correct IP address is assigned to the multifunction printer to which the wireless setting is set, and then click **Install**.

**NOTE:** If your system has any of the following operating systems:
- Windows XP x64
- Windows Server® 2003 x64
- Windows Server® 2008 x64
- Windows Vista x64
- Windows Vista x86
  skip step 12 and go to step 13.

12. If you select the **I am setting up this printer on a server** check box on the **Select Printer** screen and also select the **PostScript Driver** check box on the **Enter Printer Settings** screen, the **Adobe Systems Inc. License Agreement** screen appears. Select the **I accept the terms of the license agreement** option button, and then click **Install**.

13. On the **Congratulations!** screen, click **Finish** to complete the installation. A test page will be printed.
Step 2. Construct new wireless network environment for both computer and multifunction printer (When wireless setting needs to be set to your computer)

1. Insert the *Drivers and Utilities* CD into your computer to launch the installation software.

   **NOTE:** If the CD does not automatically launch, click **Start**→**Run**, and then type `D:\setup.exe` (where `D` is the drive letter of your CD), and then click **OK**.

   **NOTE:** For Windows Vista, click Continue when the **User Account Control** dialog box appears.

2. Select the **Network Installation** option button, and then click **Next**.

3. Select the **Configure Wireless Printer using a wireless connection (Advanced)** option button, and then click **Next**.

4. Reset the wireless setting of the multifunction printer following the steps on the **Reset Wireless Setting** screen.

5. Create the wireless setting of your computer following the steps shown on the **Enable Communication with Printer** screen, and then click **Next**. The steps are as follows:

   **For Windows XP and Windows Server 2003:**
   a. Select **Network Connections** from **Control Panel**.
   b. Right-click **Wireless Network Connection** and select **Properties**.
   c. Select the **Wireless Networks** tab.
   d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

   **NOTE:** Ensure that you write down the current wireless computer settings in step `d` and step `f` so that you can restore them later.

   e. Click the **Advanced** button.
   f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.
   g. Click the **Add** button to display **Wireless network properties**.
   h. In the **Association** tab, enter the following information and click **OK**.

   - **Network name (SSID):** `dell_device`
   - **Network Authentication:** `Open`
   - **Data encryption:** `Disabled`
Ad hoc network: checked

i. Click the Move up button to move the newly added SSID to the top of the list.

j. Click OK to close the Property dialog box.

For Windows Vista:

a. Open Control Panel.

b. Select Network and Internet.

c. Select Network and Sharing Center.

d. Select Connect to a network.

e. Select dell_device from the network items listed in Connect to a network.

f. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

g. Click Close in the dialog box after confirming the connection is a success.

For Windows Server 2008:

a. Open Control Panel.

b. Select Network and Sharing Center.

c. Select Connect to a network.

d. Select dell_device from the network items listed in Connect to a network.

e. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

f. Click Close in the dialog box after confirming the connection is a success.

6. On the Enter Wireless Network Settings screen, set each wireless setting item, and then click Next.

7. When you select the Fixed IP option button for IP Address assignment, click Change... and enter the IP address and subnet mask on the screen.

NOTE: When you enter a fixed IP address, avoid the "169.254.xxx.xxx" address used by AutoIP.

8. Set each item on the Enter Printer Settings screen, and then click Next.

9. On the Printer Software screen, specify the software that you want to install and installation path, and then click Next. At this point, the wireless setting specified on the Enter Wireless Network...
Settings screen is sent to the multifunction printer.

10. On the **Wireless configuration is now complete** screen, create the wireless setting sent to the multifunction printer on your computer following the steps below, and then click **Next**.

**For Windows XP and Windows Server 2003:**

- a. Select **Network Connections** from **Control Panel**.
- b. Right-click **Wireless Network Connection** and select **Properties**.
- c. Select the **Wireless Network** tab.
- d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.
- e. Click **Advanced**.
- f. Do either of the following:

  **When wireless ad-hoc mode is set to the multifunction printer:**
  - Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

  **When wireless infrastructure mode is set to the multifunction printer:**
  - Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

- g. Click **Add** to display **Wireless network** properties.
- h. Enter the setting that you send to the multifunction printer and click **OK**.
- i. Click **Move up** to move the setting to the top of the list.
- j. Click **OK** to close the **Property** dialog box.

**For Windows Vista:**

- a. Open **Control Panel**.
- b. Select **Network and Internet**.
- c. Select **Network and Sharing Center**.
- d. Select **Connect to a network**.
- e. Select the setting you send to the multifunction from the network items listed in Connect to a network.
- f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.
g. Click Close in the dialog box after confirming the connection is a success.

For Windows Server 2008:

a. Open Control Panel.

b. Select Network and Sharing Center.

c. Select Connect to a network.

d. Select the setting you send to the printer from the network items listed in Connect to a network.

e. Select Connect Anyway in the warning dialog box indication indicating you are entering an unsecured area.

f. Click Close in the dialog box after confirming the connection is a success.

11. On the Setting-Ready Printer screen, verify that the correct IP address is assigned to the multifunction printer to which the wireless setting is set, and then click Install.

**NOTE**: If your system has any of the following operating systems:
- Windows XP x64
- Windows Server® 2003 x64
- Windows Server® 2008 x64
- Windows Vista x64
- Windows Vista x86
,skip step 12 and go to step 13.

12. If you select the I am setting up this printer on a server check box on the Select Printer screen and also select the PostScript Driver check box on the Enter Printer Settings screen, the Adobe Systems Inc. License Agreement screen appears. Select the I accept the terms of the license agreement option button, and then click Install.

13. On the Congratulations! screen, click Finish to complete the installation. A test page will be printed with the installed printer by clicking the Print Test Page button.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web browser.

**NOTE**: The Dell Printer Configuration Web Tool is not available when the multifunction printer is locally attached to a computer or a print server.

**Wireless Installation using Dell Printer Configuration Web Tool**
Step 1. Install a multifunction printer to the already-operating wireless network (When wireless setting is already set to your computer)

For Dynamic Host Configuration Protocol network:

1. Create wireless setting of your computer following the steps below:

   For Windows XP and Windows Server 2003:
   a. Select Network Connections from Control Panel.
   b. Right-click Wireless Network Connection and select Properties.
   c. Select the Wireless Networks tab.
   d. Ensure that the check box for Use Windows to configure my wireless network settings is checked.

   NOTE: Ensure that you write down the current wireless computer settings in steps d and f so that you can restore them later.

   e. Click the Advanced button.
   f. Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
   g. Click the Add button to display Wireless network properties.
   h. In the Association tab, enter the following information and click OK.

   Network name (SSID): dell_device
   Network Authentication: Open
   Data encryption: Disabled
   Ad hoc network: checked

   i. Click the Move up button to move the newly added SSID to the top of the list.
   j. Click OK to close the Property dialog box.

   NOTE: When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Windows Vista:
   a. Open Control Panel.
   b. Select Network and Internet.
   c. Select Network and Sharing Center.
d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select **dell_device** from the network items listed in **Connect to a network**.

e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

f. Click **Close** in the dialog box after confirming the connection is a success.

2. Check the IP address assigned by AutoIP on the multifunction printer.

   For example, 168.254.1.1

3. Check that the IP address on your computer is assigned by DHCP.

4. Open Dell Printer Configuration Web Tool using the Web browser.

   For example, http://168.254.1.1/

5. Change the wireless setting of the multifunction printer on Dell Printer Configuration Web Tool.

6. Reset the multifunction printer.

7. Restore the wireless setting on your computer.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Click **Advanced**.
e. Do either of the following:

When wireless ad-hoc mode is set to the multifunction printer:

- Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

When wireless infrastructure mode is set to the multifunction printer:

- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

f. Select the setting that you send to the multifunction printer in the list in **Preferred Network** group.

g. Click **Move up** to move the setting to the top of the list.

h. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Windows Vista:

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

For Windows Server 2008:

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

For Fixed IP network:

1. Create wireless setting of your computer following the steps below:
For Windows XP and Windows Server 2003:

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

**NOTE:** Ensure that you write down the current wireless computer settings in steps d and f so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

g. Click the **Add** button to display **Wireless network properties**.

h. In the **Association** tab, enter the following information and click **OK**.

Network name (SSID): *dell_device*

Network Authentication: Open

Data encryption: Disabled

Ad hoc network: checked

i. Click the **Move up** button to move the newly added SSID to the top of the list.

j. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Windows Vista:

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select *dell_device* from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.
For Windows Server 2008:

a. Open Control Panel.

b. Select Network and Sharing Center.

c. Select Connect to a network.

d. Select dell_device from the network items listed in Connect to a network.

e. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

f. Click Close in the dialog box after confirming the connection is a success.

2. Check the IP address on your computer.

   For example, 1.2.3.4

3. Set the IP address on the multifunction printer.

   For example, 1.2.3.5

4. Open Dell Printer Configuration Web Tool using the Web browser.

   For example, http://1.2.3.5/

5. Change the wireless setting of the multifunction printer on Dell Printer Configuration Web Tool.

6. Reset the multifunction printer.

7. Restore the wireless setting on your computer.

For Windows XP and Windows Server 2003:

a. Select Network Connections from Control Panel.

b. Right-click Wireless Network Connection and select Properties.

c. Select Wireless Network tab.

d. Click Advanced.

e. Do either of the following:

When wireless ad-hoc mode is set to the multifunction printer:

   o Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
When wireless infrastructure mode is set to the multifunction printer:

- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

- Select the setting that you send to the multifunction printer in the list in **Preferred Network** group.

- Click **Move up** to move the setting to the top of the list.

- Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

- Open **Control Panel**.

- Select **Network and Internet**.

- Select **Network and Sharing Center**.

- Select **Connect to a network**.

- Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

**For Windows Server 2008:**

- Open **Control Panel**.

- Select **Network and Sharing Center**.

- Select **Connect to a network**.

- Select the original setting from the network items listed in **Connect to a network**, and then click **Connect**.

**Step 2. Construct new wireless network environment for both computer and multifunction printer (When wireless setting needs to be set to your computer)**

**For Dynamic Host Configuration Protocol network:**

1. Create wireless setting of your computer following the steps below:

   **For Windows XP and Windows Server 2003:**
a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

**NOTE:** Ensure that you write down the current wireless computer settings in steps e and g so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

g. Click the **Add** button to display **Wireless network properties**.

h. In the **Association** tab, enter the following information and click **OK**.

   - **Network name (SSID):** dell_device
   - **Network Authentication:** Open
   - **Data encryption:** Disabled
   - **Ad hoc network:** checked

   i. Click the **Move up** button to move the newly added SSID to the top of the list.

   j. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.
For Windows Server 2008:

a. Open Control Panel.

b. Select Network and Sharing Center.

c. Select Connect to a network.

d. Select dell_device from the network items listed in Connect to a network.

e. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

f. Click Close in the dialog box after confirming the connection is a success.

2. Check the IP address assigned by AutoIP on the multifunction printer.

For example, 168.254.1.1

3. Check that the IP address on your computer is assigned by DHCP.

4. Open Dell Printer Configuration Web Tool using the Web browser.

For example, http://168.254.1.1

5. See "Print Server Settings" in the "Dell Printer Configuration Web Tool" to create a wireless setting.

6. Reset the multifunction printer.

7. Restore the wireless setting on your computer.

For Windows XP and Windows Server 2003:

a. Select Network Connections from Control Panel.

b. Right-click Wireless Network Connection and select Properties.

c. Select Wireless Network tab.

d. Ensure that the check box for Use Windows to configure my wireless network settings is checked.

e. Click Advanced.

f. Do either of the following:

When wireless ad-hoc mode is set to the multifunction printer:

o Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
When wireless infrastructure mode is set to the multifunction printer:

- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

  g. Click **Add** to display **Wireless network properties**.

  h. Enter the setting that you send to the multifunction printer and click **OK**.

  i. Click **Move up** to move the setting to the top of the list.

  j. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

  a. Open **Control Panel**.

  b. Select **Network and Internet**.

  c. Select **Network and Sharing Center**.

  d. Select **Connect to a network**.

  e. Select the setting you send to the multifunction from the network items listed in **Connect to a network**.

  f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

  g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

  a. Open **Control Panel**.

  b. Select **Network and Sharing Center**.

  c. Select **Connect to a network**.

  d. Select the setting you send to the printer from the network items listed in **Connect to a network**.

  e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

  f. Click **Close** in the dialog box after confirming the connection is a success.

**For Fixed IP network:**
1. Create wireless setting of your computer following the steps below:

For Windows XP and Windows Server 2003:

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

   **NOTE:** Ensure that you write down the current wireless computer settings in steps d and f so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

g. Click the **Add** button to display **Wireless network properties**.

h. In the **Association** tab, enter the following information and click **OK**.

   Network name (SSID): **dell_device**
   Network Authentication: **Open**
   Data encryption: **Disabled**
   Ad hoc network: **checked**

   i. Click the **Move up** button to move the newly added SSID to the top of the list.

   j. Click **OK** to close the **Property** dialog box.

   **NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Windows Vista:

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.
g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select **dell_device** from the network items listed in **Connect to a network**.

e. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

f. Click **Close** in the dialog box after confirming the connection is a success.

2. Check the IP address on your computer.

   For example, 1.2.3.4

3. Set the IP address on the multifunction printer.

   For example, 1.2.3.5

4. Open Dell Printer Configuration Web Tool using the Web browser.

   For example, http://1.2.3.5

5. Change the wireless setting of the multifunction printer on Dell Printer Configuration Web Tool.

6. Reset the multifunction printer.

7. Restore the wireless setting on your computer.

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

e. Click **Advanced**.
f. Do either of the following:

**When wireless ad-hoc mode is set to the multifunction printer:**
- Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

**When wireless infrastructure mode is set to the multifunction printer:**
- Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

h. Enter the setting that you send to the multifunction printer and click **OK**.
  i. Click **Move up** to move the setting to the top of the list.
  j. Click **OK** to close the **Property** dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select the setting you send to the printer from the network items listed in **Connect to a network**.

e. Select **Connect Anyway** in the warning dialog box indicating you are entering an
Wireless Setting through Dell Printer Configuration Web Tool
- Advanced setup

Access point (Infrastructure, DHCP network)

1. Create new wireless settings for your computer.

For Windows XP and Windows Server 2003:
   a. Select Network Connections from Control Panel.
   b. Right-click Wireless Network Connection and select Properties.
   c. Select the Wireless Networks tab.
   d. Ensure that the check box for Use Windows to configure my wireless network settings is checked.

   **NOTE:** Ensure that you write down the current wireless computer settings in steps d and g so that you can restore them later.

   e. Click the Advanced button.
   f. Select Computer to Computer (ad hoc) networks only and close the Advanced dialog box.
   g. Click the Add button to display Wireless network properties.
   h. In the Association tab, enter the following information and click OK.

   Network name (SSID): dell_device
   Network Authentication: Open
   Data encryption: Disabled
   Ad hoc network: checked

   i. Click the Move up button to move the newly added SSID to the top of the list.
   j. Click OK to close the Property dialog box.

   **NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

For Windows Vista:
a. Open Control Panel.

b. Select Network and Internet.

c. Select Network and Sharing Center.

d. Select Connect to a network.

e. Select dell_device from the network items listed in Connect to a network.

f. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

g. Click Close in the dialog box after confirming the connection is a success.

For Windows Server 2008:

a. Open Control Panel.

b. Select Network and Sharing Center.

c. Select Connect to a network.

d. Select dell_device from the network items listed in Connect to a network.

e. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

f. Click Close in the dialog box after confirming the connection is a success.

2. Set up the printer wireless adapter IP address.

   a. Reset the settings for the wireless adapter to the default.

      i. Press Menu on printer Control Panel.
      ii. Scroll down and select Admin Menu.
      iii. Scroll down and select Wireless net.
      iv. Scroll down and select Reset MPC.
      v. Restart the multifunction printer.

      b. Retrieve the wireless adapter IP address on the multifunction printer.

      i. Press Menu on printer Control Panel.
      ii. Scroll down and select Admin Menu.
      iii. Scroll down and select Wireless net.
      iv. Scroll down and select TCP/IP.
      v. Scroll down and select IP Address.
(Default IP address range: 169.254.xxx.yyy, where "xxx" and "yyy" are variables ranging from 0 to 255)

3. Access Dell Printer Configuration Web Tool on your computer browser.
   a. Assign the TCP/IP address by DHCP mode (Change the TCP/IP properties to obtain the IP address automatically).
   b. Ensure that your computer has the same IP address range as the printer wireless adapter.

For example, 169.254.xxx.zzz, where "xxx" and "zzz" are variables ranging from 0 to 255

   c. Access the Dell Printer Configuration Web Tool using the Web browser, and then type printer wireless adapter settings in the address field of the browser.

For example, http://169.254.xxx.yyy/, where "xxx" and "yyy" are variables ranging from 0 to 255 (Your wireless adapter IP address)

   d. Change wireless settings (SSID/ communication mode) from Dell Printer Configuration Web Tool.

   i. Click **Print server setting** on the left navigational bar.
   ii. Click the **Print server setting** tab.
   iii. Click the **TCP/IP** sub-tab.
   iv. Select **DHCP**.
   v. Click the **Apply new setting** button without restarting the multifunction printer (Ignore the screen instructions to restart the multifunction printer).
   vi. Click the **Wireless LAN** sub-tab.
   vii. Change the **SSID** setting (according to your Access point SSID) and change **Network type** to **Infrastructure**.
   viii. Click the **Restart printer to apply new settings** button.

4. Once printer wireless adapter is properly configured, you may use the typical network printer installation method to complete driver installation.

5. To communicate with the multifunction printer, you need to restore the previous wireless settings on your computer.

6. Restore the previous wireless settings for your computer.

   **For Windows XP and Windows Server 2003:**
   a. Select **Network Connections** from **Control Panel**.
   b. Right-click **Wireless Network Connection** and select **Properties**.
   c. Select the **Wireless Network** tab.
   d. Click the **Advanced** button.
e. Select **Access point (Infrastructure) networks only** and close the Advanced dialog box (Applicable to the multifunction printer with the wireless infrastructure mode).

f. Select the setting that you send to the multifunction printer in the list in the **Preferred Network** group.

g. Click **Move up** to move the setting to the top of the list.

h. Click **OK** to close the Property dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select the setting you send to the multifunction from the network items listed in Connect to a network.

f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

g. Click **Close** in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open **Control Panel**.

b. Select **Network and Sharing Center**.

c. Select **Connect to a network**.

d. Select the setting you send to the printer from the network items listed in **Connect to a network**.

e. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.

f. Click **Close** in the dialog box after confirming the connection is a success.

**Access point (Infrastructure, Fixed IP network)**

1. Ensure that the addresses of your computer and access point is in the same IP range. Match the subnet mask and gateway addresses of your computer to the access point settings.
2. Create new wireless settings of your computer by following the steps below:

**For Windows XP and Windows Server 2003:**

a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select the **Wireless Networks** tab.

d. Ensure that the check box for **Use Windows to configure my wireless network settings** is checked.

**NOTE:** Ensure that you write down the current wireless computer settings in steps d and f so that you can restore them later.

e. Click the **Advanced** button.

f. Select **Computer to Computer (ad hoc) networks only** and close the Advanced dialog box.

g. Click the **Add** button to display Wireless network properties.

h. In the **Association** tab, enter the following information and click **OK**.

Network name (SSID): dell_device
Network Authentication: Open
Data encryption: Disabled
Ad hoc network: Checked

i. Click the Move up button to move the newly added SSID to the top of the list.

j. Click OK to close the Property dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**For Windows Vista:**

a. Open **Control Panel**.

b. Select **Network and Internet**.

c. Select **Network and Sharing Center**.

d. Select **Connect to a network**.

e. Select **dell_device** from the network items listed in **Connect to a network**.

f. Select **Connect Anyway** in the warning dialog box indication indicating you are entering an unsecured area.
g. Click Close in the dialog box after confirming the connection is a success.

**For Windows Server 2008:**

a. Open Control Panel.

b. Select Network and Sharing Center.

c. Select Connect to a network.

d. Select dell_device from the network items listed in Connect to a network.

e. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

f. Click Close in the dialog box after confirming the connection is a success.

3. Check the IP, subnet mask, and gateway address on your computer.

   For example, IP: 192.168.1.1
   Subnet mask: 255.255.0.0

4. Set the IP address from the multifunction printer Control Panel to be in the same range as that of your computer. Match the subnet mask and gateway addresses of the multifunction printer to your computer settings.

   a. Press the Menu button.

   b. Scroll to the Admin menu.

   c. Select Wireless Net.

   d. Select TCP/IP.

   e. Select Get IP Address.

   f. Select Panel.

   g. Scroll back to IP Address.

   h. Manually enter the IP address using the directional buttons on the control panel and press enter button.

   For example, 192.168.1.2

   i. Scroll back to Subnet Mask.

   j. Manually enter the subnet mask address using the directional buttons on Control Panel and press the <Enter> button.
j. Scroll back to **Gateway Address**.

l. Manually enter the gateway address using the directional buttons on **Control Panel** and press the <Enter> button.

m. Restart the multifunction printer.

5. Open Dell Printer Configuration Web Tool using the Web browser.

   For example, http://192.168.1.2

6. Change wireless settings of the multifunction printer from Dell Printer Configuration Web Tool.
   a. Click **Print server setting** on the left navigational bar.

b. Click **Print server setting** tab.

c. Click **Wireless LAN** sub-tab.

d. Change the SSID setting (according to your access point SSID) and change **Network type** to **Infrastructure**.

e. Click the **Restart printer to apply new settings** button.

7. Restore the previous wireless settings for your computer.

   **For Windows XP and Windows Server 2003:**
   a. Select **Network Connections** from **Control Panel**.

b. Right-click **Wireless Network Connection** and select **Properties**.

c. Select **Wireless Network** tab.

d. Click **Advanced**.

e. Do either of the following:

   **When wireless ad-hoc mode is set to the multifunction printer:**
   o Select **Computer to Computer (ad hoc) networks only** and close the **Advanced** dialog box.

   **When wireless infrastructure mode is set to the multifunction printer:**
   o Select **Access point (Infrastructure) networks only** and close the **Advanced** dialog box.

f. Select the setting that you send to the multifunction printer in the list in **Preferred Network** group.

g. Click **Move up** to move the setting to the top of the list.
For Windows Vista:

a. Open Control Panel.

b. Select Network and Internet.

c. Select Network and Sharing Center.

d. Select Connect to a network.

e. Select the setting you send to the multifunction from the network items listed in Connect to a network.

f. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

g. Click Close in the dialog box after confirming the connection is a success.

For Windows Server 2008:

a. Open Control Panel.

b. Select Network and Sharing Center.

c. Select Connect to a network.

d. Select the setting you send to the printer from the network items listed in Connect to a network.

e. Select Connect Anyway in the warning dialog box indicating you are entering an unsecured area.

f. Click Close in the dialog box after confirming the connection is a success.

8. Click OK to close the Property dialog box.

**NOTE:** When your operating system is earlier than Windows 2000, create settings according to the manual of the wireless setting tool provided by your wireless device manufacturer.

**Setup Security**

1. Press ▼ until >SETUP appears, and then press ✓.

2. Press ▼ until >Admin Menu appears, and then press ✓.

3. Press ▼ until >Secure Settings is displayed. Press ✓.

4. Press ▼ until the desired setting is displayed. Press ✓.
To set or change the password to limit access to the menus from the operator panel.

Set the password of the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Values:

<table>
<thead>
<tr>
<th>Panel Lock Set</th>
<th>Sets a password to limit access to Admin Menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy/Scan/Fax Lock</td>
<td>Sets a password to limit access to the copy, scanner, and fax.</td>
</tr>
<tr>
<td>Secure Receive</td>
<td>Sets a password when you receive a fax.</td>
</tr>
</tbody>
</table>

**NOTE:** This menu sets a password to lock the operator panel. When changing the password for the Dell Printer Configuration Web Tool, click Set Password on the left frame and set the password.

**Troubleshooting Instructions**

Use the Customer Mode to locate the unit in the multifunction printer that causes a problem.

**Diagnostic Menu Map (Customer Mode)**

1. Turn off the multifunction printer.

2. Turn on the multifunction printer while holding down ▲ and ▼. The Customer Mode menu appears.
Testing "Print Quality"

"Print Quality" is used to diagnose print quality defects.

1. On the Customer Mode menu, go down to Cyan20%, Magenta20%, Yellow20%, or Black20% and press ✅.
<table>
<thead>
<tr>
<th>Cyan 20%</th>
<th>Outputs cyan toner at 20% density on the whole area of the paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magenta20%</td>
<td>Outputs magenta toner at 20% density on the whole area of the paper.</td>
</tr>
<tr>
<td>Yellow20%</td>
<td>Outputs yellow toner at 20% density on the whole area of the paper.</td>
</tr>
<tr>
<td>Black20%</td>
<td>Outputs black toner at 20% density on the whole area of the paper.</td>
</tr>
</tbody>
</table>

After you output the test results, contact Dell.

**Testing "TonerPalletCheck" or "ContaminationChk"**

"Toner Pallet Check" and "ContaminationChk" are used to diagnose machine problems.

1. On the **Customer Mode** menu, go down to **TonerPalletCheck** or **ContaminationChk**, and press ✓.

<table>
<thead>
<tr>
<th>TonerPalletCheck</th>
<th>Allows you to identify the problem with the toner when print quality problems occur while printing pictures or photos.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContaminationChk</td>
<td>Allows you to check for any regular lines or spots when printing if print quality problems are occurring.</td>
</tr>
</tbody>
</table>

After you output the test results, contact Dell.

**Change the ECM Mode**

You can enable or disable the ECM mode.

On the **Customer Mode** menu, go down to **Fax/Scanner Dialog**→**Parameter**→**Fax Parameter**→**Capability ECM**, and then press ✓.

<table>
<thead>
<tr>
<th>Enable*</th>
<th>Enables the ECM mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable</td>
<td>Disables the ECM mode.</td>
</tr>
</tbody>
</table>

**Clear NVRAM**

You can restore the original factory default menu settings by initializing NVRAM.

1. Press ▼ until >SETUP appears, and then press ✓.
2. Press ▼ until >Admin Menu appears, and then press ✓.
3. Press ▼ until >Maintenance appears, and then press ✓.
4. Press ▼ until >Init NVRAM appears, and then press ✓.

5. The Are you sure? message appears on the operator panel. Press ✓.

Turn off the multifunction printer, and then on again.

Others

How to replace Print cartridges

⚠️ CAUTION: Before performing any of the following procedures, read and follow the safety instructions in your Owner's Manual or Product Information Guide.

⚠️ NOTICE: To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.

Dell print cartridges are available only through Dell. You can order more cartridges online at http://www.dell.com/supplies or by phone. To order by phone, see "Contacting Dell" in the Owner's Manual or in this manual.

Dell recommends Dell print cartridges for your multifunction printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

⚠️ CAUTION: Never throw used print cartridges into a fire. The residual toner could explode resulting in burns and injuries.

⚠️ CAUTION: Since the used print cartridge may spill some toner, do not shake it.

Removing the Used Print Cartridge

1. Push the button (right side) and open the front cover.
2. Grasp the handles at both ends of the print cartridge that you want to replace and pull it out.

⚠️ **CAUTION:** Since the used print cartridge may spill some toner, do not shake it.

**Installing a New Print Cartridge**

1. Select the new print cartridge which color matches the color of the handles on the printer cartridge to be replaced and shake it five or six times to distribute the toner evenly.
2. Remove the print cartridge from its packaging.

- **NOTE:** To protect the drum against bright light, do not remove the orange protective cover of the print cartridge before the cartridge is inserted into its slot in the multifunction printer.

3. Completely remove the seal from the print cartridge by pulling the tab on the end of the print cartridge.

- **NOTE:** Pull the seal out straight. Pulling the seal diagonally may tear it.

4. Grasp both handles of the print cartridge with the label facing up and slide the cartridge into the same color slot. Ensure that the cartridge is fully inserted.
5. Remove the orange protective cover of the installed print cartridge and discard.

6. Close the front cover.
How to replace the Fuser Unit

⚠️ **CAUTION:** To prevent electric shock, always turn off the multifunction printer and disconnect the power cable from the grounded outlet before performing maintenance.

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your *Owner’s Manual* or *Product Information Guide*.

⚠️ **NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.

⚠️ **NOTE:** Remove any print jobs from the output tray, and close the multipurpose feeder before opening the front cover.

Dell fuser unit is available only through Dell. To order by phone, see "Contacting Dell" in the *Owner’s Manual* or in this manual.

Dell recommends Dell fuser unit for your multifunction printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

**Removing the Used Fuser Unit**

⚠️ **CAUTION:** To avoid burns, do not replace the fuser unit immediately after printing, as the fuser unit gets very hot during this process.

1. Turn off the multifunction printer and wait for 30 minutes for the fuser unit to cool down before removal.

2. Push the button (right side) and open the front cover.
3. Lift the chute gate to its upright position.

4. Release the levers at both ends of the fuser unit.
5. Hold both sides of the installed fuser unit, pull it towards the front of the multifunction printer to release the connection on the right side, then lift upward to remove.

**Installing a New Fuser Unit**

1. Unpack a new fuser unit and hold both sides of the fuser unit with both hands.
2. With the connector of the fuser unit toward the slot, push the connector into the slot firmly.

NOTE: Ensure that the fuser connector is firmly seated.

3. Lock both levers at the ends of the fuser unit.
4. Lower the chute gate to its horizontal position.

5. Close the front cover.
How to replace Rollers

There are three separator rollers in the multifunction printer which need to be replaced periodically. One is in the tray and the others are inside the multifunction printer. Basically, all the separator rollers are replaced in the same way as described in this section.

**CAUTION:** To prevent electric shock, always turn off the multifunction printer and disconnect the power cable from the grounded outlet before performing maintenance.

**CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your Owner’s Manual or Product Information Guide.

Dell separator rollers are available only through Dell. To order by phone, see "Contacting Dell" in the Owner’s Manual or in this manual.

Dell recommends Dell separator rollers for your multifunction printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

Removing the Used Separator Roller in Tray

**NOTE:** Remove any print jobs from the tray before pulling the tray out of the multifunction printer.

1. Pull the tray out of the multifunction printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the multifunction printer.
NOTE: Remove all paper from the tray before opening the separator roller cover.

2. Push back the handles on each side of the separator roller cover as shown in the following illustration and open the cover.

3. Turn the separator roller until the roller hook can be seen.
4. Pull the separator roller hook out of the groove in the axle, and then slide the separator roller to the right.

**Installing the New Separator Roller in the Tray**

1. Align the hole of the new separator roller with the axle.
2. Slide the separator roller along the axle so the protrusions fit completely into the slots and the roller hook reseats into the groove on the axle.

3. Close the separator roller cover until both sides click into place.

4. Load paper into the tray and replace it into the multifunction printer.
Removing the Used Separator Roller Inside the Multifunction Printer

1. Pull the tray out of the multifunction printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the multifunction printer.

2. Turn the separator roller until the roller hook can be seen.
2. **NOTE:** The roller is located approximately 165 mm (6.5 in.) inside the machine as measured from the face of the paper tray opening.

3. Pull the separator roller hook out of the groove on the axle, and then slide the separator roller to the left.

4. Repeat steps 2 and 3 to remove the other separator roller from the inside of the multifunction printer.
Installing the New Separator Roller Inside the Multifunction Printer

1. Align the hole of the new separator roller with the axle.

2. Slide the separator roller along the axle so the protrusions fit completely into the slots and the roller hook re-seats into the groove on the axle.
3. Replace the tray into the multifunction printer.

---

Replacing the Transfer Belt Unit

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your Owner's Manual or Product Information Guide.

⚠️ **NOTICE:** Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, or oil from your hands on the film of the transfer belt unit may reduce print quality.

⚠️ **NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.
Dell transfer belt units are available only through Dell. To order by phone, see "Contacting Dell" in the Owner's Manual or in this manual. Dell recommends Dell transfer belt units for your multifunction printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

**Removing the Used Transfer Belt Unit**

- **NOTE:** Remove any print jobs from the output tray, and close the multipurpose feeder cover before opening the front cover.

1. Ensure that the multifunction printer is turned off.
2. Push the side button and open the front cover.
3. Pull up on the belt release levers and rotate the transfer belt unit up as shown in the illustration.
CAUTION: Do not touch the inside of the multifunction printer. Some parts may be hot. Allow time for the multifunction printer to cool before attempting to remove parts in this area.

4. Hold both sides of the transfer belt unit with both hands and pull up the left side of the unit until the peg on the left side comes out of the groove. Then, shift the transfer belt unit to the right and remove the unit from the multifunction printer.

Installing a New Transfer Belt Unit
1. Unpack a new transfer belt unit.

2. Insert the left peg into the corresponding left side belt unit hole, then align the right peg with the groove, and then push down on the right side of the transfer belt unit to seat into place.

3. Close the transfer belt unit by pulling it down until it clicks.
4. Remove the film cover from the installed transfer belt unit and discard.

5. Close the front cover.
Printing With Web Services for Devices (WSD)

This section provides information for network printing with WSD, Microsoft's new Windows Vista protocol.

Printer Setup

You can install your new printer on the network using the Drivers and Utilities CD that shipped with your printer, or using Microsoft's Windows Add Printer wizard.

However, when you use IPv6 Mode, you cannot install the printer driver from the Drivers and Utilities CD. Use the Add Printer wizard.

Installing a Printer Driver Using the Add Printer Wizard

1. Click Start → Control Panel → Hardware and Sound → Printers.
2. Click Add a printer to launch the Add Printer wizard.
3. Select Add a network, wireless or Bluetooth printer.
4. In the list of available printers, select the one you want to use, and then click Next. If your computer is connected to a network, only printers listed in Active Directory for your domain are displayed in the list.
5. If prompted, install the printer driver on your computer. If you are prompted for an administrator password or confirmation, type the password or provide confirmation.
6. Complete the additional steps in the wizard, and then click Finish.
7. Print a test page to verify print installation.
8. Click Start → Control Panel → Hardware and Sound → Printers.
9. Right-click the printer you just created, and then click Properties.
10. On the General tab, click Print Test Page. When a test page prints successfully, printer installation is complete.
Maintaining Your Multifunction Printer

Periodically, your printer requires you to complete certain tasks to maintain optimum print quality. If several people are using the multifunction printer, you may want to designate a key operator to maintain your multifunction printer. Refer printing problems and maintenance tasks to this key operator.

- Determining the Status of Supplies
- Conserving Supplies
- Ordering Supplies
- Storing Print Media
- Storing Consumables
- Replacing Print Cartridges
- Replacing the Fuser Unit
- Replacing Separator Rollers
- Replacing the Transfer Belt Unit
- Adjusting Color Registration
- Cleaning the scanner
- Cleaning the Roller in the ADF

Determining the Status of Supplies

If your multifunction printer is connected to the network, the Dell Printer Configuration Web Tool can provide instant feedback on remaining toner levels. Type the printer IP address in your Web browser to view this information. To use the E-Mail Alert Setup feature that notifies you when the multifunction printer requires new supplies, type your name or the name of the key operator in the e-mail list box.

On the operator panel, you can also confirm the following:

- Any supply or maintenance items that require attention replacing (However, the multifunction printer can only display information about one item at a time.)
- Amount of toner remaining in each print cartridge

Conserving Supplies

You can change several settings in your software program or on the operator panel to conserve print cartridge and paper.
<table>
<thead>
<tr>
<th>Supply</th>
<th>Setting</th>
<th>Function</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print cartridge</td>
<td>Draft Mode in the Advanced</td>
<td>This check box allows the users to select a print mode that uses less toner. When this feature is used, the image quality will be lower than when it is not used.</td>
<td></td>
</tr>
<tr>
<td>Print media</td>
<td>Multiple Up</td>
<td>The multifunction printer prints two or more pages on one side of a sheet. Values for <strong>Multiple Up</strong> are 2 Up, 4 Up, 8 Up, 16 Up, or 32 Up. Combined with the duplex setting, <strong>Multiple Up</strong> allows you to print up to 64 pages on one sheet of paper. (32 images on the front and 32 on the back)</td>
<td></td>
</tr>
<tr>
<td>Duplex</td>
<td></td>
<td>This allows you to print on both sides of a sheet of paper. Duplex printing is only available when the optional duplexer is installed on the multifunction printer.</td>
<td></td>
</tr>
</tbody>
</table>

**Ordering Supplies**

You can order consumables from Dell on the Internet when using a networked printer. Type the IP address of your multifunction printer in your Web browser, launch the **Dell Printer Configuration Web Tool**, and click the **Order Supplies at:** to order toner for your multifunction printer.

You can also order print cartridges by the following method.

1. Click **Start** ➔ **All Programs** ➔ **Dell Printers** ➔ **Additional Color Laser Software** ➔ **Dell Supplies Management System**.

   The **Dell Supplies Management System** window appears.

2. Select your multifunction printer from the **Select Printer Model** list.

3. If ordering from the Web:
   a. When you cannot get information from the multifunction printer automatically by two-way communication, a window that prompts you to type the Service Tag number appears. Type your Dell printer Service Tag number in the field provided. Your Service Tag number is located inside the front door of your multifunction printer.

   b. Select an URL from the **Select Reorder URL** list.

   c. Click **Visit Dell printer supplies ordering web site**.

4. If ordering by phone, call the number that appears under the **By Telephone** heading.

**Storing Print Media**
To avoid potential paper feeding problems and uneven print quality, there are several things you can do.

- To achieve the best possible print quality, store print media in an environment where the temperature is approximately 21°C (70°F) and the relative humidity is 40%.
- Store cartons of print media on a pallet or shelf, rather than directly on the floor.
- If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so the edges do not buckle or curl.
- Do not place anything on top of the print media packages.

---

**Storing Consumables**

Store consumables in their original packaging until you need to use them. Do not store consumables in:

- Temperatures greater than 40°C (104°F).
- An environment with extreme changes in humidity or temperature.
- Direct sunlight.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

---

**Replacing Print Cartridges**

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your Owner's Manual or Product Information Guide.

⚠️ **NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.

Dell print cartridges are available only through Dell. You can order more cartridges online at [http://www.dell.com/supplies](http://www.dell.com/supplies) or by phone. To order by phone, see "Contacting Dell" in the Owner's Manual or in this manual.

Dell recommends that you use Dell print cartridges for your multifunction printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.
CAUTION: Never throw used print cartridges into a fire. The residual toner could explode resulting in burns and injuries.

CAUTION: Since the used print cartridge may spill some toner, do not shake it.

Removing the Used Print Cartridge

1. Push the button (right side) and open the front cover.

2. Grasp the handles at both ends of the print cartridge that you want to replace and pull it out.
CAUTION: Since the used print cartridge may spill some toner, do not shake it.

Installing a New Print Cartridge

1. Select the new print cartridge which color matches the color of the handles on the printer cartridge to be replaced and shake it five or six times to distribute the toner evenly.

2. Remove the print cartridge from its packaging.
NOTE: To protect the drum against bright light, do not remove the orange protective cover of the print cartridge before the cartridge is inserted into its slot in the multifunction printer.

3. Completely remove the seal from the print cartridge by pulling the tab on the end of the print cartridge.

NOTE: Pull the seal out straight. Pulling the seal diagonally may tear it.

4. Grasp both handles of the print cartridge with the label facing up and slide the cartridge into the same color slot. Ensure the cartridge is fully inserted.
5. Remove the orange protective cover of the installed print cartridge and discard.

6. Close the front cover.
Replacing the Fuser Unit

**CAUTION:** To prevent electric shock, always turn off the multifunction printer and disconnect the power cable from the grounded outlet before performing maintenance.

**CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your Owner’s Manual or Product Information Guide.

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.

**NOTE:** Remove any print jobs from the output tray, and close the multipurpose feeder before opening the front cover.

Dell fuser unit is available only through Dell. To order by phone, see “Contacting Dell” in the Owner’s Manual or in this manual.

Dell recommends Dell fuser unit for your multifunction printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

Removing the Used Fuser Unit

**CAUTION:** To avoid burns, do not replace the fuser unit immediately after printing, as the fuser unit gets very hot during this process.

1. Turn off the multifunction printer and wait for 30 minutes for the fuser unit to cool down before removal.

2. Push the button (right side) and open the front cover.
3. Lift the chute gate to its upright position.

4. Release the levers at both ends of the fuser unit.
5. Hold both sides of the installed fuser unit, pull it towards the front of the multifunction printer to release the connection on the right side, then lift upward to remove.

**Installing a New Fuser Unit**

1. Unpack a new fuser unit and hold both sides of the fuser unit with both hands.
2. With the connector of the fuser unit toward the slot, push the connector into the slot firmly.

**NOTE:** Ensure that the fuser connector is firmly seated.

3. Lock both levers at the ends of the fuser unit.
4. Lower the chute gate to its horizontal position.

5. Close the front cover.
Replacing Separator Rollers

There are three separator rollers in the multifunction printer which need to be replaced periodically. One is in the tray and the others are inside the multifunction printer. Basically, all the separator rollers are replaced in the same way as described in this section.

**CAUTION:** To prevent electric shock, always turn off the multifunction printer and disconnect the power cable from the grounded outlet before performing maintenance.

**CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your *Owner's Manual* or *Product Information Guide*.

Dell separator rollers are available only through Dell. To order by phone, see "Contacting Dell" in the *Owner's Manual* or in this manual.

Dell recommends Dell separator rollers for your multifunction printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

Removing the Used Separator Roller in Tray

**NOTE:** Remove any print jobs from the tray before pulling the tray out of the multifunction printer.

1. Pull the tray out of the multifunction printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the multifunction printer.
NOTE: Remove all paper from the tray before opening the separator roller cover.

2. Push back the handles on each side of the separator roller cover as shown in the following illustration and open the cover.

3. Turn the separator roller until the roller hook can be seen.
4. Pull the separator roller hook out of the groove in the axle, and then slide the separator roller to the right.

**Installing the New Separator Roller in the Tray**

1. Align the hole of the new separator roller with the axle.
2. Slide the separator roller along the axle so the protrusions fit completely into the slots and the roller hook reseats into the groove on the axle.

3. Close the separator roller cover until both sides click into place.

4. Load paper into the tray and replace it into the multifunction printer.
Removing the Used Separator Roller Inside the Multifunction Printer

1. Pull the tray out of the multifunction printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the multifunction printer.

2. Turn the separator roller until the roller hook can be seen.
2. **NOTE:** The roller is located approximately 165 mm (6.5 in.) inside the machine as measured from the face of the paper tray opening.

3. Pull the separator roller hook out of the groove on the axle, and then slide the separator roller to the left.

4. Repeat steps 2 and 3 to remove the other separator roller from the inside of the multifunction printer.
Installing the New Separator Roller Inside the Multifunction Printer

1. Align the hole of the new separator roller with the axle.

2. Slide the separator roller along the axle so the protrusions fit completely into the slots and the roller hook re-seats into the groove on the axle.
3. Replace the tray into the multifunction printer.

Replacing the Transfer Belt Unit

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your *Owner’s Manual or Product Information Guide*.

⚠️ **NOTICE:** Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, or oil from your hands on the film of the transfer belt unit may reduce print quality.

⚠️ **NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.
Dell transfer belt units are available only through Dell. To order by phone, see "Contacting Dell" in the Owner's Manual or in this manual. Dell recommends Dell transfer belt units for your multifunction printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

**Removing the Used Transfer Belt Unit**

**NOTE:** Remove any print jobs from the output tray, and close the multipurpose feeder cover before opening the front cover.

1. Ensure that the multifunction printer is turned off.
2. Push the button (right side) and open the front cover.

3. Pull up on the belt release levers and rotate the transfer belt unit up as shown in the illustration.
CAUTION: Do not touch the inside of the multifunction printer. Some parts may be hot. Allow time for the multifunction printer to cool before attempting to remove parts in this area.

4. Hold both sides of the transfer belt unit with both hands and pull up the left side of the unit until the peg on the left side comes out of the groove. Then, shift the transfer belt unit to the right and remove the unit from the multifunction printer.

Installing a New Transfer Belt Unit
1. Unpack a new transfer belt unit.

2. Insert the left peg into the corresponding left side belt unit hole, then align the right peg with the groove, and then push down on the right side of the transfer belt unit to seat into place.

3. Close the transfer belt unit by pulling it down until it clicks.
4. Remove the film cover from the installed transfer belt unit and discard.

5. Close the front cover.

---

**Adjusting Color Registration**

To adjust the color registration when you first install the multifunction printer or after moving it to a new location, follow the procedure below. See "Operator Panel" and "Color Reg Adjust" for information about the operator panel.

**Printing the Color Registration Chart**

Use the operator panel to print the color registration chart.
1. Press ▼ until >SETUP appears, and then press ✔.
2. Press ▼ until >Admin Menu appears, and then press ✔.
3. Press ▼ until >Maintenance appears, and then press ✔.
4. Press ▼ until >Color Reg Adjust appears, and then press ✔.
5. Press ▼ until >ColorRegi Chart appears, and then press ✔.

The color registration chart is printed.

**Determining Values**

From the lines to the right of the Y (Yellow), M (Magenta), and C (Cyan) pattern, find the values of the straightest lines.

> **NOTE:** You can also use the densest colors of the lattice pattern to find the straightest lines. The colors printed at the highest density are those next to the straightest lines. When 0 is the value nearest the straightest line, you do not need to adjust the color registration. When the value is not 0, follow the procedure outlined in "Entering Values".

![Color Registration Chart](image)

**Entering Values**

Using the operator panel, enter the values that you found in the color registration chart to make adjustments.
1. Press \( \downarrow \) until >SETUP appears, and then press \( \checkmark \).

2. Press \( \downarrow \) until >Admin Menu appears, and then press \( \checkmark \).

3. Press \( \downarrow \) until >Maintenance appears, and then press \( \checkmark \).

4. Press \( \downarrow \) until >Color Reg Adjust appears, and then press \( \checkmark \).

5. Press \( \downarrow \) until >Enter Number appears, and then press \( \checkmark \).

   The cursor is located at the first digit of the Enter Number.

6. Press \( \uparrow \) or \( \downarrow \) until you reach the value (for example, +3) displayed on the chart.

7. Press \( \leftarrow \) once and move the cursor to the next value.

8. Repeat steps 6 and 7 to enter all of the digits of the Enter Number, and then press \( \checkmark \).

9. Press \( \downarrow \) until >ColorRegi Chart appears, and then press \( \checkmark \).

   The color registration chart is printed with the new values.

10. Color registration adjustment is complete when the straightest \( Y \) (Yellow), \( M \) (Magenta), and \( C \) (Cyan) lines are next to the 0 line.

   \[ \text{CAUTION: After printing the color registration chart, do not turn off the multifunction printer until the printer motor has stopped running.} \]

   \[ \text{NOTE: If 0 is not next to the straightest lines, determine the values and adjust the multifunction printer again.} \]

---

**Cleaning the scanner**

Keeping the scanner clean helps ensure the best possible copies. Dell recommends cleaning the scanner at the start of each day and during the day, as needed.

1. Slightly dampen a soft lint-free cloth or paper towel with water.

2. Open the document cover.
3. Wipe the surface of the document feeder glass and ADF glass until it is clean and dry.

4. Wipe the underside of the white document cover and white sheet until it is clean and dry.

5. Close the document cover.

1. White Sheet
   - NOTE: Handle with care.

2. Document Cover

3. ADF Glass

4. Document Feeder Glass
Cleaning the Roller in the ADF

Keeping the two rollers in the ADF clean helps ensure the best possible copies. Dell recommends cleaning the rollers at regular intervals.

1. Open the cover of the ADF.

2. Wipe the roller with a dry soft lint-free cloth or paper towel until it is clean.

If the rollers get soiled with ink stains, paper from the ADF may also be soiled. In this case, slightly dampen a soft lint-free cloth or paper towel with a neutral detergent or water, and then remove the contamination from the roller until it is clean and dry.
Removing Options

If the printer location needs to change or the multifunction printer and print media handling options need to be shipped to a new location, all print media handling options must be removed from the multifunction printer. For shipping, pack the multifunction printer and print media handling options securely to avoid damage.

- Removing the Optional 550-Sheet Paper Feeder
- Removing the Optional Duplexer
- Removing the Optional Memory Card
- Removing the Optional Multi-Protocol Card
- Removing the Wireless Printer Adapter

Removing the Optional 550-Sheet Paper Feeder

**NOTE:** If you are removing the optional 550-sheet paper feeder, be sure to turn off the multifunction printer, unplug the power cable, and disconnect all cables from the back of the multifunction printer before completing these tasks.

1. Turn off the multifunction printer and unplug the printer power cable.

2. Pull the tray out of the multifunction printer until it stops. Hold the tray with both hands, lift the front slightly, and remove it from the multifunction printer.

3. Remove the two screws joining the multifunction printer and the optional 550-sheet paper feeder by unscrewing them with a coin or similar object.
4. Gently lift the multifunction printer off the tray module, and place it on a level surface.

**CAUTION:** To lift the multifunction printer safely, remove the print cartridges and lift it with two people facing the front and back. Never try to lift the multifunction printer while facing its right and left sides.

5. Insert the tray into the multifunction printer, and push until it stops.
Removing the Optional Duplexer

**NOTICE:** Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, or oil from your hands on the film of the transfer belt unit may reduce print quality.

**NOTICE:** To protect the drums of the print cartridges against bright light, close the front cover within five minutes. If the front cover remains open for more than five minutes, print quality may deteriorate.

1. Ensure that the multifunction printer is turned off and unplug the power cord from the rear of the multifunction printer.

2. Push the button (right side) and open the front cover.
3. Pull up on the belt release levers and rotate the transfer belt unit up as shown in the illustration.

4. Hold the latch of the duplexer as shown in the following illustration and pull out the duplexer from the multifunction printer.
5. Close the transfer belt unit by pulling it down.

6. Close the front cover.
Removing the Optional Memory Card

1. Ensure that the multifunction printer is turned off and unplug all cables including the power cord from the rear of the multifunction printer.

2. Turn the screw on the control board cover gently in a counter-clockwise direction and open the cover.

3. Pull the latches on both edges of the socket outward at the same time to raise the memory card up.
4. Hold the memory card and pull it out.

5. Close the control board cover and turn the screw clockwise.
Removing the Optional Multi-Protocol Card

NOTE: If the optional wireless printer adapter is also installed, it must be removed first.

1. Ensure that the multifunction printer is turned off and unplug all cables including the power cord from the rear of the multifunction printer.

2. Turn the screw on the control board cover gently in counter-clockwise direction and open the cover.

3. Remove the two screws from the multipurpose card on the back side of the control board.
4. Hold the multi-protocol card and remove it from the control board.

5. Close the control board cover and turn the screw clockwise.
Removing the Wireless Printer Adapter

1. Ensure that the multifunction printer is turned off.

2. Turn the screw on the control board cover gently in a counter-clockwise direction and open the cover.

3. Remove the wireless printer adapter cap from the control board by releasing the cap's hooks.
4. Remove the wireless printer adapter from the multifunction printer.

5. Attach the plate by tightening the screw on the back side of the multifunction printer to cover the wireless printer adapter socket.
6. Close the control board cover and turn the screw clockwise.
Printer Specifications

- **OS Compatibility**
- **Power Supply**
- **Dimensions**
- **Memory**
- **Page Description Language (PDL)/Emulation, Operating System, and Interface**
- **Environmental**
- **Cables**
- **Copier Specification**
- **Scanner Specification**
- **Facsimile Specifications**

### OS Compatibility


¹ Your Dell Multifunction Color Laser Printer 3115cn is compatible with Microsoft, Novell and Linux operating systems, but Dell technical phone support only supports factory-installed operating systems (Microsoft) for the first 30 days for free. See [http://www1.us.dell.com/content/products/compare.aspx/laser?c=us&cs=555&l=en&s=biz](http://www1.us.dell.com/content/products/compare.aspx/laser?c=us&cs=555&l=en&s=biz) for more details. The customer will have to purchase technical support from the manufacturer of the operating system in order to get technical assistance beyond 30 days.

² If the customer has other operating systems, such as Novell or Linux, and has purchased Gold Technical Support (for more information on Gold Technical Support, see [http://www1.us.dell.com/content/topics/global.aspx/services/en/gts?c=us&cs=555&l=en&s=biz](http://www1.us.dell.com/content/topics/global.aspx/services/en/gts?c=us&cs=555&l=en&s=biz)), the telephone support will be a "best effort" attempt to resolve the operating system issue. If the manufacturer needs to be contacted, the customer must pay an additional fee for that support. The only time that Dell pays for the third party support is when Dell is responsible for the issue. In the case of getting the multifunction printer installed and working, this is configuration and the customer would be responsible for paying.

³ Mac OS X, Novell, Linux, and UNIX support network scanning and printing only.

### Power Supply
### Rated Voltage

- 220-240 VAC
- 110-127 VAC

### Frequency

- 50/60 Hz

### Current

- 5 A
- 11 A

### Dimensions

Height: 730 mm (28.74 in.)
Width: 460 mm (18.11 in.)
Depth: 520 mm (20.47 in.)

Weight (not including cartridge): 35 kg (77.2 lb)

### Memory

<table>
<thead>
<tr>
<th>Base memory</th>
<th>128 MB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum memory</td>
<td>1152 MB (128+1024 MB)</td>
</tr>
<tr>
<td>Connector</td>
<td>200 pin DDR2 SO-DIMM</td>
</tr>
<tr>
<td>DIMM Size</td>
<td>256 MB, 512 MB, 1024 MB</td>
</tr>
<tr>
<td>Speed</td>
<td>PC2-3200, PC2-4200, PC2-5300</td>
</tr>
</tbody>
</table>

### Page Description Language (PDL)/Emulation, Operating System, and Interface

#### PDL/Emulations

Adobe PostScript 3, PCL 6, PCL5c

#### OSes


#### Interfaces

- **Standard local:**
  - USB, IEEE 1284
  - 10Base-T/100Base-TX Ethernet
- **Optional network:**
  - IEEE802.11b/802.11g (Wireless)
MIB Compatibility

A Management Information Base (MIB) is a database containing information about network devices (such as adapters, bridges, routers, or computers). This information helps network administrators manage the network (analyze performance, traffic, errors, and so on). Dell Multifunction Color Laser Printer 3115cn complies with standard industry MIB specifications, allowing the multifunction printer to be recognized and managed by various printer and network management software systems, such as IBM Tivoli, Hewlett-Packard OpenView, CA Unicenter, Hewlett-Packard Web JetAdmin, and so on.

Environmental

Operation

<table>
<thead>
<tr>
<th>Temperature</th>
<th>5-32°C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative humidity</td>
<td>15-85% RH (no condensation)</td>
</tr>
</tbody>
</table>

Print Quality Guarantee

<table>
<thead>
<tr>
<th>Temperature</th>
<th>10-28°C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative humidity</td>
<td>15-85% RH (no condensation) (Temperature should be 28°C or below at 85% RH.)</td>
</tr>
</tbody>
</table>

Storage

<table>
<thead>
<tr>
<th>Temperature range</th>
<th>-20-40°C (0-104 °F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage humidity range</td>
<td>5-95% RH (no condensation)</td>
</tr>
</tbody>
</table>

Altitude

<table>
<thead>
<tr>
<th>Operating</th>
<th>Up to 3,100 m (10,000 feet)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage</td>
<td>70.9275 Kpa</td>
</tr>
</tbody>
</table>

Chemical Emission
Cables

Your interconnection cable must meet the following requirements:

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Connection specifications and symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Wall jack connector</td>
<td><img src="image" alt="FAX" /></td>
</tr>
<tr>
<td>2 Phone connector</td>
<td><img src="image" alt="Handset" /></td>
</tr>
<tr>
<td>3 USB</td>
<td><img src="image" alt="USB" /></td>
</tr>
<tr>
<td>4 Parallel</td>
<td><img src="image" alt="IEEE 1284" /></td>
</tr>
<tr>
<td>5 Wireless</td>
<td><img src="image" alt="IEEE802.11b/802.11g" /></td>
</tr>
<tr>
<td>6 Ethernet</td>
<td><img src="image" alt="10 Base-T/100 Base-TX" /></td>
</tr>
</tbody>
</table>

Concentration of ozone: 0.019 mg/m³
Copier Specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Resolution</td>
<td>Optical: 600 x 600 dpi</td>
</tr>
<tr>
<td>Copy Speed</td>
<td>Color 17 cpm, Black&amp;White 30 cpm (In case when scanned from document feeder glass, and feed paper from standard tray)</td>
</tr>
<tr>
<td>Paper Size</td>
<td>A5, A4, B5, Executive, Letter, Legal 13&quot;, Legal 14</td>
</tr>
<tr>
<td>Zoom Rate</td>
<td>Document feeder glass: 25% - 400%, ADF: 25% - 400%</td>
</tr>
<tr>
<td>Multiple copies</td>
<td>1 - 99 pages</td>
</tr>
<tr>
<td>Copy mode (=Original Type)</td>
<td>Text, Text&amp;Photo, Photo, Best</td>
</tr>
<tr>
<td>Scanning method</td>
<td>Charge coupled device (CCD) module</td>
</tr>
</tbody>
</table>

Scanner Specification
### Facsimile Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Compatibility</strong></td>
<td>ITU-T Group 3</td>
</tr>
<tr>
<td><strong>Applicable line</strong></td>
<td>Public Switched Telephone Network (PSTN) or behind PABX</td>
</tr>
<tr>
<td><strong>Data coding</strong></td>
<td>MH/MR/MMR/JBIG</td>
</tr>
<tr>
<td><strong>Modem speed</strong></td>
<td>33.6 Kbps</td>
</tr>
<tr>
<td><strong>Transmission speed</strong></td>
<td>Approx. 3 seconds/page *Transmission time applies to memory transmission of text data with ECM compression using only ITU-T No.1 Chart. *</td>
</tr>
<tr>
<td><strong>Scanning speed</strong></td>
<td>Document glass: approx. 3 seconds/A4 (at standard fax resolution mode) ADF: approx. 5 seconds/Letter (at standard fax resolution mode), 7.5 seconds/Letter (at fine fax resolution mode)</td>
</tr>
<tr>
<td><strong>Maximum document length</strong></td>
<td>Document glass: 297 mm ADF: 356 mm</td>
</tr>
<tr>
<td><strong>Paper size</strong></td>
<td>Letter, A4, Legal</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>Standard: 203 x 98 dpi, Fine: 203 x 196 dpi, Super Fine: 406 x 392 dpi</td>
</tr>
<tr>
<td><strong>User Memory</strong></td>
<td>4 MB (320 pages)</td>
</tr>
<tr>
<td><strong>Halftone</strong></td>
<td>256 levels</td>
</tr>
</tbody>
</table>
Printing With UNIX Filter (UNIX/Linux)

- Overview
- Installing the UNIX Filter
- Uninstalling the UNIX Filter
- Printing and Using the Utilities
- Precautions and Limitations

Overview

The UNIX Filter

This section describes the features of the UNIX filter and its operating environment.

Features

The UNIX Filter is a utility software which converts files created by the UNIX workstation into a format which conforms to the PostScript language loaded in the multifunction printer. The utility provides software that converts text files, SunRaster image files (for Sun/Solaris only), TIFF image files and XWD image files into the PostScript language program. Also, it makes use of the printer features to output in the following manner.

- Input paper selection
- Double-sided printing
- Output paper selection

NOTICE: Depending on the configurations of the printers, some may not be able to use the UNIX filter.

Operating Environment

Text files, SunRaster image files (for Solaris only), TIFF (Tagged Image File Format) image files and XWD (X Windows Dump) image files received from a workstation connected to the multifunction printer by a USB cable or parallel cable (hereinafter referred to as the local workstation), or from one located on the network (hereinafter referred to as the remote workstation), can be converted into the PostScript language program and output to the multifunction printer.
In addition, it can also be used in an environment where a multifunction printer, installed with an interface board, is connected directly to the network.

**Before Using UNIX Filter**

Check the following items before using the UNIX filter. Before setting up the workstation, set up the multifunction printer as follows:

1. Ensure that the lpd port is working or not when using the network environment. If the lpd port is not working, set LPD to On on the operator panel. (Mandatory) See "Protocol" for more information.

   When a parallel or USB port is to be used, ensure that the USB ports are working. (Mandatory)

2. Set up IP address and subnet mask when the multifunction printer is used in the network environment. (Mandatory)

Installing the UNIX Filter

Before Installation

The following are required for the installation.

- Supported operating system is described in "Page Description Language (PDL)/Emulation, Operating System, and Interface".

  Disk capacity: 20 MB of free disk space required, including temporary working space for installation.

- Log on as a root account to perform the operation here. If you have no root privilege, contact your system administrator.

- Output printer must be registered in the workstation before using UNIX filter. (HP-UX)
  Use `sam` command for registration of output printer.
  For more information, see the HP-UX related manual.

Files Added by the Installation

The following files will be added when the UNIX filter is installed.

Solaris

<table>
<thead>
<tr>
<th>Directory</th>
<th>File name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>/usr/local/dellbin3115</td>
<td>txt2ps2</td>
<td>Text conversion utility</td>
</tr>
<tr>
<td></td>
<td>sunras2ps2</td>
<td>SunRaster conversion utility</td>
</tr>
<tr>
<td></td>
<td>tiff2ps2</td>
<td>TIFF conversion utility</td>
</tr>
<tr>
<td></td>
<td>xwd2ps2</td>
<td>XWD conversion utility</td>
</tr>
<tr>
<td></td>
<td>dellpsif</td>
<td>Input filter</td>
</tr>
<tr>
<td>/usr/lib/lp/postscript</td>
<td>dellposttxt3115cn</td>
<td>Symbolic link file to call txt2ps2</td>
</tr>
<tr>
<td></td>
<td>dellpostps3115cn</td>
<td>Symbolic link file to call dellpsif</td>
</tr>
<tr>
<td></td>
<td>dellbinpath3115</td>
<td>Directory description file for the UNIX filter print tool</td>
</tr>
<tr>
<td>/usr/lib/lp/model</td>
<td>Model interface program</td>
<td>Source file of the model interface program (stored as the printer name during registration)</td>
</tr>
<tr>
<td>/etc/lp/interfaces</td>
<td>Model interface program</td>
<td>Interface program for PRINTER (stored as the printer name during registration)</td>
</tr>
<tr>
<td>Directory</td>
<td>File name</td>
<td>Contents</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>/etc/lp/fd</td>
<td>posttxt3115cn.fd</td>
<td>Filter description file for txt2ps2</td>
</tr>
<tr>
<td></td>
<td>dell3115cn.fd</td>
<td>dell3115cn filter description file for Dell Multifunction Color Laser Printer 3115cn</td>
</tr>
<tr>
<td></td>
<td>postio3115.fd</td>
<td>postio3115 Filter description file</td>
</tr>
<tr>
<td></td>
<td>download3115.fd</td>
<td>download3115 filter description file</td>
</tr>
<tr>
<td>/usr/share/man/man1</td>
<td>txt2ps23115cn.1</td>
<td>Manual page file for txt2ps2</td>
</tr>
<tr>
<td></td>
<td>sunras2ps23115cn.1</td>
<td>Manual page file for sunras2ps2</td>
</tr>
<tr>
<td></td>
<td>tiff2ps23115cn.1</td>
<td>Manual page file for tiff2ps2</td>
</tr>
<tr>
<td></td>
<td>xwd2ps23115cn.1</td>
<td>Manual page file for xwd2ps2</td>
</tr>
<tr>
<td></td>
<td>dellpsif3115cn.1</td>
<td>Manual page file for dellpsif</td>
</tr>
</tbody>
</table>

**NOTE:** The directories listed are default directories.

**Linux**

<table>
<thead>
<tr>
<th>Directory</th>
<th>File name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>/usr/local/dellbin3115</td>
<td>txt2ps2</td>
<td>Text conversion utility</td>
</tr>
<tr>
<td></td>
<td>tiff2ps2</td>
<td>TIFF conversion utility</td>
</tr>
<tr>
<td></td>
<td>xwd2ps2</td>
<td>XWD conversion utility</td>
</tr>
<tr>
<td></td>
<td>printcap. sample</td>
<td>Printcap file sample</td>
</tr>
<tr>
<td></td>
<td>dellpsif</td>
<td>Input Filter</td>
</tr>
<tr>
<td></td>
<td>.dellpsdefault3115</td>
<td>Default command option file</td>
</tr>
<tr>
<td>/usr/share/man/man1</td>
<td>txt2ps23115cn.1</td>
<td>Manual page file for txt2ps2</td>
</tr>
<tr>
<td></td>
<td>tiff2ps23115cn.1</td>
<td>Manual page file for tiff2ps2</td>
</tr>
<tr>
<td></td>
<td>xwd2ps23115cn.1</td>
<td>Manual page file for xwd2ps2</td>
</tr>
<tr>
<td></td>
<td>dellpsif3115cn.1</td>
<td>Manual page file for dellpsif</td>
</tr>
</tbody>
</table>

**NOTE:** The directories listed are default directories.

**HP-UX**
### Directory List

<table>
<thead>
<tr>
<th>Directory</th>
<th>File name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>/usr/local/dellbin3115</td>
<td>txt2ps2</td>
<td>Text conversion utility</td>
</tr>
<tr>
<td></td>
<td>xwd2ps2</td>
<td>XWD conversion utility</td>
</tr>
<tr>
<td></td>
<td>tiff2ps2</td>
<td>TIFF conversion utility</td>
</tr>
<tr>
<td>/usr/lib/lp/postscript</td>
<td>dellbinpath3115</td>
<td>Directory description file for the UNIX filter print tool</td>
</tr>
<tr>
<td>/usr/spool/lp/interface</td>
<td>Model interface program</td>
<td>Interface program for PRINTER (stored as the printer name during registration)</td>
</tr>
<tr>
<td>/usr/share/man/man1</td>
<td>txt2ps23115cn.1</td>
<td>Manual page file for txt2ps2</td>
</tr>
<tr>
<td></td>
<td>tiff2ps23115cn.1</td>
<td>Manual page file for tiff2ps2</td>
</tr>
<tr>
<td></td>
<td>xwd2ps23115cn.1</td>
<td>Manual page file for xwd2ps2</td>
</tr>
</tbody>
</table>

**NOTE:** The directories listed are default directories.

### Installation Procedure Overview

This section provides information on the installation of the UNIX filter using the UNIX workstation.

**Linux**

1. Setup the multifunction printer and network.
2. Insert the *Drivers and Utilities* CD into the local workstation.
3. Run the installer and begin the installation.
4. Edit `/etc/printcap` and print for testing the multifunction printer.

**Solaris**

1. Setup the multifunction printer and network.
2. Insert the *Drivers and Utilities* CD into the local workstation.
3. Run the installer and begin the installation.
4. Print for testing the multifunction printer.

**HP-UX**

1. Setup the multifunction printer and network.
2. Insert the *Drivers and Utilities* CD into the local workstation.

3. Run the installer and begin the installation.

4. Print for testing the multifunction printer.

### Operation on Linux

#### Installation of Software

1. Insert the *Drivers and Utilities* CD in the CD-ROM drive of the local workstation.
   If CD-ROM drive is not mounted on your workstation, extract files by using another workstation that has a CD-ROM drive to transfer those files to your workstation.

2. Log on as a root account and extract the installation script from the *Drivers and Utilities* CD.

   **NOTICE:** If you have no root privilege, contact your system administrator.

   ```
   # mount /dev/cdrom /mnt/cdrom
   # cd /tmp
   # cp /mnt/cdrom/UXFILTER.tar /tmp
   # tar xvf ./UXFILTER.tar
   ```

   **NOTE:** CD-ROM is sometimes mounted automatically.

3. Type `.install.sh` and run the installer.

   ```
   #./install.sh
   ```

4. Select the printer model to install.

   ```
   Printer Model?
   1. Dell MFP Color Laser 3115cn
   2. Exit
   Enter Process No(1/2)? : 1
   ```

5. It asks whether you want to install the filter. Type `<y>`.

   ```
   Install Filter? (y/n) [y] : y
   ```

   **NOTE:** If [ ] appears in a message, the default value will appear inside the [ ]. It will be selected when you press the <Enter> key.

The disk status on the workstation appears. 20 MB of free disk space is required for the installation of the filter.
6. Specify the directory to install the filter. To install into /usr/local/dellbin3115, press the <Enter> key. To change the directory, specify one. Change the directory to.

Enter Library directory name [/usr/local/dellbin3115]

7. Confirm the directory to be installed.

directory is '/usr/local/dellbin3115' (y/n)[n] : y

The software installation is complete.

**Setting the Multifunction Printer**

Write system settings in /etc/printcap or /etc/printcap.local referencing /usr/local/dellbin3115/printcap.sample.

**Linux (LPRng):**

/etc/printcap.local OR /etc/printcap

```
lp:  
 :bk:  
 :bkf:  
 :lpd_bounce=true:  
 :sd=/var/spool/lpd/lp:  
 :af=/var/spool/lpd/lp/lpacct:  
 :lf=/var/spool/lpd/lp/log:  
 :rm=PrinterHostName:  
 :rp=ps:  
 :if=/usr/local/dellbin3115/dellpsif:  
```

**NOTICE:** The directory to spool can be created in the partition with sufficient disk space. If there is no spooling directory, it is not possible to print large files.

**NOTICE:** The account files or logging files can be created with the file name specified in the directory path specified.

**Operation on Solaris**

**Installation/System Setting**

1. Insert the *Drivers and Utilities* CD in the CD-ROM drive of the local workstation. If CD-ROM drive is not mounted on your workstation, extract files by using another workstation that has a CD-ROM drive to transfer those files to your workstation.
2. Log on as a root account and extract the installation script from the *Drivers and Utilities* CD.

**NOTICE:** If you have no root privilege, contact your system administrator.

```
# cd /tmp
# cp /cdrom/cdrom0/UXFILTER.tar /tmp
# tar xvf ./UXFILTER.tar
```

3. Type `./install.sh` and run the installer.

```
# ./install.sh
```

4. Select the printer model to install.

```
Printer Model ?
  1. Dell MFP Color Laser 3115cn
  2. Exit
Enter Process No (1/2)? : 1
```

5. The following menu appears. Select <1> and set up the local printer.

```
Solaris Installation for Dell MFP Laser Printer 3115cn Type Printer
  1. Set Local Printer
  2. Set Remote Printer
Enter Process No (1/2)? : 1
```

6. Type the device name of the connection port.

```
Enter port-device-name? [/dev/ecpp0] : /dev/bpp0
```

**NOTICE:** Specify the device file in the communication port available.

7. When Set Remote Printer is selected, type the host name of the server or the host name of the multifunction printer.

```
Enter server-hostname? : server
server-hostname is 'server' (y/n)[y] : y
```

**NOTICE:** The host name of the server must be pre-registered with DNS, NIS, NIS+ or /etc/hosts.

8. When Set Remote Printer is selected, type the remote printer name.
NOTICE: Type `ps` when the multifunction printer is a network connection printer.

9. **Type the printer name to be registered with the system.**

```
Enter printer-name? [dell3115cn] : dell3115cn
Printer-name is 'dell3115cn' (y/n)[y] : y
```

10. **Specify the directory to install the utility. To install into `/usr/local/dellbin3115`, press the <Enter> key. To change the directory, specify one.**

```
Enter Binary directory name? [/usr/local/dellbin3115] :
```

11. **If this utility has been installed earlier, the user will be prompted whether to overwrite the earlier version.**

```
directory is '/usr/local/dellbin3115' (y/n)[n] : y
```

12. **If the server input at 5 the multifunction printer connected by the network, type `<y>`. If the server and the multifunction printer are connected locally, type `<n>`.**

```
'dell3115cn'is network printer?:(y/n)[y] : y
```

The software installation is complete.

**NOTICE:** When the printing settings are modified or changed by the Administration Tool (admintool) after the installation, printing may not work.

**Operation on HP-UX**

**Installation Procedure**

**NOTE:** The host name of the output printer which you want to specify in 6 must be pre-registered with a `sam` command.

1. Insert the `rivers and utilities` CD into the CD-ROM drive of the local workstation.

2. Log on as a root account and extract the installation script from the `Drivers and Utilities` CD.
**NOTICE:** If you have no root privilege, contact your system administrator.

```
# mount -F cdfs -o cdcase /dev/dsk/c1t2d0 /cdrom
# cd /tmp
# cp /cdrom/uxfilter.tar /tmp
# tar xvf UXFILTER.tar
```

**NOTE:** /dev/ds/clt2d0 is an example. Specify the CD-ROM device file for all workstations.

3. Type `.install.sh` and run the installer.

```
# ./install.sh
```

4. **Select the printer model to install.**

```
Printer Model ?
1. Dell MFP Color Laser 3115cn
2. Exit
Enter Process No (1/2)? : 1
```

5. **Specify the directory to install the utility.**

```
Enter install directory name /usr/local/dellbin3115] :
directory is '/usr/local/dellbin3115' (y/n)[n]: y
```

6. **Type the name of the output printer.** Type `delllp3115cn`. Type the printer name to be registered with the system.

```
Enter output-printer-name? : delllp3115cn
output-printer-name is 'delllp3115cn' (y/n)[y]: y
```

**NOTE:** The registered printer name can be verified by executing `lpstat -v`.

7. **Type the logical printer name.** Register `dell3115cn`. Type a printer name that has not already been registered with the system.

```
Enter logical-printer-name? : dell3115cn
Printer-name is 'dell3115cn' (y/n)[y]: y
```

8. **The utility will be installed in the directory specified at 5.** Registration will be executed here so that the logical printer registered at 7 can access the utility. As this process is automatically executed, no input is required. With the above steps, the installation is complete.
Uninstalling the UNIX Filter

About Uninstalling

The UNIX filter does not come with an uninstaller. To uninstall the UNIX filter, follow the following procedure.

⚠️ NOTICE: Log on as a root account to perform the operation here. If you have no root privilege, contact your system administrator.

**Linux**

1. Delete the descriptions for each multifunction printer from `/etc/printcap`.
2. Delete the added spool directory.
3. Restart `lpd`.
4. Delete all the directories that contain the UNIX filters and the files in these directories created during the installation. The following directories must be deleted.
   ```
   /usr/local/dellbin3115
   ```
   The above directories are standard directories created during the installation. If you had specified other directories for the installation, delete those directories.

**Solaris**

1. Delete the multifunction printer that was registered with the system. Use the printer name created during the installation and the `lpadmin` command.
   ```
   # lpadmin -x printername
   ```
2. Delete the filters registered with the system. Delete the filters registered during the installation using the `lpfilter` command.
   ```
   # lpfilter -f dell3115cn -x (for Dell Multifunction Color Laser Printer 3115cn)
   # lpfilter -f download3115 -x
   # lpfilter -f postio3115cn -x
   # lpfilter -f posttxt3115cn -x
   ```
3. Delete the symbolic files required to call up the filter. Delete the following files from `/usr/lib/lp/postscript`.
   ```
   dellposttxt3115cn
dellpostps3115cn
dellbinpath3115
   ```
4. Delete the interface program files of Selected printer type name from /usr/lib/lp/model. Please also delete the interface program files of Selected printer name from /etc/lp/interfaces.

5. Delete all the directories that contain the UNIX filters and the files in these directories created during the installation. The following directories must be deleted.

   /usr/local/dellbin3115

6. Delete the filter description files. Delete the following files from /etc/lp/fd. Filter description files for various printers.

   dell3115cn.fd (for Dell Multifunction Color Laser Printer 3115cn)
download3115.fd
dpostio3115cn.fd
posttxt3115cn.fd

**HP-UX**

1. Delete the multifunction printer that was registered with the system. Use the `sam` command to delete the printer set up during the installation.

   # sam

2. Delete all the directories that contain the UNIX filters and the files in these directories created during the installation. The following directories must be deleted.

   /usr/local/dellbin3115 (directory specified during the installation)

---

**Printing and Using the Utilities**

**Printing (Linux)**

This section provides information on printing with the filter. To print, specify the multifunction printer registered with `/etc/printcap` as the output destination.

**Printing From Linux**

To print to the default printer:

If the multifunction printer is registered as the default printer, the name of the multifunction printer can be shortened and specified as shown in the following example.

% lpr filename
To print to other multifunction printer:

To print to a multifunction printer named `dell3115cn`, type as follows:

```
% lpr -Pdell3115cn filename
```

To select a paper tray for printing:

To select a paper tray for printing, the `.dellpsdefault3115` file must be executed in advance to define the multifunction printer which uses the desired paper tray.

To select tray 2 (optional 550-sheet paper feeder) for printing, execute the `.dellpsdefault3115` file and define the multifunction printer so that it feeds paper from tray 2. `Specify tray2`, which is the defined printer name, as follows:

```
% lpr -Ptray2 filename
```

About `/usr/local/dellbin3115/.dellpsdefault3115`:

This is the file for system default settings when using various utilities via `/etc/printcap`. Hereinafter, it is referred to as the `default command option setting file`.

Method:

To define a multifunction printer named `a4d` which prints on A4 with the long-edge binding feature turned on, follow the following steps.

Procedure:

1. Register the printer `a4d` with `/etc/printcap`.

   Linux (LPRng):

   `/etc/printcap.local` or `/etc/printcap`

   ```
   a4d:
   :bk:
   :bkf:
   :lpd_bounce=true:
   :sd=/var/spool/lpd/a4d:
   :af=/var/spool/lpd/a4d/a4d.acct:
   :lf=/var/spool/lpd/a4d/log:
   :rm=PrinterHostName: 
   :rp=ps: 
   :if=/usr/local/dellbin3115/dellpsif_a4d: 
   ```

2. Log on as the root account and create the symbolic links for `dellpsif_a4d` of IF Filter for printing on A4 with the long-edge binding feature turned on.

   ```
   # ln -s /usr/local/dellbin3115/dellpsif /usr/local/dellbin3115/dellpsif_a4d
   ```
3. Add the following descriptions to the default command option setting file that specifies the user defined commands of the dellpsif_a4d of IF Filter.

```
/usr/local/dellbin3115/.dellpsdefault3115
dellpsif_a4d -IA4 -D
```

4. When the printer name a4d is specified, printing can be done on A4 with the long-edge binding feature turned on.

```
% lpr -Pa4d filename
```

## Printing (Solaris)

This section provides information on printing that makes use of the filter. To print from Solaris, specify the multifunction printer registered during the installation of filters as the output destination.

**NOTICE:** To use the `lp` command, ensure that the operating environment of the spooler has been set up correctly (enabled, available) using the `lpstat` command (`lpstat -p all`). For details on the options of the `lp` command and the `lpstat` command or how to make use of them, see the related manuals of Solaris.

### Printing From Solaris

To print to the default printer:

If the multifunction printer is registered as the default printer, the name of the multifunction printer can be shortened and specified as shown in the following example.

```
% lp filename
```

To print to other printers:

To print to a multifunction printer named `dell3115cn`, type as follows:

```
% lp -d dell3115cn filename
```

**NOTE:** The name of the printer can be confirmed by executing `lpstat -v`.

To change the default printer temporarily for printing:

To change the default printer, set the printer name in the environment variable `LPDEST`.

To set a multifunction printer named `dell3115cn` as the default printer for printing, type as follows:

```
% setenv LPDEST dell3115cn
% lp filename
```
NOTE: Using this method, a default printer can be set up for each user.

NOTE: The above example describes the setup method executed when csh is used.

To select a paper tray for printing:

To select a paper tray for printing, specify the paper tray after the \texttt{-y} option of the \texttt{lp} command.

NOTE: Depending on installed options, the available paper trays are different.

To set a multifunction printer named \textit{dell3115cn} as the default printer for printing, type as follows:

\texttt{% lp -d dell3115cn -y landscape -y letter filename}

The following options can be specified by the \texttt{lp} command.

To print text files:

NOTE: It prints according to the length and width specified by the \texttt{lpadmin} command.

\begin{itemize}
\item \texttt{-y double}
  \begin{itemize}
  \item Sets printing to two-column printing.
  \end{itemize}
\item \texttt{-y landscape}
  \begin{itemize}
  \item Rotates the image by 90° and uses the paper in the landscape orientation.
  \end{itemize}
\item \texttt{-y size=n}
  \begin{itemize}
  \item Sets the font size to n point.
  \end{itemize}
\item \texttt{-y outcolumn=n}
  \begin{itemize}
  \item This option converts text to single-byte text and sets printing to start from the nth column.
  \end{itemize}
\item \texttt{-y outline=n}
  \begin{itemize}
  \item Sets printing to start from the nth line.
  \end{itemize}
\item \texttt{-y font=font}
  \begin{itemize}
  \item Sets the font for printing single-byte alphanumeric characters. If the font specified is not available for the multifunction printer, the default fonts are used.
  \end{itemize}
\end{itemize}

NOTE: To specify a font, type the font name as-is after the \texttt{-y font=} option.

\texttt{% lp -y font=Courier-Oblique filename}

NOTE: For information on the available fonts, see the PS Fonts List.

\texttt{-y margin=u:b:r:l}

\begin{itemize}
\item Specifies the margin of a page in inches. The \textit{u} (upper margin), \textit{b} (bottom margin), \textit{r} (right margin), and \textit{l} (left margin) are positive real numbers (up to two decimal points). The default is 0.
\end{itemize}
\-y \texttt{ps}

The input file will be processed as the PostScript file. If the file does not begin with "\%!", "\%!" will be output to the beginning line. Whether the file contains "\%!" will be ignored.

To print text/PostScript files:

\-y \texttt{DuplexBook}

Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound.

\-y \texttt{DuplexList}

Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound.

\-y \texttt{tray-input}

The paper tray-related parameters that can be specified by the \texttt{lp} command are as follows:

\texttt{tray1}
Feed paper from tray 1 (Standard 250-sheet tray).

\texttt{tray2}
Feed paper from tray 2 (Optional 550-sheet paper feeder).

\texttt{a4}
Feed paper from the tray loaded with A4 (210 x 297 mm).

\texttt{a5}
Feed paper from the tray loaded with A5 (148 x 210 mm).

\texttt{b5}
Feed paper from the tray loaded with B5 (182 x 257 mm).

\texttt{letter}
Feed paper from the tray loaded with Letter (8.5 x 11 inches).

\texttt{folio}
Feed paper from the tray loaded with Folio (8.5 x 13 inches).

\texttt{legal}
Feed paper from the tray loaded with Legal (8.5 x 14 inches).

\texttt{executive}
Feed paper from the tray loaded with Executive (7.25 x 10.5 inches).

\texttt{monarch}
Feed paper from the tray loaded with Monarch (3.875 x 7.5 inches).

\texttt{com10}
Feed paper from the tray loaded with Envelope #10 (4.125 x 9.5 inches).
dl
Feed paper from the tray loaded with DL (110 x 220 mm).

c5
Feed paper from the tray loaded with C5 (162 x 229 mm).

MxNmm
Feed paper from the tray loaded with MxNmm defined by users.
Possible range specified:
Width: 76.2-220.0 mm
Length: 98.0-355.6 mm

MxNin
Feed paper from the tray loaded with MxNinches defined by users.
Possible range specified:
Width: 3.00-8.66 inches
Length: 3.86-14.0 inches
If this option is not specified or the tray specified tray is not available, feed paper from the
default tray.

-y toner_save
Turns on the save toner mode for printing. The print result will be fainter than that of normal
printing.

-y nc=n
Specifies the number of output copies (the value of copies must be a positive integer). If this
option is not specified, 1 will be selected.

-y cl
Specifies that printing be collated. If the copies option is not specified, this option will be
ignored.

-y ps
The input file will be processed as the PostScript file. If the file does not begin with %!, %! will
be output to the beginning line. If a file contains %!, this option will be ignored.

-y msi
Specifies multipurpose feeder.

-y m=type
Specifies multipurpose feeder Paper Type.

Available multipurpose feeder Paper Types are as follows:

B
FinePaper/Bond/Plain Paper 2

BB
FinePaperBack/Bond/Plain Paper 2 - Side 2

P
Stationary/Plain/Plain Paper 1

PB
StationaryBack/Plain/Plain Paper 1 - Side 2

H1
If this option is not specified, multipurpose feeder Paper Type for the multifunction printer can be used.

-y mfo=mode

Specifies orientation for multipurpose feeder.

Available orientations for multipurpose feeder are as follows:

le
Landscape

ler
Landscape (Rotated)

se
Portrait

ser
Portrait (Rotated)

-y po=n

Specifies alternate tray.

Available alternate trays are as follows:
0
Use system settings

1
Display message

2
Feed from multipurpose feeder

3
Use nearest size (Adjust to fit)

4
Use larger size (Adjust to fit)

5
Use nearest size (No zoom)

6
Use larger size (No zoom)

-y st=mode

Specifies feed separators from.
Available feed separators from the following:

  auto
  AutoTray/Auto

1
1stTray/Tray 1 (Standard 250-sheet tray)

2
2ndTray/Tray 2 (Optional 550-sheet paper feeder)

off
Off

-y sp
Specifies printed separators.

-y sb
Specifies Skip Blank Pages.

-y cm=mode

Specifies output color.
Available output colors are as follows:

c
Color (CMYK)

k
Black
-y pr=mode
  Specifies print mode.
  Available print modes are as follows:
  
  hs
  High speed

  hq
  High quality

- y cc=mode
  Specifies image types.
  Available image types are as follows:
  
  0
  Off

  1
  Photo

  2
  sRGB

  3
  Standard/ Normal

  4
  Presentation

  This option is available only for color printing and when entry data is RGB data.

- y gc=mode
  Specifies RGB gamma correction.
  Available RGB gamma corrections are as follows:
  
  1.0
  1.0

  1.4
  1.4

  1.8
  1.8

  2.2
  2.2

  2.6
  2.6

  off
  Off
This option is available only for color printing and when entry data is RGB data.

-y sc=mode

Specifies screen.
Available screens are as follows:

0
Fineness

1
Gradation

2
Auto

3
For Transparency

-y gg=mode

Specifies gray guaranteed.
Available gray guaranteed modes are as follows:

on
On

off
Off

This option is available only for color printing.

-y ct

Specifies color transformation.
This option is available only for color printing.

-y br=mode

Specifies brightness adjustment.
Available brightness adjustment option value are as follows:

+5
Bright 5

+4
Bright 4

+3
Bright 3

+2
Bright 2
+1
Bright 1

+0
Normal

-1
Dark 1

-2
Dark 2

-3
Dark 3

-4
Dark 4

-5
Dark 5

-y r gbc=mode

Specifies RGB color correction.

Available RGB color corrections are as follows.

10
Perceptual

11
Saturation

12
Relative Colorimetric

13
Absolute Colorimetric

This option is available only for color printing and when entry data is RGB data.

-y rgbpr=mode

Specifies RGB input profile.

Available RGB input profile option value are as follows:

0
sRGB

1
AdobeRGB

This option is available only for color printing and when entry data is RGB data.

-y rgbtb=mode

Specifies RGB color temperature.
Available RGB color temperature option value are as follows:

5000
5000K
6000
6000K
9300
9300K

This option is available only for color printing and when entry data is RGB data.


Specifies adjustment value for color balance of each color/density:

Available adjustment values are as follows:

+3
Dark 3

+2
Dark 2

+1
Dark 1

0
Normal

-1
Light 1

-2
Light 2

-3
Light 3

-Cb
Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0" (Normal).

For example, if you want to specify "Light 2" for Cyan medium density, "Dark 3" for Yellow high density, and "Dark 2" for Black low density, it can be specified using either of the following:

-Cb=0:-2:0:0:0:0:0:0:+3:+2:0:0

-Cb=-2:-----:+3:+2:

-y -hld=PrintType:UserID:Password:DocumentName
Secure Print

PrintType

store

Secure Print/Store Print

proof

Proof Print

UserID

Up to eight single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A":" (colon).

Password

Up to 12 single-byte characters from 0x30 to 0x39 (numeric characters).

DocumentName

Up to 12 single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A":" (colon).

Secure Print

- y hld=store:UserID:Password:DocumentName

- y hld=store:UserID:Password:

Store Print

- y hld=store:UserID::DocumentName

- y hld=store:UserID::

Proof Print

- y hld=proof:UserID::DocumentName

- y hld=proof:UserID::

- y -jown= jobownername: Password Authentication Setting

Specifies the job owner name and password for authentication.

- When only job owner name is specified (-Jown=jobownername:) (no password specified), authentication password is treated as not specified.

- When only password is specified (-Jown=:password) (no job owner name specified), login user name is used as job owner name. Entered password is used as authentication password.

- When neither of job owner name nor password is specified (-Jown=:), login user name is used as job owner name, and authentication password is treated as not specified.
When a job owner name exceeds allowable character length, the extra characters are ignored.

When an unacceptable character is specified for job owner name, "Unknown User" is used as job owner name.

**NOTE:** Characters acceptable for job owner name are alphanumeric characters and symbols, except for space and colon.

**NOTE:** Up to 32 characters are acceptable for job owner name.

When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the authentication password is treated as not specified.

**NOTE:** Only numbers are acceptable for password.

**NOTE:** Acceptable password length is between 4 and 12 characters.

Incomplete form of -Jown option is treated as no authentication setting being made. In such case, if authentication setting is made with the environmental variable, it is used as setting information.

**Printing (HP-UX)**

This section provides information on printing from the registered logical printer during the installation.

**Printing From HP-UX**

To print to the default printer:

If the multifunction printer is registered as the default printer, the name of the multifunction printer can be shortened and specified as shown in the following example.

```
% lp filename
```

To print to other printers:

To print to a multifunction printer named `dell3115cn`, type as follows:

```
% lp -d dell3115cn filename
```

To change the default printer temporarily for printing:

To change the default printer, set the printer name in the environment variable `PRINTER`.

To set a multifunction printer named `dell3115cn` as the default printer for printing, type as follows:
To print with added options:

To print with the options, specify the option of the `lp` command using `-o` as follows:

The available options are the same as `txt2ps2/tiff2ps2/xwd2ps2`.
Depending on installed options, the available paper trays are different.

```
% lp -d dell3115cn -o r -o ILT filename
```

To print using file format:

To print text files:

```
% lp -d dell3115cn filename
```

To print XWD files:

```
% lp -d dell3115cn -o XWD filename
```

To print TIFF format files:

```
% lp -d dell3115cn -o TIF filename
```

To print PostScript files:

```
% lp -d dell3115cn filename
```

To print PostScript files as text files:

```
% lp -d dell3115cn -o TX filename
```

However, for PostScript files with options set up, such as paper selection, etc., when the same option is specified, it will be ignored.

**Authentication Printing**

This section provides information on how to specify the user name and password used for authentication printing in the environment variable.

**Specifying the User Name**

**To specify the User Name for Authentication Printing:**

You can specify a unique user name in the environment variable as follows:

```
% setenv JOWN3115U "jobownername"
```

You can specify the login name as the user name as follows:
NOTE: Up to 32 characters are acceptable for the user name. When a user name exceeds allowable character length, the extra characters are ignored.

NOTE: If you specify the filter option when authentication printing is already specified, the filter option has the higher priority over authentication printing.

### Specifying the Password

**To Specify the Password for Authentication Printing:**

If you need to specify the password in authentication printing, you can specify the password in the environment variable as follows:

```
% setenv JOWN3115P "password"
```

If you do not specify the password inexplicitly, type as follows:

```
% setenv JOWN3115P ""
```

NOTE: Acceptable password length is between 4 and 12 characters. When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the extra characters are ignored.

NOTE: If you specify the filter option when authentication printing is already specified, the filter option has the higher priority over authentication printing.

NOTE: If you only specify the password without specifying the user name in the environment variable, the login name is assumed as the user name.

NOTICE: If you enter the password in the login file for automatically allocating the environment variable when you log in, you are recommended to specify the appropriate access privilege that prevents unauthorized users from reading the login file.

### txt2ps2 (Linux/Solaris/HP-UX)

#### Format

```
```

#### Function

Reads text, converts it to the PostScript language program, and writes to standard output. If the filename is
not specified, the standard input will be taken as the command input. By typing character strings in the environmental variable TXT2PS2OPTION, the input of option at the command line can be omitted.

At the environmental variable TXT2PS2OPTION and the command line, if no option is specified, the multifunction printer will output in 10-point font size in the portrait orientation.

At the environmental variable TXT2PS2OPTION and the command line, if the same option is specified, the one specified at the command line will prevail.

txt2ps2 outputs the PostScript language program that adjusts the line/column according to the paper size. For this reason, the user need not be aware of the paper size. If there is an option to specify the line/column, automatic line feed according to the paper size will not be executed. Printing will be output according to the line/column specified.

txt2ps2 interprets the following control codes. Other control codes/undefined codes will be converted to octal numbers and output as-is.

LF

Line feed

FF

Form feed (modifiable by option)

TAB

8-column tab stop (modifiable by option)

BS

Backspace 1 character

**Option**

-d

Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound. This option is available only when optional duplexer is installed on the multifunction printer.

![Diagram](image)

-D

Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound. This option is available only when optional duplexer is installed on the multifunction printer.
-规定纸张托盘。

指定纸张托盘。可以通过直接指定托盘或指定纸张尺寸来选择纸张托盘。当指定纸张尺寸时，将自动查找并选择装有指定尺寸纸张的托盘。

选择纸张托盘的参数如下：

1

Feed paper from tray 1 (Standard 250-sheet tray).

2

Feed paper from tray 2 (Optional 550-sheet paper feeder).

A4

Feed paper from the tray loaded with A4 (210 x 297 mm).

A5

Feed paper from the tray loaded with A5 (148 x 210 mm).

B5

Feed paper from the tray loaded with B5 (182 x 257 mm).

LT

Feed paper from the tray loaded with Letter (8.5 x 11 inches).

FL

Feed paper from the tray loaded with Folio (8.5 x 13 inches).

LG

Feed paper from the tray loaded with Legal (8.5 x 14 inches).

EX

Feed paper from the tray loaded with Executive (7.25 x 10.5 inches).

MO

Feed paper from the tray loaded with Monarch (3.875 x 7.5 inches).
COM10
Feed paper from the tray loaded with Envelope #10 (4.125 x 9.5 inches).

DL
Feed paper from the tray loaded with DL (110 x 220 mm).

C5
Feed paper from the tray loaded with C5 (162 x 229 mm).

MxNmm
Feed paper from the tray loaded with MxNmm defined by users.
Possible range specified:
Width: 76.2-220.0 mm
Length: 98.0-355.6 mm

MxNin
Feed paper from the tray loaded with MxNinches defined by users.
Possible range specified:
Width: 3.00-8.66 inches
Length: 3.86-14.0 inches

If this option is not specified or the tray specified is not available, feed paper from the default tray.

-t
Turns on the save toner mode for printing. The print result will be fainter than that of normal printing. In some cases, this option will be ignored.

-2
Sets printing to two-column printing.

-r
Rotates the image by 90° and uses the paper in the landscape orientation.

-F
Ignores the form feed code (FF).

-l[lines]
Specifies the number of lines per page.

-w[columns]
Specifies the number of columns per line.
-outcolumns
  Converts print data to single-byte text and sets printing to start from outcolumns.

-Loutlines
  Prints text from the outline columns.

-en
  Expands horizontal tabs to $n$ columns (space). The default is 8.

-ssize
  Specifies the font size as point size. The default is 10.

-E
  This function turns on the image enhancement function. For models without the image enhancement mechanism, this option will be ignored.

-ffont
  Sets the font.

**NOTE:** The available fonts are limited to the font in the multifunction printer. For more information, see "Understanding Fonts."

-Nc=copies
  Specifies the number of output copies (the value of copies must be a positive integer).

-cl
  Specifies that printing be collated. If the copies option is not specified, this option will be ignored.

-ps
  The input file will be processed as the PostScript file. If the file does not begin with `%!`, `%!` will be output to the beginning line. If a file contains `%!`, it will be processed in the same way as dellpsif.

-mg=up:bottom:right:left
  Specifies the margin of a page in inches. The upper margin, bottom margin, right margin, and left margin are positive real numbers (up to two decimal points). The default is 0.

  -mg=0:0:0:3
Sets the left margin to 3 inches.

-mg=3:3:0:5

Sets the upper margin to 3 inches; bottom margin, 3 inches; and left margin, 5 inches. If the margin is 0, it can be omitted.

-mg::::3

Sets the left margin to 3 inches.

-Hd=position:format:page

Specifies the position that the user information of the header or footer is output at. position specifies output position. But this option is available only for converting text files.

ul

Output on the upper left corner of the paper.

ur

Output on the upper right corner of the paper.

dl

Output on the lower left corner of the paper.

dr

Output on the lower right corner of the paper.

format specifies the contents and the order to output. This option is omissible. If this option is omitted, uh is specified as the default value.

u

User name

h

Host name

t

Date and time

If the output contents are specified as tuh, it is output as follows: Date and Time User: username Host: hostname

page specifies the page to output. This option is omissible.

f

Output the top page only.

(default in case of PostScript files conversion)
Output all pages.
(design in case of Text files conversion)

Specify these options as follows:
In the case that convert text file, output the host name following the user name on the upper right corner of the paper, output all pages.
(User name, Host name, all page output are default)

- Hd=ur
- Hd=ur:uh
- Hd=ur:uh:a

In the case that convert PostScript file, output the host name following the date and time on the lower left corner of the paper, output all pages (a option value is necessary because output the top page only is default when PostScript file is converted.)

- Hd=dl:th:a

**NOTICE:** If the paper size is not specified, it outputs the header and footer at the position of A4 size by default. If the paper size is specified by `lp` command, the output position of the header or footer is not changed from the position of the paper size specified by txt2ps2. Specify the paper size at the same time when the header and footer option is used. Sometimes all pages are not printed despite specifying all page output when PostScript file conversion is specified. In such cases, specify output the top page only. By using TZ environmental variable, specify time zone (GMT etc.).

- Hf font

Specify the font to print the header and footer. European fonts the same as half size alphanumeric fonts can be specified. Helvetica is specified as default. If the wrong font is specified, the default European font of the multifunction printer can be used. If the header/footer output option is specified, the font specification for the header/footer is ignored.

- MSI

Specifies multipurpose feeder.

- M=type

Specifies multipurpose feeder Paper Type.
Available multipurpose feeder Paper Types are as follows:

B

FinePaper/Bond/Plain Paper 2

BB

FinePaperBack/Bond/Plain Paper 2- Side 2

P

Stationary/Plain/Plain Paper 1
PB
StationaryBack/Plain/Plain Paper 1 - Side 2

H1
ThickPaper/Heavyweight 1/Covers 1

H1B
ThickPaperBack/Heavyweight 1/Covers 1 - Side 2

H2
ThickPaper2/Heavyweight 2/Covers 2

H2B
ThickPaper2Back/Heavyweight 2/Covers 2 - Side 2

OHP
Transparency

L
LabelPaper/Labels

C2
Coated/Coated 2/Coated Paper 2

C2B
Coated Back/Coated 2/Coated Paper 2- Side 2

C3
Coated Thick/Coated 3/Coated Paper 3

C3B
Coated Thick Back/Coated 3/Coated Paper 3- Side 2

E
Envelope

If this option is not specified, multipurpose feeder Paper Type of the multifunction printer can be used.

-Mfo=mode

Specifies orientation for multipurpose feeder.
Available orientations for multipurpose feeder are as follows:
Landscape

Landscape (Rotated)

Portrait

Portrait (Rotated)

-Pon

Specifies alternate tray. Available alternate trays are as follows:

0

Use system settings

1

Display message

2

Feed from multipurpose feeder

3

Use nearest size (Adjust to fit)

4

Use larger size (Adjust to fit)

5

Use nearest size (No zoom)

6

Use larger size (No zoom)

-St=mode

Specifies feed separators from. Available feed separators froms are as follows:

auto

AutoTray/Auto
1st Tray/Tray 1 (Standard 250-sheet tray)

2nd Tray/Tray 2 (Optional 550-sheet paper feeder)

`off`

`-Sp`

Specifies printed separators. Available only when the paper tray for separators is specified.

`-Sb`

Specifies Skip Blank Pages.

`-Cm=mode`

Specifies output color. Available output colors are as follows:

`c`

Color (CMYK)

`k`

Black

`-Pr=mode`

Specifies print mode. Available print modes are as follows:

`hs`

High Speed

`hq`

High Quality

`-Cc=mode`

Specify RGB Color Correction. Available RGB Color Corrections are as follows:

`0`
Off

1

Photo

2

sRGB

3

Standard/ Normal

4

Presentation

This option is available only for color printing and when entry data is RGB data.

-Gc=mode

Specifies RGB gamma correction.
Available RGB gamma corrections are as follows:

1.0

1.0

1.4

1.4

1.8

1.8

2.2

2.2

2.6

2.6

off

Off

This option is available only for color printing and when entry data is RGB data.

-Sc=mode

Specifies screen.
Available screens are as follows:
Fineness

Standard

Auto

Gradation

-Gg=mode

Specifies gray guaranteed. Available gray guaranteed options are as follows:

on

On

off

Off

This option is available only for color printing.

-Ct

Specifies color transformation. This option is available only for color printing.

-Br=mode

Specifies brightness adjustment. Available brightness adjustment option value are as follows:

+5

Bright 5

+4

Bright 4

+3

Bright 3

+2
Bright 2
+1

Bright 1
+0

Normal
-1

Dark 1
-2

Dark 2
-3

Dark 3
-4

Dark 4
-5

Dark 5

-\text{RGB}_{c}=mode

Specifies RGB color correction.

Available RGB color corrections are as follows:

10
Perceptual

11
Saturation

12
Relative Colorimetric

13
Absolute Colorimetric

This option is available only for color printing and when entry data is RGB data.

-\text{RGB}_{r}=mode
Specifies RGB input profile.
Available RGB input profile option value are as follows:

0  
  sRGB
1  
  AdobeRGB
This option is available only for color printing and when entry data is RGB data.

-\textbf{RGBTp=mode}

Specifies RGB color temperature.
Available RGB color temperature option value are as follows:

5000  
  \textbf{5000K}
6000  
  \textbf{6000K}
9300  
  \textbf{9300K}
This option is available only for color printing and when entry data is RGB data.


Specifies adjustment value for color balance of each color/density.
Available adjustment values are as follows:

+3  
  Dark 3
+2  
  Dark 2
+1  
  Dark 1
0  
  Normal
Light 1

Light 2

Light 3

-Cb

Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0" (Normal).

For example, if you want to specify "Light 2" for Cyan medium density, "Dark 3" for Yellow high density, and "Dark 2" for Black low density, it can be specified using either of the following:

-Cb=0::-2:0:0:0:0:0:0:+3:+2:0:0
-Cb=::-2:0:0:0:0:0:0:+3:+2:0::

-Hld=PrintType:UserID:Password:DocumentName

Secure Print

PrintType

store

Secure Print/Store Print

proof

Proof Print

UserID

Up to eight single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).

Password

Up to 12 single-byte characters from 0x30 to 0x39 (numeric characters).

DocumentName

Up to 12 single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).
Secure Print

-Hld=store:UserID:Password:DocumentName
-Hld=store:UserID:Password:

Store Print

-Hld=store:UserID::DocumentName
-Hld=store:UserID::

Proof Print

-Hld=proof:UserID::DocumentName
-Hld=proof:UserID::

**NOTICE:** Ensure that you specify Secure Print only when you directly print data to a multifunction printer. Secure Print may not be available if you specify it when data need to be printed through another server or data need to be handled by another program such as PostScript files. Collate is automatically specified when you specify Proof Print.

-Jown=jobownername: Password Authentication Setting

Specifies the job owner name and password for authentication.

- When only job owner name is specified (-Jown=jobownername:) (no password specified), authentication password is treated as not specified.
- When only password is specified (-Jown=:password) (no job owner name specified), login user name is used as job owner name. Entered password is used as authentication password.
- When neither of job owner name nor password is specified (-Jown=:), login user name is used as job owner name, and authentication password is treated as not specified.
- When a job owner name exceeds allowable character length, the extra characters are ignored.
- When an unacceptable character is specified for job owner name, "Unknown User" is used as job owner name.

**NOTE:** Characters acceptable for job owner name are alphanumeric characters and symbols, except for space and colon.

**NOTE:** Up to 32 characters are acceptable for job owner name.

- When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the authentication password is treated as not specified.

**NOTE:** Only numbers are acceptable for password.
NOTE: Acceptable password length is between 4 and 12 characters.

Incomplete form of -Jown option is treated as no authentication setting being made. In such case, if authentication setting is made with the environmental variable, it is used as setting information.

Example

To convert the program list of the file.txt file into the PostScript language program that sets the paper to the landscape orientation and prints in the 2-up mode, type as follows:

```bash
% txt2ps2 -r -2 file.txt | lpr (for Linux)
% txt2ps2 -r -2 file.txt | lp (for Solaris/HP-UX)
```

To convert file.txt to the PostScript language program and output it to the file.ps file, type as follows:

```bash
% txt2ps2 file.txt > file.ps
% lpr file.ps (for Linux)
% lp file.ps (for Solaris/HP-UX)
```

To convert the output result of the command into the PostScript language program using txt2ps2 and print it to the multifunction printer, type as follows:

```bash
% ls -alF | txt2ps2 | lpr (for Linux)
% ls -alF | txt2ps2 | lp (for Solaris/HP-UX)
```

Environmental Variable

TXT2PS2OPTION

Optional settings based on the environmental variable. To output in the 2-up mode, 8 points and the landscape orientation, type as follows:

```bash
% setenv TXT2PS2OPTION "-2 -s8 -r"
```

To use the same options as those of the dellpsif filter specified by printcap, type as follows:

```bash
% setenv TXT2PS2OPTION "<dellpsif>"
```

File

/usr/local/dellbin3115/.dellpsdefault3115
This is the default command option setting file for individual users.

Important

- When the same option is specified twice, the later setting will prevail. As TXT2PS2OPTION is analyzed before the option of the command line, it is possible to temporarily modify the options already set in TXT2PS2OPTION by typing at the command line.
• The comment description (%%page:m n) of the page number cannot be output to the PostScript program file which is output by the default option of txt2ps2. Thus, when the output of txt2ps2 is to be taken as the output of another application (psrev of TRANSCRIPT, etc.), add the page number description by inserting the line command (-I lines).

• If a BS code is found at the beginning of a line, the print position of the next character will be located at the left of the beginning of the line.

• When there are multiple tab codes in one line, the tab position may be off as a result of automatic line feed. In such case, use the -I or -w option.

• The number of columns specified by the -w option is not the actual number of printed characters. The actual number of single-byte characters to be printed is derived by deducting the output column position (outcolumns) specified by the o option from the number of columns specified by the -w option. The -mg option cannot be specified when -w, -l, -o, and -L option are specified. The start positions of margin of the margin command (-mg=u:b:r:l) are not set against the edge of the paper. The margins are set against the printable area of the paper allowed by the multifunction printer. Use the -ps option only when a PostScript file that contains no %! at the beginning of the file is used as the PostScript file. If a normal text file is input, it will not function correctly.

• In HP-UX, txt2ps2 considers files written by PostScript that contain %! at the beginning of the file as the PostScript files. To print PostScript files as text files, specify the TX option. With this option, PostScript files will be processed as text files.

sunras2ps2 (Solaris)

Format


Function

Reads SunRaster data, converts it to the PostScript language program and writes to standard output. If the filename is not specified, the standard input will be taken as the command input. SunRaster files with a pixel depth of 1, 8, 24, and 32 bits can be specified.

sunras2ps2 takes filename as having been created in 72dpi and calculates the output size. Thus, to convert SunRaster files created in other resolutions, specify the size option (-s, -S) explicitly.

Option

-d
Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound. This option is available only when the optional duplexer is installed on the multifunction printer.

-D

Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound. This option is available only when the optional duplexer is installed on the multifunction printer.

-itray-input

Specifies the paper tray. A paper tray can be selected by directly specifying a tray or by specifying a paper size. When a paper size is specified, the tray loaded with paper of the specified size will be found and selected automatically.

The parameters for selecting a paper tray are as follows:

1

Feed paper from tray 1 (Standard 250-sheet tray).

2

Feed paper from tray 2 (Optional 550-sheet paper feeder).

A4

Feed paper from the tray loaded with A4 (210 x 297 mm).

A5

Feed paper from the tray loaded with A5 (148 x 210 mm).

B5

Feed paper from the tray loaded with B5 (182 x 257 mm).
Feed paper from the tray loaded with Letter (8.5 x 11 inches).

Feed paper from the tray loaded with Folio (8.5 x 13 inches).

Feed paper from the tray loaded with Legal (8.5 x 14 inches).

Feed paper from the tray loaded with Executive (7.25 x 10.5 inches).

Feed paper from the tray loaded with Monarch (3.875 x 7.5 inches).

Feed paper from the tray loaded with Envelope #10 (4.125 x 9.5 inches).

Feed paper from the tray loaded with DL (110 x 220 mm).

Feed paper from the tray loaded with C5 (162 x 229 mm).

Feed paper from the tray loaded with MxNmm defined by users.

Possible range specified:
Width: 76.2-220.0 mm
Length: 98.0-355.6 mm

Feed paper from the tray loaded with MxN inches defined by users.

Possible range specified:
Width: 3.00-8.66 inches
Length: 3.86-14.0 inches

If this option is not specified or the tray specified is not available, feed paper from the default tray.

-t

Turns on the save toner mode for printing. The print result will be fainter than that of normal printing. In some cases, this option will be ignored.
-r
Rotates the image by 90° and uses the paper in the landscape orientation.

-n
Disables the addition of the showpage. It is used when files converted to the PostScript language program are merged with files created with other applications.

-l=left,bottom
Specifies the print position. Printing will be executed from the left and bottom of the page. The default is 0.25 inches for both left and bottom.

-s=width,height
Specifies the output size. Printing will be executed with the width and height in inches.

-S=width
Sets the width of the output size in inches. The height will be calculated automatically according to the width.

-E
This function turns on the image enhancement function. In some cases, this option will be ignored.

-Nc=copies
Specifies the number of output copies (the value of copies must be a positive integer).

-CI
Specifies that printing be collated. If the copies option is not specified, this option will be ignored.

-Hd=position:format
Specifies the position to be output the user information as the header or footer. position specifies output position. But this option is available only for converting text files.

  ul
Output on the upper left corner of the paper.

  ur
Output on the upper right corner of the paper.

  dl
Output on the lower left corner of the paper.

dr

Output on the lower right corner of the paper.

format specifies the contents and the order to output. This option is omissible. If this option is omitted, uh is specified as the default value.

u

User name

h

Host name

t

Date and time
If the output contents are specified as tuh, it is output as follows:
Date and Time User: username Host: hostname.

Specify these options as follows:
In the case that convert text file, output the host name following the user name on the upper right corner of the paper, output all pages.
(User name, Host name, all page output are default)

-Hd=ur
-Hd=ur:uh

-Hf

Specify the font to print the header and footer. European fonts the same as half size alphanumeric fonts can be specified. Helvetica is specified as default. If the wrong font is specified, default European font of the multifunction printer can be used. If header/footer output option is specified, the font specification of header/footer is ignored.

-MSI

Specifies multipurpose feeder.

-M=type

Specifies multipurpose feeder Paper Type. Available multipurpose feeder Paper Types are as follows:

B

FinePaper/Bond/Plain Paper 2

BB

FinePaperBack/Bond/Plain Paper 2 - Side 2
P
Stationary/Plain/Plain Paper 1
PB
StationaryBack/Plain/Plain Paper 1 - Side 2
H1
ThickPaper/Heavyweight 1/Covers 1
H1B
ThickPaperBack/Heavyweight 1/Covers 1 - Side 2
H2
ThickPaper2/Heavyweight 2/Covers 2
H2B
ThickPaper2Back/Heavyweight 2/Covers 2 - Side 2
OHP
Transparency
L
LabelPaper/Labels
C2
Coated/Coated 2/Coated Paper 2
C2B
Coated Back/Coated 2/Coated Paper 2- Side 2
C3
Coated Thick/Coated 3/Coated Paper 3
C3B
Coated Thick Back/Coated 3/Coated Paper 3- Side 2
E
Envelope
If this option is not specified, multipurpose feeder Paper Type of the multifunction printer can be used.

-Mfo=mode
Specifies orientation for multipurpose feeder.
Available orientations for multipurpose feeder are as follows:

Landscape

Landscape (Rotated)

Portrait

Portrait (Rotated)

Specifies alternate tray.
Available alternate trays are as follows:

0
Use system settings

1
Display message

2
Feed from multipurpose feeder

3
Use nearest size (Adjust to fit)

4
Use larger size (Adjust to fit)

5
Use nearest size (No zoom)

6
Use larger size (No zoom)

Specifies feed separators from.
Available feed separators from the following:
auto
   AutoTray/Auto

1
   1stTray/Tray 1 (Standard 250-sheet tray)

2
   2ndTray/Tray 2 (Optional 550-sheet paper feeder)

off
   Off

-Sp
   Specifies printed separators.
   Available only when the paper tray for separators is specified.

-Sb
   Specifies Skip Blank Pages.

-Cm=mode
   Specifies output color.
   Available output colors are as follows:
   c
      Color (CMYK)
   k
      Black

-Pr=mode
   Specifies print mode.
   Available print modes are as follows:
   hs
      High speed
   hq
      High quality

-Cc=mode
Specifies image types.
Available image types are as follows:

0
  Off
1
  Photo
2
  sRGB
3
  Standard/ Normal
4
  Presentation

This option is available only for color printing and when entry data is RGB data.

-Gc=mode

Specifies RGB gamma correction.
Available RGB gamma corrections are as follows:

1.0
  1.0
1.4
  1.4
1.8
  1.8
2.2
  2.2
2.6
  2.6
off
  Off

This option is available only for color printing and when entry data is RGB data.
---

**-Sc=mode**

Specifies screen. Available screens are as follows:

0

Fineness

1

Gradation

2

Auto

3

For Transparency

**-Gg=mode**

Specifies gray guaranteed. Available gray guaranteed options are as follows:

on

On

off

Off

This option is available only for color printing.

**-Ct**

Specifies color transformation. This option is available only for color printing.

**-Br=mode**

Specifies brightness adjustment. Available brightness adjustment option value are as follows:

+5

Bright 5

+4

Bright 4
+3
Bright 3
+2
Bright 2
+1
Bright 1
+0
Normal
-1
Dark 1
-2
Dark 2
-3
Dark 3
-4
Dark 4
-5
Dark 5

-\text{RGBc=mode}

Specifies RGB color correction.

Available RGB color corrections are as follows:

10
Perceptual

11
Saturation

12
Relative Colorimetric

13
Absolute Colorimetric
This option is available only for color printing and when entry data is RGB data.

-\texttt{RGBPr=mode}

Specifies RGB input profile.

Available RGB input profile option value are as follows:

0

\texttt{sRGB}

1

\texttt{AdobeRGB}

This option is available only for color printing and when entry data is RGB data.

-\texttt{RGBTp=mode}

Specifies RGB color temperature.

Available RGB color temperature option value are as follows:

5000

\texttt{5000K}

6000

\texttt{6000K}

9300

\texttt{9300K}

This option is available only for color printing and when entry data is RGB data.


Specifies adjustment value for color balance of each color/density.

Available adjustment values are as follows:

+3

\texttt{Dark 3}

+2

\texttt{Dark 2}

+1
Dark 1

0

Normal

-1

Light 1

-2

Light 2

-3

Light 3

-Cb

Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0"(Normal).

For example, if you want to specify "Light 2" for Cyan medium density, "Dark 3" for Yellow high density, and "Dark 2" for Black low density, it can be specified using either of the following:

-Cb=0:-2:0:0:0:0:0:+3:+2:0:0
-Cb=-2:.:.:.:.:+3:+2:.

-Hld=PrintType:UserID:Password:DocumentName

Secure Print

PrintType

store

Secure Print/Store Print

proof

Proof Print

UserID

Up to eight single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A":" (colon).

Password

Up to 12 single-byte characters from 0x30 to 0x39 (numeric characters).
DocumentName

Up to 12 single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).

Secure Print

-Hld=store:UserID:Password:DocumentName

-Hld=store:UserID:Password:

Store Print

-Hld=store:UserID::DocumentName

-Hld=store:UserID::

Proof Print

-Hld=proof:UserID::DocumentName

-Hld=proof:UserID::

**NOTICE:** Ensure that you specify Secure Print only when you directly print data to a multifunction printer. Secure Print may not be available if you specify it when data need to be printed through another server or data need to be handled by another program such as PostScript files. Collate is automatically specified when you specify Proof Print.

-Jown=jobownername: Password Authentication Setting

Specifies the job owner name and password for authentication.

- When only job owner name is specified (-Jown=jobownername:) (no password specified), authentication password is treated as not specified.
- When only password is specified (-Jown=:password) (no job owner name specified), login user name is used as job owner name. Entered password is used as authentication password.
- When neither of job owner name nor password is specified (-Jown=::), login user name is used as job owner name, and authentication password is treated as not specified.
- When a job owner name exceeds allowable character length, the extra characters are ignored.
- When an unacceptable character is specified for job owner name, "Unknown User" is used as job owner name.

**NOTE:** Characters acceptable for job owner name are alphanumeric characters and symbols, except for space and colon.

**NOTE:** Up to 32 characters are acceptable for job owner name.

- When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the authentication password is
Only numbers are acceptable for password.

Acceptable password length is between 4 and 12 characters.

Incomplete form of -Jown option is treated as no authentication setting being made. In such case, if authentication setting is made with the environmental variable, it is used as setting information.

Example

To output the displayed screen image to a file using the snapshot command and convert the file into the PostScript language program using the `sunras2ps2` command, type as follows:

```
% sunras2ps2 file.rs > file.ps
```

To output the displayed screen image to a file using the snapshot command, convert the file into the PostScript language program using the `sunras2ps2` command and output it to a multifunction printer, type as follows:

```
% sunras2ps2 file.rs | lp
```

Important

- When -s and -S are specified at the same time or when the same option is specified twice, the later setting will prevail.
- If the output size option (-s, -S) is not specified, scaling will be executed taking one pixel of the raster data as one pixel of the multifunction printer.
- If the print position option specifies a point beyond the printable area of the multifunction printer, data beyond the printable area will not be printed.

**tiff2ps2 (Linux/Solaris/HP-UX)**

**Format**

```
```

**Function**
Reads TIFF data, converts it to the PostScript language program and writes to standard output. If the filename is not specified, the standard input will be taken as the command input. TIFF files with a pixel depth of 1, 4, 8, 24, and 32 bits can be specified. There are four types of supported compression formats.
Huffman compression (CCITT Group 3 transformed Huffman run length encoding)
Fax-CCITT3 compression (facsimile-compatible CCITT Group 3)
PackBits compression
Non-compression
Even in the above compression format, the TIFF file that has multiple images in one file is not supported.
tiff2ps2 takes filename as having been created in 72 dpi and calculates the output size. Thus, to convert TIFF files created in other resolutions, specify the size option (-s, -S) explicitly for conversion.

Option

-d

Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound. This option is available only when the optional duplexer is installed on the multifunction printer.

-D

Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound. This option is available only when the optional duplexer is installed on the multifunction printer.

-I tray-input

Specifies the paper tray.
A paper tray can be selected by directly specifying a tray or by specifying a paper size.
When a paper size is specified, the tray loaded with paper of the specified size will be found and selected automatically.
The parameters for selecting a paper tray are as follows:
1
Feed paper from tray 1 (Standard 250-sheet tray).

2
Feed paper from tray 2 (Optional 550-sheet paper feeder).

A4
Feed paper from the tray loaded with A4 (210 x 297 mm).

A5
Feed paper from the tray loaded with A5 (148 x 210 mm).

B5
Feed paper from the tray loaded with B5 (182 x 257 mm).

LT
Feed paper from the tray loaded with Letter (8.5 x 11 inches).

FL
Feed paper from the tray loaded with Folio (8.5 x 13 inches).

LG
Feed paper from the tray loaded with Legal (8.5 x 14 inches).

EX
Feed paper from the tray loaded with Executive (7.25 x 10.5 inches).

MO
Feed paper from the tray loaded with Monarch (3.875 x 7.5 inches).

COM10
Feed paper from the tray loaded with Envelope #10 (4.125 x 9.5 inches).

DL
Feed paper from the tray loaded with DL (110 x 220 mm).

C5
Feed paper from the tray loaded with C5 (162 x 229 mm).

MxNmm
Feed paper from the tray loaded with MxNmm defined by users
Possible range specified:
Width: 76.2-220.0 mm
Length: 98.0-355.6 mm
Feed paper from the tray loaded with MxN inches defined by users
Possible range specified:
Width: 3.00-8.66 inches
Length: 3.86-14.0 inches

If this option is not specified or the tray specified is not available, feed paper from the default tray.

-t

Turns on the save toner mode for printing. The print result will be fainter than that of normal printing. In some cases, this option will be ignored.

-r

Rotates the image by 90° and uses the paper in the landscape orientation.

-n

Disables the addition of the showpage. It is used when files converted to the PostScript language program are merged with files created with other applications.

-l=left,bottom

Specifies the print position. Printing will be executed from the left and bottom of the page. The default is 0.25 inches for both left and bottom.

-s=width,height

Specifies the output size. Printing will be executed with the width and height in inches.

-S=width

Sets the width of the output size in inches. The height will be calculated automatically according to the width.

-E

This function turns on the image enhancement function. In some cases, this option will be ignored.

-Nc=copies

Specifies the number of output copies (the value of copies must be a positive integer).

-C1

Specifies that printing be collated. If the copies option is not specified, this option will be ignored.
-Hd=position:format

    Specifies the position to be output the user information as the header or footer.
    position specifies output position. But this option is available only for converting text files.

    ul
        Output on the upper left corner of the paper.
    ur
        Output on the upper right corner of the paper.
    dl
        Output on the lower left corner of the paper.
    dr
        Output on the lower right corner of the paper.

    format specifies the contents and the order to output. This option is omissible.
    If this option is omitted, uh is specified as the default value.

    u
        User name
    h
        Host name
    t
        Date and time

    If the output contents are specified as tuh, it is output as follows:
    Date and Time User: username Host: hostname.

    Specify these options as follows:
    In the case that convert text file, output the host name following the user name on the upper right corner of the paper, output all pages.
    (User name, Host name, all page output are default)

    -Hd=ur
    -Hd=ur:uh

-Hffont

    Specify the font to print header and footer. European fonts the same as half size alphanumeric fonts can be specified. Helvetica is specified as default.
    If the wrong font is specified, default European font of the multifunction printer can be used.
    If header/footer output option is specified, the font specification of header/footer is ignored.
Specifies multipurpose feeder.

\[-M=type\]

Specifies multipurpose feeder Paper Type. Available multipurpose feeder Paper Types are as follows:

B

FinePaper/Bond/Plain Paper 2

BB

FinePaperBack/Bond/Plain Paper 2 - Side 2

P

Stationary/Plain/Plain Paper 1

PB

StationaryBack/Plain/Plain Paper 1 - Side 2

H1

ThickPaper/Heavyweight 1/Covers 1

H1B

ThickPaperBack/Heavyweight 1/Covers 1 - Side 2

H2

ThickPaper2/Heavyweight 2/Covers 2

H2B

ThickPaper2Back/Heavyweight 2/Covers 2 - Side 2

OHP

Transparency

L

LabelPaper/Labels

C2

Coated/Coated 2/Coated Paper 2

C2B

Coated Back/Coated 2/Coated Paper 2 - Side 2

C3
Coated Thick/Coated 3/Coated Paper 3

C3B

Coated Thick Back/Coated 3/Coated Paper 3- Side 2

E

Envelope

If this option is not specified, multipurpose feeder Paper Type of the multifunction printer can be used.

-Mfo=mode

Specifies orientation for multipurpose feeder. Available orientations for multipurpose feeder are as follows:

le

Landscape

ler

Landscape (Rotated)

se

Portrait

ser

Portrait (Rotated)

-Pon

Specifies alternate tray. Available alternate trays are follows:

0

Use system settings

1

Display message

2

Feed from multipurpose feeder

3

Use nearest size (Adjust to fit)

4
-St=mode

Specifies feed separators from.
Available feed separators from the following:
  auto
    AutoTray/Auto
  1
    1stTray/Tray 1 (Standard 250-sheet tray)
  2
    2ndTray/Tray 2 (Optional 550-sheet paper feeder)
  off
    Off

-Sp

Specifies printed separators.
Available only when the paper tray for separators is specified.

-Sb

Specifies Skip Blank Pages.

-Cm=mode

Specifies output color.
Available output colors are as follows:
  c
    Color (CMYK)
  k
    Black
-Pr=mode

Specifies print mode.
Available print modes are as follows:

hs
  High speed
hq
  High quality

-Cc=mode

Specifies image types.
Available image types are as follows:

0
  Off
1
  Photo
2
  sRGB
3
  Standard/Normal
4
  Presentation
This option is available only for color printing and when entry data is RGB data.

-Gc=mode

Specifies RGB gamma correction.
Available RGB gamma corrections are as follows:

1.0
  1.0
1.4
  1.4
1.8
  1.8
This option is available only for color printing and when entry data is RGB data.

-Sc=mode

Specifies screen. Available screens are as follows:

0
Fineness

1
Gradation

2
Auto

3
For Transparency

-Gg=mode

Specifies gray guaranteed. Available gray guaranteed options are as follows:

on
On

off
Off

This option is available only for color printing.

-Ct

Specifies color transformation. This option is available only for color printing.
-Br=mode

Specifies brightness adjustment.

Available brightness adjustment option values are as follows:

+5
  Bright 5
+4
  Bright 4
+3
  Bright 3
+2
  Bright 2
+1
  Bright 1
+0
  Normal
-1
  Dark 1
-2
  Dark 2
-3
  Dark 3
-4
  Dark 4
-5
  Dark 5

-RGBc=mode

Specifies RGB color correction.

Available RGB color corrections are as follows:

10
Perceptual

Saturation

Relative Colorimetric

Absolute Colorimetric

This option is available only for color printing and when entry data is RGB data.

-RGBPr=mode

Specifies RGB input profile.
Available RGB input profile option value are as follows:

0
  sRGB
1
  AdobeRGB

This option is available only for color printing and when entry data is RGB data.

-RGBTp=mode

Specifies RGB color temperature.
Available RGB color temperature option value are as follows:

5000
  5000K
6000
  6000K
9300
  9300K

This option is available only for color printing and when entry data is RGB data.

Specifies adjustment value for color balance of each color/density.

Available adjustment values are as follows:

+3
  Dark 3
+2
  Dark 2
+1
  Dark 1
0
  Normal
-1
  Light 1
-2
  Light 2
-3
  Light 3
-Cb

Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0" (Normal).

For example, if you want to specify "Light 2" for Cyan medium density, "Dark 3" for Yellow high density, and "Dark 2" for Black low density, it can be specified using either of the following:

-Cb=0:-2:0:0:0:0:0:+3:+2:0:0
-Cb=0:-2:0:0:0:0:0:+3:+2:0:0

-Hld=PrintType:UserID:Password:DocumentName

Secure Print

PrintType

store
Secure Print/Store Print

proof

Proof Print

UserID

Up to eight single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).

Password

Up to 12 single-byte characters from 0x30 to 0x39 (numeric characters).

DocumentName

Up to 12 single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).

Secure Print

-Hld=store: UserID: Password: DocumentName

-Hld=store: UserID: Password:

Store Print

-Hld=store: UserID::DocumentName

-Hld=store: UserID::

Proof Print

-Hld=proof: UserID::DocumentName

-Hld=proof: UserID::

**NOTICE:** Ensure that you specify Secure Print only when you directly print data to a multifunction printer. Secure Print may not be available if you specify it when data need to be printed through another server or data need to be handled by another program such as PostScript files. Collate is automatically specified when you specify Proof Print.

-Jown= jobownername: Password Authentication Setting

Specifies the job owner name and password for authentication.

- When only job owner name is specified (-Jown=jobownername:) (no password specified), authentication password is treated as not specified.
- When only password is specified (-Jown=:password) (no job owner name specified), login user name is used as job owner name. Entered password is used as authentication password.
- When neither of job owner name nor password is specified (-Jown=:), login user name is used as job owner name, and authentication password is treated as not specified.
When a job owner name exceeds allowable character length, the extra characters are ignored.

- When an unacceptable character is specified for job owner name, "Unknown User" is used as job owner name.

**NOTE:** Characters acceptable for job owner name are alphanumeric characters and symbols, except for space and colon.

**NOTE:** Up to 32 characters are acceptable for job owner name.

- When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the authentication password is treated as not specified.

**NOTE:** Only numbers are acceptable for password.

**NOTE:** Acceptable password length is between 4 and 12 characters.

Incomplete form of -Jown option is treated as no authentication setting being made. In such case, if authentication setting is made with the environmental variable, it is used as setting information.

**Example**

To convert the TIFF image into the PostScript language program and output it to a file, type as follows:

```
% tiff2ps2 file.tiff > file1.ps
```

To output the TIFF image to a multifunction printer, type as follows:

```
% tiff2ps2 file.tiff | lpr (for Linux)
% tiff2ps2 file.tiff | lp (for Solaris/HP-UX)
```

**Important**

- When -s and -S are specified at the same time or when the same option is specified twice, the later setting will prevail.

- When the output size option (-s, -S) is not specified, scaling will be executed taking one pixel of the TIFF data as one pixel of the multifunction printer.

- If the print position option (-left bottom) specifies a point beyond the printable area of the multifunction printer, data beyond the printable area will not be printed.

**xwd2ps2 (Linux/Solaris/HP-UX)**

**Format**

**Function**

Reads XWD data, converts it to the PostScript language program and writes to standard output. If the filename is not specified, the standard input will be taken as the command input. XWD files with a pixel depth of 1, 4, 8, 24, and 32 bits can be specified.

There are three types of supported compression formats.

The visual class is Static Gray and the pixel is 1 bit.

The visual class is Pseudo Color and the pixel is 4 bits or 8 bit. The image format is Zpixmap.

The visual class is True Color and the pixel is 24 bits or 32 bit. The image format is Zpixmap.

xwd2ps2 takes filename as having been created in 72dpi and calculates the output size. Thus, to convert XWD files created in other resolutions, specify the size option (-s, -S) explicitly for conversion.

**Option**

-d

Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound. This option is available only when the optional duplexer is installed on the multifunction printer.

-D

Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound. This option is available only when the optional duplexer is installed on the multifunction printer.
-itray-input

Specifies the paper tray. A paper tray can be selected by directly specifying a tray or by specifying a paper size. When a paper size is specified, the tray loaded with paper of the specified size will be found and selected automatically. The parameters for selecting a paper tray are as follows:

1

Feed paper from tray 1 (Standard 250-sheet tray).

2

Feed paper from tray 2 (Optional 550-sheet paper feeder).

A4

Feed paper from the tray loaded with A4 (210 x 297 mm).

A5

Feed paper from the tray loaded with A5 (148 x 210 mm).

B5

Feed paper from the tray loaded with B5 (182 x 257 mm).

LT

Feed paper from the tray loaded with Letter (8.5 x 11 inches).

FL

Feed paper from the tray loaded with Folio (8.5 x 13 inches).

LG

Feed paper from the tray loaded with Legal (8.5 x 14 inches).

EX

Feed paper from the tray loaded with Executive (7.25 x 10.5 inches).

MO

Feed paper from the tray loaded with Monarch (3.875 x 7.5 inches).

COM10

Feed paper from the tray loaded with Envelope #10 (4.125 x 9.5 inches).

DL

Feed paper from the tray loaded with DL (110 x 220 mm).

C5
Feed paper from the tray loaded with C5 (162 x 229 mm).

MxNmm

Feed paper from the tray loaded with MxN mm defined by users.
Possible range specified:
Width: 76.2-220.0 mm
Length: 98.0-355.6 mm

MxNin

Feed paper from the tray loaded with MxN inches defined by users
Possible range specified:
Width: 3.00-8.66 inches
Length: 3.86-14.0 inches

If this option is not specified or the tray specified is not available, feed paper from the default tray.

-t

Turns on the save toner mode for printing. The print result will be fainter than that of normal printing. In some cases, this option will be ignored.

-r

Rotates the image by 90° and uses the paper in the landscape orientation

-n

Disables the addition of the showpage. It is used when files converted to the PostScript language program are merged with files created with other applications.

-l=left,bottom

Specifies the print position. Printing will be executed from the left and bottom of the page. The default is 0.25 inches for both left and bottom.

-s=width,height

Specifies the output size. Printing will be executed with the width and height in inches.

-S=width

Sets the width of the output size in inches. The height will be calculated automatically according to the width.

-E

This function turns on the image enhancement function. In some cases, this option will be ignored.
-Nc=copies

Specifies the number of output copies (the value of copies must be a positive integer).

-Cl

Specifies that printing be collated. If the copies option is not specified, this option will be ignored.

-Hd=position:format

Specifies the position to be output the user information as the header or footer. position specifies output position. But this option is available only for converting text files.

ul

Output on the upper left corner of the paper.

ur

Output on the upper right corner of the paper.

dl

Output on the lower left corner of the paper.

dr

Output on the lower right corner of the paper.

format specifies the contents and the order to output. This option is omissible. If this option is omitted, uh is specified as the default value.

u

User name

h

Host name

t

Date and time
If the output contents are specified as tuh, it is output as follows:
Date and Time User: username Host: hostname.

-Hf font

Specify the font to print header and footer. European fonts the same as half size alphanumeric fonts can be specified. Helvetica is specified as default. If the wrong font is specified, default European font of the multifunction printer can be used. If header/footer output option is specified, the font specification of header/footer is ignored.

-MSI
Specifies multipurpose feeder.

-M=type

Specifies multipurpose feeder Paper Type. Available multipurpose feeder Paper Types are as follows:

B
  FinePaper/Bond/Plain Paper 2
BB
  FinePaperBack/Bond/Plain Paper 2 - Side 2
P
  Stationary/Plain/Plain Paper 1
PB
  StationaryBack/Plain/Plain Paper 1 - Side 2
H1
  ThickPaper/Heavyweight 1/Covers 1
H1B
  ThickPaperBack/Heavyweight 1/Covers 1 - Side 2
H2
  ThickPaper2/Heavyweight 2/Covers 2
H2B
  ThickPaper2Back/Heavyweight 2/Covers 2 - Side 2
OHP
  Transparency
L
  LabelPaper/Labels
C2
  Coated/Coated 2/Coated Paper 2
C2B
  Coated Back/Coated 2/Coated Paper 2 - Side 2
C3
Coated Thick/Coated 3/Coated Paper 3

C3B

Coated Thick Back/Coated 3/Coated Paper 3- Side 2

E

Envelope

If this option is not specified, multipurpose feeder Paper Type of the multifunction printer can be used.

-Mfo=mode

Specifies orientation for multipurpose feeder. Available orientations for multipurpose feeder are as follows:

le

Landscape

ler

Landscape (Rotated)

se

Portrait

ser

Portrait (Rotated)

-Pon

Specifies alternate tray. Available alternate trays are as follows:

0

Use system settings

1

Display message

2

Feed from multipurpose feeder

3

Use nearest size (Adjust to fit)

4
-St=mode

Specifies feed separators from.
Available feed separators from the following:

auto

AutoTray/Auto

1

1stTray/Tray 1 (Standard 250-sheet tray)

2

2ndTray/Tray 2 (Optional 550-sheet paper feeder)

off

Off

-Sp

Specifies printed separators.
Available only when the paper tray for separators is specified.

-Sb

Specifies Skip Blank Pages.

-Cm=mode

Specifies output color.
Available output colors are as follows:

c

Color (CMYK)

k

Black
-Pr=mode

Specifies print mode.
Available print modes are as follows:

hs

High speed

hq

High quality

-Cc=mode

Specifies image types.
Available image types are as follows:

0

Off

1

Photo

2

sRGB

3

Standard/ Normal

4

Presentation

This option is available only for color printing and when entry data is RGB data.

-Gc=mode

Specifies RGB gamma correction.
Available RGB gamma corrections are as follows:

1.0

1.0

1.4

1.4

1.8

1.8
This option is available only for color printing and when entry data is RGB data.

-Sc=mode

Specifies screen. Available screens are as follows:

0

Fineness

1

Gradation

2

Auto

3

For Transparency

-Gg=mode

Specifies gray guaranteed. Available gray guaranteed options are as follows:

on

On

off

Off

This option is available only for color printing.

-Ct

Specifies color transformation. This option is available only for color printing.
-Br=mode

Specifies brightness adjustment.

Available brightness adjustment option value are as follows:

+5
  Bright 5
+4
  Bright 4
+3
  Bright 3
+2
  Bright 2
+1
  Bright 1
+0
  Normal
-1
  Dark 1
-2
  Dark 2
-3
  Dark 3
-4
  Dark 4
-5
  Dark 5

-RGBc=mode

Specifies RGB color correction.

Available RGB color corrections are as follows:

10
Perceptual
11

Saturation
12

Relative Colorimetric
13

Absolute Colorimetric

This option is available only for color printing and when entry data is RGB data.

-\texttt{RGBPr=mode}

Specifies RGB input profile.

Available RGB input profile option value are as follows:

0
sRGB
1
AdobeRGB

This option is available only for color printing and when entry data is RGB data.

-\texttt{RGBTp=mode}

Specifies RGB color temperature.

Available RGB color temperature option value are as follows:

5000
5000K
6000
6000K
9300
9300K

This option is available only for color printing and when entry data is RGB data.

Specifies adjustment value for color balance of each color/density.

Available adjustment values are as follows:

+3
  Dark 3
+2
  Dark 2
+1
  Dark 1
0
  Normal
-1
  Light 1
-2
  Light 2
-3
  Light 3
-Cb

Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0" (Normal).

For example, if you want to specify "Light 2" for Cyan medium density, "Dark 3" for Yellow high density, and "Dark 2" for Black low density, it can be specified using either of the following:

-Cb=0:2:0:0:0:0:0:0:+3:+2:0:0
-Cb=::2:::3:+3:+2::

-Hld=PrintType:UserID:Password:DocumentName

Secure Print

PrintType

store
Secure Print/Store Print
proof
Proof Print

UserID
Up to eight single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).

Password
Up to 12 single-byte characters from 0x30 to 0x39 (numeric characters).

DocumentName
Up to 12 single-byte characters from 0x20 to 0x7E, except 0x20 " " (blank) and 0x3A ":" (colon).

Secure Print
-Hld=store:UserID:Password:DocumentName
-Hld=store:UserID:Password:

Store Print
-Hld=store:UserID::DocumentName
-Hld=store:UserID::

Proof Print
-Hld=proof:UserID::DocumentName
-Hld=proof:UserID::

NOTICE: Ensure that you specify Secure Print only when you directly print data to a multifunction printer. Secure Print may not be available if you specify it when data need to be printed through another server or data need to be handled by another program such as PostScript files. Collate is automatically specified when you specify Proof Print.

-Jown=jobownername: Password Authentication Setting

Specifies the job owner name and password for authentication.

- When only job owner name is specified (-Jown=jobownername:) (no password specified), authentication password is treated as not specified.
- When only password is specified (-Jown=:password) (no job owner name specified), login user name is used as job owner name. Entered password is used as authentication password.
- When neither of job owner name nor password is specified (-Jown=:), login user name is used as job owner name, and authentication password is treated as not specified.
When a job owner name exceeds allowable character length, the extra characters are ignored.

When an unacceptable character is specified for job owner name, "Unknown User" is used as job owner name.

NOTE: Characters acceptable for job owner name are alphanumeric characters and symbols, except for space and colon.

NOTE: Up to 32 characters are acceptable for job owner name.

NOTE: When an unacceptable character is specified for password, or when a specified password is not within the range of the allowable character length, the authentication password is treated as not specified.

NOTE: Only numbers are acceptable for password.

NOTE: Acceptable password length is between 4 and 12 characters.

Incomplete form of -Jown option is treated as no authentication setting being made. In such case, if authentication setting is made with the environmental variable, it is used as setting information.

Example

To convert the XWD image into the PostScript language program and output it to a file, type as follows:

```
xwd2ps2 file.xwd > file.ps
```

To output the XWD image to a multifunction printer, type as follows:

```
xwd2ps2 file.xwd | lpr (for Linux)
xwd2ps2 file.xwd | lp (for Solaris/HP-UX)
```

Important

- When -s and -S are specified at the same time or when the same option is specified twice, the later setting will prevail.

- When the output size option (-s, -S) is not specified, scaling will be executed taking one pixel of the TIFF data as one pixel of the multifunction printer.

- If the print position option (-l left bottom) specifies a point beyond the printable area of the multifunction printer, data beyond the printable area will not be printed.

dellpsif (Linux)

Format
Function

If the first two characters of the input data are not `%!`, the dellpsif filter will convert it to the PostScript language program that can be output according to the paper size. If the first two characters of the input data are `%!`, it will be considered the PostScript language program and no data conversion will be executed. The following control codes are interpreted for the conversion of input data.

LF

   Line feed

FF

   Form feed

TAB

   8-column tab stop

BS

   Backspace 1 character

The dellpsif is the hard link file of txt2ps2. The dellpsif filter will be used as the IF filter specified by /etc/printcap. The lpd daemon will specify the following command options and start up the dellpsif filter.

dellpsif -w width -l length -i indent -n login -h host accountfile

In addition, options usable by txt2ps2 can be specified by the
/usr/local/dellbin3115/.dellpsdefault3115 file. With this option, detailed control can be achieved. However, if the input data are PostScript files, only the following options of txt2ps2 will become valid.

-d

   Enables the short-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the shorter edge of the pages can be bound. This option is available only when the optional duplexer is installed on the multifunction printer.

-D

   Enables the long-edge binding feature. When it is specified, the printing direction or position will be adjusted and both sides of the paper printed so that the longer edge of the pages can be bound. This option is available only when the optional duplexer is installed on the multifunction printer.
-I tray-input

  Specifies the paper tray. The parameters to be able to specify are the same as txt2ps2.

-t

  Turns on the save toner mode for printing. The print result will be fainter than that of normal printing. In some cases, this option will be ignored.

-E

  This function turns on the image enhancement function. In some cases, this option will be ignored.

-Nc=copies

  Specifies the number of output copies (the value of copies must be a positive integer).

-C1

  Specifies that printing be collated. If the copies option is not specified, this option will be ignored.

-ps

  The input file will be processed as the PostScript file. If the file does not begin with %!, %! will be output to the beginning line. For files with %!, this option will be ignored.

-MSI

  Specifies multipurpose feeder.

-M=type

  Specifies multipurpose feeder Paper Type. If this option is not specified, multipurpose feeder Paper Type of the multifunction printer can be used.

-Mfo=mode

  Specifies orientation for multipurpose feeder.

-Pon

  Specifies alternate tray.

-St=mode

  Specifies feed separators from.
-Sp
  Specifies printed separators.

-Sb
  Specifies Skip Blank Pages.

-Cm=mode
  Specifies output color.

-Pr=mode
  Specifies print mode.

-Cc=mode
  Specifies image types.
  This option is available only for color printing and when entry data is RGB data.

-Gc=mode
  Specifies RGB gamma correction.
  This option is available only for color printing and when entry data is RGB data.

-Sc=mode
  Specifies screen.

-Gg=mode
  Specifies gray guaranteed.
  This option is available only for color printing.

-Ct
  Specifies color transformation.
  This option is available only for color printing.

-Br= mode
  Specifies brightness adjustment.

-RGBc= mode
  Specifies RGB color correction.
This option is available only for color printing and when entry data is RGB data.

-rgbPr= mode

Specifies RGB input profile. This option is available only for color printing and when entry data is RGB data.

-rgbTpr= mode

Specifies RGB color temperature. This option is available only for color printing and when entry data is RGB data.


Specifies adjustment value for color balance of each color/density.

-cb Option value must be specified in the following order:

Cyan low density, Cyan medium density, Cyan high density, Magenta low density, Magenta medium density, Magenta high density, Yellow low density, Yellow medium density, Yellow high density, Black low density, Black medium density, Black high density

If no value is specified, it is treated as "0" (Normal).

File

/usr/local/dellbin3115/.dellpsdefault3115
This is the default command option setting.

Important

- The dellpsif filter ignores the pw and pl entries of /etc/printcap. Thus, the pw and pl entries cannot be used to change the option of each paper size.

- If the same option is specified for PostScript files which already have added options, such as paper selection, it will be ignored.

- Use the -ps option only when a PostScript file that contains no %! at the beginning of the file is processed as the PostScript file. If a normal text file is input, it will not function correctly.

Precautions and Limitations

During Installation

Pay attention to the following points during the installation.
Solaris

- Use `lpadmin` command to register the default printer.

  ```
  # lpadmin -d PrinterName
  ```

- To inhibit the banner sheets output, change the value of `nobanner=no` to `nobanner=yes` that includes in the file corresponding to the printer name in `/etc/lp/interfaces`.

- The printer registered by UNIX filter must not be changed by admintool.

- When `Content types: postscript` is displayed by typing `lpstat -p printername -l`, it’s necessary to delete the printer and reinstall.

- To install UNIX filter into the default directory `(/usr/local/dellbin3115)`, it’s necessary to create `/usr/local` directory in advance.

HP-UX

- The multifunction printer to specify as an output printer must be registered in your system. To register an output printer, use `sam` command and so on. See the HP-UX related manual for details.

- To install UNIX filter into the default directory `(/usr/local/dellbin3115)`, it’s necessary to create `/usr/local` directory in advance.

Linux

- To install UNIX filter into the default directory `(/usr/local/dellbin3115)`, it’s necessary to create `/usr/local` directory in advance.

During Printing

Pay attention to the following points during printing.

Using `lp/lpr` Command (Linux/Solaris/HP-UX)

- If an option is specified incorrectly, no error message will be output. If printing is not executed after the `lp` command is executed, activate each utility individually and error messages will be output. (Using Solaris, the error message is displayed on the screen. Using Linux, the error message is written into the error log file specified by `printcap`.)

- In text printing, the environmental variable `TXT2PS2OPTION` will be ignored.

- In text printing, if a BS code is found at the beginning of a line, the print position of the next character will be on the left of the beginning of the line.

- In text printing, when there are multiple tab codes in one line, the positions of tab may be off due to
automatic line feed. If this happens, specify \texttt{l} or \texttt{w} option.

- In text printing, the number of columns specified by the \texttt{w} option does not reflect the number of characters actually printed. The actual number of single-byte characters to be printed is derived by deducting the output column position (out columns) specified by the \texttt{o} option from the number of columns specified by the \texttt{w} option.

- If the same option is specified, or if \texttt{s}, \texttt{S} are both specified, the one specified later will prevail.

- In printing images, if the print position option (\texttt{l}) specifies an area beyond the printable area of the multifunction printer, data beyond the printable area will not be printed. (Using Solaris, it's impossible to output images by \texttt{lp} command.)

\textbf{Using \texttt{txt2ps2} (Linux/Solaris/HP-UX)}

- When the same option is specified twice, the later setting will prevail. As \texttt{TXT2PS2OPTION} is analyzed before the option of the command line, it is possible to temporarily modify the options already set in \texttt{TXT2PS2OPTION} by inputting at the command line.

- The default output of \texttt{txt2ps2} cannot output the comment description (\texttt{%%page:m n}) of the page number. This is because the converted PostScript language program controls line feed and form feed. Thus, when the output of \texttt{txt2ps2} is to be taken as the output of another application (\texttt{psrev} of \texttt{TRANSCRIPT}, etc.), add the page number description by inserting the line command (\texttt{-I lines}).

- If a BS code is found at the beginning of a line, the print position of the next character will be on the left of the beginning of a line.

- When there are multiple tab codes in one line, the positions of tab may be off due to automatic line feed. If this happens, specify the \texttt{-l} or \texttt{-w} option.

- The number of columns specified by the \texttt{-w} option does not reflect the number of characters actually printed. The actual number of single-byte characters to be printed is derived by deducting the output column position (out columns) specified by the \texttt{o} option from the number of columns specified by the \texttt{w} option.

- The \texttt{-mg} option cannot be specified when \texttt{-w}, \texttt{-l}, \texttt{-o}, and \texttt{-L} option are specified.

- The start positions of margins of the margin command (\texttt{-mg=u:b:r:l}) are not set against the edge of paper. The margins are set against the printable area for paper allowed by the multifunction printer.

- Use the \texttt{-ps} option only when a PostScript file that contains no \texttt{%!} at the beginning of the file is used as the PostScript file. If a normal text file is input, it will not function correctly.

- To use the same options as those of the \texttt{dellpsif} filter by \texttt{TXT2PS2OPTION}, set the user’s home directory in the environmental variable \texttt{HOME}. If the environmental variable \texttt{HOME} is not set up, the same options as those of the \texttt{dellpsif} filter cannot be used. (Linux)

\textbf{Using \texttt{sunras2ps2/tiff2ps2/xwd2ps2} (\texttt{sunras2ps2} apply to Solaris only)}

- If the same option is specified, or if \texttt{s}, \texttt{S} are both specified, the one specified later will prevail.

- If the size option (\texttt{s}, \texttt{S}) is not specified, scaling will be executed taking one pixel of the image data as one pixel of the multifunction printer.
- If the print position option (-l left bottom) specifies a point beyond the printable area of the multifunction printer, data beyond the printable area will not be printed.

**Using tiff2ps2 (Linux/Solaris/HP-UX)**

- There are four types of supported compression formats.
  - Huffman compression (CCITT Group 3 transformed Huffman run length encoding)
  - Fax-CCITT3 compression (facsimile-compatible CCITT Group 3)
  - PackBits compression
  - Non-compression

Even if the format is a supported format, the tiff that has multiple images in one file is not supported.

**Using xwd2ps2 (Linux/Solaris/ HP-UX)**

- There are three types of supported compression formats.
  - The visual class is Static Gray and the pixel is 1 bit.
  - The visual class is Pseudo Color and the pixel is 4 bits or 8 bit. The image format is Zpixmap.
  - The visual class is True Color and the pixel is 24 bits. The image format is Zpixmap.

**Using dellpsif (Linux)**

- Use the `-ps` option only when a PostScript file that contains no `%!` at the beginning of the file is used as the PostScript file. If a normal text file is input, it will not function correctly.

- `-w`, `-l` option usually correspond to `pw`, `pl` entry of `/etc/printcap`. However, this UNIX filter ignore `pw`, `pl` entry of `/etc/printcap`. So, the option cannot be changed by each page size using `pw, pl` entry.

**Printing PostScript Files (Linux/Solaris/ HP-UX)**

- If same options for the PostScript file that contains options, such as paper size, are specified using dellpsif (Linux) or the `lp` command (Solaris/HP-UX), the specified option will be ignored.

**Printing Image Files (Solaris)**

- To print image files from Solaris the user cannot specify the image file directly with the `lp` command for printing. Make use of `sunras2ps2`, `tiff2ps2`, `xwd2ps2` and convert the file to a PostScript file. Output it using the `lp` command after the conversion.

```bash
% xwd2ps2 file.xwd | lp
```

**The double-sided printing (Linux/Solaris/HP-UX)**

- The multifunction printer without an optional duplexer is unable to do double-sided printing.
Header/footer Option (-Hd=position:format:page, -Hfheaderfont) (txt2ps2,sunras2ps2,tiff2ps2,xwd2ps2)

- If the paper size is not specified when using options, it outputs the header/footer at the position of A4-size paper. To specify the paper size at the same time to use header/footer option. (If the paper size for the PostScript file converted by using the option is specified by the option of \texttt{lp} command for example, the position of the header and footer cannot be changed.)

- The margin is specified automatically when the option is used. When the option to specify the margin is used at the same time, the value that is smaller than the value specified automatically as follows is ignored.

  In case of text files
  
  Upper margin: 0.23 inch
  Lower margin: 0.06 inch
  Right margin: 0.03 inch
  Left margin: 0.09 inch

  In case of images
  
  Lower margin: 0.3 inch

- When using the option, the number of lines and the number of columns specified are ignored. Also, it is impossible to specify landscape and 2-column.

- In case of the PostScript file, it happens that the multifunction printer doesn't output all pages despite that \texttt{output all page} is specified. In such a case, specify \texttt{print the only top page}.

- It's impossible to use \texttt{lp} command in Solaris.

TBCP Filter (Solaris/Linux/HP-UX)

- Ensure that the TBCP Filter is available so the multifunction printer can specify the availability of the TBCP Filter.

For Libtiff Software

Copyright © 1988-1997 Sam Leffler


THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Printing With CUPS (Linux)

This section provides information for printing or setting up the printer driver with CUPS (Common UNIX Printing System) on Turbolinux 10 Desktop, RedHat ES 3/4 or SUSE 9.2/9.3.

- **Operation on Turbolinux 10 Desktop or RedHat ES 3/4**
- **Operation on SUSE 9.2/9.3**

### Operation on Turbolinux 10 Desktop or RedHat ES 3/4

#### Installing the Printer Driver

1. Double-click **Dell-MFP-Laser-3115cn-x.x-x.noarch.rpm** in the **Drivers and Utilities** CD.
2. Type the administrator's password.
3. Click **Continue** in the **Completed System Preparation** window.
   Installation starts. When the installation is complete, the window is automatically closed.

#### Setting Up the Queue

To execute printing, you must set up the print queue on your workstation.

1. Start the Web browser. Type **http://localhost:631/** in **Location**, and then press the **Enter** key.
2. Click **Manage Printers**.
3. Click **Add Printer** at the bottom of the window.
4. Type **root** as the user name, and type the administrator's password.
5. Type the printer's name in the **Name** box in the **Add New Printer** window, and then click **Continue**.
   The **Location** and **Description** do not have to be specified.
6. Select **LPD/LPR Host or Printer** from the **Device** menu, and then click **Continue**.
7. Type the printer's IP address in **Device URI**.
   Format: **lpd://xxx.xxx.xxx.xxx** (printer's IP address)
8. Select **Dell** from the **Make** menu, and then click **Continue**.
9. Select **Dell MFP Laser 3115cn...** from the **Model** menu, and then click **Continue**.
   The message **Printer xxx has been added successfully.** appears.

The set up is complete.
When you have finished setting up the queue you can print jobs from the software program. Start the print job from the software program, and then specify the queue in the print dialog box.

However, sometimes you can only print from the default queue depending on the software program (for example Mozilla). In these cases, before you start printing, set the queue you want to print to as the default queue. For information on specifying the default queue, see "Setting the Default Queue."

**Setting the Default Queue**

1. Click **Start → System → Terminal**.
2. Type the following command in the terminal window:
   
   ```
   su
   (Type the administrator's password)
   lpadmin -d (The queue name)
   ```

**Specifying the Printing Options**

You can specify the printing options such as color mode or double-sided printing.

1. Start the Web browser. Type `http://localhost:631/` in Location, and then press the Enter key.
2. Click **Manage Printers**.
3. Click **Configure Printer** of the queue for which you want to specify the printing options.
4. Type root as the user name, and type the administrator's password.
5. Specify the required settings, and then click **Continue**.
   The message **Printer xxx has been configured successfully.** appears.

The setting is complete. Execute printing from the software program.

**Uninstalling the Printer Driver**

1. Click **Start → System → Terminal**.
2. Type the following command in the terminal window:
   
   ```
   su
   (Type the administrator's password)
   rpm -e Dell-MFP-Laser-3115cn
   ```

The printer driver is uninstalled.
Operation on SUSE 9.2/9.3

Installing the Printer Driver

1. Double-click **Dell-MFP-Laser-3115cn-x.x-x.noarch.rpm** in the *Drivers and Utilities* CD.
2. Click **Install package with YaST**.
3. Type the administrator's password. Installation starts. When the installation is complete, the window is automatically closed.

Setting Up the Queue

To execute printing, you must set up the print queue on your workstation.

1. Click **Start** → **Applications** → **System** → **YaST**.
2. Type the administrator's password. **YaST Control Center** is activated.
3. Select **Hardware** from **Printer**.
4. **Printer setup: Autodetected printers** is activated.
   For USB connections:
   a. Select **Dell MFP Laser 3115cn** on USB (**//Dell/MFP%20Laser%203115cn** or **/dev/usblp**) as **Available are**, and then click **Configure...**
   b. Confirm the settings in **Edit configuration**, and then click **OK**.

   For parallel connections:
   a. Select **Other (not detected)** as **Available are** in **Printers to configure**, and then click **Configure...**
   b. Select **Parallel printer** as **Printer Type**, and then click **Next**.
   c. Click **Next**.
   d. Set the name of the printer queue in **Queue name**, and type the queue name for printing in **Name for printing**. The **Description of Printer** and **Location of Printer** do not have to be specified.
   e. Select the **Do Local Filtering** check box, and then click **Next**.
   f. Select **DELL** in **Select manufacturer**. Select **Dell MFP Laser 3115cn** in **Select Model**, and then click **Next**.
g. Confirm the settings in Edit configuration, and then click OK.

For network connections:

a. Select Other (not detected) as Available are in Printers to configure, and then click Configure....

b. Select the Print via LPD-Style Network Server as Printer Type, and then click Next.

c. Type the printer’s IP address in Host name of the printer server. And type the name of the printer queue in Name of the remote queue, and then click Next.

d. Set the name of the printer queue in Queue name, and type the queue name for printing in Name for printing. The Description of Printer and Location of Printer do not have to be specified.

e. Select the Do Local Filtering check box, and then click Next.

f. Select DELL as Select manufacturer. Select Dell MFP Laser 3115cn as Select Model, and then click Next.

g. Confirm the settings in Edit configuration, and then click OK.

5. Click Finish.

Printing From the Application Program

When you have finished setting up the queue you can print jobs from the application program. Start the print job from the application program, and then specify the queue in the print dialog box.

However, sometimes you can only print from the default queue depending on the application program (for example Mozilla). In these cases, before you start printing, set queue you want to print to as the default queue. For information on specifying the default queue, see "Setting the Default Queue".

Setting the Default Queue

1. To activate the Printer setup: Autodetected printers, do the following:
   a. Click Start→Applications→System→YaST.

   b. Type the administrator's password. YaST Control Center is activated.

   c. Select Hardware from Printer.

2. Printer setup: Autodetected printers is activated.

3. Click Change....
4. Select the multifunction printer you want to set to default, and then click **Set as default**.

5. Click **Finish**.

### Specifying the Printing Options

You can specify the printing options such as color mode or double-sided printing.

1. Start the Web browser. Type `http://localhost:631/` in **Location**, and then press the **Enter** key.

2. Type `root` as the user name, and type the administrator's password. The **CUPS** window appears.

   **NOTE:** Set the password for authority as the printer administrator before setting the printer queue. If you have not set it, go to "Setting the Password for Authority as the Printer Administrator".

3. Click **Manage Printers**.

4. Specify the required settings, and then click **Continue**. The message **Printer xxx has been configured successfully**. appears.

The setting is complete. Execute printing from the application program.

### Setting the Password for Authority as the Printer Administrator

You must set the password for authority as the printer administrator to do operations as the printer administrator.

1. Click **Start ➔ Applications ➔ System ➔ Terminal ➔ Konsole**.

2. Type the following command on the terminal window:

   ```
   su
   (Type the administrator's password.)
   lppasswd -g sys -a root
   (Type the password for authority as the printer administrator after the Enter password prompt.)
   (Retype the password for authority as the printer administrator after the Enter password again prompt.)
   ```

### Uninstalling the Printer Driver

1. Click **Start ➔ Applications ➔ System ➔ Terminal ➔ Konsole**.
2. Type the following command on the terminal window:

```
su
(Type the administrator's password)
rpm -e Dell-MFP-Laser-3115cn
```

The printer driver is uninstalled.
Safety and Regulatory Information

- Safety Information
- Regulatory Information
- Noise Emissions Levels
- Laser Notice
- Energy Star
- MSDS Materials for Dell Printer
- Telecommunication Line Cord
- When Using the Telephone Equipment

Safety Information

⚠️ CAUTION: Read and follow all safety instructions in your Owner’s Manual or Product Information Guide prior to setting up and operating your printer.

Regulatory Information

Federal Communications Commission (FCC) Compliance Information Statement (US Only)

The Dell™ Multifunction Color Laser Printer has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult your point of purchase or service representative for additional suggestions.
The manufacturer is not responsible for any radio or television interference caused by using other than recommended cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could void the user's authority to operate this equipment.

**NOTE:** To assure compliance with FCC regulations on electromagnetic interference for a Class A computing device, use a properly shielded and grounded CABLE. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC regulations.

**FCC Identification Information**

The following information is provided on the device or devices covered in this document in compliance with FCC regulations:

- Model number: Dell™ Multifunction Color Laser Printer
- Company name: Dell Inc.
  One Dell Way
  Round Rock, Texas 78682 USA
  512-338-4400

**FCC Information**

This device, IEEE 802.11g Wireless LAN USB Adapter, complies with Part 15 of the FCC Rules.

Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received; including interference that may cause undesired operation.

**Warning:** Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user authority to operate the equipment.

Tested to comply with FCC standard. FOR HOME OR OFFICE USE.

**FCC RF Radiation Exposure Statement:**

1. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment, under 47 CFR 2.1093 paragraph (d)(2).
2. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

The **IEEE 802.11g Wireless LAN USB Adapter** has been tested to the FCC exposure requirements
Industry Canada Compliance Statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Avis de Conformité aux Normes de l'industrie du Canada

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

European Community (EC) Directives Conformity

This product has been determined to be in compliance with 73/23/EEC (Low Voltage Directive), 89/336/EEC (EMC Directive), and amendments of the European Union.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

CE Notice (European Union)

Marking by the symbol indicates compliance of this Dell printer to the EMC Directive and the Low Voltage Directive of the European Union. Such marking is indicative that this Dell system meets the following technical standards:

- EN 55024 - Information Technology Equipment - Immunity Characteristics - Limits and Methods of Measurement.
- EN 61000-3-2 - Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 2: Limits for Harmonic Current Emissions (Equipment Input Current Up to and Including 16 A Per Phase).
- EN 61000-3-3 - Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 3: Limitation of Voltage Fluctuations and Flicker in Low-Voltage Supply Systems for Equipment With Rated Current Up to and Including 16 A.
- EN 60950 - Safety of Information Technology Equipment.

NOTE: EN 55022 emissions requirements provide for two classifications:

- Class B is for typical domestic areas.
This Dell device is classified for use in a typical Class B domestic environment.

A Declaration of Conformity in accordance with the preceding directives and standards has been made and is on file at Dell Inc. Products Europe BV, Limerick, Ireland.

**CE Mark Notice**

This equipment complies with the essential requirements of the European Union Directive 1999/5/EC.

*Cet équipement est conforme aux principales caractéristiques définies dans la Directive européenne RTTE 1999/5/CE.*

*Die Geräte erfüllen die grundlegenden Anforderungen der RTTE-Richtlinie (1999/5/EC).*

*Questo apparecchiatura è conforme ai requisiti essenziali della Direttiva Europea R&TTE 1999/5/CE.*

*Este equipo cumple los requisitos principales de la Directiva 1999/5/CE de la UE, “Equipos de Terminales de Radio y Telecomunicaciones”*

*Este equipamiento cumple los requisitos esenciales da Directiva 1999/5/CE do Parlamento Europeu e do Conselho (Directiva RTT).*

*Ο εξοπλισμός αυτός πληροί τις βασικές απαιτήσεις της κοινοτικής διάταξης EU R&TTE 1999/5/ΕΚ.*

*Deze apparaat voldoet aan de noodzakelijke vereisten van EU-wetgeving betreffende radioapparatuur en telecommunicatie-eindapparatuur 1999/5/EG.*

*Dette udstyr opfylder de Værsligle krav i EU's direktiv 1999/5/EC om Radio- og teleterminaludstyr.*

*Dette utstyr er i overensstemmelse med hovedkravene i R&TTE-direktivet (1999/5/EC) fra EU.*

*Utrustningen uppfyller kraven för EU-direktivet 1999/5/EC om ansluten teleutrustning och ömsesidigt erkännande av utrustningens överensstämmelse (R&TTE).*


**Información NOM (únicamente para México)**

La información siguiente se proporciona en el dispositivo o en los dispositivos descritos en este documento, en cumplimiento con los requisitos de la Norma Oficial Mexicana (NOM):
Exportador: Dell Inc.  
One Dell Way  
Round Rock, TX 78682

Importador: Dell Computer de México, S.A. de C.V.  
Paseo de la Reforma 2620 - 11° Piso  
Col. Lomas Altas  
11950 México, D.F.

Enviar a: Dell Computer de México, S.A. de C.V.  
al Cuidado de Kuehne & Nagel de México S. de R.L.  
Avenida Soles No. 55  
Col. Peñón de los Baños  
15520 México, D.F.

Número del modelo: Dell Multifunction Color Laser Printer 3115cn

Tensión de alimentación: 110-127 VAC

Frecuencia: 50/60 Hz

Consumo de corriente: 11 A

**Noise Emissions Levels**

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

<table>
<thead>
<tr>
<th>1-meter average sound power level, B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
</tr>
<tr>
<td>Without option: 6.3B</td>
</tr>
<tr>
<td>With full option: 6.8B</td>
</tr>
<tr>
<td>Idling</td>
</tr>
<tr>
<td>4B</td>
</tr>
</tbody>
</table>

**Laser Notice**

The printer is certified in the U.S. to conform to the requirements of 21CFR, Chapter 1, Subchapter J for Class I (1) laser products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1.

Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser that is nominally a 5 milliwatt gallium arsenide laser operating in the wavelength region of 770-795 nanometers. The laser system and printer are designed so there is never any human access to laser radiation above a Class I level during normal operation, user maintenance, or prescribed service condition.
Energy Star

ENERGY STAR® Compliance

Any Dell product bearing the ENERGY STAR® emblem on the product or on a start-up screen is certified to comply with Environmental Protection Agency (EPA) ENERGY STAR® requirements as configured when shipped by Dell.

ENERGY STAR® Emblem

The EPA’s ENERGY STAR® program is a joint effort between the EPA and manufacturers to reduce air pollution by promoting energy-efficient products.

You can help reduce electricity usage and its side effects by turning off your product when it is not in use for extended periods of time, particularly at night and on weekends.

MSDS Materials for Dell Printer

All MSDS materials for Dell Printers can be found at the following URL:
http://www1.us.dell.com/content/topics/global.aspx/corp/environment/en/prod_design?c=us&l=en&s=corp&~section=001

Telecommunication Line Cord
CAUTION: To reduce the risk of fire, use only No. 26 AWG or larger telecommunication line cord.

When Using the Telephone Equipment

When using your telephone equipment, basic safety precautions should always be followed to reduce the risk of fire, electric shock and injury to persons, including the following:

- Do not use this product near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.

- Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from lightning.

- Do not use the telephone to report a gas leak in the vicinity of the leak.

- Use only the power cord indicated in this manual.
Appendix

- Dell Technical Support Policy
- Contacting Dell
- Warranty and Return Policy

Dell Technical Support Policy

Technician-assisted technical support requires the cooperation and participation of the customer in the troubleshooting process and provides for restoration of the operating system, software program and hardware drivers to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical support is available at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for third-party software and peripherals is provided by the original manufacturer, including those purchased and/or installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus).

Contacting Dell

You can access Dell Support at [http://www.support.dell.com/](http://www.support.dell.com/). Select your region on the top page, and fill in the requested details to access help tools and information.

You can contact Dell electronically using the following addresses:

- **World Wide Web**
  - [http://www.dell.com/ap/](http://www.dell.com/ap/) (for Asian/Pacific countries only)
  - [http://www.euro.dell.com](http://www.euro.dell.com) (for Europe only)

- **Anonymous file transfer protocol (FTP)**
  - Log in as user: anonymous, and use your email address as your password.

- **Electronic Support Service**
  - mobile_support@us.dell.com
  - support@us.dell.com
  - apsupport@dell.com (for Asian/Pacific countries only)
  - support.euro.dell.com (for Europe only)

- **Electronic Quote Service**
  - apmarketing@dell.com (for Asian/Pacific countries only)
Warranty and Return Policy

Dell Computer Corporation ("Dell") manufactures its hardware products from parts and components that are new or equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your printer, see the Owner's Manual or Product Information Guide.